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All Users I
This section contains instructions for OpenText customers using Trading Grid 
Online products.The information is organized by the various components that 
comprise Trading Grid Online.

■ “Introduction”

■ Chapter 1, “Getting Started”

■ Chapter 2, “Operations Center”

■ Chapter 3, “Transaction Manager”

■ Chapter 4, “File Transfer Service”

■ Chapter 5, “Active Documents”

■ Chapter 6, “Document Manager”

■ Chapter 7, “Reports for Trading Grid Messaging Service”

■ Chapter 8, “Active Invoices with Compliance”

■ Chapter 9, “Trading Grid Analytics”

Note: You might not have access to all of the components described in this guide. 
The products and features available are based on your trading community and 
subscription permissions.
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Introduction

Trading Grid Online is a single, global, and multi-lingual portal that provides easy 
access to OpenText products and services.

You can send and receive documents directly from Trading Grid Online, and view 
reports showing your sent and received document activity.

Trading Grid Online also interfaces with the OpenText Trading Grid Messaging 
Service (TGMS), which enables the electronic exchange of inbound and outbound 
business documents in a secure, fast, and reliable manner. As a TGMS customer, 
you can use Trading Grid Online to administer your mailbox, including such 
activities as adding and maintaining EDI addresses, trading partnerships, and other 
users within your account. Trading Grid Online administers, monitors, manages, 
and reports TGMS transactions by:

■ Trading information electronically with your global partners efficiently.

■ Reporting the status of both sent and received documents. 

Note: For more information about TGMS, refer to the OpenText TGMS User Guide.

About This Guide
This guide explains how to navigate Trading Grid Online and use the various 
components, depending on your role and subscription priveleges.

Audience
This guide is intended for the following audience:

■ Company Administrators

■ Company Users
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System Requirements 

Operating System
OpenText Trading Grid Online supports the following operating systems:

■ Microsoft Windows

■ Mac OS X

Browser Requirements
Trading Grid Online supports the following browsers:

■ Internet Explorer v11 

■ Mozilla Firefox v46

■ Google Chrome, as needed

Browsers must be enabled for JavaScript, and popup blockers must be disabled.

PC Requirements
■ Personal Computer (500MHz) 

■ 256MB RAM

■ Recommended screen display setting: 1024 x 768

Conventions Used in This Guide
This guide uses the following conventions:

Convention Description Example

Bold text Buttons, fields, menu options, and 
hyperlinks in Trading Grid Online.

Click Save.

“Blue text in quotes” Links to other sections in the guide. “Navigate Trading Grid 
Online” on page 6. 

Italic text References other relevant 
publications.

See the TGMS User Guide.

Trading Grid Online Support

Online Help
To access the online help for a Trading Grid Online page, click in the title bar.
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Contact Us
If you cannot find an answer to your questions in online help, contact the 
OpenText Client Services Help Desk by phone or email.

1 Click in the title bar from any page in Trading Grid Online.

The Customer Support links display.

2 Click the appropriate link to locate the email address or phone number for the 
Client Services Help Desk near your location.
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Getting Started 1
This chapter provides an overview of Trading Grid Online, including navigation tips 
and how to set up your user profile.

Topics include:

■ “Access Trading Grid Online” on page 5

■ “Navigate Trading Grid Online” on page 6

■ “User Profiles” on page 7

■ “Configure Trading Grid Online” on page 9

Access Trading Grid Online
To access Trading Grid Online
1 Go to the following URL from your Internet browser:

https://tradinggrid.gxs.com/ 

2 Log in to Trading Grid Online with your user name and password.
The Operations Center page opens. 

The Operations Center is the home page for Trading Grid Online. This page 
displays Alerts, Announcements, Invitations, and other notifications. For more 
about using the Operations Center, see “Operations Center” on page 11.

https://tradinggrid.gxs.com/
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Navigate Trading Grid Online

Navigation Panel
All Trading Grid Online pages have a similar layout. The Navigation Panel on the 
left side of every page is a is collapsible panel that provides access to the 
components that your company subscribes to. The component buttons indicate the 
functions that you can perform from a page. You can show or hide the Navigation 
Panel and configure the way the components functions display.

To show or hide the Navigation Panel
Click  to collapse the panel.

Click to show the panel.

Trading Grid Online Tabs
The Trading Grid Online tabs display the components that your company is 
subscribes to. 

Note: The Trading Grid Online tabs in your application also depend on your role 
and user access privileges.
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User Profiles
Your user profile contains your contact information, user ID, and password that 
you defined during registration. It also lists your service privileges. You can update 
the information at any time.

To update profile information
1 Click My Profile.

The My Profile page opens.
 

2 Update your information in the Personal Information section, as needed.
3 Click Submit from the Actions drop-down menu. 

To view Service Privileges
1 Select Service Privileges from the My Profile page. 

The Service Privileges page indicates the your service access with check marks 
next to the approved services.
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User Profiles

Example: Service Access Priviledges (not a complete list of services).
.

Note: Only your Company Administrator can add or change your access privileges 
in Trading Grid Online.

To change your password
1 Click Change Password from the My Profile page.
2 Type the updated password information.
3 When finished, click Actions > Submit.

Note: The Community Manager or Company Administrator might have defined 
password policies, such as an expiration period or content restrictions, that 
apply to all users at your company or in your community. 

To change your User ID
1 Click Change User ID.
2 Type the updated User ID information.
3 When finished, click Actions > Submit.

To update security question information
1 Click Update Security Questions. 
2 For questions 1 through 5, use the drop-down menu to select a desired security 

question, and type the appropriate answer. 
3 When finished, click Submit.
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Configure Trading Grid Online
You can change the layout and the contents displayed on configurable Trading Grid 
pages. 

To configure Trading Grid Online pages
1 Click  in the title bar.

Note: If the configure icon does not display in the title bar, the page is not 
configurable.
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Configure Trading Grid Online
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Operations Center 2
This chapter describes the Trading Grid Online Operations Center. 

Topics include:

■ “Overview” on page 11

■ “Message Center” on page 12

■ “Configure the Operations Center” on page 13

■ “User Options” on page 17

Overview
The Operations Center opens automatically when you log in to the system. This 
page is the home page for Trading Grid Online and it is available to all users.  

Note: The features available from the Operations Center are based on your role 
and subscription permissions.
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Message Center
The Message Center displays system messages and alerts. 

Message Dashboard
The Message Dashboard shows new, unopened messages and the date that the 
newest message was received.

Message Types
There are four types of messages in the dashboard: 

Message Type Description

Alerts Notifications about important information that might require 
attention.
The system keeps Alert messages until the number of days 
specified in the message.

Announcements Notifications about Trading Grid Online issues or events.
The system keeps Announcement messages until the number of 
days specified by your Company Administrator.

New Features Notifications about new or upcoming Trading Grid Online 
features.
The system keeps Announcement messages until the number of 
days specified by your Company Administrator.

Invitations Invitations provide invitation statistics.

Alerts Section
The messages display in the Alerts section (on the right side of the page).

Manage Messages

Main Area
The content area contains text and data based upon the selected link or tab. The 
information displayed is configurable.

To Do this

View a message. 1 Click the type of message you want to view.
2 Select a message.

The message opens in the Alerts section.

Save a message. 1 Select a message.
2 Click Actions > Save.

The message is saved until you delete it manually.

Delete a message. 1 Select a message.
2 Click Actions > Delete.

The message is deleted.
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Configure the Operations Center
You can configure the Operations Center by copying up to five other components 
to the page, and set up the page layout and content display to access the easily.

Copy Components

To copy components to the Operations Center

1 Click  in the title bar.
 

The Configure this Page window opens.

2 Click the Page Components arrow.
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Configure the Operations Center

The Page Components section lists your available components.

3 Check the appropriate checkboxes in the Copy to Operations Center section 
for the components you want to copy. 

4 Click Set Components. 

The Component column list the copied components.

5 Click Apply. 
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You can now access the copied components from the Navigation Panel. 
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Other Page Options
To Do this

Show or hide columns Click  to hide the column.

Click  to show the column.

Print information from a section Click .

Hide component data Click the Minimize icon > Apply.

Display component data Click the Maximize icon > Apply.

Remove a component Check the component checkbox, and click Remove > Apply.

Change the sequence of components 
on a page

In the Order column, number the components in the desired 
order. Click Apply.
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User Options
■ “Intelligent Web Form (IWF) Users” on page 17

■ “Active Documents Users” on page 17

■ “Active Invoices with Compliance (AIC) Users” on page 17

■ “Trading Grid Messaging Service (TGMS) Users” on page 17

■ “Trading Grid Resellers” on page 18

■ “Company Administrators” on page 18

■ “Community Administrators” on page 18

Intelligent Web Form (IWF) Users
Use the Operations Center to perform the following tasks:

■ View, save, and delete documents

■ Access files and documents from your Inbox or Sendbox

To access documents from the Operations Center 

1 In the Type column of the Message Dashboard, click the Document 
Manager link.

A summary of your documents opens.

To access files and documents from your Inbox or Sendbox
Do one of the following:

■ Click the applicable number in the Total column of the Message Dashboard.

■ Click the Document Manager tab to open Document Manager.

Active Documents Users
If your company subscribes to the current version of Active Documents, click the 
Active Documents tab.

Otherwise, click the Reports Tab for the older version of Active Documents. See 
Appendix B, “Active Documents Classic”.

Active Invoices with Compliance (AIC) Users 
To work with your invoices, click the Reports tab.

Trading Grid Messaging Service (TGMS) Users
To upload or send a file from the Transaction Manager, click the Transaction 
Manager tab.

To see all Trading Grid Online subscription reports, click the Reports tab.
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Trading Grid Resellers
To set up a new company, or to view and modify information for an existing 
company’s Trading Partners, users, alerts and configurations, and more, click the 
Community Manager tab.

Note: This tab is available only to Community Administrators and Resellers.

Company Administrators
To view and modify information about your Trading Grid account, your Trading 
Partners, your company users, your company alerts and configurations, and more, 
click the Account Manager tab.

Note: This tab is available only to Community Administrators.

Community Administrators
To view and modify information for a Trading Grid company, Trading Partner, 
company user, company alerts and configurations, and more for your community, 
click the Community Manager tab.

Note: This tab is available only to Community Administrators and Resellers.
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Transaction Manager 3
This chapter describes how to send and receive documents from your mailbox 
using the Transaction Manager. 

Topics include:

■ “Overview” on page 19

■ “File Inbox” on page 19

■ “View or Download a Transaction File” on page 20

■ “Upload and Send a File” on page 22

Overview
From the Transaction Manager, you can view and download documents from your 
Trading Grid Messaging Service mailbox.  You can also send both EDI and non-EDI 
documents to your trading partners.

The Transaction Manager displays the transactions waiting in your mailbox from 
Trading Partners and allows you to copy them to your desktop. This feature 
eliminates the need to use a separate communications software package or 
protocol, as well as unsuccessful retrievals due to software or protocol session 
version conflicts.

File Inbox
The File Inbox lists trading partner transactions in your mailbox. You can retrieve, 
download, and view these transactions. 
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The File Inbox provides the following information for each transaction:

Field Description

Your EDI Address The EDI address where the transaction was sent. 

Trading Partner EDI Address The EDI address of the trading partner that sent the 
transaction. 

Partner's Company The name of the trading partner's company. 

Application Reference Refers to the type of data in the file. For example, 850. 

Control Number The Interchange Control Number of inbound and 
outbound data.

ILOG The Input Log Number (ILOG), assigned by Trading Grid 
Online to uniquely identify a file transmitted by the Sender 
for tracking purposes. 
An ILOG is an 11-digit number, based on the combination 
of the month, day, Greenwich Mean Time, and the decimal 
fraction of the hour.

Data Type The application reference document type. 

Mailbox Process Date/Time The date and time when the transaction was available for 
pickup from the mailbox. 

GXS Receipt Date/Time The date and time when GXS received the transaction. 

Days Before System Deletion The number of days before Trading Grid Online deletes 
the transaction, as specified by a user or company.
Note: Deleted files cannot be accessed or retrieved. 

Reactivate Flag (Icon) Indicates that the receiver has reactivated the file. 

View or Download a Transaction File
To view or download a transaction file

1 Click the Transaction Manager tab.

2 Click the Control Number of the applicable transaction.

The File Download dialog box opens.
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3 Do one of the following: 

■ Select Save File. Follow the prompts to download the transaction file to 
your desktop.

■ Select Open with, and click Browse to open the application.

Important: 

■ For large transaction file sizes (and depending on connection speed), the 
download might take some time.

■ If you cancel the File Download dialog in this step, Trading Grid Online still 
considers the transaction “received” from your mailbox. That transaction is 
no longer in your File Inbox. 

■ After you receive a transaction, it is viewable as an “opened” transaction in 
your Inbound Status report under the Reports tab. From the report, 
select the transaction and click the Inbound Reactivate command to 
send the transaction back to your File Inbox again. For more information, 
see “Document Manager.”
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Upload and Send a File
To upload and send a file to a Trading Partner

1 Create the file on your desktop computer; for example:
ISA*00*          *00*          *ZZ*JDZ00005       *ZZ*DEMOHUB01      
*050301*1446*^*00403*000001024*0*T*>

GS*PO*JDZ00005*DEMOHUB01*20050301*1446*121*X*004030

ST*850*00121024

BEG*00*SA*PO100**20050926

REF*AN*AN547794

PER*BD*JOHN SMITH*TE*(203) 452-9390

FOB*PP

DTM*002*20050301

DTM*118*20050315

TD5****M*TRUCK

N9*AH*AH520981

MTX**ALL COSTS AND ALLOWANCES ARE CONSIDERED CONFIRMED UPON YOUR

MTX**EDI VENDOR ACCT 49999001

MTX**FAX:888-999-2207/403-999-2789

MTX**THIS PURCHASE ORDER IS SUBJECT TO THE SAME TERMS AND

MTX**CONDITIONS AS COMPANY ABC PURCHASE ORDER FORM 662

N1*BT*SAFEWAY*9*1234567892222

N3*P.O. BOX 29093

N4*PHOENIX*AZ*85038*USA

N1*ST*TRACY PRODUCE*9*1234567894444

N3*16900 WEST SCHULTE ROAD

N4*TRACY*CA*95376*USA

PO1**100*CA*10.96**UA*114299966412

PID*F*08***BLUE JEANS, MENS SIZE 34x32

PO1**200*CA*2.96**UA*224299966412

PID*F*08***T SHIRTS, MENS SIZE LARGE

PO1**300*CA*3.96**UA*334299966412

PID*F*08***BOXER SHORTS, MENS SIZE LARGE

PO1**400*CA*14.96**UA*444299966412

PID*F*08***TENNIS SHIRT, WHITE, MENS SIZE MEDIUM

CTT*4

SE*32*00121024

GE*1*121

IEA*1*000001024

2 Click the Transaction Manager tab.

The File Inbox page opens.

3 Click Sending Files from the Navigation Panel.



T RA N S A C T I O N  M A N A G E R
Upload and Send a File

Trading Grid Online  23

3  

The Sending Files page opens.

4 Type the filename path, or click Browse to locate the file you want to send. 

Note: Contact OpenText Support if you do not know, or cannot find, the 
applicable filename.

5 To verify that the selected file is correct, click View (optional).
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6 Do one of the following: 

■ If the file contains the partner's address information, click send to send the 
file.

■ If the file does not contain the partner’s address information, continue to 
step 7.

7 Check the Recipient data is embedded in the file check box.

The page refreshes and displays additional fields.   

8 Provide the appropriate information in the new fields. All fields are required.

9 When finished, click Send.

Column Name Description

Trading 
Relationship

The name of the trading partner that you want to receive the 
file. 

Sender's Reference The sender's Transmission Reference number. This number 
identifies either the file or the interchange control number.

Application 
Reference

Indicates the type of data contained in the file, for example, 
850. 
Note: Trading Grid Online automatically appends *BIN to the 
Application Reference for non-EDI documents. 
To disable the Application Reference:

1 Click the Configure icon in the title bar. 
2 Check the Append *BIN to Application Reference for 

Non-EDI documents checkbox.
3 Click Apply.
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File Transfer Service 4
File Transfer Service (FTS) is an application hosted by OpenText, which iused by 
companies and their trading partners to share EDI and non-EDI files over the 
Internet. 

This chapter explains how to manage and share files using FTS.

Topics include: 

■ “Browser Requirements” on page 25

■ “Search for Files” on page 26

■ “Upload Files” on page 28

■ “Download Files” on page 30

■ “Delete Files” on page 30

■ “Export FTS File Metadata” on page 31

■ “View File History” on page 32

■ “View a Partner’s FTS” on page 33

Browser Requirements
FTS runs on the following Internet browsers. 

■ Internet Explorer, Versions 10 and 11

■ Firefox, Version 29 (and greater)
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File Transfer Service Tab
This section explains how to search for files in Retrieve Files (files your partner sent 
to you for download in FTS) and Send Files (files your company uploaded to FTS 
for download by your trading partner) in FTS.  

Search for Files
To find files in FTS
1 In the Navigation panel, click Retrieve Files or Send Files, depending on the 

type of files you want to view.
■ Send Files lists files your company uploaded. 

■ Retrieve Files lists files your partners uploaded.

Note: Hub users also have My View and Support User View tabs at top 
left. My View (default) shows the hub company’s view of received and sent 
files. To use Support User View to view a partner’s FTS view, see “View a 
Partner’s FTS” on page 33.
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Status column icons on the new page indicate the current status of files:

Note: Hover over the icon to view a description.

To also view a previous status of a file, see “View File History” on page 32.

The column display varies by trading community. For example, columns might 
display the following information for files in the list:

2 To list only files associated with a specific metadata value (for example, 
Sender) during upload, or were uploaded during a specific time range, provide 
that metadata in the fields above the list, then click Search. 
To use a time range, click the calendar icons next to the From and To fields, 
then click a date to insert it. 

Search fields vary by trading community. 

To restore the original list, remove the search values, then click Search again. 

Icon Description

 New File For Retrieve Files only. A new file received by your 
company. Other actions, such as a file download, have not 
yet occurred.

 Downloaded File For Send Files and Retrieve Files. The File has been 
downloaded from FTS.
See “Download Files” on page 30.

 Submitted For Send Files only. The file was uploaded to FTS 
successfully by your company. 
See “Upload Files” on page 28.

 Error For Send Files only. The action to send a file through FTS or 
upload a file through FTP failed.

 Expired For Send Files and Retrieve Files. FTS has deleted the file 
automatically after 45 days of receiving it. The file name 
remains in the list of files, but users cannot download it.

Column Item (Example) Description

Sender The sender of the invoice.

Receiver The receiver of the invoice.

File Type The type of file, for example, BIN for a binary, non-EDI 
file).

File Size The size of the file (in bytes).

User For Send Files. The name of user who uploaded the file in 
FTS). 
Note: FTS does not record the user name when files are 
sent to OpenText through FTP or Managed Services.

Days Before Deletion The number of days remaining before the system 
automatically deletes the file. FTS retains all files for 45 
days after they are uploaded. 
Users can also delete files manually. See “Delete Files” on 
page 30.

Created Date The timestamp when a file was uploaded to FTS. 
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3 In some trading communities, you can sort a list in one of the following ways: 
■ Click a column header to sort the list using that data attribute. Example: 

Sender. To sort in reverse order, click the header again. 

■ If a column header contains an empty field, type the first few characters of 
a value to reorder the list using that value to begin the list.

4 To change the number of rows that display in a list, select a different value in 
the drop-down menu below the list.

5 To view later pages in a list, click a page number or pagination link to the right 
of the number of rows control:

Upload Files
Usually only trading partner companies, not the hub company, upload files in the 
FTS user interface. Most hub companies send files directly to OpenText, which 
transfers the files to FTS. However, a hub company can be configured to upload 
files in FTS. 

Uploading files includes specifying metadata associated with the files. Metadata 
varies by trading community. For example, your community might use metadata to 
define the sender and receiver for files. FTS validates uploads to ensure that 
mandatory metadata fields are populated. 

Note: FTS also validates to ensure that data is present in the file. No other 
validations occur. 

After a file is uploaded, no alert is sent to the receiver for the file. 

Page Scroll Icon Description

|< Return to the first page. 

<< Go back one page.

>> Go forward one page. 

>| Go to the last page. 
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To upload files in FTS
1 Click Send Files in the Navigation Panel. 

2 Click Send New File. 
The Send File dialog box opens. 

3 Click Select File. 
4 Browse to the file that you want to upload to FTS, and click Open. 

Note: The maximum file size is 50MB. 

5 Provide metadata to associate with the file. 
Note: A red asterisk (*) indicates the field is required. For example, a file 
type of ACH might require entering a bank name in a different field. In addition, 
some fields might be required if you provide some other values. 

6 Click Send. The dialog box remains open. 
To remove the message that displays in the dialog box, click the X at the far 
right of the message. 

7 Do one of the following: 
■ To upload another file, repeat the steps for the Send File dialog. 

■ To close the Send File dialog, click Close. The uploaded file displays at 
the top of the Send Files list. 

For a description of the list pages, see “Search for Files” on page 26.
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Download Files
Use this procedure to download files from Retrieve Files (files your partner sent 
to you for download in FTS) or Send Files (files your company uploaded to FTS 
for download by your trading partner). 

You can download a file with any status. 

To view a file, first download it, then open it. You cannot open files in FTS. 

To export metadata for files, see “Export FTS File Metadata” on page 31.

(Hubs only) To view whether or not your trading partner downloaded a file, view 
the partner’s FTS. See “View a Partner’s FTS” on page 33. 

To download files in FTS
1 In the panel at left, Click Retrieve Files or Send Files. 
2 Find files to download. See “Search for Files” on page 26.
3 In the file list, select the check boxes of files you want to download. 

Note: To download all files on the current page, check the check box in the 
header row. This does not download all files in a list with multiple pages.

4 Above the list, click Download Selected Files, or right-click the table and in 
the menu select Download Selected Files. A confirmation message displays.
Multiple files save in a zip file. 

5 Open or save the file(s). The Downloaded icon displays in the file row.

Delete Files
To delete uploaded files
The default file retention period is 45 days after upload. The Days Before 
Deletion column in the Retrieve Files and Send Files lists indicates how many 
days remain before the system automatically deletes a file.

OpenText archives automatically deleted files for another 320 days. 

To delete files in FTS
1 In the panel at left, Click Retrieve Files or Send Files. 
2 Find files to delete. See “Search for Files” on page 26.
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3 Check the check boxes for the files you want to delete. 

4 Click Delete Selected Files. A confirmation message displays, and FTS 
removes that file row 
Note: You can also right-click on the row of a file, then click Delete from the 
menu that displays.

Export FTS File Metadata
Use this procedure to export metadata of the files in Retrieve Files or Send 
Files. 

This action exports only the metadata associated with files, not the file content. 

To download files, see “Download Files” on page 30.

To export FTS file metadata
1 From the Navigation Panel, click Retrieve Files or Send Files. 
2 To narrow the list of files to only those that you want to export, use the search 

fields above the list to show only files of interest. See “Search for Files” on 
page 26.

3 (Optional) To export only records on the current page in the list, not all pages, 
select Export Current View of Records above the list. 

4 Click Export All Records, then select PDF, CSV, or Excel to specify the file 
format for the export file. 

5 In the dialog box, select whether to open or save the export file. Cick OK to 
continue. 
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View File History
Use this procedure to view the file history, such as when the file was uploaded or 
downloaded. 

A trading partner user with a restricted role can view only his or her own actions in 
a file history. If the user does not have a restricted role, the user can view actions 
by others users at the same company. 

A hub user can view the action history for himself or herself or a trading partner 
company. 

To view status and user for a file in FTS
1 Click Retrieve Files or Send Files from the Navigation Panel.
2 Find files to view. See “Search for Files” on page 26.
3 In the file list, right-click in the row of the file you want to view. A menu 

displays.

4 Click History. A dialog box displays the history of actions for the file. 
Note: Close the dialog boxbefore trying view History for a different row. 

The dialog box contents include the following:

■ Status history of the file. 

Note: A file in Submitted status may also include a Saved status 
that occurred a few seconds earlier. Both occur in FTS after a user 
uploads a file. 

■ Login name of the user in your company who uploaded or downloaded the 
file in FTS. 

Note: Your user role might not enable you to see names of other 
users. 

■ When the action occurred, such as the dates and times a file was 
submitted to FTS and downloaded from FTS. 
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View a Partner’s FTS 
This function is available only to hub companies, not their trading partners. Hubs 
use it to do the following: 

■ View lists of files the partner has received and sent. 

■ View whether or not a partner has downloaded files from you. 

■ Download files available for download by the partner. 

■ Export metadata that can be exported by the partner. 

Hubs cannot upload files for their partners. 

To open a partner’s FTS view
1 In the panel at left, Click Retrieve Files or Send Files, depending on which 

list page you want to view for a partner. 
2 Click the Support User View tab.
3 Click Select Company. 

4 Do one of the following: 
■ If you see the partner company in the list, click its link in the Company 

Name column to go to the selected list page for the partner. 

■ For a long list, type the first few characters the partner name in the 
Company Name field, then an asterisk (*), then click Search. Then, in 
the Company Name column click the link of the partner you want to 
view. 

5 When the list page opens, you can use perform the following functions: 
■ “Search for Files” on page 26

■ “Download Files” on page 30

■ “Export FTS File Metadata” on page 31

Note: If you go to the other list page in FTS (that is, Retrieve Files or Send 
Files), FTS will default to the My View tab. Repeat the steps above to display 
a partner view for that list page. 

6 To switch to your view of the list page, click the My View tab.
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Active Documents 5
Active Documents is a reporting tool that provides up-to-date information about 
your transactions with four reports:

■ Activity Summaries

■ Exception Summaries

■ Document Volume by Type Reports

■ Document Volume by Partner Reports

This chapter explains how to use the Active Documents Dashboard to search for 
transactions and create these reports. Topics include:

■ “Active Documents Dashboard” on page 36

■ “Search for Transactions” on page 41

■ “View Search Results” on page 52

■ “Save Search Criteria” on page 60

■ “Transaction Process Lifecycle Information” on page 60

■ “Reports” on page 80

■ “Delivered Reports” on page 82

Important: If you are an Active Documents subscriber and do not have access to 
the most current version of Active Documents, see “Active Documents Classic” for 
more information.

Note: You might not see all features described explained in this chapter, 
depending on your company's subscription agreeement and the permissions 
assigned to your role.
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Active Documents Dashboard
The Active Documents Dashboard is divided into four quadrants, one for each 
report. To open the dashboard, click the Active Documents tab. 

Dashboard Features
In addition to viewing reports, you can do the following from each report panel:

■ Search for data from the current date to the past 90 days.

■ View transactions from the Search Results page.

■ Change the 24-hour reporting period.

■ Export reports data to PDF and CSV file formats.
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View Transactions from the Dashboard

To view transactions from the Active Documents Dashboard
1 Double-click on a yellow or blue bar in a report.

Change The Reporting Period

To change the reporting period
1 Use the calendar icons to select a time period.

2 Click Apply in the calendar. 
3 Click Apply again in the quadrant.

Export Data from the Dashboard

To export data to PDF or CSV formats
1 Click Export.

2 Select PDF Document or CSV Document.
3 Follow the prompts to open or save the file in the desired format.
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Activity Summary
The Activity Summary shows the status of both inbound and outbound 
transactions for a specific time period, along with the number of current records for 
each status level.

The Activity Summary classifies transactions based on four status levels:

Status Level Description

Not Extracted Transactions not picked up by trading partners.

Extracted Transactions picked up by trading partners.

Not Acknowledged Transactions unacknowledged by trading partners or for 
which acknowledgments are late.

Routed Transactions sent to another Trading Grid product such as 
Active Invoices with Compliance.
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Exception Summary
The Exception Summary shows exception information for a specific time period, 
along with the number of current records for each type of exception. 

Exception Type Description

Negative Status 
Alerts

Not applicable (unless set up by an administrator).

Extended Errors Errors related to extended events, which your company can publish 
to OpenText from a back-end system. For example, your system 
might detect that a file failed to reconcile and report the failure to 
OpenText. 
Note: This information displays in Active Documents only if you 
also subscribe to the Extended Event service. 

Unreconciled 
Extended Events

During transaction processing, the system did not receive all events 
from a business unit that subscribes to the Extended Event service.

Processing Errors Errors reported by either the routing system or translation system.

Late 
Acknowledgements

Files that trading partners have not acknowledged or for which 
acknowledgments are late.

Communication 
Errors

There are two types of communication errors:
■ Errors reported by the communications protocol, standard, or 

interface that submitted the transaction.
■ Errors related to Trading Grid Messaging Service (TGMS), 

typically if TGMS rejects inbound and outbound data submitted 
by a TGMS subscriber or inbound data from an interconnecting 
network.

Rejected Outbound files rejected by trading partner or inbound files rejected 
by the customer.

Interconnect 
Rejects 

For inbound files only, such as files from a third-party VAN, rejected 
by OpenText. Available in future releases.
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Document Volume by Type Reports
Document Volume by Type reports show the document count for each type of 
document that was sent and received during a specific time period.

Document Volume by Partner Reports
Document Volume by Partner reports show the number of documents that were 
sent to a trading partner and received by the trading partner during a specified 
time period. 
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Customize the Active Documents Home Page
You can customize Active Documents tab to display the Dashboard, Search page, 
or Saved Search page whenever Active Documents opens.

To customize the home page
1 Click  at the top of any Active Documents page.

2 Select the default view from the My Home Page dialog box.

The page refreshes and opens to the default home page view.

Search for Transactions
You can search for transactions by file format, such as EDI, XML, and user-defined 
formats, and set the search level for file, interchange, and document levels. 
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To search for transactions
1 Click the Active Documents tab in Trading Grid Online.
2 Click Search from the Dashboard.

The Search page displays.

3 Set the criteria for the search.
The following standard search options are available for all searches. To see all 
the search options, click Show more options ... 

Search Field Description

Time Range ■ Specific Range: The default option and the time period is 
the previous 3 days (or 36 hours). To change the time 
period, click the calendar icon, then specify a new start date 
and time or end date and time, as applicable.

■ Relative Range: 
■ Start Time: Use the drop-down menu to specify when 

to begin the search, for example, 2 days ago or a specific 
day and time.

■ End Time: Use the drop-down menu to specify when to 
end the search such as Tomorrow, Today, or 
Yesterday. If you select # of Days Ago, the value 
must be less than the number of days specified for Start 
Time. 

For example, search from 5 days ago to 3 days ago, starting 
at 00:00:00 and ending at 11:59:59 on the last day.

Note: Set the preferred time zone in your profile. The time zone 
then displays on all pages (Search, Results, etc.).

GXS Ref No A unique reference number or document number, assigned by 
the Active Documents meta data repository to track the 
following:

■ Transmission files — preceded by F- 
■ EDI interchanges — preceded by I- 
■ EDI groups 
■ EDI documents — preceded by D- 
■ XML documents — preceded by U- 
■ Trading Grid Messaging Service transactions 

Note: Click the GXS Ref Num for an item on the Search Results 
page to view life cycle processing information quickly. 

Partner Name The company name of the trading partner associated with the 
partner address.

Mailbox A OpenText mailbox ID (or IDs). 

Partner Address The mailbox ID (or IDs) of the trading partner. 

My Address Your EDI ID or OpenText routing mailbox ID (or IDs). 
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4 Click Search.
The Search Results page opens. See “View Search Results” on page 52.

Direction The direction of the data flow from the ID specified in the My 
Address field, which can be outbound, inbound, or both.

■ Direction of the file:
■ Outbound — The company is the sender.
■ Inbound — The company is the receiver. 
■ Inbound and Outbound — The sender and receiver both 

belong to the user’s company.
■ Direction of the interchange:

■ Outbound — The company is the sender.
■ Inbound — The company is the receiver. 

■ Direction of the document:
■ Outbound — The company is the sender.
■ Inbound — The company is the receiver. 
■ Inbound and Outbound — The sender and receiver are 

both belong to the same company.
It uses the interchange sender and receiver addresses 
for EDI data. Otherwise, the file sender and receiver are 
used.

Search Level The search level refers to the type of data that can be retrieved. 
■ File — Searches for two types of files, which contain 

documents passing through the Managed Services 
environment: 
■ Files with data that has been translated from one non-

EDI data format to another non-EDI data format.
■ Files with data that has been processed as pass-through 

data (without translation). 
Options include searching for files with or without errors, 
negative alerts, and other events.

■ Interchange — Searches for data in an EDI format that 
reports activity at the interchange level.

■ Document — Searches for electronic business documents, 
typically, in two formats:
■ EDI format, reporting activity at the document level.
■ XML format, processed with XML document identification.
Options include viewing related documents (for example, 
Invoices related to Purchase Orders searched for).

Search Field Description
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Search for Transactions by Search Level
The following explains how to perform specific searches based on File, 
Interchange, and Document Search levels.

To search for a file
1 Click Search in the Active Documents Dashboard.
2 Set the standard search criteria. See “Search for Transactions” Step 3.
3 Select File for the search level. 
4 Set the search criteria for the file search, as applicable. To expand the file 

Search page, click Show other options.
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Search Field Description

Application Reference The application reference for the file, which typically indicates a 
file or document type. 

Sender Reference A number or alpha-numeric value that references the file in the 
routing process. The system assigns this value during the 
routing cycle.

Status A drop-down list of possible statuses for a search, based on the 
platform, tracking level, and configuration. Status searches can 
apply to inbound and outbound transactions. 
In Managed Services, you can search for the following status:

■ With Errors 
■ Without Errors 
■ With Negative Alerts — The last status alert was for an 

error or an event that did not occur within a specified time 
period for the event type.

■ Without Negative Alerts — The status alert for the file 
was for an event that occurred within the specified time 
period for the event type.

In other implementations, you might also be able to search on 
these statuses: 

■ Extracted — The trading partner retrieved the document 
from the mailbox or interconnect service.

■ Unextracted — The trading partner did not retrieved the 
document from the mailbox or interconnect service.

■ Rejected (by OpenText)
■ Rejected from Interconnect 
■ Incomplete — Incomplete itineraries (OpenText 

instructions for processing a document)
■ All

Original File Name The name of the original file that was sent.

Communication Type The communications protocol, standard, or interface used to 
submit a transaction to the Trading Grid.

ILOG Number Input Log Number. A unique, 11-digit number assigned by the 
the system to identify a file transmitted by the Sender. 
This number is based on a combination of the month, day, 
Greenwich Mean Time, and the decimal fraction of the hour.

Mailbag ID A unique number that references an interconnect service such 
as a third-party VAN. 

Translation Instance Identifies which Application Integrator translation instance 
processed the transaction. 
The number of translation instances depends on your system 
implementation. 

Translation Session 
Number

A unique number assigned to each translation process.

Service Reference A unique identifier assigned by the messaging platform. 
Typically for internal use.
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5 Click Search.

To search for an interchange 
1 Click Search in the Active Documents Dashboard.
2 Set the standard search criteria. See “Search for Transactions” Step 3.
3 Select Interchange for the search level. 

 

4 Set the search criteria for the interchange search. 

5 Click Search.

Key Name The type and value of a document identifier, assigned by the 
sender to identify a particular document, for example, Purchase 
Order Number. 
Note: If using TGMS, select DOCUMENT ID. 

 key value Type the identifier value(s) for the selected key. For example, 
type the actual PO Number or Product ID to use in the search. 
You can type a partial value ending in an asterisk (*) for the 
system to return any documents with the key value that begins 
with those characters. You can add multiple values separated 
by a comma.

 Primary Key Select this option if the first key you entered is the primary key. 

 +Add Another Key Click this link to add one or more secondary keys.

Search Field Description

Interchange Control 
Number

A number assigned by EDI systems to the interchange 
header and trailer segments of an EDI file to verify data 
integrity.

Production/Test Flag A field or flag in the EDI interchange header for ANSI X12 
formats, indicating if a transaction is for testing or 
production purposes. Users can send test transactions in 
the production system to Trading Partners, and this flag 
distinguishes which transactions are test and which are 
production. 
Consult your Trading Partner to determine how to use this 
flag.

Search Field Description
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To search for a document
1 Click Search in the Active Documents Dashboard.
2 Set the standard search criteria. See “Search for Transactions” Step 3.
3 Select Document for the search level. 

Set the search criteria for the document search, as applicable. To expand the 
document Search page, click Show other options.
 

 

Parameter Description

Document Type An EDI code that identifies a specific type of EDI document, such as 
810 or INVOIC. 
To search for multiple Document Types: 
To search for multiple types of documents, separate each type with 
a comma. For example, type 810, INVOICE.

Status A drop-down list of possible statuses for a search, based on the 
platform, tracking level, and configuration. Status searches can 
apply to inbound and outbound transactions. 
In Managed Services, you can search the following statuses, 
depending on your service subscription: 

■ Acknowledged 
■ Not Acknowledged 

In any implementation, leave All selected to not search based on a 
specific status. 
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4 Click Search.

Active Invoices for Compliance (AIC) Additional Search 
Features

If your company subsribes to AIC, you can also configure search key settings, and 
search for invoice status, and legal profile names.

Configure Search Key Settings
The Key Settings feature allows you to customize document search keys by setting 
a key as the primary (default) search key for and setting key operators. Up to six 
keys can be configured.

Key Name The type and value of a document identifier, such as a purchase 
order number, assigned by the sender to identify a particular 
document. 
Active Invoice for Compliance (AIC) Users: Active Documents 
provides additional search support for AIC. See “Active Invoices for 
Compliance (AIC) Additional Search Features” on page 48

TGMS Users: Select DOCUMENT ID. This applies to any type of 
document identification number (Purchase Order Number, Invoice 
Number, Ship Notice Number, etc.), specified in the key value field.

 key value The identifier value, or values, for a selected key. For example, type 
the actual purchase order number or product ID to use in the 
search. 
To search for multiple key values: 
To search for multiple key values, separate each type with a comma. 
For example, type 123, 789.
Search Tip: 
Type a partial value, followed by an asterisk (*) to retrieve all 
documents that begin with those characters, for example, 1234*.

 Primary Key Select this option if the first key typed is the primary key. 

 +Add Another Key Click this link to add one or more secondary keys.

Functional Group 
Type

A two-digit code in the group header segment of an ANSI X12 EDI-
formatted file that identifies the type of business document it 
contains such as PO, PS, IN.

Functional Group 
Control Number

A number assigned by EDI systems to the functional group header 
and trailer segments of an EDI file to verify data integrity. Typically, 
this number applies only to data in ANSI X12 format.

My Functional 
Group Address

Your EDI functional group address. 
Applies only to the ANSI X12 standard.

Parameter Description
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To add or configure Search Keys
1 Click  next to Key Name.

The Key Settings dialog box opens.

2 To add a key, type a key name.

3 Specify whether you want the key to be the primary key.

4 Set the key operator from the Operator drop-down menu for a key.

5 Type a value for the key.

6 To always display the key by default, click the Display checkbox.

7 Click Save.

Search By Invoice Status

To search by invoice status
1 On the Search page, click Show more options.

■ equals is less than

■ is greater than is less than or equals

■ is greater than or equals
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The page expands.
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2 To search by invoice status, select one of the following options from the Status 
drop-down menu:

3 To search by download status, select one of the following options from the 
Download Status drop-down menu:

4 To search by legal profile name, type the name of your company or Trading 
Partner name in the Legal Profile Names section.

5 Click Search.

■ All With Errors

■ Without Error In Progress

■ In Contingency

■ All Sender Pending Invoice 
Download

■ Sender Invoice Download Complete Recipient Pending Invoice 
Download

■ Recipient Invoice Download 
Complete
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View Search Results
The Search Results page displays the applicable file, document, or interchange 
transactions, based on your search criteria. 

From the Search Results page, you can perform several tasks:

■ Download the search results in PDF or CSV format, including batch downloads.

■ Download single files or multiple files.

■ Create a subset of the search results.

■ Specify search filter criteria.

■ Change the default settings for search results. 

■ Save the search criteria. 

■ Use the filters to create a subset of your results, including by Sender/Receiver 
Address(es), Trading Partner Name, Direction, and Document Type.
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Download Search Results
You can download search results in PDF or CSV format. 

To download the search results 
1 On the Search Results page, click Export Results.

2 Select PDF Document or CSV Document.
3 Follow the prompt to open or save the search results.

The search results display in the desired format, for example, PDF.
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Download Documents and Files from Search Results
You can download single items from the Search Results page (files, interchanges, 
and documents), as well as multiple items in a bulk download.

Note: The download limit for multiple items is 20MB. However, there is no size 
limit for downloading a single file.

Download Single Items

To download single items from the Search Results page
You may wish to download a single file, document or interchange to view just one 
individual item or if the item’s file size is larger than the download limit of 20MB.

1 Click the checkbox for the file you want to download.
2 Click More > Export File.
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3 In the Export File dialog box, select the format for the download:
■ Original: Refers to the original data in the format as it was received.

■ Formatted: Refers to a formatted version with line breaks inserted for 
easier viewing.

 

The Export File page displays the item to be downloaded, including the total file 
size (in bytes). 
 

4 Click Export Selected File(s).
5 Save the file when downloaded.
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Download Multiple Items

To download multiple items from the Search Results page
Note: The examples in the steps below are relevant to a File search, however, the 
same steps apply to Interchange and Document searches.

1 Click the checkboxes for the items you want to download. 
■ To select all of the items on the page, click the checkbox at the top of the 

column.

■ To select up to 100 items on a page at one time, specify the number from 
the Items per Page drop-down menu.

2 Click More > Export File. 

3 Select the format for the download from the Export File dialog box:
■ Original: Refers to the original data in the format as it was received.

■ Formatted: Refers to a formatted version with line breaks inserted for 
easier viewing.
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4 Click Continue.
Note: Depending on the number of files, it may take several minutes to 
download multiple files.

The Export File page displays the list of files to download, including the number 
of files selected and total file size (in bytes). You can also uncheck files in the 
list.
 

5 Click Export Selected Files(s) and follow the prompts to bulk download the 
compressed (zipped) data files.
Note: After the download starts, you cannot cancel or go back to the previous 
page.
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6 Select Save File to save the .zip file to your Windows Explorer Downloads 
folder.
Note: The bulk download feature is also available from the Lifecycle Details 
page. See “Transaction Process Lifecycle Information” on page 60.

Bulk File Download Errors
If the total file size for the bulk download exceeds 20MB, a warning displays, and 
the Export Selected Files button is disabled. 

In this case, do any of the following:

■ Uncheck the large files that prevent the bulk download, so that the total file size 
is less than 20MB. Then, click Export Selected Files.

■ Click Cancel, and download the large files individually. See “Download Single 
Items” on page 54.
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Change Column Settings 

To change the column settings on the Search Results page
1 Click Settings.

  

■ Scroll or use the text box above the Available Columns list to find a 
column you want to add.

■ Use the arrows to add or remove columns. 

■ To change the order of columns displayed, in the Selected Columns box, 
click the column name and drag it to a different position in the list.

■ To change the default sort, select a new column from the Sort By 
dropdown. To change the sort sequence of the current listing only, click on 
a column heading. For a reverse sort, click the column heading again.

■ Specify the number of items to display per page by checking an Items per 
Page option. 

■ To restore the default settings, click Reset Defaults,

2 Click the Save & Apply. These settings are saved until the next time you 
modify the settings.

Results with More than 7000 Records
For searches that return more than 7,000 results, the system displays the first 
7,000 found. 

To see the remaining results
1 Save the search. See “To save a Search."
2 Schedule a report. See “Schedule a Report."
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Save Search Criteria
To save a Search, you must create the search and generate the results. 

To save a Search
1 Create and run the search.
2 On the Search Results page, click Save Search.

A dialog box opens.

3 Type a Search Name.
4 Click Save.

To run a saved search
You can use a search that you, or someone else in your organization, have saved.

1 Click the Active Documents tab.
2 On the Dashboard page, click the Saved Search tab.
3 On the My Saved Searches page, you can do the following. 

■ To immediately run a search, click the Search Name link.

■ To change the parameters of a search, click the Edit icon. Make your 
changes and then, on the Search Results page, click Save Search and 
save the search. If the search has already been scheduled, you must 
specify a new Search Name to save the search.

■ To delete a saved search, click the Delete icon. 

Important: You cannot delete a saved search until you have deleted it 
from the Scheduled Reports listing. See “View Scheduled Reports."

Transaction Process Lifecycle Information
Active Documents captures the processing lifecycle history of files, EDI 
interchanges, EDI documents, and XML documents as they pass through various 
tracking points. 

Processing lifecycle details provide information about a specific transaction at key 
processing points in each environment. The points that display in the lifecycle 
history depend on the path the transaction follows during its lifecycle. 

Note: The Transaction Processing Lifecycle can provide visibility into both internal 
and Managed Services processes in one view. You may have the option to publish 
edge events to Active Documents. Edge events are transactions from a customer’s 
internal system, such as SAP (an ERP system).
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View Process Lifecycle Information

To view processing lifecycle information for a transaction
1 Search for a transaction, and locate the record on the Search Results page. See 

“Search for Transactions." 
2 Click the link in the GXS Reference Number column on the Search Results 

page. 
The Lifecycle Details page displays. The Summary Information section shows 
the processing history of a file, interchange, or document. 

The Details section lists the processing steps for the transaction, translator, 
application, or other service used to process the transaction. 
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3 To view the details of a processing stage, click next to a step (in the Step 
column). 
 

View Input and Output Files (Translation Step)
If a process lifecycle includes a Translation step, you can view and download both 
Input and Output files.

1 In the Details section of the Lifecycle Details page, click next to the 
Translation processing step. 
 

2 Click View Input & Output File(s).
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Some translation steps may include multiple input or multiple output files. You 
can download single files, or all all output or input files at one time.

3 Select Show: Output Files or Show: Input Files.
 

The available output or input files display in the page list.

4 Click the checkboxes for the files you want to download, and click Export File.
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5 In the Export File dialog box, select the format for the download:
■ Original: Refers to the original data in the format as it was received.

■ Formatted: Refers to a formatted version with line breaks inserted for 
easier viewing.

 

6 Click Continue.
Note: Depending on the number of files, it may take several minutes to 
download multiple files.

The Export File page displays the list of files to download, including the number 
of files selected and total file size (in bytes). You can also uncheck files in the 
list.
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7 Click Export Selected Files(s) and follow the prompts to bulk download the 
compressed (zipped) data files.
Note: After the download starts, you cannot cancel or go back to the previous 
page.
 

8 Select Save File to save the .zip file to your Windows Explorer Downloads 
folder.
Note: The bulk download feature is also available from the Lifecycle Details 
page. See “Transaction Process Lifecycle Information” on page 60.
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Bulk File Download Errors
If the total file size for the bulk download exceeds 20MB, a warning displays, and 
the Export Selected Files button is disabled. 

In this case, do any of the following:

■ Uncheck the checkboxes for the large files that prevent the bulk download, so 
that the total file size is less than 20MB. Then, click Export Selected Files.

■ Click Cancel, and download the large files individually. See “Download Single 
Items” on page 54.

Download Process Lifecycle Information
You can download documents and files from the Process Lifecycle page in several 
formats by exporting the data file to a .txt file or exporting the details to a PDF.

Download Data Files

To export a data file to a text file
1 Click Export Data File.
2 Select the format for the download:

■ Original: The original data in the format as it was received.

■ Formatted: A formatted version with line breaks for easier viewing.
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3 Follow the prompt to open or save the file.
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To export details to PDF
1 In the Summary Information section of the details page, click Export Details 

to PDF.
2 Follow the prompt to open or save the file.
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View File and Document Heirarchies

To view the hierarchy of files and documents involved in a lifecycle
1 Click the Lifecycle Content tab on the Search Results page.

 

2 Click the GXS Reference Number for the document or file to drill down for more 
detail.
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3 To drill down further, click on an item in the row.
 

Error Information
If the processing lifecycle contains error information, you can drill down to view 
information about the processing errors such as an invalid address, decryption 
error, etc.

To view process lifecycle error information
1 On the Processing Lifecycle page, click the details tab for the file, interchange, 

or document, for example, the File Details tab. 
The Summary Information section displays the total number of errors.
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2 To view error information, click the View Errors in the Error Count section.
The applicable error information displays.
 

Status Alerts
If your company subscribes to the Status Alert Service, the Processing Lifecycle 
provides a Status Alerts summary. Status Alerts allow customers to optionally 
receive status alerts for their inbound and outbound transactions at different 
points, as the transactions are processed on the Active Documents platform and 
delivered to their Trading Partners. 

Status alerts provide status information about transaction processing, including 
processing events that might require action. The alerts also communicate 
transaction events to your backend system and send email notifications about 
events that may require immediate attention or action. 

Note: Status alerts are defined by the Community Administrator.  If your company 
does not subscribe to this service but would like to, see your Community 
Administrator or OpenText Representative.

The Status Alerts summary links to details about the status alerts through your 
Active Documents Dashboard. The Processing Lifecycle page displays only the 
most recent report for a status type. 

To view information about a status alert
1 Click its link in the Status File column. 

The Status Alerts section of the Processing Lifecycle provides the following 
information:

■ The status of key events in transaction processing.

■ Green icons indicate positive event statuses (events that occurred within 
the configured time period).

■ Red icons indicate negative event statuses under two conditions:

■ An error event occurred. 

■ A specific event did not occur within configured time period. 

For example, a red icon for a mailboxed event might indicate that the event 
was rejected, or it was not received before a specific period of time. 

■ The time of an event status update.

■ A link to view details of the status alert. 

Invalid detail in the 
Data Field Element.
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Event Types
Depending on your implementation, possible Event Types might include the 
following: 

Status Description

accepted The file was received by Active Documents from the 
trading partner's system. This is the starting point for all 
flows.

mailboxed Active Documents mailboxed the translation output file for 
delivery to the trading partner. Not used if the translated 
status is in the same lifecycle.

tgmsmailboxed The file was sent to the Trading Partner through Trading 
Grid Message Services (TGMS).

extracted The Trading partner extracted the file from the mailbox or 
interconnect. 

tgmsextracted The file was received by the Trading Partner via Trading 
Grid Message Services (TGMS).

receivedbp Received by my Partner. The file/document was delivered 
to the trading partner's destination.

receivedfp The file was received from my Partner. The file/document 
was delivered to my destination.

Functional Acknowledgement Information
The Processing Lifecycle page might display Functional Acknowledgement (FA) 
information. 

An Acknowledgment Code is from the functional acknowledgment (997 document 
or CONTRL message) that was reconciled with the document. There are seven 
possible acknowledgement codes: 

Managed Service Platform Data
Multiple Managed Service Platform entries might exist because transactions can 
pass through the Managed Service Platform at different stages of processing. 

For example, the translated output entered another Managed Service routing cycle 
for transmission to the recipient.

■ A — Accepted. ■ R — Rejected.

■ E — Accepted with errors. ■ W — Rejected. Assurance failed validity tests.

■ M — Rejected. The message 
authentication code failed.

■ X — Rejected. The content after decryption 
could not be analyzed.

■ P — Partially Accepted. At least 
one transaction set was rejected.
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TGMS Data
Trading Grid Messaging Service (TGMS) enables data exchange with your partners. 
It manages your inbound and outbound transactions. 

As with Managed Services, multiple Trading Grid Messaging Service sections might 
exist because transactions can pass through TGMS, as well as Managed Services, 
at different stages of processing. 

Other processing stages might also display, such as a Trading Grid Message Service 
Mailbag step, when a collection of files are going to a Trading Partner through a 
third party.

Communication Sections
A processing lifecycle might display different types of communication information.

Depending on your Trading Grid Online service communication setup, the 
Processing Lifecycle page might include sections that display data exchange 
information, including the following protocols or standards: 

AS2 FTP/SFTP SAP ALE

AS3 X.400 OFTP

IFTP SMG HTTPS

POP3 SMTP

Similar to the Managed Service Platform and Trading Grid Messaging Service, the 
lifecycle might include multiple communication sections, depending on the 
processing that takes place.

Extended Event Data
Extended events are processing events that occur outside of OpenText and that 
your company publishes to OpenText. If you subscribe to the Extended Event 
service, the Processing Lifecycle page displays extended event data such as IDOC 
number, status information, and SAP Client identifier.
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Translation Information
The Translation section for a Processing Lifecycle describes the translation input 
and output and includes both original and formatted input and output files (if 
available).

  

If you received an error in this section:

■ You can use the “Active Documents Translation Errors” for reference. 

■ For users subscribing to the Cloud Based Translations service, use these 
translation error descriptions and solutions for initial troubleshooting, as follows.

1 Go to Appendix C, “Active Documents Translation Errors”.
2 Find the error number.
3 Read the information regarding the potential cause of the error and the 

resolution for the error.
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Related Documents

To view business documents related to the process lifecycle
1 On the Processing Lifecycle page, click the Related Business Documents tab. 

The Search Results page opens with a list of related documents.

2 To view specific information, filter the list.
For example, to view a specific type of document, specify a document type 
such as 850. 

Audit Notes
You can view audit information, such as a record of email notifications, status 
updates, and other activity for the processing lifecycle. 

To view audit notes for a lifecycle
1 Scroll down to the Audit Notes section.

A list of Audit messages and notes displays the following information:

■ Type of entry (for example, Audit of an email notification, or Note 
generated by the system or a OpenText technician)

■ Author of the entry

■ Date the entry was created

■ Details of the entry

■ Whether or not a notification was sent.
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t 

2 To view an email notification such as confirmation that a file was sent, click the 
View link.
A copy of the email displays. 

Business Document Viewer
The Business Document Viewer allows you view Electronic Data Interchange (EDI) 
files shared with Trading Partners in either HTML or PDF fprmats. You can view a 
document online, or download it directly to a PDF.

Supported Standards: 
The Business Document Viewer supports the following EDI standards: 

■ ANSI

■ TRADACOM

■ EDIFACT
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To display the Business Document Viewer
1 Search for a document. See ? ...

2 On the Search Results page, click the GXS Ref No for the document you wish to 
view.

The Process Lifecycle page displays the Document Details tab.

3 Click Show Document Rendering.

The Document Viewer (Business Mode) opens the document in it’s original 
format. 
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Note: You might not see a document if it does not meet one of the supported 
standards. If the file is not available, an error message displays. 
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4 To save the document as a PDF, click Export to PDF, and follow the prompt to 
open or save the file.

Document Viewer Analyst Mode
To view the document in analyst mode and see the report structure, click Analyst 
Mode.
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To Download Rendered Documents Directly to PDF
1 In the Process Lifecycle page, click Document Rendering.

2 Click Download Document Rendering.

3 Follow the prompt to open of save the PDF.

Reports
Active Documents provides traditional document tracking reports, based on your 
search criteria. 

You can generate these reports on demand or schedule them. 

Schedule a Report
Reports are created from saved searches.

1 If necessary, 
a Click the Active Documents tab. 
b Search for the transactions you want to report on. See “Search for 

Transactions."
c Save the search. See “Save Search Criteria."

2 Click the Saved Searches tab. 
3 Click the clock icon.
4 In the dialog box, select the Report Format.
5 Click Frequency > Search Frequency, and select when you want to run the 

report. To run a one-time report, select Now.
6 If you want the report 

■ Emailed to yourself and other contacts, click Email Report and select the 
applicable people.

■ Sent via a platform, e.g., Enterprise, click Send Report via Platform and 
provide the applicable data. Active Documents sends the report to a 
mailbox on a platform enterprise machine. Either of the following is 
possible: 

■ Users with access can access the machine by FTP and download the 
report. 
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■ The mailbox can forward the report to another machine or service that 
makes it available to users. 

7 Click Save.
The system adds the schedule to the Scheduled Reports list. If you selected a 
Frequency of Now, the system generates this as a one-time report.

8 To see your scheduled report, click the Trading Grid tab > Reports tab > 
Scheduled Reports.

View Scheduled Reports

To view a scheduled reports list
1 If you are currently in Active Documents, click the Trading Grid tab.
2 Click the Reports tab > Scheduled Reports.

The Scheduled Reports page opens.  

To view the current schedule for a report, in the Report Name column, click 
the applicable report name. 

Note: If the Report Name is not a hyperlink, the report is a one-time report 
previously executed. 

Change/Generate/Delete a Report Schedule

To change a report schedule
1 Click Scheduled Reports.
2 In the Report Name column, click the applicable report name. 
3 In the Save or Schedule dialog that opens, view or change information. 
4 Click Save.

To immediately generate a scheduled report 
1 Click Scheduled Reports. 
2 Find the applicable report in the list. 
3 In the Execute Once column, click Execute for the report. 
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The system adds a one-time report to the Scheduled Reports list with the same 
name, along with ONCE and the current date and time.

Note: Many users delete one-time reports. Select the report check box, then 
click Delete. 

4 Click Delivered Reports to view the report. 

To delete scheduled reports
1 Click Scheduled Reports. 
2 In the View drop-down list at top, click Only my reports. The list refreshes.
3 Click the check box(es) in the row of the scheduled report(s) to delete. 
4 Click Delete.

Delivered Reports
Delivered Reports are Scheduled Reports, including one-time reports, generated by 
the system. 

To view a list of delivered reports
1 If you are currently in Active Documents, click the Trading Grid tab.
2 Click the Reports tab > Delivered Reports.

The Delivered Reports page opens.  

On the Delivered Reports page, 

The list shows the following for each generated report. 

■ Name of the report (click the name link to open the report) 

■ Report format (for example, PDF)

■ Date and time the report was generated 

■ Name of user who created/scheduled the report 

■ Report status, such as New, Read, Processing, or Failed

■ Report ID (click link to view audit log for the report)



A C T I V E  D O C U M E N T S
Delivered Reports

Trading Grid Online  83

5  

Download Reports

To download reports
1 In the Delivered Reports list, find the row containing the latest version of this 

report.
2 In the Report Name column, click the name of the report. (The status cannot 

be Processing.)
3 Follow the prompts to open (or save) the report. 

View Audit Logs

To view the Audit Logs 
An audit log for a delivered report includes information such as who received the 
report and when. A log is available only if Active Documents emails the report to 
recipients. 

1 In the Delivered Reports list, find the row containing the latest version of this 
report.

2 In the Report ID column, click the link for the report. A dialog displays audit 
information, such as who received the report.
  

Delivered Reports Retention Period
Active Documents deletes delivered reports after 45 days. 

Delete Delivered Reports

To delete a delivered report
Delete delivered reports from the Scheduled Reports list. See “To delete 
scheduled reports” on page 82.
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Reports for Trading Grid 
Messaging Service 7

The Reports component is an online reporting tool that provides up-to-date 
information about your transactions.

Note: The types of reports you can view are based on your subscription and your 
role. Depending on your company's subscription agreement and the permissions 
assigned to your role, you might not see all reports listed in this chapter. 

Topics include:

■ “Tips for Viewing Reports” on page 86

■ “TGMS Reports” on page 86

■ “Transaction Summary Report” on page 87
View an up-to-date informational snapshot of your sent and received 
information. 

■ “About Status Reports and Billable Reports” on page 88
See sent, received, and rejected interchanges and find the cause of any 
rejected items. Some reports are billable based on the quantity of data. 

■ “Trading Partnership Transaction Report” on page 92
List of interchanges sent and received to/from your trading partners. 

■ “Inbound Reactivate Report” on page 92
Reactivate an interchange. 

■ “About Transaction Alert Logs” on page 93
List of notifications that you received. 

■ “Functional Acknowledgement Management (FAM)” on page 98

■ “All Tracked Trading Partners Report” on page 98 
Provides an overview of your community’s performance for the current 
month.

■ “Compliant Trading Partners” on page 100 
Lists trading partners that responded to all documents on time. 

■ “Late Trading Partners Report” on page 100 
Lists trading partners that responded after the policy time period expired.

■ “No Acknowledgement Trading Partners Report” on page 101 
Lists trading partners that have not yet responded to all documents and 
the policy time period has expired.

■ “Excluded from Tracking Report” on page 102 
Lists trading partners whose documents are excluded from tracking.

■ “Functional Acknowledgement Scorecard (FAS)” on page 106



86 Trading Grid Online

R E P O RT S  F O R  T RA D I N G  G R I D  M E S S A G I N G  S E R V I C E

Tips for Viewing Reports

Tips for Viewing Reports
Below are tips for accessing and viewing most Trading Grid reports.

■ To access your reports, from any page in the Trading Grid, click the Reports tab. 
Use the links on the left side of the page to access the report you want.

■ To print a printable report, at the top of the report, click  Print.

■ To download a report, at the top of the report, click:

■  CSV to download the data into an Excel spreadsheet, or 

■  Save to save and download the report into a text file.

■ For all Trading Grid reports, do some or all of the following.

■ Collapse the report by clicking  Collapse that precedes the report title 
of the listing. To expand the report, click  Expand.

■ Expand the content area by eliminating the left panel. At the top of the left 
panel, click  Hide. To restore the left panel, click  Display that 
precedes the report title line.

■ By default, most report listings are sorted, in ascending order, by ILOG 
number. You can resort the listing by another sortable column, in either 
ascending or descending order. A sortable column is designated by a  
Down arrow after the column name. Click the Down arrow once to sort in 
ascending order; click it again to sort in descending order.

Define the number of interchanges that appear in each page of the list. Select the 
number from the View drop-down menu.

TGMS Reports
The Trading Grid Message Service reports are:

■ “Transaction Summary Report” on page 87
View an up-to-date informational snapshot of your sent and received 
information. 

■ “About Status Reports and Billable Reports” on page 88
See sent, received, and rejected interchanges and find the cause of any 
rejected items. Some reports are billable based on the quantity of data. 

■ “Trading Partnership Transaction Report” on page 92
List of interchanges sent and received to/from your trading partners. 

■ “Inbound Reactivate Report” on page 92
Reactivate an interchange. 

■ “About Transaction Alert Logs” on page 93
List of notifications that you received. 
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Transaction Summary Report
The Transaction Summary provides an up-to-date, snapshot of sent and received 
data. Trading Grid displays the information in real-time. Real-time means each time 
you send or receive a document, it is instantly reflected in the Transaction 
Summary report. 

For sent and received documents, view the following information for the selected 
time period. You can select on one of these time periods.

Report section Description

Time period

Inbound Overview

Outbound Overview

 

■ Back 1 Hour — From one hour earlier until the current time.

■ Today — From 12 a.m. of the current day until the current 
time.

■ Back 1 Day — From 12 a.m. of the previous day until the 
current time.

■ Incoming Interconnect Rejected — Number of 
documents sent from a Third Party network.

■ Incoming OpenText Rejected — Number of documents 
sent from the OpenText network that OpenText refused.

■ Transactions to Download — Number of documents in 
your mailbox that you have not downloaded yet.

■ Rejected transactions — Number of documents OpenText 
rejected and did not send.

■ Last 2 Send Sessions — Date/Time of the most and next-
most recent send session. For each session, displays the 
number of documents

■ That were Successfully sent.
■ That OpenText refused to send (Rejected) due to errors.
■ In a “holding area” (Pending) waiting for OpenText to 

send.
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View transactions by selecting one or All mailboxes.  

About Status Reports and Billable Reports
Based on your company’s subscription, you see either Status Reports or Billable 
Reports on the left side of a Reports page. 

These reports provide the details summarized in your Transaction Summary report. 
and include these reports:

■ “Inbound Status Report” on page 89

■ “Outbound Status Report” on page 90

■ “Interconnect Status Report” on page 91

■ “Delivered and Scheduled Reports” on page 92

Important: For Billable Reports, your company is billed based on the quantity 
of data returned in a report. For Status Reports, your company is not charged 
because the reports are included in your company’s subscription.

Whichever report you select, a search page opens. 

You can use two methods to search.

■ On the Quick Links line, click one of the options.
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■ In the Search option area, enter your search criteria, and click Submit.

For information about search fields, see “TGMS Report Columns” on page 96.

Inbound Status Report
The Inbound Status report shows all documents received. It includes identifying 
information for each document. This report displays information on all 
interchanges sent to you during up to the previous 45 days. The report defaults to 
interchanges received within the past 24 hours. 

The Inbound Status report lets you

■ See when or if you received an interchange from your partner. 

■ Ensure you have successfully retrieved all interchanges that were waiting for 
you.

■ Investigate rejected interchanges.  

Note: For information about the report columns, see“TGMS Report Columns” on 
page 96.

Use this procedure to reactivate an interchange that you downloaded so you can 
“re-receive” it.

To reactivate an interchange from the Inbound Status Report

1 Click the Reports tab > Inbound Status.

2 In the Select column, select the interchange(s) to re-activate.

Note: You can re-activate interchanges with an Opened status.
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3 Click Actions > Reactivate. 

See also:

■ “Configure TGMS Report Data” on page 97

■ “Tips for Viewing Reports” on page 86

Outbound Status Report
The Outbound Status report displays identifying information for each document 
that you sent, including error conditions for rejected transactions. This report can 
display information about all interchanges sent up to nine days in the past. The 
report defaults to interchanges sent within the last 24 hours.

Note: For information about the report columns, see“TGMS Report Columns” on 
page 96.

Use this procedure to resubmit an interchange. 

To resubmit an interchange from the Outbound Status Report

1 Click the Reports tab > Outbound Status.

2 In the Select column, select the interchange(s) to resubmit.

3 Click Actions > Resend. 

A confirmation page opens. It specifies if the resubmit(s) were successful. It also 
specifies the new ILOG number(s).
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See also

■ “Configure TGMS Report Data” on page 97

■ “Tips for Viewing Reports” on page 86

Interconnect Status Report
While the Interconnect Status report is similar to the Inbound Status report, it 
displays interchanges received using a network other than the OpenText network, 
called an interconnect. The report defaults to interchanges received within the last 
24 hours. 

The Interconnect Status report lets you:

■ See when or if you received an interchange from your partner. 

■ Investigate rejected interchanges. Occasionally, a trading partner on an 
Interconnect sends a document to you, but the OpenText network rejects the 
interchange. It could be rejected for multiple reasons, for example, an invalid 
relationship. When an interchange is rejected it is not delivered to your mailbox. 

From this report, you can:

■ Re-receive (Reactivate) an interchange that you already downloaded to your 
desktop. 

■ Resend (resubmit) any interchange. For example, if an Interconnect user sends 
data and the Trading Grid rejects it because of an error, such as a pending 
trading relationship, you can tell the Trading Grid to resend the data after the 
trading relationship is confirmed. which eliminates the need of making the 
Interconnect user resend it.

To reactivate an interchange from the Inbound Reactivate Report

1 Click the Reports tab > Interconnect Status.

2 In the Select column, select the interchange(s) you want.

3 Click Actions > Reactivate or Resend. 

A confirmation page opens. The page specifies if the resubmit(s) were successful. 
It also specifies the new ILOG number(s).  

Note: For information about the report columns, see“TGMS Report Columns” on 
page 96.

See also

■ “Configure TGMS Report Data” on page 97

■ “Tips for Viewing Reports” on page 86
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Delivered and Scheduled Reports
If your company decided to compile reports in the background and make them 
available when completed, you see the Delivered Reports link under the 
Billable or Status Reports section. 

This option is for large companies with large volumes of data. 

Trading Partnership Transaction Report
This report summarizes the transactions and sent and received interchanges 
between you and your trading partners. For each partner, the report lists each 
transaction, its description, and its number of KCs. 

Note: This report is for the previous month. For example, if the current month is 
November, the report lists the transactions and interchanges for October.

See also

■ “Tips for Viewing Reports” on page 86

Inbound Reactivate Report
The Inbound Reactivate report displays information about all interchanges sent to 
you that are eligible for “reactivation,” that is, interchanges you have opened for up 
to the previous 45 days. The report defaults to interchanges received and opened 
within the last 24 hours. 
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This report lets you reactivate the interchange so that you can “re-receive” it.

In addition, you can reactivate an interchange that you already downloaded to 
your desktop so you can “re-receive” it. 

To reactivate an interchange using the Inbound Reactivate Report

1 Click the Reports tab > Inbound Reactivate.

2 In the Select column, select the interchange(s).

3 Click Actions > Reactivate. 

A confirmation page opens. It specifies if the reactivation(s) were successful.

See also

■ “TGMS Report Columns” on page 96 for information about the report columns.

■ “Tips for Viewing Reports” on page 86

About Transaction Alert Logs
Depending on your company subscriptions, you see a list of notifications that you 
received. On the left side of the page, click an action to see a list of notifications.

Notifications include:

■ “Mailbox Arrival Report” on page 94

■ “Mailbox Error Report” on page 94

■ “Mailbox Inactivity Report” on page 95

■ “Functional Acknowledgement Delinquency Report” on page 95

■ “Interchange Exceptions Report” on page 95
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Mailbox Arrival Report
The Mailbox Arrival report lists all documents that arrived in your mailbox.

Mailbox Error Report
The Mailbox Error report lists all documents that could not be delivered to your 
trading partner due to a processing error, including the error code and description.
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Mailbox Inactivity Report
The Mailbox Activity report lists all mailboxes that have been inactive for a 
previously specified time period.

Functional Acknowledgement Delinquency Report
The Functional Acknowledgement Delinquency report lists all late functional 
acknowledgement documents.

Interchange Exceptions Report
The Interchange Exceptions report lists all noncompliant interchanges; that is, 
documents that are not in compliance with the ANSI X12 standard due to an error. 
The report includes the error description.
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TGMS Report Columns
For each report, the list shows the following information:

Note: If you do not see all columns described, you might need to re-configure the 
listing to display them (see “Configure TGMS Report Data” on page 97). 

Status values include:

Status Type Description

Mailboxed Outbound Interchange document was delivered to your trading 
partner's mailbox or the appropriate Interconnect and is 
ready to be picked up.

Opened Inbound Interchange documents were downloaded from the 
mailbox to the receiver's PC.

Picked Up Outbound Trading partner or the appropriate interconnect has 
picked up the interchange document.

Rejected All Interchange was rejected by OpenText.

Unopened Inbound Interchange documents were not yet downloaded from 
the mailbox to the receiver's PC.

■ Days before System Deletion — Interchanges are kept for the retention 
period your company specifies. This column displays the number of days before 

TGMS Report Column Description

ILOG Input Log Number, assigned by the Trading Grid for 
tracking purposes. A log number assigned by 
Interchange Services for tracking purposes. An ILOG is 
an 11-digit number, based on the combination of the 
month, day, Greenwich Mean Time, and the decimal 
fraction of the hour.

Mailbox Mailbox the interchange was sent to (for Inbound Status) 
or from (for Outbound Status).

Your EDI Address, Trading 
Partner EDI Address

The EDI addresses of you and your trading partner.

Interconnect If data came from, or is going to, another network, this is 
the network (VAN) name.

Control Number Interchange Control Number of the data coming in (for 
Inbound Status) or going out (for Outbound Status).

Application Reference The type of data that is contained in the file, for 
example, 850.

Data Type The application reference document type.

Mailbox Process Date/Time When the interchange was available for pickup from the 
mailbox.

OpenText Receipt Date/Time When OpenText received the interchange.

Receiver Pickup Date/Time When the receiver picked up the interchange from the 
mailbox.

Status Current status of the interchange. Click the Status to see 
interchange details. 
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Trading Grid deletes the interchange from the system. After it has been deleted, 
you cannot access or retrieve it. where does this go?

Configure TGMS Report Data
You can change the layout and the contents displayed on some report pages. Or, 
you can copy the Transaction Summary report to your Operations Center home 
page. 

To configure report data

1 Click the Reports tab, then open the report to configure.

2 To configure the current page, in the Reports title line, click  Configure. 

3 Depending on the available options, do one or more of the following:

4 Click Apply. 

Trading Grid re-configures the page according to your specifications. 

To . . . Do this . . .

Copy the Transaction 
Summary to the Operations 
Center page

Select Copy to Ops Center. 

Hide a listing on the page Select Minimize for the applicable component. 
Note: After a component is minimized, click Expand 
to view its content. 

Rearrange the columns for a 
listing

In the Order column, enter the column order 
sequence you want. 

Eliminate one or more columns 
from view

In the Hide column, select the columns you do not 
want to see. 

Change the default sort 
sequence for a listing

In the Sort column, select the column by which you 
want the data sorted.

Select the number of 
transactions on a page

In the Lot Size field, type a value.

Select a time zone for report 
information on these reports.
Inbound Status
Outbound Status
Interconnect Status

1 From the Default Mailbox list, select the 
mailbox or ALL. 

2 From Default report name Time Zone, select
■ Mailbox Time Zone — To use the default 

time zone of the mailbox(es). 
■ GMT — To use Greenwich Mean Time. 
■ My Time Zone — To use your default time 

zone. 
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Functional Acknowledgement Management (FAM)
The Functional Acknowledgement service provides a series of reports. These 
reports provide a comprehensive look at community performance for the current 
month, prior month, and year-to-date (for Buyers and Retailers). Reports include

■ “All Tracked Trading Partners Report” on page 98 
Provides an overview of your community’s performance for the current month.

■ “Compliant Trading Partners” on page 100 
Lists trading partners that responded to all documents on time. 

■ “Late Trading Partners Report” on page 100 
Lists trading partners that responded after the policy time period expired.

■ “No Acknowledgement Trading Partners Report” on page 101 
Lists trading partners that have not yet responded to all documents and the 
policy time period has expired.

■ “Excluded from Tracking Report” on page 102 
Lists trading partners whose documents are excluded from tracking.

All Tracked Trading Partners Report
The All Tracked Trading Partners report provides an overview of your community’s 
performance for the current month. Statistics at the top show the number of 
documents in each category. 

Report Field Description

Acknowledged on Time All documents in all functional groups that were 
acknowledged on-time. 

Late Acknowledgement Documents that were acknowledged after the policy time 
period expired. 

Not Acknowledged Documents that need acknowledgment and the policy time 
period has expired. 

Pending Documents that need acknowledgment, but are not yet 
considered late. 

Excluded Documents that are excluded from tracking.
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A pie chart shows trading partner statistics in each category. Move the cursor to 
one of the colored segments to see the number and percentage of trading partners 
in that category. 

Compliant Trading partners that acknowledged all documents in all functional 
groups on-time. 

Late Ack Trading partners that acknowledged one or more documents after the 
policy time period expired. 

No Ack Trading partners that have one or more documents that need 
acknowledgment and the policy time period has expired. 

Note: A trading partner that has been late once in the current month is included 
in the Late Ack category. Likewise, if the trading partner acknowledged all but one 
document, that company is represented in the No Ack category.

See also

■ “Filter Report Data” on page 102

■ “View Data by Trading Partner or Document Type” on page 104
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Compliant Trading Partners
The Compliance Trading Partner report shows trading partners that responded to 
all documents on time. Click an EDI Address to see interchange and Functional 
Group information. A Functional Group is a set of “like” or same documents, for 
example, Purchase Orders, Invoices.

See also

■ “Filter Report Data” on page 102

■ “View Data by Trading Partner or Document Type” on page 104

Late Trading Partners Report
The Late Trading Partners report shows the trading partners that responded after 
the policy time period expired for at least one document. Click an EDI Address to 
see interchange and Functional Group information. A Functional Group is a set of 
“like” or same documents, for example, Purchase Orders, Invoices
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. 

See also

■ “Filter Report Data” on page 102

■ “View Data by Trading Partner or Document Type” on page 104

No Acknowledgement Trading Partners Report
The No Acknowledgement Trading Partners report shows the trading partners that 
have not yet responded to all documents and the policy time period has expired. 
Click an EDI Address to see interchange and Functional Group information. A 
Functional Group is a set of “like” or same documents, for example, Purchase 
Orders, Invoices.
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See also

■ “Filter Report Data” on page 102

■ “View Data by Trading Partner or Document Type” on page 104

Excluded from Tracking Report
The Excluded from Tracking report lists the trading partners whose documents you 
are not tracking.

See also

■ “Filter Report Data” on page 102

■ “View Data by Trading Partner or Document Type” on page 104

Filter Report Data
You can define data filters and apply them to your FA Management reports to get 
the exact data that you want.

To filter report data on FAM reports
1 Click the Reports tab > Functional Acknowledgement Management. 

2 On the left, select the name of the report you want to view: 

■ All Tracked

■ Compliant

■ Late

■ No Acknowledgment

■ Excluded from Tracking
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3 In the statistical area at the top, click Set Filter.

The Functional Acknowledgement Filters page opens.

4 In the Filter Name field, enter the name of the filter you are creating. 

5 Enter your filtering criteria:

Important: Any filter parameter you enter overrides the corresponding 
parameter that was defined in the Event alerts or FA Management alerts. If 

Filter Options Description

Time to Delinquency Select the number of hours after receipt that the 
trading partner(s) has to acknowledge all documents 
or document groups. 

Functional Group/Document 
Type

Click Browse to find and select a specific document 
type. If you do not make a selection, data for all 
document types shows in the reports.

Your EDI Address Click Select to select which of your EDI addresses to 
see reports for. If you do not make a selection, data 
for all of your EDI addresses shows in the reports.

Trading Partner EDI Address Click Select to select which of your trading partner 
EDI addresses to see reports for. If you do not make 
a selection, data for all EDI addresses for all trading 
partners shows in the reports.
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there is no corresponding Event alert or FA Management alert parameter, and 
you do not enter a filter parameter, an “ALL” applies for that parameter.

6 To apply the filter to your current report data, select the Apply This Filter 
option.

7 Click Create New Filter. 

Your filter displays in the list at the top of the page. The filter remains active until 
you deactivate it. 

To deactivate, modify, or delete the filter
Use this procedure to deactivate (or re-activate) the filter, modify the filter, or 
delete the filter.

1 Click the Reports tab > Functional Acknowledgement Management. 

2 On the left, select the name of the report you want, either: 

■ All Tracked

■ Compliant

■ Late

■ No Acknowledgment

■ Excluded from Tracking

3 In the statistical area at the top, click Set Filter.

The Functional Acknowledgement Filters page opens.

4 Click the Filter Name to re-activate, deactivate, modify, or delete.

5 Perform the appropriate action:

6 Click Update.

View Data by Trading Partner or Document Type
You can change your report view by selecting a different View By option at the 
top of the page, either trading partner or document type. 

To . . . Do this:

Delete the filter Click Delete. 

Deactivate the filter Clear (deselect) the Apply This Filter check box.

Modify the filter Change the filter parameters.

Re-activate the filter Select the Apply This Filter check box.
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■ If you are Viewing By Trading Partner, 

■ If you are Viewing By Document Type, 

The report . . . Displays statistics for . . . 

All Tracked All tracked trading partners (default).

Compliant Trading partners that responded to all documents on time. 
■ On the Compliant Trading Partners page, click an EDI 

Address to see interchange and functional group 
information.

Late Trading partners that responded after the policy time period 
expired to at least one document.

■ On the Late Trading Partners page, click an EDI Address to 
see interchange and functional group information.

No 
Acknowledgement

Trading partners that have not yet responded to all documents 
and the policy time period has expired. 

■ On the No Acknowledgement Trading Partners page, click an 
EDI Address to see interchange and functional group 
information.

Excluded From 
Tracking 

Trading partners whose documents you do not track.

Click this action . . . To see statistics for . . . 

All Tracked All tracked documents from all trading partners (default).

Compliant All documents that all trading partners responded to on time. 
■ On the Compliant Documents page, click a Document 

Type to see interchange and functional group information.

Late Documents that one or more trading partners responded to 
after the policy time period expired. 

■ On the Late Documents page, click a Document Type to 
see interchange and functional group information.
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Functional Acknowledgement Scorecard (FAS)
The Functional Acknowledgement Scorecard (FAS) applies to suppliers and 
vendors. It gives each supplier access to details and analysis of their supply chain 
performance. The service includes

■ Trading Partner Dashboard summarizing document acknowledgement 
performance for all suppliers in your company.

■ Month-to-date and prior month transaction visibility.

■ Statistics for on-time, late, and unacknowledged transactions.

■ Summary graphs showing monthly distribution of functional acknowledgement 
performance.

The first page you access provides an overview of your company performance for 
the current month. Statistics at the top show the number of documents in each 
category. 

Acknowledged on Time All documents in all functional groups that were acknowledged 
on-time. 

Late Acknowledgement Documents that were acknowledged after the policy time period 
expired. A policy time period is the number of hours the hub 
allows trading partners to acknowledge a document before the 
Hub considers partners to be late. 

Not Acknowledged Documents that need acknowledgment and the policy time 
period has expired. 

Pending Documents that need acknowledgment, but are not yet 
considered late. 

Excluded Documents that are excluded from tracking. 

No Acknowledgement Documents that have yet to be acknowledged and the policy 
time period has expired. 

■ On the No Acknowledgement Documents page, click a 
Document Type to see interchange and functional group 
information.

Excluded From 
Tracking

Documents from any or all trading partners that you do not 
track.

Click this action . . . To see statistics for . . . 
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The area below the statistics lists all the compliant trading partners in the company 
for the current month: 

Trading Partner 
Information

Pending

Acknowledged On Time

To see other data views, you can 

■ “Change Scorecard Parameters” on page 107

■ “Filter Report Data” on page 102

Change Scorecard Parameters
The Functional Acknowledgement Scorecard parameters determine which statistics 
you see.

To change Scorecard parameters
1 Click the Reports tab > Functional Acknowledgement Scorecard. 

2 Select the data to view. If you have multiple mailboxes, select the applicable 
Mailbox Number, or All (default). 

3 Select the time period. You can compare current month performance to prior 
months by selecting a different time link. 

■ Click Month to Date (default) to see current month-to-date activity. 

■ Click Prior Month to see previous month and notice trends. 

4 Select the type of information. Within the time period you selected, you can see 
a listing of information for trading partners by clicking a report view action on 
the left side of the page. 

5 Perform the appropriate action: 

■ EDI Address, Supplier ID, Trading Partner — 
Information about the individual supplier. 

■ FGs Sent — Number of functional groups sent. A 
functional group is a set of “like” or same documents, for 
example, Purchase Orders, Invoices. 

■ Count — Functional groups containing one or more 
documents that were acknowledged within the policy time 
period. 

■ Count — Functional groups containing one or more 
documents that were acknowledged within the policy time 
period. 

■ Avg — Average amount of time it took to acknowledge all 
documents in all functional groups. 

■ Min, Max — Shortest and longest amounts of time it took 
to acknowledge all documents in a functional group. 

To see trading partners that . . . Do this . . .

Responded to all documents on time Click Compliant TPs.

Responded after the policy time period 
expired for at least one document

Click Late TPs.

Have not yet responded to all documents and 
the policy time period has expired

Click No Acknowledgement.
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Active Invoices with Compliance (AIC) is a service that allows for country-specific 
regulatory compliance in invoice sharing between suppliers and buyers. This 
chapter explains how to use AIC to view and validate invoice transactions. 

Topics include:

■ “Overview” on page 109

■ “Search for Invoices Using Active Documents” on page 112

■ “Search for Invoices Using Active Invoices” on page 135

Note: Depending on your company’s subscription agreement and permissions, 
you might not see all items listed in this chapter. 

Overview

AIC Search Tools
AIC provides two search tools to help you monitor the transmission, validation, and 
success of invoice transactions, depending on the time period for the search and 
the type of invoice information you want to view.

■ Active Documents Search

■ Active Invoices Search

Active Documents Search
The Active Documents search tool tracks invoice activity within the past 90 days. 

Features:
■ Verify invoice transmission.

■ Confirm AIC processing status

■ View GXS processing history

■ Identify key invoice details

■ Identify errors

■ View invoice data in the submitted format (Supplier)

■ View invoice data in AIC XML format (Supplier and Buyer)

For more information, see “Search for Invoices Using Active Documents” on 
page 112.
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Active Invoices Archive
After an invoice has been processed by AIC, it is stored in the Active Invoices 
Archive. This archive provides an invoice history for auditing and legal purposes. It 
stores electronically signed, and non-signed, invoices for 6 to 20 years, depending 
on each country’s legal requirements or the subscriber preferences.

You can view legal invoice content in several formats, and access signature and 
certificate details. 

Features:
■ View invoice data in the format submitted by Suppliers

■ View Supplier and Buyer invoice data in AIC XML format

■ View or download signed and unsigned invoices as PDFs

■ View signature and certificate details for signed invoices

■ Download invoice artifacts

■ Schedule invoice reporting

■ View invoice processing history

■ View invoice audit history

For more information, see “Active Invoices Archive” on page 135.

Supported Document Types

Supported Credit Notes

Supported Invoices

■ Avoir ■ Return Credit Note

■ Credit Memo ■ Tax Credit Note

■ Gutschrift ■ TaxCreditNote - SelfBill

■ Retouren-Gutschrift

■ AbbreviatedInvoicel ■ CTe ■ Lastschrift ■ Tax Invoice

■ CFDIv2.2 ■ CTe - SelfBill ■ MDe ■ TaxInvoice - SelfBill

■ CFDIv2.2- SelfBill ■ Debit Memo ■ NFe ■ TaxDebitNote - SelfBill

■ CFDIv3.2 ■ Facture ■ NFe - SelfBill ■ TEMELFATURA

■ CFDIv3.2 - SelfBill ■ facture ■ PaySlip-CFDIv3.2 ■ TICARIFATURA

■ Combined Invoice ■ facture commercial ■ PriceAdjust - SelfBill ■ VPNS

■ Complete Invoice ■ FATTURAPA ■ Rechnung ■ Tax Invoice

■ Corrected Invoice ■ FPNS ■ RPS

■ Coupon ■ Invoice List ■ SelfInvoicing
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AIC Rules and Requirements

Data Flow
The direction of data flow between a sender and receiver can be outbound, 
inbound, or both, depending on the type of invoice. 

File Data 

Interchange Data 

Document Data 

ID Requirements
Two IDs must be provided to send source invoice documents to AIC:

■ Sender and Receiver Value Added Tax (VAT) IDs

■ Unique legal entity IDs

Exception:
The only exception to this rule is for invoices from an MDE document exchange 
platform where only the Sender VAT ID/Legal Entity Unique ID is required.

Multiple Invoices
AIC supports an interchange of multiple invoice documents. Multiple invoice 
documents can be sent to AIC at the same time. 

Exception:
AIC does not support multiple invoice documents for EANCOM input types. Only 
one EANCOM Invoice document can be sent to AIC at a time.

File Size
AIC supports PDF files containing up to 10,000 lines.

Direction Description

Outbound The company is the Sender.

Inbound The company is the Receiver. 

Inbound and Outbound The company is both sending and receiving invoices.

Direction Description

Outbound The company is the Sender.

Inbound The company is the Receiver. 

Direction Description

Outbound The company is the Sender.

Inbound The company is the Receiver. 

Inbound and Outbound The Sender and Receiver belong to the same company.
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Files to be signed cannot exceed more than 4 MB.

Interchange File Rejection
Interchange files are rejected if an irrecoverable error occurs while processing.

Mapping
Mapping of key invoice attributes and their path in the canonical format is pre-
configured in the AIC system.

Search for Invoices Using Active Documents
Use the Active Documents search tool to view invoice activity within the past 90 
days. 

You can search for basic information, such as a partner name or mailbox number. 
Or, locate files, documents, and interchanges and view their lifecycle and AIC event 
information.

Basic Active Documents Searches

To search for invoices using basic search criteria
1 Click the Reports tab.

The Active Documents Search page opens. The File search level fields also 
display by default.

2 Set the criteria for the search.
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The following options are available when searching for invoices using Active 
Documents. 

Search Field Description

Select Saved Searches Choose a search that you or other users have saved. See “Save 
Searches” on page 186.

GXS Ref No A unique reference number or document number, assigned by 
the Active Documents meta data repository to track items.

My Address Your EDI ID or OpenText routing mailbox ID (or IDs). 

Partner Name The company name of the trading partner associated with the 
partner address.

Time Frame Provides options for searching within a specific time period. 
See “Search for Invoices by Time Frame” on page 114.

Mailbox A OpenText mailbox ID (or IDs). 

Direction The direction of the data flow from the ID specified in the My 
Address field, which can be outbound, inbound, or both.
It uses the interchange sender and receiver addresses for EDI 
data. Otherwise, the file sender and receiver are used.
See “Data Flow” on page 111.

Partner Address The mailbox ID (or IDs) of the Trading Partner. 

(Search Level) Search levels refer to the type of data that can be retrieved. 
File
Interchange
Document

■ File — Searches for two types of files, which contain 
documents passing through the Managed Services 
environment: 
■ Files with data that has been translated from one non-

EDI data format to another non-EDI data format.
■ Files with data that has been processed as pass-

through data (without translation). 
Additional options include searching for files with or 
without errors, negative alerts, and other events.

■ Interchange — Searches for data in an EDI format that 
reports activity at the interchange level.

■ Document — Searches for electronic business 
documents, typically, in two formats:
■ EDI format: Reports activity at the document level.
■ XML format: Processed with XML document 

identification.
Additional options include viewing related documents such 
as invoices related to purchase orders.
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Search for Invoices by Time Frame
From the Active Documents Search page, you can search for invoices that were 
generated in a specific time frame in three ways:

■ Number of Days Range

■ Specific Date Range

■ Relative Time Range

To search for invoices within a Specific Number Of Days
1 On the Active Documents Search page, select Specific No. Of Days from the 

Time Frame drop-down menu.

2 Specify the range for the number of recent days for the search in the Last “X” 
No. Of Days, To: and From: fields.

For example, search from 5 days ago to 3 days ago.

3 Specify the start time and end times for the search.

For example, beginning at 00:00:00 the first day and ending at 11:59:59 on the 
last day.

4 Click Search.

To search by Specific Date Range
1 On the Active Documents Search page, select Specific Date Range from the 

Time Frame drop-down menu.

The default is the time period for the previous 36 hours. 

2 To change the time period:

a Click the calendar icon.

b Specify a new start date and time or end date and time.

3 Click Search.
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To search by Relative Time Range
1 On the Active Documents Search page, select Relative Time Range from the 

Time Frame drop-down menu.

2 Specify the start time for the relative search time frame. 

a Select one of the following options from the From: drop-down menu. 

■ Monday of this week

■ Monday of last week

■ First of this Month

■ First of last Month

b Select one of the following options from the To: drop-down menu. 

■ Tomorrow

■ Yesterday

3 Click Search.

Searching for Multiple Items
If searching for multiple items, such as addresses, separate each address with 
comma. 

Example: ZZ:122133399,09:0045599999

Wildcard Searches
If you know only one value for a a search field, type * for a wildcard search.
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Advanced Active Documents Searches
Advanced searches allow you to locate files, documents, and interchanges. You can 
then view their lifecycle and AIC event information.

Search For Files

To search for files
1 Click the Reports tab in Trading Grid Online. 

The Active Documents Search page opens for a File search by (default).

2 Specify the criteria for the search. 

Search Field Description

Application 
Reference

The application reference for the file, which typically indicates a 
file or document type.
Example: 850,810

ILOG Number Input Log Number. A unique, 11-digit number assigned by the 
the system to identify a file transmitted by the Sender. 
This number is based on a combination of the month, day, 
Greenwich Mean Time, and the decimal fraction of the hour.

Interconnect 
Name

The name of a third-party service, such as a VAN, between your 
company and OpenText. Used if a file is sent to, or received from 
a third party. 

Translation 
Session Number

A number assigned to each translation process.
Example: 850

Sender Reference A number or alpha-numeric value that references the file in the 
routing process. The system assigns this value during the routing 
cycle.
Example: 613821382
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3 Click Search.

The File Search Results page lists the files that meet the search criteria by the 
most recent timestamp (Created Date and Time column). See “View Search 
Results” on page 123.

Status A list of possible statuses for a search, which can apply to both 
inbound and outbound transactions. 
You can search for the following file status:

■ Extracted — The trading partner retrieved the document 
from the mailbox or interconnect service.

■ Rejected — The file was rejected by OpenText.
■ Rejected from Interconnect 
■ Unextracted — The trading partner did not retrieved the 

document from the mailbox or interconnect service.
■ Incomplete — Incomplete itineraries (OpenText 

instructions for processing a document).
■ With Errors
■ Without Errors 
■ All

Mailbag ID A unique number that references an interconnect service such as 
a third-party VAN. 

Original File Name The name of the original file that was sent.

Search Field Description
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Search For Interchanges 

To search for Interchanges
1 Click the Reports tab in Trading Grid Online. 

The Active Documents Search page opens. 

2 Select Interchange to open the Interchange search section.
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3 Specify the criteria for the search.

4 Click Search.

The Interchange Search Results display for the invoice Interchanges that meet 
the search criteria. By default, the page sorts the Interchange list by Created 
Date and Time, starting with the most current date and time. 

See “View Search Results” on page 123.

Search Field Description

Interchange Control Number A unique nuber used to track an interchange.

Production/Test Flag There are three types of flags:
■ Both Production and Test

■ Production

■ Test
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Search For Documents

To search for documents
1 Click the Reports tab in Trading Grid Online. 

The Active Document Search page opens. 

2 Select Document to open the Document search section.
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3 Specify the criteria for the document search.

Parameter Description

Document Type An EDI code that identifies a specific type of EDI document, such as 
810 or INVOIC. 
To search for multiple Document Types: 
To search for multiple types of documents, separate each type with 
a comma. For example, type 810, INVOICE.

Functional Group Control 
Number

A number assigned by EDI systems to the functional group header 
and trailer segments of an EDI file to verify data integrity. Typically, 
this number applies only to data in ANSI X12 format.

My Functional Group Address Your EDI functional group address. 
Applies only to the ANSI X12 standard.

Functional Group Type A two-digit code in the group header segment of an ANSI X12 EDI-
formatted file that identifies the type of business document it 
contains such as PO, PS, IN.

Translation Session Number A unique nuber used to track a Translation Session.

 Primary Key Select this option if the first key typed is the primary key. 

Primary Key Value The identifier value for the primary key. 
For example, type the actual purchase order number or product ID 
to use in the search. 
To search for multiple primary key values, separate each type with a 
comma. For example, type 123, 789.
Search Tip: 
Type a partial value, followed by an asterisk (*) to retrieve all 
documents that begin with those characters, for example, 1234*

Secondary Key

Secondary Key Value The identifier value for the secondary key. 
To search for multiple secondary key values, separate each type 
with a comma. For example, type 123, 789.
Search Tip: 
Type a partial value, followed by an asterisk (*) to retrieve all 
documents that begin with those characters, for example, 1234*

Status A drop-down list of possible statuses for a search, based on the 
platform, tracking level, and configuration. Status searches can 
apply to inbound and outbound transactions. 
In Managed Services, you can search the following statuses, 
depending on your service subscription: 

■ Acknowledged 
■ Not Acknowledged 

Note: In any implementation, leave All enabled to not search based 
on a specific status. 

Legal Profile Names ■ My Name 

■ Partner Name 

Invoice Date Range ■ Specific Date 

■ From Date 

■ Last ‘X’ Days 

■ To Date 
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4 Click Search.

The Document Search Results page displays the invoice documents that meet 
the search criteria. By default, the Search Results page sorts by Created Date 
and Time, starting with the most current date and time. 

See “View Search Results” on page 123.
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View Search Results
The Search Results page for file, interchange, and document criteria displays the 
applicable files by the most recent timestamp.

From all Search Results pages, you can also do the following: 

To Description

Sort the data. Click a column heading to sort the data from ascending to 
descending order (or vice versa).

View and save search results as a 
PDF file.

Click .

View and save the search results 
as a .csv file.

Click .

Print search results. Click .

View search criteria. Click View Search Criteria to view the parameters for 
the current search.

Save or schedule reports. Click Save/Schedule Report to save a report as a .csv 
or .pdf file or schedule when to generate a new report .
See “Schedule Reports” on page 124.

View Processing Lifecycle 
information.

Click the GXS Ref Number for an invoice to open the 
Processing Lifecycle page.
See “View Processing Lifecycle Information” on page 130.

Save Search Queries
After setting the search criteria and generating the results, you can save the search 
query settings (also called a report query) to use again for a report. 

You can use a search query that both you and others in your organization have 
saved.

To save a search query
1 Set the search criteria, and run the search. See “Active Documents Search” on 

page 109.

2 On the Search Results page, click Save/Schedule Report.

The Save or Schedule page displays, along with the report name.
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3 Type a name for the report in the Name field.

4 Click Save.

The Active Documents Search page updates the My Saved Searches list with 
the saved report.

Schedule Reports
Scheduling reports allows you to get the latest report data without having to 
manually run a report. You can schedule reports to run automatically at certain 
times (daily, weekly, or monthly), and email reports to Trading Partners and users 
in your company in .csv or .pdf formats.

To set up a report schedule
1 In the Search Results page, click Save/Schedule Report.

The Save or Schedule page displays the name of the company for the report.

2 Type a name for the report in the Name field.
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3 Click the checkbox, I want to schedule this report, and select the time 
frame and time zone for the scheduled report. 

Note: To run a one-time report, select Now.

4 Click the checkbox for the report format, either CSV or PDF.

5 To email the report, click the checkbox, Send this report as an email 
attachment. Specifiy the email addresses of the users and contacts to receive 
the report.

Note: You can only add contacts and users that have access to the report 
folder, listed as available.

6 Yo send the file to a Trading Partner through Trading Grid Message Services 
(TGMS), click the Send this report via TGMS checkbox.

7 Click Save.
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The system adds the schedule to the Scheduled Reports list and displays a 
confirmation message. 

To view the scheduled report, click Scheduled Reports in the Reports tab. See 
“View Report Schedules” on page 126.

View Report Schedules
The Scheduled Reports page lists all of the reports that have been scheduled for 
delivery and the delivery status. 

From the Scheduled Reports page, you can also do the following:

■ Change a report schedule.

■ Delete a scheduled report.

■ Schedule a one-time report to run immediately.

To view scheduled reports
1 Click the Reports tab in Trading Grid Online. 

2 Click Scheduled Reports.

The Scheduled Reports page opens. 

3 Click the name of the report in the Report Name column to view the schedule. 

Note: If the report name does not display as a hyperlink, it is a one-time report 
that was previously executed. 

To run a one-time report immediately
1 Click the Reports tab in Trading Grid Online. 

2 Click Scheduled Reports.

The Scheduled Reports page opens. 

3 Click the report name.

4 Click Execute for the report. 

The system adds a one-time report to the Scheduled Reports list with the 
same name, along with ONCE and the current date and time.
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To change a report schedule

1 Click the Reports tab in Trading Grid Online. 

2 Click Scheduled Reports.

The Scheduled Reports page opens. 

3 Click the name of the report in the Report Name column.

The Save or Schedule page opens. 

4 Change schedule criteria for the report. 

5 Click Save.

To delete a scheduled report
1 Click the Reports tab in Trading Grid Online. 

2 Click Scheduled Reports.

The Scheduled Reports page opens. 

3 Click Only my reports from the View drop-down menu.
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The list refreshes.

4 Click the check box for report(s) you want to delete from the list.

5 Click Delete.

View Delivered Reports Lists
Delivered Reports are scheduled reports, including one-time reports, which have 
been generated by the system. 

To view a list of delivered reports
1 Click the Reports tab in Trading Grid Online. 

2 Click Delivered Reports.

The Delivered Reports page opens. 
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The Delivered Reports page lists the following information for each report. 

■ Name of the report 

■ Report format (such as PDF)

■ Date and time the report was run 

■ Name of user who created/scheduled the report 

■ Report status (such as New, Read, Processing, or Failed)

■ Report ID (click the link to view audit log for the report)

Note: Active Documents deletes delivered reports after 45 days.

To download a delivered report
1 Locate the latest version of the report in the Delivered Reports list.

2 Click the name of the report. 

Note: The status cannot be Processing.

3 Follow the prompts to open (or save) the report. 

View Audit Logs
An audit log for each delivered report provides additional information such as who 
received the report and the time it was delivered. 

Note: An audit log is only available if Active Documents emails the report to 
recipients. 

To view the Audit Logs 
1 Locate the latest version of the report in the Delivered Reports list.

2 In the Report ID column, click the link for the report. 

The Audit Log displays audit information such as who received the report.
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Delete Delivered Reports
Delete a delievered report from the Scheduled Reports list. See “To delete a 
scheduled report” on page 127.

View Processing Lifecycle Information
Active Documents captures the processing history of files, EDI interchanges, EDI 
documents, and XML documents as they pass through various tracking points. 

Processing lifecycle details provide information about a specific transaction at key 
processing points in each environment. The points that display in the lifecycle 
history depend on the path the transaction follows. 

You can view processing lifecycle information for a transaction:

■ AIC process details

■ Document details

■ Managed Service Platform details

■ Trading Grid Messaging Service (TGMS) details

Note: To view processing lifecycle information quickly, click the GXS Ref Num for 
an invoice on the Search Results page. KP: Edit from here if time allows

To view processing lifecycle information for a transaction

1 Search for a file, document, or interchange. See “Active Documents Search” on 
page 109.

2 On the Search Results page, do one of the following:

■ Documents: Click the Document ID for the applicable document. 

■ Files: Click the Sender Reference number for the applicable file.

Below is an example of a Processing Lifecycle page.
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3 To download the Processing Lifecycle page into a PDF document, which can 
then be printed, click .

4 The Processing Lifecycle page includes several sections, depending on the 
processing stages. Some sections allow you to further drill down through the 
data. 

Click these lifecycle icons to navigate through the page. 

To view AIC process details
On the Process Lifecycle page, click . The AIC area tells you if the invoice 
transaction and the electronic signing were successful. If there were errors, click 
the Error link for an explanation. Correct the invoice and resubmit it.

If there were no errors, the invoice is now a Legal Invoice. You can view the 
signing information, as well as all other invoice information, in the Legal Invoices 
archive. For more information, see “Active Invoices Archive” on page 135.

To view document details 

1 On the Process Lifecycle page, click . 

2 Click List Document(s). 

The List Documents page opens. 

3 Do any of the following: 

To view Description

Process Lifecycle or related documents Click an icon in the Document ID column to access the Process 
lifecycle and related documents. 

Content of the data file(s) involved 1 In the Translation section, click the Data and Models link. 
The Data nd Models dialog box opens. 

2 Click Download to download the appropriate file.
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To view Managed Service Platform details
Multiple Managed Service Platform entries might exist because transactions can 
pass through the Managed Service Platform at different stages of processing.

For example, in a transaction with no errors, the Managed Service Platform routes 
the file to a translator. Then, the translated output enters another Managed Service 
routing cycle for transmission to the recipient. 

To view TGMS details
TGMS is the GXS network that enables data exchange with your partners. It 
manages your inbound and outbound transactions. 

As with the Managed Service Platform, multiple TGMS sections might exist because 
transactions can pass through the TGMS, as well as Managed Services, at different 
stages of processing. 

For example, this section displays when the transaction was received and routed to 
the translator.

3 On the List Documents page, click the applicable Invoice ID. 
The Process Lifecycle page opens for the invoice.

To view Description
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Also see “Email Alerts” on page 133.

Email Alerts
Depending on your role (Buyer or Supplier) and the profile set up by your Company 
Administrator in the Legal Profile or profiles, you might receive some or all of the 
following email alerts. These alerts are notifications about the invoice validation 
and processing.

■ Invoice copy — Email notification that includes an unsigned copy of the 
invoice. The invoice copy is in a readable PDF format. This copy is useful for 
workflow authorization or dispute resolution. 

■ Invoice success — For Suppliers only. Notification that the invoice successfully 
processed.
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■ Invoice process failure — For Suppliers only. Notification that errors were 
found in the invoice and processing stopped. You should correct the error(s) in 
the invoice and resubmit the invoice into the Trading Grid.
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Search for Invoices Using Active Invoices
This section explains how to find and view signed invoices, non-signed invoices, 
and credit notes in the Active Invoices Archive. 

Active Invoices Archive
After an invoice is signed, it goes to the Active Invoices Archive. This archive 
provides an invoice history for auditing and legal purposes. It can contain copies of 
electronically signed and non-signed invoices from 6 to 20 years, as required by 
your country. 

You can view the following for each active invoice:

■ Invoice data in the Supplier's format.

■ Signed or unsigned invoices in a readable PDF format.

■ Signature and certificate details.

■ Invoice processing history.

■ Invoice audit history.

The database stores these documents for up to 20 years, according to your 
country’s legal requirements. 

To search for an invoice in the Active Invoices Archive
1 Click the Reports tab in Trading Grid Online. 

The Active Document Search page opens. 

2 Select Document. Then click Active Invoices.
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The Search Archive page opens. From this page you can search for invoices in 
the Legal Archive, dated within the past 20 years. 
 

3 Set the search criteria. 

Important: The Transaction Date Range section criteria is based on when 
GXS processed the document, whereas the Invoice Date Range is based on 
the date and time the invoice was created, as stated in the actual invoice 
document.
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Field Description

Transaction Date Range

Time Frame The date and time when the system received the invoice. There are 
five ways to search for documents by date:

■ Specific Date 

■ Specific Date Range 

■ Specific No. of days 

■ Relative Time Range

■ None — search all available records.

From Date/To Date Click the calendar icons to select the From Date and To Dates. 
Use the 24-hour clock format, such as 0:00 to 23:59. 

 Last “X” No. of Days Specify the number of days back from the current date.

 Document Details 

Order # A unique number used to track an invoice.

Document Type The document type, for example: Tax Invoice or Tax Credit 
Note.

Invoice Number A unique number used to track an invoice.

Invoice Value The total monetary amount of the invoice. 

Invoice Number Range (From/To) A range of Invoice Numbers for a search.

Invoice List (Upload) Click Browse to upload an invoice.

Invoice Value (incl VAT) The Invoice total including the VAT costs:
■ = (equal)

■ < (less than)

■ > (greater than) 

Example: $100 before taxes.

Invoice Value (excl VAT) The Invoice total without the VAT costs.

Status Either All invoices, invoices With Errors, or invoices Without 
Errors.

Currency The currency on which the invoice is based. 

Legal Profile - My Information

My Legal Name/Unique Entity ID 
Use this section to look for invoices based on one or more legal 
profiles.
Type the name or ID of the legal profile defined for your Company's 
entity, for example, factory, plant, division, sub-division, etc., or 
provide the other information as applicable.

Legal Profile - Partner Information

Partner Legal Entity 
Name/Unique ID

The name or ID of the legal profile defined for the Trading Partner's 
entity.

Partner VAT ID The VAT ID
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Role Type The role of the legal entity or business unit 
■ Sender — Sends invoices only.

■ Receiver — Receives only.

■ Both — Sends and receives invoices.

Note: In the case of self-billing, a Buyer Receiver of documents 
might also send invoices. In this case, select Both.

Additional Search Filter Additional search filter include the following: 
■ IPA Number

■ General Ledger Invoice Number (Sender)

■ Invoice External ID

■ Buyer Siret Number

Extended Search Key as Sender  See “Setup Extended Search Keys” on page 140.

Extended Search Key as Receiver  See “Setup Extended Search Keys” on page 140.

Invoice Date Range 

None Search all available records.

Specific Date The exact date for an invoice search.

Start Date The start date for an invoice search. 

End Date The end date for an invoice search. 

Last ‘X” days The number of days back from the current date.

Software Version The software version.

View Type ■ Legal Archive — Search the entire archive. 

■ Secure Delivery — Search for the securely delivered items to 
view, extract, open, or download. 

The Secure Email Delivery feature delivered these documents 
through a secure email link. An email message with a secure 
link to the documents was sent to the person delegated in the 
Legal Profile by your Company Administrator, who then 
downloaded it to the Active Invoice Archive. 
Note: Documents received via Secure Email Delivery are 
retained for 180 days only.

Field Description
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4 Click Search.

The system automatically saves the search query (on the Search Archive page), 
and the Invoice List page displays the search results.
 

See also:

■ “Cancel an Invoice” on page 143.

■ “Invoice Information Page” on page 164

■ “Information Links” on page 166

■ “Legal Entity Partner List” on page 170

■ “Tax Exemption Justification Documents” on page 172

Back Click Back to return to the Search Archive page. 

Clear To clear the search fields and start a new search, click Clear.

Field Description
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Setup Extended Search Keys
You can can create custom search keys that are relevant to your operation and 
configure the Active Documents Search page to allow users to search for 
information using secondary keys. Up to three extended search keys can be 
configured.

To configure an extended search key
1 Click the Reports tab in Trading Grid Online.

The Active Documents Search page opens.

2 Select Document for the search Level. 

3 Click Active Invoices in the Navigation Panel. 
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The Search Archive page opens. 
 

4 Set the basic search criteria, as applicable. See “Active Invoices Archive” on 
page 110.

5 Specify the Role Type, either Sender, Receiver or both. 

Note: If Sender is selected, the Extended Key Search as Receiver fields 
are disabled (and vice-versa). If both are specified, both sections are enabled.
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6 Select a key to configure from the Select Key drop-down menu.

7 Do one of the following:

■ Type a value for the search in the Value field. This value can be anything, 
that is relevant to your operation, for example, a serial number, expiration 
date, or a specific term. 

■ Type a wildcard value (*). This value must include a leading and trailing 
asterick (*) .

8 Click Add.

The new key displays in the key list. 

9 Select the View Type, either Legal Archive or Secure Delivery.

10 Click Search.

The Invoice List displays the search results.
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Cancel an Invoice
Note: This feature may not be available, depending on your country, role, and 
permissions.

Important: Before cancelling an invoice, note the following.

■ Invoices can only be cancelled by authorized users who are familiar with 
the local legislation, fiscal laws, and tax implications. If you want to cancel 
an invoice and are not authorized, contact your Administrator.

■ After an invoice is cancelled, it cannot be retrieved.

■ Depending on the legal requirements of your country, cancelling an invoice 
might not cancel all documents related to the invoice.

To cancel an archived invoice

1 Search for the invoice (or invoices) that you want to cancel. See “Search for 
Invoices Using Active Invoices” on page 135.

The Invoice List displays the search results.
 

2 Select Invoice Cancel. 

The page refreshes, and the checkboxes for the uncancelled invoices in the list 
are enabled. 

3 Click the checkbox for the invoices you want to cancel.

4 Click Cancel Invoice. 
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5 Click OK when prompted.

The Invoice Cancellation page displays.
 

6 Click Cancel Invoice.

The Invoice Cancellation page indicates the success or failure of the 
cancellation.
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Attach Files to An Invoice
You can attach up to five files to an invoice, such as a customer quote, proof of 
delivery, proof of receipt, etc. 

Note: Invoice attachments are typically for the benefit of a sender and visible only 
to OpenText customers.

To attach a file to an invoice

1 Search for the invoice. See “Search for Invoices Using Active Invoices” on 
page 135.

The Invoice List displays the search results.
 

2 Open the invoice. 

The Invoice Information page displays.

3 Click Upload Attachments.

The Browse button is enabled. 
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. 

4 Click Browse, and navigate to the file you want to upload.
. 

5 Click Open.

The attachment is now attached to the invoice and accessible from the Invoice 
Information page.



A C T I V E  I N V O I C E S  W I T H  C O M P L I A N C E
Search for Invoices Using Active Invoices

Trading Grid Online  147

8  

. 

6 To open the attachment, click Download in the Attachments section.
. 

7 Specifiy whether you want to open or save the file, and click OK.
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Redeliver Invoices
If a customer requests another copy of an invoice, you can redeliver a copy via 
email and secure email, as well as their TGO mailbox, as often as needed.

You can redeliver up to 100 invoices at a time. The system sends the invoice to the 
recipient through the same delivery method used in the initial delivery, such as 
email or secure email, and notifiies the sender of the redelivery.

To redeliver an invoice
1 Search for the invoice that you want to redeliver. See “Search for Invoices Using 

Active Invoices” on page 135.
The Invoice List displays the search results.
. 

2 Click Deliver Invoice Copy.

3 Click the checkbox for the invoice you want to deliver.

The Deliver Invoice Copy button displays.
. 

4 Click Deliver Invoice Copy.

The Deliver Invoice page displays the invoice to be delivered.
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. 

5 Click Deliver.

The system resends the invoice to the recipient, based on the original delivery 
method, and a confirmation message displays.
. 

6 To return to the Invoice List, click Back to Invoice List.

Redelivery Notifications
The system notifies the sender by email when an invoice (or multiple invoices) is 
redelivered. 

The examples below show two types of redelivery notifications.
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. 

. 
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Send Multiple Invoices in a Batch
You can email up to 100 invoices as a batch, which can be up to 15MB in size. The 
system then processes and returns the batch invoices in the same order as 
originally received.

Note: This features applies only to Internal Archive Invoices.

1 Search for the invoice (or invoices) that you want to send. See “Search for 
Invoices Using Active Invoices” on page 135.

The Invoice List displays the search results.
. 

2 Click Download/Deliver.

3 Click the checkboxes for the invoices you want to send in a batch.

Notice that each time you click a checkbox, the Total Download Size displays 
at the top of the page.
. 

4 Click Deliver.

The Deliver page displays a list of the invoices to be sent as a batch and the 
total download size of the batch.
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. 

5 Click the checkbox for the delivery mode, either Email or Mailbox.

6 Click Deliver.
. 

A confirmation message indicates if the delivery is successful.
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Delivery Notifications
The system notifies the sender by email when a batch of invoice is delivered. 

Invoice Batch Delivery Errors
If the invoices selected for batch delivery exceeds 15MB, the Deliver page displays 
an error message.

. 

Upload Unrelated and Non-sequential Invoices
From the Search Archive page, you can search for invoices with non-sequential 
invoice numbers and upload them as .csv files.

Search for Non-Sequential Invoices or Unrelated Invoices
When searching for these types invoices, specify a specific invoice number or 
range, for example, invoice numbers 100 to 200. You can also search for invoice 
numbers that are not sequential, for example, Invoice 1, Invoice 542, Invoice 
10137, etc. 

Then, instead of having to perform multiple queries, you can upload a list of 
unrelated, non-sequential invoices in a comma delimited value (csv) file to the 
search page.

1 Create a list of invoices, and save it as a .csv file. 
Note: The list can contain up to 500 invoices.
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2 Select Invoice List on the Search Archive page. 

3 Click Browse, and specify the location of the .csv file to upload.
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The invoices display in the Invoice List. 

Note: You can also use the text field with comma separators to search for 
multiple invoices or type ‘*’ for a wild card search, for example *, *ABC or 
*ABC*.

Format Non-Invoice XML Files
This feature allows you to view and download HTML representations of the 
following types of documents:

■ Timestamp Files

■ Government Sent Responses

■ Failed Delivery Notice Acknowledgements

■ Deadline Passed Notice Acknowledgements

■ Delivery Receipt Acknowledgements

■ Rejection Notice Acknowledgements

■ Transmission Notice Acknowledgements

■ Outcome Notice Acknowledgements

■ Application Responses

■ Cancelled Acknowledgements
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To non-invoice XML files
1 Search for the invoice you want to format. 

The Invoice List displays the requested invoice.
. 

2 Click the invoice in the list.

The Invoice Information page displays.
. 

3 Click View.

The Application Response page displays the formatted invoice information.

Below are examples formatted non-invoices XML files.
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Example TimeStamp File:

Example Government Sent Response
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Example Delivery Receipt
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Example Failed Delivery Notice
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Example Rejection Notice
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Example Outcome Notice
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Example DeadLine Passed Notice
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Example Application Response File

Example Cancelled Acknowledgement
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Invoice Information Page
The Invoice Information page differs for Buyers and Suppliers, and differs if the 
invoice is a signed or non-signed EDI invoice, or a Credit Note.

This page is accessed from the Invoice Archive - Search Results page. See “Search 
for Invoices Using Active Invoices”.

Signed Invoices
The following Invoice Information page is for a Signed Invoice. 

Non-signed EDI Invoices
The example below shows the Invoice Information page is for a Non-Signed 
Invoice. 
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Send PDFs to AIC 
If authorized by your System Administrator, users can send PDFs created on their 
system directly to AIC for signing and storing. 

Authorize AIC to receive and sign PDFs
Note: The System Administrator must set the following:

■ In the Account Manager: Service Configuration page, set the subscription 
package to Active Invoice Sign Incoming File-Sender for the 
subscription. 

■ Set the Process Type to Active Invoice Sign Input in the Legal Profile 
section. 

. 
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Below is an example of the subscription required for this feature.
. 

Important: When AIC receives the data and creates the PDF, it validates that all 
of the incoming data is legal and compliant. To create a legal invoice, AIC reviews 
the data and makes sure that all mandatory fields are complete, then creates the 
PDF. If a user sends the PDF, AIC cannot validate the content or open the PDF to 
make sure all mandatory fields are completed. 

Process EDI Batch Files as Signed EDI Invoices
AIC supports multiple invoice signing and validation processes. 

EANCOM Signature Rules
This feature supports the following EANCOM signature rules:

■ EANCOM-IDEAL-EVIDENCE

■ EANCOM-AECOC-EVIDENCE

■ EANCOM-GS1AT-EVIDENCE

■ EANCOM-GS1AT2-EVIDENCE

Information Links
The Invoice Information page differs depending on if you are Buyer or Supplier and 
if the invoice is a signed invoice or a non-signed EDI invoice, or a credit note. You 
might not see all of the following information
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■ For the Original File: Click Download to download, or view, a version of the 
original unsigned invoice. The format displayed depends on how the invoice was 
created. For example: 

■ For the Validated Signed Invoice: Click View to view the Signed Invoice in a 
PDF format. 

You can then do the following in the PDF document,

Click To

Go to a specific page in the invoice.

See the digital signature.

View and reply to comments or markups in the invoice.

View invoice attachments.

■ Revalidate to view the signature and digital certificate details in a 
readable format
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■ For an Invoice Copy, click Download to download a formatted copy of the 
original invoice in a PDF document.

■ For the invoice Audit Trail, click Download to view or download the process 
lifecycle of the invoice. 
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■ For the Summary List, click Download to view or download the Summary List 
showing all message transmissions, both sent and received, associated with the 
invoice. The list also indicates any anomalies detected at each transmission. This 
list is generated once per day.

. 

■ For the PDF Container, click View to see the document and all its related data. 
Once you open the “container,” on the left side of the page click the attachment 
icon to see all the associated documents in the container. 

■ For the Tax Exemption Justifying Document (for more information, see “Tax 
Exemption Justification Documents” on page 172), click Download to download 
or view the associated document justifying VAT exemption in a PDF format.
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See also:

■ “Legal Entity Partner List” on page 170

■ “Tax Exemption Justification Documents” on page 172

■ “Search for Invoices Using Active Invoices” on page 135

■ “Invoice Information Page” on page 164

■ “Securely Delivered Items” on page 193

Legal Entity Partner List 
Important: This topic applies, and its functions might be required, if you have 
Trading Partners that send or receive Non-Signed EDI Invoices.

Every Company that sends or receives Non-Signed EDI Invoices must maintain a 
file of Trading Partners with whom the invoices are exchanged to log and track 
Trading Partner changes. AIC provides a search function that lets you quickly find 
an associated Trading Partner's legal entity profile to see if, for example, contact 
information has changed or if the Trading Partner E-Invoicing agreement has 
terminated.

Note: A Legal Entity is the record of the unique Buyer or Supplier party, typically 
from a tax registration perspective, that exchange compliant invoices through AIC. 
This is a company or a business unit or division within a company. For example, 
Company ABC might operate in three European countries and might be registered 
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as a unique entity with the tax offices of each of those three countries. Therefore, 
Company ABC has three corresponding legal entities configured within AIC.

To see a Trading Partner(s) associated to a specific Legal Entity or Legal 
ID

1 If necessary, log into the GXS Trading Grid and click the Reports tab.

2 On the left side, click Active Invoices > Active Invoices > Legal Entity 
Partner List.

The Legal Entity Partnership List page opens.
 

3 For My Legal Entity Name or My Legal Entity ID, enter a valid name or ID 
of the entity that trades with the Partner(s).

Note: A a valid Name or ID must be entered. If you do not know the exact 
Name or ID, contact your Company Administrator. 

4 If you are looking for a specific Trading Partner that you trade with, enter that 
Trading Partner's Legal Entity Name or Legal Entity ID.

5 Click Search.

The page redisplays listing the Trading Partners associated to your Company's 
Legal Entity Name or ID that you specified.
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From this page you can do the following: 

See also:

■ “Search for Invoices Using Active Invoices” on page 135

■ “Invoice Information Page” on page 164

■ “Information Links” on page 166

■ “Tax Exemption Justification Documents” on page 172

Tax Exemption Justification Documents
Important: This topics applies, and its functions might be required, if you have 
Trading Partners that send or receive Non-Signed EDI Invoices.

If your Company has a document that justifies VAT exemption, you can upload it 
into the Archive. After you upload a tax exemption justification document, it 
applies to all subsequent invoices that are sent and received within the Legal Entity 
that you specify. This means that

To Description

Resort the listing Click the applicable column header.

View a log of changed 
information 

Click  for the applicable entity.

Download the listing Click . 
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■ For a tax exemption document to apply to an invoice, the Buyer or Supplier must 
upload this document before the invoice is successfully sent or received.

■ After a tax exemption document is uploaded it applies to all subsequently 
archived invoices until a new tax exemption document is uploaded.

For example: 

In this example: 

■ Invoice1, Invoice2, and Invoice3 are not linked to any tax exemption document. 

■ Invoice4 and Invoice5 are linked to tax exemption document Version 1. 

■ Invoice6 is linked to tax exemption document Version 1 because it was already in 
the Archive when Version 2 was uploaded. 

■ Invoice7, Invoice8, and Invoice9 are linked to tax exemption document Version 
2. 

To upload a tax exemption document
Important: The tax exemption document must be in PDF format and cannot 
be larger than 4MB.

1 In the Reports Tab, select Active Invoices from the Navigation Panel.

2 Click Upload Tax Exemption Document. 

The Upload Document Justifying Tax Exemption page opens.
 

On January 9, 2012 Invoice1, Invoice2, and Invoice 3 are archived.
On January 10, 2012, tax exemption document Version 1 is uploaded and archived.
On January 15, 2012 Invoice4, and Invoice5 are archived.
On March 1, 2012 at 2 PM, Invoice6 is archived.
On March 1, 2012 at 3 PM, tax exemption document Version 2 is uploaded and 
archived.
On March 2, 2012 Invoice7, Invoice8, and Invoice9 are archived.
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3 For My Legal Entity Name or My Legal Entity ID, enter the applicable 
name or ID of the entity associated with the Trading Partner(s) and the invoices 
this document applies to. 

Important: You cannot upload a document until you enter a valid Name or 
ID. If you do not know the exact Name or ID contact your Company 
Administrator. 

4 For Upload Tax Exemption Document, click Browse to find your document 
or enter the path and filename.

5 Click Upload. 
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Trading Grid Analytics 9
Trading Grid Analytics allows you to view the business and operational 
performance of your trading community and provides metrics for several 
performance indicators relevant to customers using OpenText Managed Services. 

This chapter explains how to use Trading Grid Online Analytics and describes the 
Analytics Dashboard and metric components. 

Topics include:

■ “Overview” on page 175

■ “Analytics Dashboard” on page 176

■ “Metrics Tab” on page 183

■ “Filter Performance Metrics” on page 189

■ “Export Performance Metric Data” on page 199

■ “Dashboard Settings” on page 201

Overview
Trading Grid Analytics creates a visual representation of your transaction data, 
based upon the following Business and Operational metrics.

Operational Metrics (top 10)

- Document Volume by Trading Partner

- Document Volume by Type

Operational metrics measure metadata in 
a transaction.

Business Metrics

- Order Acceptance

- ASN Timeliness

- Invoice Accuracy 

- Price Variance

- Quantity Variance

- Top Trading Partners by Spend

Business metrics measure data in the 
detail of a transaction.

- Top Products by Invoiced Amount
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Reporting Period
The standard reporting period includes the past 90 days. However, your service 
agreement might have an expanded reporting period from 13 months to up to five 
years.

Analytics Dashboard
The Analytics Dashboard displays the Key Performance Indicators (KPIs) with dial 
graphs and bar graphs. See “Analytics Dashboard” on page 176. The system data 
is updated every 24 hours.

The information can be filtered in several ways, including by date range for the 
reporting period, currency, and more. See “Filter Performance Metrics” on 
page 189.

To view the Analytics Dashboard
1 From the Operations Center page, click Trading Grid Analytics. 

The Analytics Dashboard opens. 

The reporting period is located in the upper-right of the page. The default view 
is the buy side of the supply chain. 
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2 If your company is on the sell side, you must change the view. 

To change the Analytics Dashboard view
You can toggle the view to either the Buy Side or Sell Side.

1 Click the dial you want to view.

2 Click the View drop-down menu.

3 Select Buy Side or Sell Side. 

The dashboard updates to the buy side or sell side view.

To change the Reporting Period
1 Click the calendar tools to change the start date and end date. 

2 Click Apply.

The dashboard updates to specified reporting period.

3 To view additional details about a metric, click the label or the dial for the 
metric.

Analytics Dashboard Top Panel
The top panel displays five business performance metrics related to order 
fulfillment. 

■ Order Acceptance

■ ASN Timelines

■ Invoice Accuracy

■ Quantity Variance

■ Price Variance

Percentage is the performance measurement, and the gauge bar color indicates 
the range of performance quality.
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Metric Description

Order Acceptance Order Acceptance is the percentage of fully acknowledged purchase 
orders. The Order Acceptance metric compares two KPIs:

■ The number of orders from the selected time period.

■ The number of those orders that were accepted in full.

Note: Partially acknowledged purchase orders ARE NOT fully 
acknowledged.
The system used EDI 855’s and ORDRSP (a Purchase Order Response) 
documents for this metric.

■ ANSI - 850 BEG03 matches to 855 BAK03. 

■ The order is fully accepted when 855 BAK02 = AD, AK, AC, AT, AP 
or ZZ.
- BEG03 = Purchase Order Number
- BAK03 = Purchase Order Number
- BAK02 = Acknowledgement Type

■ EDIFACT - ORDERS BGM02 matches ORDRSP RFF0102 
(where RFF0101 = ON or VN).

■ The order is fully accepted when ORDRSP BGM03 = 6, 11, 32, 44.
- 48BGM02 = Message Number
- RFF0102 = Reference Number
- RFF0101 = Reference Qualifier
- BGM03 = Message Code

ASN Timelines Advanced Shipping Notice (856 as per ANSI X 12).
ASN Timeliness is the percentage of timely ASN instances created within 
the specified delay threshold (default = 15 min).
An ASN is timely if the elapsed time between the interchange date/time 
and the document date/time creation is within the delay threshold. 

■ ANSI - 856 Take ISA09/10 – BSN03/04 = Timeliness. 

■ If Timeliness < TimeParm (selected by user – 15 min default) then 
ON-TIME. 
- ISA09 = Interchange Date
- ISA10 = Interchange Time
- BSN03 = Date
- BSN04 = Time

■ EDIFACT - DESADV Take UNB0401/02 – DTM0102 = Timeliness.

■ If Timeliness < TimeParm (selected by user – 15 min default) then 
ON-TIME.
- UNB0401 = Date of Preparation
- UNB0402 = Time of Preparation
- DTM0102 = Date & Time Period



T R A D I N G  G RI D  A N A L Y T I C S
Analytics Dashboard

Trading Grid Online  179

9  

Invoice Accuracy Invoice Accuracy is the percentage of invoices that accurately reflect 
quantities and prices in the original orders.

■ ANSI - 850 BEG03 matches to 810 BIG04. 

■ Align PO106/07 to IT106/07. 
■ Match PO102 to IT102 (Quantity) & PO104 to IT104 (Price).

- PO106 = Product Service Qualifier, PO107 = Product Service ID 
- PO102 = Quantity Ordered, PO104 = Unit Price.
- BIG04 = Purchase Order Number
- IT106 = Product Service Qualifier
- IT107 = Product Service ID
- IT102 = Quantify Invoiced
- IT104 = Unit Price

■ EDIFACT - ORDERS BGM02 matches to INVOICE RFF0102 (where 
RFF0101 = ON or VN).

■ Align PO LIN0301 to Inv LIN0301.
■ Match PO QTY0102 to Inv QTY0102 (Qty) & PO PRI0102 to Inv 

PRI0102 (Price).
- LIN0301 = Item Number
- QTY0102 = Quantity
- PRI0102 = Price

Quantity Variance Quantity Variance indicates the average line item percentage difference 
between the invoiced quantity and the purchase order quantity.

■ ANSI - 850 BEG03 matches to 810 BIG04.

■ Align PO106/07 to IT106/07 and PO102-IT102/PO102*100. 
■ Then, average the variance of total line items for each Trading 

Partner.
■ EDIFACT - ORDERS BGM02 matches to INVOICE RFF0102 (where 

RFF0101 = ON or VN).

■ Align PO LIN0301 to Inv LIN0301 and PO QTY0102 - Inv 
QTY0102/PO QTY0102 * 100. 

■ Then, average the variance quantity of the total line items for each 
Trading Partner.

Note: Refer to Quantity Variance for EDI Element descriptions in the 
Quantity Variance calculations for ANSI and EDIFACT.

Metric Description
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Note: Top Trading Partners by Spend and Top Products by Invoiced Amount are 
also KPI Business Metrics and displayed as bar graphs.

Performance Default Ranges
Below are the KPI default ranges for the following Business Metrics. 

Analytics Dashboard Bar Graphs
The bar graphs display two Operational Metrics and two Business Metrics.

Business Metrics
■ Top Trading Partners by Spend

■ Top Products by Invoiced Amount

Operational Metrics
■ Document Volume by Trading Partners

■ Document Volume by Type

Price Variance Price Variance indicates the average line item percentage variance 
between prices on an invoice to the original purchase order price. 

■ ANSI - 850 BEG03 matches to 810 BIG04.

■ Align PO106/07 to IT106/07.
■ PO104-IT104/PO104*100 .
■ Then average the variance on line items.

■ EDIFACT - ORDERS BGM02 matches to INVOICE RFF0102 (01 = ON 
or VN)

■ Align PO LIN0301 to Inv LIN0301
■ PO PRI0102 - Inv PRI0102/PO PRI0102 * 100 
■ Then, average the variance price of the total line items for each 

Trading Partner.

Metric Positive Range 
(Green) 

Average Range
(Yellow)

Negative Range 
(Red)

Order Acceptance >=80% Between 20% and 80% <=20%

ASN Timeliness >=80% Between 20% and 80% <=20%

Invoice Accuracy >=80% Between 20% and 80% <=20%

Price Variance <=20% Between 20% and 80% >=80%

Quantity Variance <=20% Between 20% and 80% >=80%

Metric Description
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Business Metrics Bar Graphs

Top Trading Partners by Spend

Displays the top 20 trading partners based on the prices and quantities from the original order. 
Note: Documents with missing currency codes are grouped under "UNK" (unknown). 
Top partners display by Spend / Revenue of the product ordered.

■ 850 Calculate PO102 (Quantity) * PO104 (Price)

■ Capture Currency if available. 
■ Add up all line items. 

■ ANSI - 850 Calculate PO102 (Quantity) * PO104 (Price)

■ Capture currency if available. 
■ Add up all line items for all PO’s for each Trading Partner.

■ EDIFACT - ORDERS Calculate QTY0102 (Qty) * PRI0102 (Price)…. Capture Currency if available.   
Add up all line items for all PO’s for each Trading Partner.

Top Products by Invoiced Amount

Displays the top five products by invoice amount, based on the invoiced value and the qualifier that you 
select.
Note: Documents with missing currency codes are grouped under "UNK" (unknown). 
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Operational Metric Bar Graphs

Document Volume by Trading Partners

Displays the top 10 trading partners, based on the total number of X12 and EDIFACT documents 
sent and received. 
The information can be filtered for either Inbound or Outbound transactions.

Document Volume by Type

Displays the top 10 document types, based on the total number of X12 and EDIFACT documents 
sent and received. 
The information can be filtered for either Inbound or Outbound transactions.
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Metrics Tab
The Metrics tab provides access to additional detail for the Operational and 
Business metrics, which can be filtered in several ways and exported as a .pdf or 
.csv file. 

Operational Metrics Detail

To view the detail for Operational Metrics
1 From the Analytics Dashboard, click the Metrics tab. 

The Document Volume by Trading Partners page opens (by default).

2 To view the detail for Document Volume By Type, click Document Volume By 
Type from the Navigation Panel.
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Business Metrics Detail

To view Business Metric detail
1 From the Analytics Dashboard, click the Metrics tab. 

The Operational Metric, Document Volume by Partner page displays.

Note: You can also access the Metrics tab for the five dial graph business 
metrics by clicking on the graph.

2 In the Navigation Panel, click the in the Business section for the metric detail 
you want to view.

Top Trading Partners by Spend Metrics Page

Top Trading Partners by Invoiced Amount Metrics Page
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ASN Timelines Metrics Page

Note: Depending on date range selected, prior 30 days data might not be 
available for viewing, and zero displays for the four components measured. 
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Invoice Accuracy Metrics Page
 

Note: Depending on date range selected, prior 30 days data might not be 
available for viewing, and zero displays for the four components measured. 
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Order Acceptance Metrics Page
 

The View option for Order Acceptance defaults to Buy Side. If you view this metric 
and there is no data, change the view to Sell Side. 

Note: Depending on date range selected, the prior 30 days of data might not be 
available for viewing, and zero displays for the four components measured. 
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This note to be corrected in the next release.Price 
Variance Metrics Page

 

Note: Depending on date range selected, the prior 30 days of data might not be 
available for viewing, and zero displays for the four components measured. 
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Quantity Variance Metrics Page
 

Note: Depending on date range selected, the prior 30 days of data might not be 
available for viewing, and zero displays for the four components measured. 

Filter Performance Metrics
To search for specific information, you can filter the performance metrics in a 
variety of ways, and save a filter as a default. 

Metric Type Filter data by Metric

Access these filters from either the graphs on the Analytics Dashboard or the 
Metrics tab.

Business Metrics Trading Partner Name ■ All

Trading Partner Address ■ All

Item Qualifier ■ Top Partners by Spend

Currency ■ Top Partners by Spend

■ Top Products by Invoiced Amount

Operational Metrics Document Type ■ Document Volume by Trading Partner

■ Document Volume by Type
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Filter Business and Operational Metrics by Trading Partner

To filter by Trading Partner
1 Do one of the following: 

Filter data from a dial graph:

■ Click a graph label or anywhere on a graph. 

The Metric tab displays the performance detail page for the metric.
 

■ In the performance detail page, click .
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The Filter By page opens the Trading Partner Name filter (by default). 
 

■ Continue to step 2.

Filter data from a bar graph:

■ From the Analytics Dashboard, click  in a graph. 

■ Click the Filter icon .

The Metric tab displays the performance detail page.

■ In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default).

■ Continue to step 2.

2 Click the checkboxes for names of the Trading Partners for the search.

3 Click OK.

Filter Business and Operational Metrics by Trading Partner 
Address

To filter by Trading Partner Address
1 Do one of the following: 

Filter from the dial graphs:

■ Click the graph label or anywhere on the graph. 
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The Filter By page opens the Trading Partner Name filter (by default). 
 

■ Continue to step 2.

To filter from the bar graphs:

■ From the Analytics Dashboard, click  in a graph. 

■ Click (Filter) .

The Metric tab displays the performance detail page.

■ In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default).

■ Continue to step 2.

2 Click Trading Partner Address.

3 Click the checkboxes for address of the Trading Partners for the search.

4 Click OK.

Filter Operational Metrics by Document Type 

To filter by Document Type
1 From the Analytics Dashboard, click  in one of the following performance 

graphs:
■ Document Volume by Trading Partner

■ Document Volume by Type
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2 Click (Filter) .

The Metric tab displays the performance detail page.

3 In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default).
T 

4 Click Document Type to view the document type list.

5 Click the checkboxes for the types of documents for the search.

6 Click OK.

Filter Business Metrics by Currency
The U.S. dollar is default currency used in the business metrics bar graphs on the 
Analytics Dashboard. However, you can display the same information in a different 
currency by Trading Partner. 

To filter by Currency
1 From the Analytics Dashboard, click  in one of the following bar graphs:

■ Top Trading Partner by Spend
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■ Top Products by Invoiced Amount

2 Click (Filter) .

The Metric tab displays the performance detail page.

3 In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default).
T 

4 Click Currency.

5 Select the currency you want to use for the performance metric.

6 Click OK.

The information updates with the new currency.

Note: You can only select and apply one currency at a time.

Filter Business Metrics by Item Qualifier
There might be many qualifiers that are applicable to your organization, such as for 
products ordered by batch number or UBC code. The Item Qualifier Filter is 
available to the Top Products by Invoiced Amount metric to filter for such 
qualifiers. 

To filter by Item Qualifier
1 From the Analytics Dashboard, click  in Top Products by Invoiced 

Amount graph.

2 Click (Filter) .

The Metric tab displays the performance detail page.

3 In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default).
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T 

4 Click Item Qualifier. 

If there is any product with that qualifier, it will display in the automatically 
generated selection.

5 Select the qualifier from the Qualifier drop-down menu. You can select up to 
five qualifiers for the filter.
T 

6 Click OK.

The qualifier items display in the bar chart on the Analytic Dashboard.
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Save Default Filters
Saving a filter as a default displays the same graphical view of a metric, based on 
the data filtered. For example, you can save the filter for the Top Trading Partners 
by Spend graph to display specific Trading Partner names and currencies each time 
you open Trading Grid Analytics.

You can save filters for both the metrics in Analytics Dashboard Top Panel or from 
Analytics Dashboard bar graph. In addition, the filters that you set from a graph on 
the dashboard carry over to the views in the top panel (and vice versa).

To save a default filter from a bar graph
1 From the Analytics Dashboard, click  in a graph to access the filter settings .

2 Click the Filter icon .

The Filter By page list the items that can be filtered for a metric.

3 Click the tab for the filter, for example the Trading Partner Name tab. 

4 Click the checkboxes for the items to include in the filter, and click OK.

5 To add additional criteria, click the appropriate tab, and repeat step 4.
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6 After selecting all of the filter criteria, click Save as Default.

7 Click OK in the confirmation message.

The graph updates, and the default parameters display automatically each time 
you acesss the Analytics Dashboard. 

To save a default filter from the top panel
1 Click a graph label or anywhere on a graph. 



198 Trading Grid Online

T R A D I N G  G R I D  A N A L Y T I C S

Metrics Tab

The Metric tab displays the performance detail page for the metric.

2 In the performance detail page, click .

The Filter By page opens the Trading Partner Name filter (by default). 
 

3 Select the criteria for the filter, and click OK.

4 Click Save as Default.

Remove Default Filters
Removing default filters returns to the default view of the system.

To remove a default filters
1 In the Filter By page, click Clear All Filters.

2 Click OK.

The page refreshes to the default view. No Trading Partner Name or Trading 
Partner Address filters are selected, and the currency is set to USD - US Dollar.
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Export Performance Metric Data
Analytic information can be exported into a PDF or spreadsheet format (.xlsx). 

To export analytic metrics
1 Do one of the following:

Export data from a dial graph:

■ Click the graph label or anywhere on the graph. 

The Metric tab displays the performance detail page.
 

■ In the Metrics performance detail page, click .

The Export drop-down menu opens.

■ Continue to Step 2.
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To export data from a bar graphs:

■ From the Analytics Dashboard, click  in a graph. 

■ Click (Filter) .

The Metric tab displays the performance detail page.

■ In the Metrics performance detail page, click .

The Export drop-down menu opens.

2 Select either PDF Document or XLSX Document.

3 Follow your browser prompt to Open or Download the file. 

Below is an example of an exported PDF file.
 

Below is an example of an exported XLSX file.

Note: The contents of the XLSX file vary, depending upon the metric exported.
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Dashboard Settings
The Dashboard Settings feature on the Analytics Dashboard allows administrative 
users within a company to configure two settings:

■ Configure the default currency for your trading partner community; then upload 
the currency settings to the system through a batch upload process for two 
business metrics:

■ Top Trading Partners by Spend

■ Top Prodcuts by Invoiced Amount

■ Configure the default Item Qualifier for the Top Products by Invoiced Amount 
metric for an entire organization.

Trading Partner Currency Settings

To configure Trading Partner currency settings
1 Click Dashboard Settings in the Analytics Dashboard.

The Dashboard Settings page opens.
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2 Click Download File: List of partners to set default currency to generate 
a .csv file.

3 Follow the prompts to open the .csv file.

The .csv file opens.

4 Set the default currencies in the .csv file.

5 Click Save and specify the location for the file. 

6 After saving the .csv file, click Browse in the Partner Currency Config dialog 
box to select the file.

7 Click Upload.

The system automatically runs the default currencies that you set for the 
trading partners.

Note: This step involves a batch process, which might result in a time delay of up 
to 12 hours before the set currencies are updated for the Trading Partner.
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Default Item Qualifier Settings
For the Top Products by Invoiced Amount metric, you can configure the Analytics 
Dashboard to display data for a specific qualifier.

Note: Whereas setting the Item Qualifier from the Filter By page sets the default 
view at the user level, this additional filtering capability sets the default view for an 
entire organization.

For example, if the default was set to EN - EAN Number, each time a company user 
refreshes the Analytics the Dashboard, the graph for the Top Products by Invoiced 
Amount metric displays data relevant to the EAN Number. 

However, you might want to change this view for a different qualifier, such as UPC 
code. Through the Dashboard Settings page, you can configure the Analytics 
Dashboard to always display data for the new qualifier.

To configure default Item Qualifier settings
1 Click Dashboard Settings in the Analytics Dashboard.

The Dashboard Settings page opens.
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2 Select the new qualifier from the Default Qualifier drop-down menu.

3 Click Apply.

A confirmation message displays.

4 Click OK.

The Analytics Dashboard updates the Top Products by Invoiced Amount graph 
with the new default qualifer data.
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Document Manager 6
Formerly known as Intelligent Web Forms (IWF), Document Manager is a data 
management tool that allows you to manage and trade business-to-business (B2B) 
e-commerce documents, including Purchase Orders, Invoices, Ship Notices, and 
Remittance Advice forms, easily and efficiently. 

This chapter explains how to use Document Manager with either a forms viewer or 
with viewerless forms. Topics include:

■ “Overview” on page 207

■ “Document Manager Inboxes and Sendboxes” on page 211

■ “View Documents and Attachments” on page 222

■ “Create New Documents” on page 224

■ “Upload Documents to Document Manager” on page 234

■ “Create and Send Ship Notices with Labels” on page 236

■ “Send Documents and Files” on page 254

Overview

Document Manager Features
Document Manager provides the following features:

■ Message Dashboard — View up-to-date summaries about sent and received 
documents, alerts, and customer notifications. See “Message Center” on 
page 12. 

■ Intelligent Search Options — Search for items by document number, 
document type, trading partner, date, status, and more. 

■ ASN, Barcode, and Packing Options — Manage customer ASN requirements, 
pack shipments, and create customer-compliant shipping labels efficiently 
without the need to purchase and maintain additional software. 

■ Customizable Business Rules — Built-in data validation, pre-populated forms 
and template capabilities increase data accuracy and minimize data entry errors.

■ Export Capabilities— Options to export data as a Comma-Separated Value 
(CSV) file to an Excel spreadsheet or other database application.
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Hardware Requirements
OpenText recommends the following hardware components as a minimum for 
good performance: 

Hardware Component Recommended

Forms Viewer
Your system might use document forms that require a forms viewer, or it might use 
viewerless forms that do not require a viewer. 

If your system requires a forms viewer, you must first download and install a 
supported application to view, create, and edit business documents. 

Note: If your system does not require a forms viewer, please skip this section.

Supported Forms Viewers
Document Manager currently works with the following viewers: 

Forms Viewer Supported Platforms

Forms Viewers Installation
If you try to view a document and do not have a supported forms viewer installed, 
the system prompts you to download and install the default viewer (IBM Lotus 
Forms Viewer). 

Processor ■ 3GHz Dual-core 

Memory ■ 2GB 

IBM Lotus Forms Viewer 3.5.1 ■ Windows XP Professional

■ Windows XP Tablet PC

■ Windows Vista 

IBM Lotus Forms Viewer 3.5.1.2 ■ Windows XP Professional SP3

■ Windows 7 (32-bit).

IBM Forms Viewer 8.0.1 ■ Windows 7 Enterprise and Professional (32- or 64-bit). 
Tablet PC supported. 

■ Windows Vista Business, Enterprise, and Ultimate (32- 
or 64-bit).

■ Windows XP Professional (32- or 64-bit). 

Browser Requirements
IBM Form Viewer 8.0.1 supports the following browsers:

■ Internet Explorer 9 and 10

■ Firefox 22 (and previous versions). 
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To download and install the Document Viewer

1 When prompted to download the default view, click Download Now. 

2 Click Run to accept the download and begin running the InstallShield 
Wizard.lick Run to accept the download and begin running the InstallShield 
Wizard.
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3 At the next prompt, click Yes.

4 At the next prompt, select a language, and click OK. 

5 When the Installation Wizard opens, click Next.

6 Accept the terms of the license agreement, and click Next.

7 Specify the destination folder for the installation, and click Next > Install.
 

8 Click Finish to complete the installation.

9 Close all browsers, then login into Trading Grid Online to view documents. 
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Document Manager Inboxes and Sendboxes
Use the Document Manager Inboxes and Sendboxes to track and manage 
transactions with your trading partners. This section describes the following inbox 
and sendbox tools:

■ Document Inbox. See “Document Inbox” on page 211.

■ File Inbox. See “File Inbox” on page 213.

■ Document Sendbox. See “Document Sendbox” on page 214.

■ File Sendbox. See “File Sendbox” on page 217.

Document Inbox
The Document Inbox lists all documents received from your trading partners in the 
last 45-days. 

To use your Document Inbox

1 Click the Document Manager tab. 

2 Click Inbox from the Navigation Panel.

The Document Inbox opens. 

Note: When you open the Document Inbox, the File Inbox also opens.

Document Inbox Information
The Document Inbox provides the following information. 

Document Inbox Column Description

Document ID A number that identifies the document. Click this number to 
view the document content.

Trading Partner The EDI address of the Trading Partner that sent the 
document.

Document Type Indicates if the document is a Purchase Order, Invoice, 
Remittance Advice, Ship Notice, or Purchase Order 
Acknowledgment.
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Document Inbox Statuses
The Status column in the Document Inbox shows the current state of a document, 
based on four status levels:

■ New - The document has not been opened yet.

■ Read - The document was opened.

■ Downloaded - The document contents were downloaded to your desktop.

■ Turned Around - A new document was created based on the current 
document. For example, if an Invoice turned around from an Order, a status 
history indicates the Document ID, turnaround type, and creation date and time. 

To view the status of documents in your inbox
1 Click the link in the Status column for the document.

The Document Status page opens.

Status The current state of a document. 
Click the Status link to view the status information. See 
“Document Inbox Statuses” on page 212.

Date/Time The date and time when the current status was applied.

Days Before System Deletion The number of days until the system deletes a document. 
Documents can be stored in your Inbox for 45 days. 
Important: The system deletes Inbox items automatically 
after 45 days. Deleted items cannot be retrieved.

Comment Text comments provided by the user, Trading Partner, or both. 
Click the text to read the entire comment. See “View or Add 
Comments to Documents and Files” on page 220.

Document Version The Document Manager version number of the document. 
The system retains previous versions of inbound and 
outbound documents, but only the latest version of files. It 
creates a new document version each time a document is 
sent or received.

Document Inbox Column Description
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The Document Status page provides the following information about items in 
your inbox. 

File Inbox
The File Inbox lists all files that you have received from your trading partners in the 
last 45-days. 

To use your File Inbox

1 Click the Document Manager tab. 

2 Click Inbox from the Navigation Panel.

The File Inbox opens.
A

Note: When you open the File Inbox, the Document Inbox also opens.

The File Inbox provides the following information. 

File Inbox Description

Status Information Description

Status The current status of the document (New, Read, Downloaded, 
Turned Around).

Date/Time The date and time that the document was received.

User ID The ID of the user who opened the document or the last user 
to modify it. 

■ A User ID does not display if the current status of a 
document is New. 

■ A User ID does not change if a different user opens a 
document unless that user takes an action to change the 
document status. 

User First Name The first name of the person associated with the User ID.

User Last Name The last name of the person associated with the User ID.

Application Reference The type of file that was received.

Date/Time The date and time that afile that was received.
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Document Sendbox
The Document Sendbox lists all documents that you have created, saved, or sent 
within a 45-day period.

To access your Document Sendbox

1 Click the Document Manager tab. 

2 Click Sendbox.

The Document Sendbox opens.

Note: When you open the Document Sendbox, the File Sendbox also opens.

Document Sendbox Information
The Document Sendbox provides the following information.

Sendbox Column Description

Document ID A number that identifies the document. Click this number to view 
the document content.

Trading Partner The EDI address of the Trading Partner that receives the 
document.

Document Type Indicates if the document is a Purchase Order, Invoice, Remittance 
Advice, Ship Notice, or Purchase Order Acknowledgment.

Status The current state of a document in the sendbox.
Click the link in the Status column to view a document’s history or 
file activity such as when a file was opened such as when you took 
action to an item in your sendbox.
See “Document Sendbox Statuses” on page 215.

Modified Date/Time The date and time when the document was revised after it was 
first saved. 

Days before System 
Deletion

The number of days until the system deletes a document. 
Documents can be stored in your Inbox for 45 days. 
Important: Deleted items cannot be retrieved.

Comment Text comments provided by the user, Trading Partner, or both. 
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Document Sendbox Statuses
The Status column in the Document Sendbox shows the current state of sent 
documents. Items in your Document Sendbox can be one of the following statuses.

■ Saved - A document has been created or updated and saved, but not been sent. 
You must now open the item to send it. 

■ Packing - An Advanced shipping notice (ASN) is in process of being packed.

■ Packed - ASN has been packed. To send an unopened document, check the 
check box. Then, click Actions > Send. 

■ Submitted - Sending a document for the first time submits it to Trading Grid 
Online, which then checks for errors. 

■ If there are no errors, the system sends the document, and the status 
changes to Sent. 

■ If there are errors, the items’s status changes to Failed, and the document 
cannot be sent. 

■ Sent - A document was delivered to the receiver successfully.

■ Failed - Trading Grid Online could not send the document due to errors. 

■ Click the Failed status link to view the errors.

■ Resent - A document was resent successfully.

■ Resubmitted - Re-sending a document due to errors, updates, etc., submits it 
to Trading Grid Online, which then checks for errors.

■ If there are no errors, the system sends the document, and the status 
changes to Sent. 

■ If there are errors, the items’s status changes to Failed, and the document 
cannot be sent. 

■ Validated - The document form is saved and ready to send. 

■ To send it unopened, check the check box name, and click Actions > 
Send. 

Document Version The Document Manager version number of the document.
The system retains previous versions of inbound and outbound 
documents, but only the latest version of files. Each time a 
document is sent or received, it creates a new document version.

Document Attachments Indicates if attachments are provided with the document. 

Date/Time The date and time when the current status was applied. See 
“Document Sendbox Statuses” on page 215.

Sendbox Column Description
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■ Translation - (For translation subscriptions.) The document is in the translation 
process. 

Translation Statuses

■ Translation Complete — The translation completed successfully. 

■ Translation Error — An error prevented the translation from completing 
successfully. For example, empty mandatory fields, non-numeric data in a 
numeric field, or missing segments cause a translation to fail.

■ Translation Failed — An error prevented the translation. For example, 
the sender and receiver addresses do not match a profile in the system, so 
the translator cannot call a map. 

■ Send Failed — The document was not sent due to an error. 

■ Acknowledged — The buyer sent an acknowledgement file (for example, 
997 or CONTRL) in response to receiving the document. 

■ Delivered — The document was delivered successfully. 

■ Redelivered — The document was redelivered successfully.

To view the status of a document in your sendbox
1 Click the link in the Status column for the file you want to open.

The Document Status page opens.
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File Sendbox
The File Sendbox lists all document files that you have created, saved, or sent 
within a 45-day period.

To access your File Sendbox

1 Click the Document Manager tab. 

2 Click Sendbox.

The File Sendbox opens.

Note: When you open the File Sendbox, the Document Sendbox also opens. 

File Sendbox Information
The File Sendbox provides the following information. 

Status Information Description

Number A number generated by the system. 
Click this number to view the file contents.

Trading Partner's ID The EDI address of the Trading Partner that sends or receives 
a file.

Trading Partner The EDI address of the Trading Partner that that sends or 
receives a file.

Application Reference The type of file sent.

Senders Reference The sender's Transmission Reference number, which serves as 
an identifier for the file or the interchange control number. 

Status The status of a file in the sendbox.

Modified Date/Time The date and time when the file was revised after it was first 
saved. 

Days Before System 
Deletion

The number of days until the system deletes a file. Files can 
be stored in your Inbox for 45 days. 
Important: Deleted items cannot be retrieved.

Comment Text comments provided by the user, Trading Partner, or both. 

Date/Time The date and time when the current status was applied. See 
“File Sendbox Status Information” on page ?.
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File Sendbox Statuses
The Status column in the File Sendbox shows the current state of sent files. Items 
in your File Sendbox can be one of the following statuses.

■ Sent — The file was sent successfully.

■ Saved — The file has been saved.

■ Submitted — The file has been submitted.

Inbox and Sendbox Navigation Tips
Below are tips for performing common tasks from your Inboxes and Sendboxes. 

To Inbox/Sendbox Do this

View or add comments Document Inbox
Document Sendbox
File Sendbox

Click the text in the Comment column.
See “View or Add Comments to Documents and Files” 
on page 220.

Sort items in a column. All Click the column header. See “Sort Items in a Column” 
on page 219.

Print an item. All Click .

Save an item as an .xml file. All Click .

Download an item as a .csv file. Click .

Specify how many of items appear on a 
page.

Document Inbox
Document Sendbox
File Sendbox

Select the number from the View drop-down menu.

Search for Inbox and Sendbox items. All Click . See “Search for Documents and Files” on 
page 220.

View a document. Document Inbox Do one of the following:
■ Click the link in the Document ID column.

■ Check the Select the check box for the 
document. Then, click Actions > View.

View a file. File Sendbox Click the file link in the Number column, then select 
the application to use for opening the file. 

Save a document (or multiple 
documents) as a .pdf file.

Document Inbox
Document Sendbox

1 Check the check box next to the document. 
2 Click Actions > Generate PDF. 

Download and save files File Inbox
File Sendbox

Do one of the following:
■ Click the file link in the Number column.

■ Select the file, and click Actions > Download. 

3 Click Save in the File Download dialog box. 
4 Specify where you want to save the file.

Send an unopened document or 
file.

Document Sendbox 1 Check the Select check box next to the 
document. 

2 Click Actions > Send. 
Note: Only document(s) with status of 
Packing/Packed/Validated can be sent from the 
sendbox.
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Sort Items in a Column
By default, each list in a column are sorted in ascending order, either by Document 
ID or File Number. They can be resorted if there is an arrow icon in the column 
heading, as shown below. 

To resort a column:
1 Click the column header. 

2 Click again to sort the list in descending order. The arrow indicates ascending or 
descending.

Note: If there are a large number of documents , sorting a column other than 
Date/Time, or sorting in ascending order by Date/Time, might cause a processing 
delay.

Delete items. All Trading Grid Online removes documents and files from 
your Inbox after 45 days and deletes them from the 
system. 
To delete documents or files before the 45-day period:

1 Open the Document Inbox or File Inbox.
2 Check the Select check box next to the 

document or file. You can select on multiple 
pages.

3 Click Actions > Delete. 
4 Click OK in the confirmation prompt.

Increase or decrease the scroll 
height of a long document.

All To decrease the scroll height, click .

To increase the scroll height, click .

To Inbox/Sendbox Do this
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Search for Documents and Files
1 Click . 

2 Set the search criteria on the search page. 

3 Click Submit Search. 

4 The search results page displays. 

Note: The Document Type options might include types for both Inboxes and 
Sendboxes.

View or Add Comments to Documents and Files 
If a user or Trading Partner adds comments to a document, the beginning text of 
the comment displays in the Comment column.

A blank page icon in this column indicates that there are no comments for a 
document. 

To view comments in an inbox document 
1 Click the text in the Comment column. 

The Document Comment dialog box displays the entire comment.
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2 Click Cancel to close.

To add comments to an inbox document
1 Click  for the document that you want to add a comment to from the 

Comment column. 
The Document Comment dialog box opens.

2 Type the new comment, and click Submit.

The new comment displays in the Comment column (of both the Document 
Inbox and Sendbox).

Configure Inboxes and Sendboxes
You can configure the page display of the Document Manager Inboxes and 
Sendboxes to: 

■ View only specific columns.

■ Specify the column order. 

■ Display Inboxes and Sendboxes on the Operations Center page.

To configure an Inbox or Sendbox list

1 Click the Document Manager tab. 

2 Click  in the Document Manager title bar.
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The Configure Document dialog box lists the Inbox or Sendbox columns that 
are the configurable.

3 Configure the Inbox or Sendbox, as needed, and click Apply. 

View Documents and Attachments
To view documents 

1 Click the Document Manager tab. 

2 Click Inbox.

3 Click the Document ID of the document you want to open. 

To Do this

Re-order the column display Click the arrow in the Order column, and select a 
value for a column. For example, the value of 3 
places a column as the third column on the page. 
The Inbox or Sendbox columns re-display in the new 
order (from left-to-right). 

Hide or show columns Check or uncheck the Hide check box for the 
columns you want to show or hide.

Show columns Click its link to display a list of columns for an Inbox 
or Sendbox. 

Set the number of rows to 
display at the bottom of the list.

Select a Lot Size value.
The changes apply only to the selected Inbox or 
Sendbox.

Add an Inbox or Sendbox to the 
Operations Center

Check the appropriate check box in the Copy to Ops 
Center dialog box.
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Or, check the Select check box, and click Actions > View. 

4 If your system requires a forms viewer, follow the prompts to download the 
default viewer. See “Forms Viewer” on page 208. 

The View Document page displays your document contents. The example 
below uses a Document Viewer form. 

Note: The actual displays might vary by trading community.

The example View Document page below does not use a Document Viewer form.
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To view document attachments

1 To view attachments from your Trading Partner, click the Attach link in the 
View Attachment(s) field.

2 Do one of the following:

■ Click the attachment you want to view in the Document Attachments dialog box. 

■ Select the attachment, and click Actions > Download to download it to your 
computer.

Create New Documents
There are several ways to create new documents:

■ Use a Turn Around Document

■ Create a new document template

■ Create a new document from an existing template
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Create Turn Around Documents
To turn around a document, you use one document to create another. For 
example, you can open an Order and create a turnaround Invoice or Ship Notice 
that uses data from the Order. 

You can turn around up to 50 documents in one action in Document Manager. The 
documents must be from the same trading partner and use the same turnaround 
document type such as ASN. Some communities require other values in the source 
documents to be the same, such as the Ship To code for an ASN. 

When you turn around multiple documents, IWF updates the document status for 
all documents. 

Note: OpenText Global Support configures the limit for the maximum number of 
documents that can be turned around at one time. Contact your trading partner or 
OpenText for more information or to increase this limit. 

To turn around a document

1 Click the Document Manager tab. 

2 Click Inbox. 

Note: In some communities, you can turn around a document from the 
Document Sendbox, such as an ASN to an Invoice. To do so, use this procedure 
with the Document Sendbox instead of the Document Inbox. 

3 In the Document Inbox, check the appropriate check box for the document 
you want to turn around. You can also select multiple documents from multiple 
pages.

4 Click Actions > Turn Around. 

The Turn Around Document dialog box prompts you to select the type of 
document to create, for example, ASN. 

5 Select the template for the document type from the Template drop-down 
menu. Then, click Submit.

Note: This menu shows only if your system has available templates. 
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A new document form opens in the Turn Around Document page.

The form in the example below uses a forms viewer. The tabs represent 
sections of the form, for example, the Summary Information tab.
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The example form below does not use a forms viewer. 

6 Specify the information necessary for the turnaround document. Required fields 
are shaded yellow. 

■ If a form uses a forms viewer with tabs, click the tab to specify the 
information that section of the form. 

7 Click Save.

8 Continue to “Optional Steps” on page 234.
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Note: If you save or send a new Turn Around document, or exit the page 
before completing all required fields, a warning prompts you to add the 
required information. Click OK to go back and complete the form.

Navigation Tips

Document Manager with Forms Viewer
Below are tips for navigating and performing common tasks if your system uses a 
forms viewer. 

To Do this

Document Manager without Forms Viewer
Below are tips for navigating and performing common tasks if your system does 
not use a forms viewer. .

Zoom in or zoom out. Use the magnification tools or select a magnification 
from the drop-down menu. 

Add line items. Click Add Row.

Delete line items. Check the appropriate check box in the item row, and 
click Delete. You can check multiple check boxes.

Attach a file to a document. To attach a file to a document, you must save it first 
and then open the document from your Sendbox. 
See “Attach a File to a Document” on page 254. 

Save the form to a specific 
location.

Click Save Form or Save to PC.

Submit a form for Approval. For a Document Viewer form, either send the 
document or send it with approval, depending on 
how the form is designed for your trading community.
Click Submit for Approval.

Print a form. Open the printer dialog box to print the form, and 
click Print.

To Do this

Zoom in or zoom out . Use the magnification tools.

Add line items . Click Add Line Item.

Add a summary or charge to an 
Invoice.

Click Add Row. 
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Create a New Template
A template is a file that serves as a starting point for a new document, in this case, 
a document form, which is pre-formatted in some way. When you open a template, 
it already contains certain information, such as an address you use each time you 
create a document of the same type. Using templates saves time when creating 
new documents or turning around existing documents. 

To create a new document template

1 Click the Document Manager tab.

2 Click the Templates tab in the Navigation Panel 
.

3 Click Actions > Create Template. 

The Create New Template page opens.

Delete line items. Click Delete Line Item. 

Attach a file to a document. To attach a file to this document, you must save it 
first and then open the document from your 
Sendbox. 
See “Attach a File to a Document” on page 254. 

Print a form. Do one of the following:
■ Click Print. 

■ Open the form as a PDF file, and print the PDF. 

To Do this
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4 Do one of the following:

■ In the Trading Partner field, type the company name of the Trading 
Partner that will receive the document. 

■ Click Browse to find the Trading Partner. 

a Select the Trading Partner from the list in the Trading Partner page.

b Click Select.

5 Select the type of document template to use from the Document Type drop-
down menu, for example, such as Invoice. 

6 Type a name for the new template in the Template Name field. 

7 If you want other users to have access to the template, check the Allow 
others to use checkbox.

8 Click Create.

A new form opens. The example template below does not use a Document 
Viewer form. 
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9 Click  to save the form template.

10 When prompted, do one of the following:

■ To open the form, click Open in the prompt.

■ To save the form, click Save, and select a save option.

11 On the Document Templates page that displays, reorder the list by Date/Time 
to see your new template.

12 Continue to “Optional Steps” on page 234.

Create a New Document from a Template
After creating a template, you can use it to create new documents, as needed.

To create a new document from a template

1 Click the Document Manager tab. 

2 Click Creating Documents. 

3 The Create New Document page opens.
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4 Do one of the following:

■ In the Trading Partner field, type the company name of the Trading 
Partner that will receive the document. 

■ Click Browse to find the Trading Partner.

a Select the Trading Partner from the list in the Trading Partner page.

b Click Select.

5 Select the type of document you want to create from the Document Type list 
such as an Invoice. 

6 Select a template to use for creating the document from the Template list. 
Optional. Click Create.

A new document form opens.

7 Add the applicable information in the new document form. 

■ Override the existing data in the fields, as needed for the new document.

■ If the form has tabs, such as an Item Information or Line Items tab, click 
the tab. Then, add the information to that part of the form. 
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The example page below uses a Document Viewer form. 

The example page below does not use a Document Viewer form. 

8 Click Save.
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Note: If you try to save a document, or leave the page before completing all 
required fields, a warning message prompts you to add the required 
information.

■ Click No to go back and complete the form. 

■ Click Yes to save the form in its current state.

9 To attach a file to this document, you must first save it and then open the 
document from your Sendbox. See “Attach a File to a Document” on page 254. 

10 Continue to “Optional Steps” on page 234.

Optional Steps
To Do this

 

Upload Documents to Document Manager
You can also create a new form or document on your computer, and upload it to 
Document Manager. 

To upload a document

1 Create a valid form on your computer desktop

2 Trading Grid Online only accepts valid forms. 

3 Click the Document Manager tab.

4 Click Upload Offline Form.

Immediately send the document to your Trading Partner. Click Send.
Your Document Sendbox displays your 
document with a Sent status with two exceptions: 

■ ASN with Labels documents might have a 
Pack button instead of Send button because 
you must pack before sending. 

■ If the document is sent to your trading partner 
for approval, the status displays as Pending 
Approval instead of Submitted or Sent. 

Save the form, leave the form open to continue working, and add the 
document to your Document Sendbox, with a Saved (not Sent) 
status. 

Click Save.
Use this option if, for example, all mandatory fields 
are not completed.

Save and exit the form, and save the document in your Document 
Sendbox, where you can later send it. 

 Click Save & Exit.
The document has a Saved status.

Close the form without saving it. Click Cancel.

Save the form to your PC in a PFDF, XML, or CSV format. Click the PDF, XML, or CSV icon.

Email a completed form. 1 Click Email Form to attach the form to your 
message.

2 Add the recipient’s email address in the email 
application, and click Send. 

The recipient can now open the form in the Forms 
Viewer.
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5 On the Upload Offline Form page that opens, click Attach Form for Upload.
 

6 Click Attach Form for Upload. 

7 Do one of the following:

■ Specify the file location for the form. 

Include the entire path, for example:
D:\My Documents\Test Documents\Document123.xml

 

■ Browse to the file on your desktop.

8 Click Open.

9 To view the uploaded file and verify the form contents, click View Attached 
Form.

If the form is incorrect, click Remove Attached Form.
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Create and Send Ship Notices with Labels
Creating and sending Ship Notices includes the following tasks.

1 Create a Ship Notice. 
See “Create a Ship Notice” on page 236.

2 Pack the shipment. 

See “Pack a Shipment” on page 239.

3 Print the shipping labels and reports. 

See“Print Shipping Labels and Reports” on page 252.

4 Save Your Packing Information and send the Ship Notice. 

See“Save Your Packing Information and Send the Ship Notice” on page 254.

Create a Ship Notice
You can create a new Ship Notice, or create one from a Turn Around document or 
an existing template. 

To create a Ship Notice from a Turn Around document
1 Create a turnaround ASN document. See “Create Turn Around Documents” on 

page 225. 

2 Provide the required information in the new document form, using the correct 
data format. 

To create a Ship Notice from a template

1 Create the ship notice from an ASN template. “Create a New Document from a 
Template” on page 231.

2 Override the data in the fields as needed for this Ship Notice. 

For example, if the document has tabs: 

a Click the Header tab and provide all required information.

b Click the Orders tab and provide all required information.

c Select the Line Items tab and provide all required information.

To create a Ship Notice as a new document
1 Click Create Creating Documents. The Create New Document page opens.

2 In the Trading Partner field, type the name of the Trading Partner you are 
sending this document to, or click Browse to find and select the Trading 
Partner.

3 From the Document Type list, select ASN with labels.

4 (Optional) To create the Ship Notice from a template, in the Template list 
select a template.

5 Click Create.

The document form opens. 

6 Provide the information in all required fields, using the correct data format. 
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The example page below uses a Document Viewer Form.

The example page below does not use a Document Viewer Form.
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To return to the document list page, click Cancel. 

7 To add an item, in a Document Viewer form, click Add Row, or in a form that 
does not use Document Viewer, click Add Line Item. 

8 Do one of the following:

■ Continue to “Pack a Shipment” on page 239. 

■ Click Save or Save & Exit to pack the document later. 

After you save the document, it displays in Document Sendbox.
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Pack a Shipment
Packing options vary by trading communities. The two main procedures are:

■ “Pack Packages” on page 239

■ “Pack Packages into Larger Units” on page 245

As you pack a shipment, messages might prompt you for missing information. For 
example, a Total Quantity Shipped field might require a value more than 0 or IWF 
might delete the item from the ASN. 

Pack Packages
Use this procedure to pack first-level packing units in your shipment. Often, these 
are boxes or cartons. 

To pack first-level packages into other packages, see “Pack Packages into Larger 
Units” on page 245 procedure.

OpenText recommends starting by packing the smallest packing units in the 
shipment, then packing those packages in the next level of packing, etc., until you 
finally pack the highest level, such as a pallet or container. 

Note: Packing options, such as package types, vary by trading community. Some 
features described below might not be available in your trading community.

To pack packages

1 Do one of the following: 

■ After you specify the shipment information, click Pack in the ASN form.

■ If you are returning to the ASN after saving it, open the Document 
Sendbox. Then do one of the following:

■ Click the ASN link in the Document ID column.

■ Check the check box for the ASN. Then, click Actions > View/Modify. 

The Packing Screen opens.
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The left section displays order and item information, based on your selections 
in the “To create a Ship Notice from a Turn Around document” on page 236 
procedure. For each line item, the Quantity column displays the total number 
of units of the line item and the number of unpacked units. 

The section on the right is where you pack items. 

2 To see only specific items on the Item Details list, in the Filter By drop-down 
menu at top left, select the data element to filter by (for example, Order or 
SupplierItemID), then in the right drop-down menu either select a specific 
value or leave Show All selected. The list updates. 

To see the full list again, click Show All. 

3 To view information about an item, such as a description, click the Details link 
for that item. A dialog box displays. Click Close to close the box.

4 Select the packaging type.

a In the Add field, type the number of packages to create. 

Note: If you plan to use the Replicate tool, described below, select 
1.

b In the Select Packaging Type drop-down menu, select the package type 
— for example, Carton. Package types are grouped by packing level from 
lowest to highest — for example, 0, 1, 2, and 3.

Your trading community might allow you to use multiple package types in 
the same packing level — for example, cartons and medium cartons at one 
level, and pallets and medium pallets at a higher level. 

5 Click Add. 
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The newly created packaging unit(s) display on the Package(s) list on the 
right. The list is ordered from the lowest to highest level of packaging. 

6 In the Package(s) list, click a packing unit. 

The packaging unit displays in the packing area at right. It includes no items 
yet.

7 If your community is set up for you to specify a Package ID or package 
Internal Code, add that information.  
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8 On the left side of the page, select the check boxes for the line item(s) to pack 
in the packaging unit on the right. To select all items, select the check box in 
the header. 

Note: Packing rules in your community might limit your options. For example, 
some trading communities have a maximum allowable quantity for each line 
item in a master pack — for example, the quantity in the PO. This might limit 
the number of items you pack in a master pack.

9 Click the Move Right icon to add the item(s) to the packing area on the right. 

Line items display in order in the packing area. 

At right, Package Qty displays the total quantity of items in the package, and 
the Packed column displays the quantity of units packed for each item in the 
package. Unpacked item quantities display on both sides.

10 In the Packed field, change the number of units to pack in the selected 
packaging unit. 

If unpacked units remain for the item, use the next step to create and 
automatically pack an additional packing unit(s) with the same number of units 
as the package you just packed. 

11 (Optional) To replicate the packing unit currently displayed in order to pack 
more packages, 

a Click Replicate. 
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If a message displays about missing user-defined attributes, return to the 
Packing Screen to populate the user-defined attribute fields and then click 
Replicate again, or continue without populating them. See also “Add 
Mandatory Field Values” on page 248. 

A dialog displays to select the replication method. 

b Click one of the following options: 

■ Auto Replicate — The system packs all of the remaining units in as 
many packages as needed. 

■ Manual Replicate — In the No. of Packages field, specify a 
maximum number of additional packages to pack with the remaining 
items, such as 1 or 2. This might result in some units remaining 
unpacked. 

c Click Continue. A message displays the result. 

d In the message box, click Close

The Packing Screen page re-displays. For Auto Replicate, Unpacked 
quantities are 0.

12 Repeat these steps until all items are packed. 

13 To send the ASN from the Packing Screen, click Send. 

Important: This action succeeds only if all mandatory fields are populated for 
items and packages in the shipment. See: 

■ “Add Mandatory Field Values” on page 248

■ “Add Mandatory Values to One Package or Item” on page 251

Unpack a Package

To unpack the contents of a package

1 In the upper right of the page, in the Package(s) drop-down menu, select the 
packing unit. 

2 Click Unpack next to the list.

Delete a Package

To delete a package

1 Select the packing unit from the Package(s) drop-down menu. 
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2 Click  Delete next to the list. 

View/Edit Package Contents

To view and edit package contents

1 In the upper right of the page, in the Package(s) drop-down menu, select the 
packing unit. 

2 Click  Preview. A dialog box displays. 

3 To display contents, click the arrow icons next to the container. Items might be 
organized by Order number. For example: 

4 To delete an Order or specific items from the package, select those check boxes 
and click Delete. 

View Hierarchy/Delete Multiple Packages

To view the packing hierarchy and delete multiple packages

1 Click Preview Packing below the table. A popup displays the hierarchy of 
packages in the shipment.

2 To delete packages, select their check boxes. To delete all packages, select the 
check box in the header.

3 Click Delete. 
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Pack Packages into Larger Units
To pack packing units (cartons, for example) into a larger packing unit (a pallet, for 
example), you create the larger packing units and associate the smaller packages 
to them. 

To pack packing units

1 If you are not in the packing engine, at the top of the ASN form click Pack. The 
Packing Screen page opens. 

2 On the right side of the page: 

a In the Add field, type the number of large packages to create for the 
shipment.

b In the Select Packaging Type dropdown, select the package type — for 
example, Pallet. Available types vary by trading community. 

3 Click Add. 

The newly created packaging unit(s) is added to the Package(s) list on the 
right.

4 In the Package(s) list, click the packing unit that you just created — for 
example, Pallet 00001.

For example: 

The packaging unit displays in the packing area at right. 

5 To pack the container packaging unit with smaller packages, click Associate 
Package.

The Associate Package dialog displays packages available to pack into the 
pallet or container. Your community might display item SKU, Product, and 
Quantity data.

If your community displays packages that contain one type of item, the 
Associate Package dialog has columns that display the SKU, Product identifier, 
and Quantity of the item in the package in that row. 
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For example: 

If your community displays packages that contain different types of items, to 
show SKU, Product identifier, and Quantity data for items in all packages, at the 
top left, click Show All line items. To show data only for specific packages, 
click Show line items in the package row.

For example: 
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After clicking Show All line items, the dialog displays as below. 

To hide item data, click Hide All line items or Hide line items. 

6 Select packing units to associate (that is, to pack into the same larger packing 
unit): 

■ To select specific cartons (or containers) to associate, click those check 
boxes at left, then click Associate. 

■ To select all cartons (or containers), click the check box in the table header 
at top and click Associate. 

■ To select a consecutive series of cartons in the list, click the checkbox for 
the first and last carton (or container) in the series, then click Select 
Range and Associate. All packages, including and between the two that 
you selected — for example, cartons 14-20 — are automatically packed. 

The Associate Package dialog closes. On the Packing Screen page, the packed 
cartons or containers display in the Associated Packages section. 
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7 Repeat these steps, as necessary. 

Add Mandatory Field Values
After you pack, search multiple packages or items in a package to find mandatory 
user-defined fields that are missing values. You can add values to those fields and 
edit them later, if needed. 

You can add user-defined mandatory field values to 

■ Multiple packages or items — see “To add mandatory values to multiple 
packages or items” on page 248.

■ A single package or item — see “Add Mandatory Values to One Package or Item” 
on page 251. 

To add mandatory values to multiple packages or items
Important: All mandatory user-defined fields must be populated. 

1 Click Enter Attributes. 

The User Defined Attributes dialog displays. By default, the Packages tab lists 
all packages of a preselected packaging type and one or more mandatory fields 
that are missing values.
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Do any of the following to change the view: 

2 To fix missing user-defined attribute field values, click the check boxes for the 
items to fix. To select all packages, click the check box in the header. 

3 To fix missing user-defined field values, click the check boxes for the packages 
to fix. To select all packages, click the check box in the header. 

4 Click Define Attribute Values. 

A dialog box displays. 

5 Type the values for the missing mandatory user-defined fields and optional 
user-defined fields (if available).

If you selected more than one package, the dialog warns that any changes 
overwrite existing values because the packages have different values. 

6 In the dialog, enter values in the fields. 

To apply the value(s) to all packages of the selected type (for example, Carton), 
select the check box for Apply these attributes to all packages of the 
type . . . . 

7 Click Apply. The system sets the specified values for the selected package(s) 
and displays a message. 

8 Click Back to Packages. 

The User Defined Attributes dialog shows the corrected packages. The Status 
drop-down menu has Mandatory Values Completed selected.
 

To display corrected and uncorrected packages, in the Status dropdown click 
Show All. 

9 To view or change the field value or option selection for a corrected package, 
select the package, then click Define Attribute Values. 

To do this
In this 
dropdown Click

View items for a different packaging type. Package 
Type 

the applicable 
packaging type

List only packages in the selected type that have 
mandatory user-defined attribute fields that are 
complete.

Status the applicable 
option

List all packages in the selected type, whether or 
not mandatory fields are populated. 

Status Show All
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Make changes as previously described. 

10 Repeat these steps as needed to work with other package user-defined fields in 
the shipment. 

11 To correct missing user-defined field values for items in the shipment, in the 
User Defined Attributes dialog, click the Line Items tab. 

A new view displays all items in the first package of a preselected packaging 
type and one or more mandatory fields that are missing values.

Do any of the following to change the view: 

12 To fix missing user-defined field values, click the check boxes for the items to 
fix. To select all packages, click the check box in the header. 

13 At bottom left, click Define Attribute Values. A dialog opens. 

14 Specify the values for the missing mandatory and optional user-defined fields. 

15 In the dialog box, type the attribute values. 

To . . . Do this . . .

View items for a different packaging type. Select the applicable packaging type from the Package 
Type drop-down menu.

View items for a different package (such as a different 
carton).

Select the applicable package name from the Package 
Name drop-down menu.

List only items in the selected package with completed, 
mandatory user-defined fields.

Select the applicable option from the Status drop-down 
menu.

List all items in the selected packages regardless if the 
mandatory fields are populated. 

Select Show All from the Status drop-down menu.
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To apply the value(s) to all items, but only in the selected package (for 
example, Carton 00001), click the Apply these values to all line items of 
selected package check box.

To apply the value(s) only to the selected items but in all packages of the same 
packaging type, click the Apply these values to all selected line items 
across all packages check box.

16 Click Apply. The system sets the specified values for the selected item(s) and 
displays a message. 

17 Click Back to Line Items.

The User Defined Attributes dialog shows the corrected items. The Status 
dropdown shows Mandatory Values Completed is selected.  

To display corrected and uncorrected items, in Status click Show All. 

18 To view or change the field value or option selection for a corrected item, select 
the item, then click Define Attribute Values. 

Make changes as described above. 

19 Repeat the above steps as needed to work with other item user-defined fields 
in the shipment. 

Add Mandatory Values to One Package or Item
After you pack, use this procedure to add a missing value to a mandatory user-
defined field for a specific package or item in the shipment. 

For example, add package measurement information to communicate the 
dimensions of a carton or pallet. Active Orders uses this information to calculated 
package volume. 

To search packages and items for missing user-defined fields values, see “Add 
Mandatory Field Values” on page 248. 

To add mandatory values to one package or item
Important: All mandatory user-defined fields must be populated. 

1 In the packing engine, in the Package(s) drop-down menu, click the package 
that you want to work with or that contains the item — for example, Carton 
00001. 

2 Do one of the following: 

■ For package user-defined fields, click  User-Defined Attributes for 
Package. 
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■ For item user-defined fields, select one or more line items in the package 
and click  User-Defined Attributes for Pack List(s). 

A dialog displays mandatory user-defined fields for the package or item. 

For a date field, either click the  calendar icon to select a month, day, and 
year, or type the date into the field. Your preferred Date format is in your 
company Profile. 

Note: An administrator sets date validation rules. 

3 Enter the information, then click Save. The system sets the specified values for 
the selected package or item(s) and displays a message.

4 To view or change the value later, reopen the dialog using these steps. 

Assign Serial Numbers
Important: Make sure that you print the packing labels that you need before you 
do this. 

To assign serial numbers
1 To automatically assign serial numbers for packing identification, on the right 

side of the page click Update Packing Info. 

Important: After you click Update Packing Info, you cannot print labels 
and reports.

2 At the confirmation prompt, click OK. The system assigns the packing serial 
numbers.

3 To view the serial numbers, click Preview Packing.

Print Shipping Labels and Reports

To print the labels and reports

1 Click Print Labels/Reports. 
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The Label Reports page displays the programs to print shipping labels and 
reports for your community. The print programs available vary by community. 

Note: If the Ship Notice contains more than 500 packages or 750 line items, 
they system generates the report or labels asynchronously and emails you a 
PDF file. 

2 Click the program you want to generate the labels or report in PDF format. (For 
reports you might have the choice of PDF or CSV format.) 

The system generates the labels or report in PDF (or CSV) format and displays 
them on a viewer page. 

3 Use the Print function to print the labels or report. You can also save a copy of 
the labels or report to your PC. 
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Save Your Packing Information and Send the Ship Notice
After all line item units are packed in packing units, and your packing structure 
matches your actual shipment, save the packing information and return to the Ship 
Notice form. 

Important: Make sure that you printed the packing labels that you need before 
clicking Update Packing Info in the step 1 below, because after doing that, you 
cannot print labels and reports. 

To save packing data and send the Ship Notice

1 Do one of the following: 

■ To print labels later, not now, click Save and Exit on the Packing Screen 
page. Print labels later. 

■ After printing the labels (see the“Print Shipping Labels and Reports” on 
page 252 procedure), click Update Packing Info and confirm that your 
packing structure is accurate.

2 Click Send. 

3 If your packing structure includes a Container, your community might require 
you to complete additional Container information:

a At the prompt, click OK.

b Click Edit Container Properties. 

c In the container information page, complete the information for each 
container in the shipment. 

d To send the Ship Notice, click Send. The system confirms that the 
document was successfully submitted. 

Send Documents and Files

Attach a File to a Document
To attach a file to a document, your document forms must be configured to 
support this feature. Configuration occurs during forms setup. 

You cannot attach a file to a document when you create it. You must first create 
the file, save it, and then access it from your Sendbox, where it must have a 
Saved status. 

An attached file cannot exceed 5 MB. 

To attach and send a file to a partner

1 Click the Document Manager tab, and on the left side of the page, click 
Sendbox.
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2 In the Document Sendbox list, click the Document ID of the document you 
want to attach a file to.

The Document View page displays your document contents.

3 At the top of the document form, in the Add Attachment(s) section, click the 
Attach link.

4 On the Document Attachments popup that opens: 

a Click Browse to locate the file on your desktop. Then, find and select the 
file and click Open.

b In the Description field, type a descriptive title for the attachment. 

c Click Attach. Trading Grid uploads the attachment.

5 Repeat the previous step for each file you want to attach.



256 Trading Grid Online

D O C U M E N T  M A N A G E R

Send Documents and Files

6 When finished, close the Document Attachments popup, and at the top of the 
document form, click one of the following:

■ Send to immediately send the document to your Trading Partner. The 
document appears in your Sendbox with a status of Sent.

■ Save to save the form and add the document to your Sendbox, where you 
can later send it. The document has a status of Saved.

Modify and Resend Documents 
You can:

■ Modify a document that has not yet been sent.

■ Resend a document that has been sent without modifying it. 

■ Edit and resend a document that has been sent.

For files, see “Send, Modify, and Resend Files” on page 257.

To modify or resend a document

1 Click the Document Manager tab, and on the left side of the page, click 
Sendbox.

2 In the Document Sendbox list, click the check box for the document to 
modify or resend.

3 To resend a document with a Sent status to the Trading Partner, at the top of 
the list, click Actions > Resend. Trading Grid immediately submits the 
document for sending.To view and/or modify a document with a Saved status, 
or to modify a document with a Sent status and then resend it, click Actions > 
View/Modify or click Actions > Edit & Resend, respectively. 

Make your modifications.

4 Do one of the following:

■ To resend a document with a Sent status to the Trading Partner, click 
Actions > Resend. The document displays in your Document Sendbox 
with a Resent status.

■ To send the document for the first time, at the top of the form, click Send. 
The document displays in your Document Sendbox with a Sent status.

■ To save the form send or resend it later, at the top of the form, click Save. 
The document displays in your Document Sendbox with a Saved status.
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Send, Modify, and Resend Files

To resend a file without updates

1 On a Document Manager page, on the left side of the page, click Sendbox.

2 In the File Sendbox listing, in the Select column, click the box(es) of the 
file(s) to resend.

3 At the top of the listing, click Actions, then click Resend.

To send a new file, or to modify and resend a file

1 Click the Document Manager tab. 

2 To modify a file, but no longer have the applicable file on your desktop, you can 
download it from the Trading Grid. To do so,

a Click Sendbox in the left panel. 

b In your File Sendbox, click the check box for the file. 

c Click Actions > Download. 

d Follow the prompts to save the file.

3 On your desktop, make any changes to the file and click Save.

4 In the left area of any Document Manager page, click Sending Files.

5 On the Sending Files page, next to the Filename field, 

a Click Browse to locate the file on your desktop. 

b Select the file, then click Open to specify the complete path and name of 
the file. 

For example: D:\My Documents\Test Documents\Document123.xml 

6 (Optional) To make sure the file that now appears in the Filename field is the 
correct file, click View to see the file contents.

7 If the file you are sending contains your Trading Partner's address information, 
click Send. 

8 If the file does not contain your Trading Partner's address information, click the 
Recipient data NOT embedded in file option.

9 Provide the data into the new fields that display and then click Send. All fields 
are required. 

Field Name Description

Profile Click Browse to open a list of Translation Profiles, then in the 
list select the profile for your Trading Partner. If you do not 
know, or cannot find, the applicable Profile, contact Global 
Support Services.

Sender's Reference Type the Sender's Transmission Reference number. This is the 
Identifier for the file or the interchange control number. 
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Trading Relationship Click Browse to open a list of Trading Partners. Select the 
name of the Trading Partner you are sending the file to. 

Application Reference Application Reference — Type of data in the file. For example, 
for an EDI Invoice, enter 810.
For non-EDI files (for example, CSV, XML, user-defined field), 
Trading Grid automatically appends *BIN to the Application 
Reference value that you enter. To disable this function, in the 
upper right area of the page click the Configure icon, click 
the check box for Do Not Include *BIN for APRF, then click 
Apply. For example, the receiver might have a rule based on 
Application Reference, therefore it might expect a specific value 
(for example, INVOICE) and not *BIN added to that value.

Field Name Description



 

System Administrators II
This section contains instructions for company system administrators performing 
administrative tasks, including how to create customer and company accounts, and 
set up mailboxes in Trading Grid Online.

■ Chapter 10, "Community Manager," on page 260

■ Chapter 11, "Account Manager," on page 310
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Community Manager 10
As a Reseller or Community Administrator, you must first create accounts for 
customers and spoke companies then connect them to Trading Grid Online, using 
either a company hierarchy structure (parent/child) or a hub/spoke link. 

For companies using a hierarchy structure, you must set up both a parent company 
and its child company(s). 

For hub/spoke companies, such as a retail company (hub) that provides forms to 
their suppliers (spokes), the hub Community Administrator first sets up the hub 
company, then invites the spoke companies to connect (see “Invitation Tool” on 
page 297. When a spoke company registers, it specifies the association to the hub 
company, thus establishing the hub/spoke link. 

This chapter explains how to use Community Manager to set up and connect 
companies in the system. 

Topics include:

■ “Create company accounts” on page 261

■ “Add Customer User Accounts” on page 263

■ “Set Up Trading Relationships” on page 266

■ “Mailboxes and EDI Addresses” on page 275

■ “Define the Customer’s Service Contacts” on page 278

■ “Define Customer Alerts and Options” on page 282

■ “Enhanced Rules” on page 289

■ “Resolve Customer Issues” on page 297

■ “Invitation Tool” on page 297

■ “On-Boarding and Self-Registration” on page 303

■ “Pending Registrations” on page 308
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Create company accounts

Required Information
To set up a company account, you need the following information:

To create a company account
1 Click the Community Manager tab.
2 Click Company Management. 

The Company List page opens.

The list displays the companies already defined and set up in your community, 
up to 1,000 of the most recent companies that were set up in Community 
Manager. The page displays:

■ Date created.

■ Company name ■ Parent Company name (if customer is a child 
company)

■ Company address ■ Company website address

■ Industry Type ■ Primary SIC code

■ UCCEAN Number, required if Customer 
is using the Trading Grid ASN service

■ DUNS number

■ Company number, if applicable ■ Global Location number, if applicable

■ Business contact name, address, 
email, phone, FAX

■ Technical contact name, address, email, 
phone, FAX, if different from Business contact
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■ The person who set up the company.

■ Date last updated.

■ The person who updated the company information. 

At the bottom of the list, the icons are explained, as follows. 

If you are a Reseller, the  (Reseller) icon precedes your Company Name, for 
example the Training and Docs company.

3 Above the listing, on the right, from the Create drop-down list, select one of 
the following:

■ If you are a Reseller, select Reseller's Customer. 

■ If you are setting up a Reseller select Reseller.

■ Otherwise, select GXS Customer.

4 Click OK (next to the Create drop-down list).
The Step 1: Identify Company page opens. 

5 Enter the data for the company you are creating. 
Note: If you previously created the parent company, and this was a child 
company, click the Yes, identify parent company below check box and 
search for, or enter, the name of the parent company. 

6 Click Next Step.
The Step 2: Company Profile page opens.

7 Enter data about the company. 
Important: If this is a parent company, for Hierarchy Access, select the 
Allow to create child company(s) check box.

8 Click Next Step.
The Step 3: Review page opens.

9 Check that the information you entered is accurate. To make any changes, click 
Previous Step and go back to the applicable step and make your changes. 
Then, click Next Step to return to this page. 

10 Click Create. 
11 On the confirmation page, click the Return to the company list link.

The new company, preceded by the  (Reseller's customer) icon, displays in 
the Company List. 

Company Profile
The Company Profile is where you access the customer’s information. Review the 
information from the previous step. To update customer information, make the 
updates on the Company Profile page.

To review the company profile
1 Click the Community Manager tab > Company Management. Find the 

applicable company and click its name. 
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The section expands.

2 Click Company Profile. 
The Company Profile page opens.

3 Review the information and add any new information.

4 Do one of the following:
■ Click Actions > Save.

■ Click Save. 

Your changes are saved.

Assign a Subscription Package
Many new TGO functions are regularly added. We recommend that you work with 
your GXS Representative to assign or modify subscription packages.

Add Customer User Accounts
Creating a Customer user via the User Management service immediately registers 
the user and bypasses the invitation process. After the user account is created, the 
user is ready to access and work within the Trading Grid. 

Topics include: 

■ “Add New User Accounts”

■ “Activate, Deactivate, or Delete User Accounts” on page 266

Company Profile Section Description

Profile Status This data is system-generated.

Organization Hierarchy If the customer company has child companies, check 
the Allow to create child company(s) check box. 

Company Information, 
Business Contact, Technical 
Contact

The company and contact names and addresses. One 
person can be multiple contacts. The contacts receive 
user invitations after the company subscribes to 
Trading Grid.
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Add New User Accounts

To add a new user
1 Click the Community Manager tab. 
2 Click the applicable Customer Company Name.

The Company Profile page opens. 

3 Click User Management.
The User List page opens.

4 From the Actions drop-down list, select Create New User. 
The Step 1: User Information page opens.

5 Enter all the information for the user.
6 Click Next Step.

The Step 2: Service Privileges page opens.  

7 Under Service Instance(s), select the service instance(s), (the subscription 
package(s) and the options (privileges)) for each service instance that you 
want the user to have. By default, all options are selected for any service 
instance that you select.

8 Under Roles, select the role of the new user. All roles have access to the user 
functions (Service Instances) that are subscribed to by the Company.  

User Role Administrative Functions

Company 
Administrator

All of the administrative functions of Trading Grid, 
subscribed to by all Companies in the community. These 
functions exist in both the Community Manager and Account 
Manager components.

Account Administrator All of the administrative functions in Account Manager that 
are subscribed to by the Company. The functions include:

■ Maintenance of the Company Profile.
■ Inviting or setting up, and maintenance of, Company 

users (User Management).
■ Administration of the Trading Community and its 

distribution lists.
■ Subscription modification.
■ Service Configuration, which can include:

■ Setting up and maintaining mailbox information 
■ Defining and setting company or mailbox rules and 

alerts
■ Mailslotting

■ Monitor Billing invoices. 
■ Define or update the company Password Policy.

Service Configuration 
Administrator

The Service Configuration functions in Account Manager that 
are subscribed to by the Company. 
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9 Click Next Step.
The Step 3: Review page opens.

10 Carefully review the information, especially the Service Selection instances and 
options. 

11 To make any changes, click Previous Step and go back to the applicable step 
and make your changes. Then, click Next Step to return to this page.

12 Do one of the following:
■ Click Submit to enter the person into the Trading Grid. 

Note: If you did not enter all the required data, the Submit button is 
disabled.

■ To save the data you entered, but not yet activate this person in the 
Trading Grid, click Save. In the User list, the user status is Incomplete. 

A confirmation page opens.

13 Click User Management. 
The User List page displays the user you created. 

The following information displays for each user:

■ User Name — User’s name. Click the name for information about the user. 

■ User ID — User's email address.

■ Status — Status of the user:

■ Active — The user is approved to participate in the Trading Grid.

■ Inactive  — The user is not currently participating in the Trading Grid.

■ Incomplete — The user has not yet been approved to participate in 
the Trading Grid.

Trading Community 
Administrator

The Trading Community functions in Account Manager that 
are subscribed to by the company. These can include:

■ Requesting and approving trading partnerships.
■ Defining and maintaining the AutoForwarding of 

messages (see “AutoForward Partnership” on 
page 271).

■ Setting up and maintaining the AutoCopy distribution 
lists (see “AutoCopy Partnership” on page 273).

Account User None. This user does not have access to any of the 
administrative functions in the Account Manager.

Trading Partnership 
Approver

Only the Trading Community function of approving trading 
partner relationships (EDI to EDI) (see “Set Up Trading 
Relationships” on page 266).

AutoForward 
Administrator

Only the Trading Community function of setting up and 
maintaining AutoForward partnerships (see “AutoForward 
Partnership” on page 271).

AutoCopy Distribution 
List Administrator

Only the Trading Community function of defining and 
maintaining AutoCopy distribution lists (see “AutoCopy 
Partnership” on page 273).

User Role Administrative Functions
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Activate, Deactivate, or Delete User Accounts
The activate, deactivate, or delete actions can be performed for more than one 
user at a time; however, you must perform the same action for all selected users.

To activate, deactivate, or delete a user account
1 Select the user(s). 
2 Do one of the following:

■ To authorize the user to access the Trading Grid, click Actions > Activate.

■ To temporarily prevent the user from using the Trading Grid, click Actions 
> Deactivate.

■ To permanently remove the user and all his or her data from the Trading 
Grid, click Actions > Delete.

A confirmation message displays.

3 Click Yes.

Set Up Trading Relationships
This section defines the Company’s trading partnerships or relationships, that is, 
who and where they send documents to and receiving documents from. 

There are several types of partnerships you can set up for the customer.

Topics include:

■ “Current Trading Partner List”

■ “Standard Trading Partnership” on page 267

■ “Open Trade Partnership” on page 270

■ “AutoForward Partnership” on page 271

■ “AutoCopy Partnership” on page 273

Current Trading Partner List

To see a listing of the company’s current Trading Partners
1 Click the Community Manager tab, then click the applicable customer 

Company Name.
The Company Profile page opens. 

2 Click Trading Community.
The Community Manager: Trading Community page opens. 

This page displays two listings. The Trading Partners list displays the current 
partnerships and the following information for each Trading Partnership.  

Column Name Description

Mailbox Number The mailbox number(s) associated with this role and partnership.

Trading Partner Identification of the Trading Partner. 

Partner VAN The network used in this partnership.
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The second listing, the Open Tradings list, displays the EDI addresses that have 
open trading. 

Standard Trading Partnership
A standard trading partnership is set up so the customer can send (and receive) 
transactions with one specific trading partner. This partnership can then be further 
defined to: 

■ Automatically forward documents they receive from this partner to other users 
using a distribution list.

■ Automatically send a copy of documents they send to this partner to other users 
using a distribution list.

Request a Standard Trading Partnership
Use this procedure to request a trading partnership.

1 Click the Community Manager tab, then click the applicable customer 
Company Name.
The Company Profile page that opens.

2 Click Trading Community.
The Trading Community Company List page opens.

3 Do any of the following that apply:
■ If your company has multiple mailboxes, select the applicable mailbox for 

the new partnership from the Mailbox Number list, or select All. 

■ If this is your first partnership, click Request New Partnership. 

■ If this is not your first partnership, click Actions > Request New 
Partnership.

Partner EDI Address
Your EDI Address

The EDI addresses of both the customer and its Trading Partner. 
Click the Trading Partner EDI Address to see information about the 
partnership.

Your Role Whether the customer is a Sender of interchanges or a Receiver 
of interchanges. If the customer is both Sender and Receiver with 
this Trading Partner, two partnerships display for this Mailbox 
number and trading partner.

Partnership Type Type of partnership, where 
■ AutoCopy means that the customer can send one 

interchange to multiple receivers. 
■ AutoForward means that Trading Grid automatically 

forwards interchanges that the customer receives to another 
EDI Address(es). 

■ Normal refers to any standard Trading Partnership setup. 

Status Current partnership status, where 
■ Approved means that the trading partnership is currently 

active. 
■ Pending Partner Approval means that the Trading Partner 

has not yet responded to the trading partnership request. 

Column Name Description
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The Step 1: Trading Partner Details page opens. 

4 In the Partnership Information section, enter the following information:

5 In the Billing Information section, select the billing option established by the 
customer and the trading partner.

6 Click Next Step.
7 Do one of the following:

■ If you entered an Interconnect EDI Partner Address in step 4 which 
does not currently exist in the Trading Grid, a message displays. To add the 
EDI partner address, continue with the following three steps. 

1 Click the Add Partner Address link.
The Add Interconnect Partner EDI Address page opens.

2 Provide the following information.

3 Click Submit.
The Step 2: Review page opens.

Field Description

Partner EDI 
Address

Do the following:
If necessary, click Trade with Specific Partner.
In Partner VAN, do one of the following:

■ Select GXS if the trading partner is on the GXS Trading Grid 
network.

■ Select Interconnect if the trading partner is on another 
VAN service.

In Partner Address, enter the trading partner’s EDI address.

Your EDI Address Do one of the following:
■ Click Single. Type the customer’s EDI address or click 

Browse and select the address. 
■ Click Multiple. Click Browse and select the address.

Your Role Click the Sender and/or Receiver check boxes based on the 
customer’s role(s) in the trading partner relationship.
If you select both Sender and Receiver, Trading Grid creates 
two partnerships for this Mailbox number and trading partner.

Your Alias Type a name that represents the customer to the trading partner.

Field Description

Partner EDI 
Address

Type trading partner’s EDI address.

Interconnect Name Use the Select drop-down list to select the Interconnect 
Name.

Company Name Type trading partner’s company name.

Contact First Name Type trading partner’s contact information.

Contact Last Name Type trading partner’s contact information.

Contact Phone 
Number

Type trading partner’s contact phone number.
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■ If you entered an Interconnect EDI Partner Address in step 4 which 
does exist, the Step 2: Review page opens. Continue to step 8.

8 Do any of the following that apply:
■ Review the information.

■ To make any changes, click Previous Step to return to Step 1 page.

■ Make the changes, click Next Step to return to this page.

9 Click Submit.
The Trading Partnership Request Complete page opens.

10 Click Return to Trading Partnership List. 
The Trading Partnerships list page opens. The new partnership displays in the 
list with a type of Normal and a status of Pending Partner Approval.

To approve or reject, view, modify, or terminate a Standard Partnership
You can only modify the billing information. To modify other partnership details, 
you must first delete the current partnership and then create a new partnership 
with the correct details.

1 TOn the Community Manager page, click Company Management, then click 
the applicable company name. 

2 Click Trading Community.
3 In the Trading Partnerships listing, select the partnership to approve, reject, 

view, change, or terminate. 
4 Do any of the following that apply:

5 Click Save.

Action Do this

Approve Partnership Click Actions > Approve Partnership.
The partnership status changes to Approved.
Note: Only a partnership with Pending Your Approval can be 
approved.

Reject Partnership Click Actions > Reject Partnership.
The partnership status changes to Rejected.
Note: Only a partnership with Pending Your Approval can be 
rejected.

Terminate Partnership Click Actions > Delete Partnership.
The partnership is immediately removed from the listing.

View or Modify 
Partnership

Click Actions > View/Modify Partnership.
The Trading Partnership Details page opens.
Note: You can only modify the billing information. To modify 
other partnership details:

1 Delete the partnership.
2 Create a new partnership with the correct details.

Change Partnership 
Type

To change Partnership to AutoForward, see “AutoForward 
Partnership” on page 271.
To change Partnership to AutoCopy, see “AutoCopy Partnership” 
on page 273.
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Open Trade Partnership
An open trade partnership allows the customer to send (and receive) transactions 
with any trading partner within the Trading Grid. Trading documents and/or files 
with other “open” traders does not require a formal partnership setup. An Open 
Trade Partnership:

■ Allows the customer to exchange documents with any trading partner that 
requests to trade with them at that EDI address. 

■ Enforces a 50-50 split billing process, which means the customer pays for all the 
transactions that it sends, and the receiver's company pays for the transactions 
that your customer receives and for the storage of that mailbox. 

To request an open trade partnership
1 Click the Community Manager tab, then click the applicable Customer 

Company Name.
2 Click User Management.

The Trading Community Company List page opens.

3 In the Open Tradings section, do any of the following:
■ If your company has multiple mailboxes, select the applicable mailbox for 

the new partnership, from the Mailbox Number list, or select All. 

■ If this is your first partnership, click Request New Partnership.

■ If this is not your first partnership, Otherwise, click Actions > Request 
New Partnership. 

The Step 1: Open Trading Details page opens.

4 In the Partnership Information section, enter: 
■ Your EDI Address — Type your EDI address or click Browse and select 

it.

■ Your Role — If you expect to send and receive interchanges, click the 
Receiver check box.

5 Click Next Step.
The Step 2: Review page opens.

6 Do the following:
■ Review the information.

■ To make any changes, click Previous Step to return to Step 1 page.

■ Make the changes, click Next Step to return to this page.

7 Click Submit.
Make the changes and then click Next Step to return to this page.

8 Click Submit.
The Open Trading Request Complete page opens. 

9 Click Return to Trading Partnership List.
The Trading Partnerships page opens displaying the new partnership in the Open 
Tradings listing. 
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For each open Trading, the listing displays:

■ Your EDI Address — Click the EDI Address to see information about the 
partnership.

■ Your Role — Displays your role in the partnership; Sender of 
interchanges or a Sender and Receiver of interchanges.

To view, modify, or delete an open trade partnership
1 On the Community Manager page, Company Management. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community.
4 In the Open Tradings listing, select the partnership to view, change, or 

terminate. 
5 Do any of the following that apply:

6 Click Save.

AutoForward Partnership
Important: In the “Account Manager” section, please read the “AutoForward 
Partnership” and “AutoForward Implications” topics for complete information.

Set up an AutoForward Partnership
Important: Before setting up an AutoForward partnership, Trading Partnerships 
must exist and be approved between: 

■ The address that sends the interchanges and the address that receives the 
interchanges. 

■ The address that receives the interchanges and the address to which you want 
to forward the interchanges. 

To set up AutoForwarding
1 On the Community Manager page, click Company Management. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community > AutoForward 

Partnership.

Action Do this

Delete Open 
Trading 
(partnership)

Select the partnership, click Actions > Delete Open Trading.
The partnership is removed from the listing.

View/Modify Open 
Trading

1 Select the partnership, click Actions > View/Modify 
Open Trading.

2 View the partnership information.
Note: Only the billing information can be modified. To 
modify other partnership details, the partnership must be 
deleted then recreated with the correct details. 

3 Make changes to the billing information.
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4 Click Actions > Create AutoForward Partnership. 
Note: If no listing displays, click Create AutoForward Partnership again.

The Create AutoForward Partnership page opens.

5 In the AutoForward EDI Address section, enter the following:

Note: Use Search to search and select specific addresses. Click Search by 
Company to display a pop-up to enter a partial or complete name, then click 
Search. To view a listing of all companies, click Search without entering any 
search criteria. Then click the company name, and if applicable, select an 
address. 

6 To forward only specific document types, in the Document Type section, 
select the appropriate Envelope Type. 
The page refreshes displaying all associated document types in the Available 
Document Types area.

7 Do one of the following: 
■ To select one document type, select the type then click Add. 

■ To select multiple document types:

1 Press Ctrl and select the types. 
2 Release Ctrl, and click Add. 

■ To select all document types, click Add All. 

The selection displays in Selected Document Type area.

8 To remove document types:
■ Select the type(s) and click Remove.

■ To remove all types, click Remove All.

9 Click Actions > Submit. 
A confirmation message displays. The AutoForward Partnership is created.

10 Use the AutoForward Partnerships page to view this new partnership. 

To view, modify, or terminate an AutoForward Partnership
1 Tn the Community Manager page, click Company Management. 
2 Find the applicable company, and click the name. 
3 In the section that expands, click Trading Community > AutoForward 

Partnership.
The AutoForward Partnership listing opens. 

Sender EDI Address Address from where the interchanges are sent. 

Your EDI Address Customer EDI address that receives the interchanges that 
you want to forward. 

AutoForward EDI Address EDI address to which the interchanges (that are sent from 
the Sender EDI Address to Your EDI Address) should 
be autoforwarded. 
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4 Do any of the following that apply:

5 Click Actions > Submit. 

AutoCopy Partnership
Important: In the “Account Manager” section, please read the “AutoCopy 
Partnership”, “AutoCopy Implications”, and “Use AutoCopy with AutoForward” 
topics for complete information.

An AutoCopy Distribution List

To create an AutoCopy distribution list 
1 On the Community Manager page, click Company Management. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community > AutoCopy 

Distribution List.
4 Click Actions > Create Distribution List.

Note: If no listing is displayed, click Create Distribution List. 

The Create Distribution List page opens.

Action Do this

Delete Partnership 1 Select the partnership, click Actions > Delete.
The confirmation message displays.

2 Click Yes. 
The partnership is immediately removed from the listing. 

View/Modify 
Partnership

Only Document Types can be modified. To modify an EDI 
address, you must delete the current partnership, then create a 
new partnership with the correct EDI address.

To add a document type to be forwarded:
1 Select partnership, click Actions > View/Modify.
2 Locate Available Document Type area and do one of the 

following:
■ Select one document type then click Add.
■ Select multiple document types by clicking Ctrl and 

selecting document types. Release Ctrl and click Add.
■ Select all document types by clicking Add All. 
Your selection displays in the Selected Document Type 
area.

To stop a document type from being forwarded:
1 Select partnership, click Actions > View/Modify.
2 Locate the Selected Document Type area and do one of 

the following:
■ Select one document type then click Remove.
■ Select multiple document types by clicking Ctrl and 

selecting document types. Release Ctrl and click 
Remove.

■ Select all document types by clicking Remove All. 



C O M M U N I T Y  M A N A G E R
Set Up Trading Relationships

Trading Grid Online  274

1 0

5 Enter the following information. 

6 Click Actions > Submit. 
A confirmation message displays. The AutoCopy Distribution List is created.

7 Use the AutoCopy Distribution List page to view this new partnership. 

To view, modify, or delete an AutoCopy Distribution List
1 On the Community Manager page, click Company Management. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community > AutoCopy 

Distribution List. 
The Autocopy Distribution List page opens displaying all the listing information 
including: 

■ Mailbox Number — Mailbox that receives the interchanges. 

■ Distribution List Address — EDI address that receives the interchanges 
that the Trading Grid copies and sends. 

Field Description

Mailbox Number Type the number of the Mailbox that receives the interchanges. 

Distribution List 
Address

Type the EDI address that receives the interchanges Trading Grid 
copies and sends. 

Member EDI 
Addresses

Type the EDI addresses to which Trading Grid should send the 
copied interchanges. 
To add more than 10 addresses, scroll to the bottom of the page, 
then click Add. 

Primary Billing 
Address

Select Primary Billing Address if this EDI address is the 
primary billing address. 
Otherwise, leave this item un-selected.
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4 Do any of the following that apply:

5 Click Save.

Mailboxes and EDI Addresses
This section describes how to configure an EDI mailbox. The procedures describe 
how to: 

■ Update the EDI mailbox information.

■ Add other EDI addresses to mailboxes.

■ Specify data retention.

■ Select reports to receive.

Topics include:

■ “Configure EDI Mailboxes”

■ “Add or Delete Mailbox Addresses” on page 276

Configure EDI Mailboxes

To configure an EDI mailbox
1 Click the Community Manager tab, and click the applicable customer 

Company Name.
The Company Profile page opens.

2 Click Service Configuration.

Action Do this

Delete 1 Select the distribution list, click Actions > Delete.
2 Confirm the deletion.

The distribution list is removed from the listing.

View/Modify 1 Select the distribution list, click Actions > View/Modify.
2 View the distribution list information.

Note: Only the Member EDI Address information can be 
modified. To modify other distribution list information, the 
distribution list must be deleted then recreated with the 
correct details. 

3 Make the changes to the list.
■ To modify a Member EDI Address, delete it, and then 

add the correct one. 
■ To delete a Member EDI Address, select it, then click 

Actions > Delete. 
The address is removed from the list.

■ To add a new Member EDI Address, type the address 
in Add Member EDI Address, then click Add. 

■ To specify whether an address is the primary billing 
address, select or deselect the Primary Billing Address 
option.
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The Mailbox and EDI Address Maintenance page opens displaying a list of EDI 
Mailboxes that are associated to this customer account. 

3 To set or change the mailbox options, select the applicable mailbox. 
4 Click Actions > Update Mailbox.

The Mailbox Information page opens.

5 Specify the following information. 

6 Click Save.
7 Perform these steps for each mailbox associated with the customer account.

Add or Delete Mailbox Addresses
Important: You can only add or delete EDI addresses. To modify an EDI address, 
you must first delete (see “To delete an EDI address from a mailbox”) the incorrect 
address and then add the correct address, as specified below. 

To add an EDI address to a mailbox
1 Click the Community Manager tab, and click the applicable customer 

Company Name.
The Company Profile page opens.

Field Description

Mailbox Number Displays the number for the mailbox. This value cannot be 
changed.

Mailbox Alias Do one of the following:
■ To add an alias for the mailbox, type the value.
■ To change the value displayed, delete the existing value and 

enter another value.

Current Mailbox 
Password

Do one of the following:
■ To add a password for the mailbox, type the value.
■ To change the value displayed, delete the existing value and 

enter another value.
Enter the current password for the mailbox.

New Mailbox 
Password

To define a new password for the mailbox, type the password.

Confirm New 
Password

To confirm the password, type the password again.

Trading Partner 
Transaction Report

To subscribe to this report, which summarizes the transactions 
and interchanges (both sent and received) between you and 
each of your trading partners in the previous month. For each 
trading partner, the report lists each transaction, its description, 
and its number of KCs.

Send Meta Data 
Retention Period

Number of days to retain meta information on data sent from 
your mailbox / EDI address.

Transaction 
Retention Period

Select the number of days, up to a maximum of 45 days, for 
each transaction interchange to remain in your mailbox. Before 
selecting this option, refer to your contract or discuss this with 
your OpenText sales representative, as this option might have 
billing implications. 
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2 Click Service Configuration.
The Mailbox and EDI Address Maintenance page opens displaying a list of EDI 
Mailboxes that are associated to this customer account. 

3 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.
The EDI Address List page opens. 

4 Scroll down to the Add New EDI Address area and enter the information. 
5 Click Add.

A confirmation message displays.

6 Click the Return to EDI address list link.
The EDI address is added.

7 Repeat steps 3 through 5 to add additional addresses to the mailbox.

To delete an EDI address from a mailbox
1 Click the Community Manager tab, and click the applicable customer 

Company Name.
The Company Profile page opens.

2 Click Service Configuration.
The Mailbox and EDI Address Maintenance page opens.

3 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.
Note: The EDI Address List page opens. 

Important: You cannot delete an EDI address if there are trading partnerships 
currently associated with the address. You must check for and terminate any 
associated Partnerships before deleting the EDI address. See “Terminate 
Associated Partnerships” on page 277.

4 Locate the applicable EDI address, and click the view partnership link in the 
Associated Partnerships? column. 

5 Select the address to delete.
6 Click Actions > Delete EDI Address.

A confirmation message displays.

7 Click Yes.
The EDI address is deleted.

Terminate Associated Partnerships
Before deleting an EDI address, you must first verify whether any associated 
partnerships exist that reference the EDI address. If partnerships do reference the 
address, then the partnerships must be terminated so the EDI address can be 
deleted.

To verify and terminate associated partnerships
1 On the Community Manager tab, click the applicable customer Company 

Name.
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The Company Profile page opens.

2 Click Service Configuration.
The Mailbox and EDI Address Maintenance page opens displaying a list of EDI 
Mailboxes that are associated to this customer account.

3 Click Mailbox and EDI Address.
The Mailbox and EDI Address Maintenance page opens. 

4 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.
The EDI Address List page opens displaying the EDI addresses and associated 
partnerships for the selected Mailbox number. 

5 Locate the EDI address that needs to be deleted.
6 Do one of the following:

■ If no link displays in the Associated Partnerships? column, there is no 
associated partnership. This EDI address can be deleted. Continue to “Add 
or Delete Mailbox Addresses” on page 276.

■ If the View partnership link displays in the Associated Partnerships? 
column, click the link.

Identify the partnership(s) that need to be terminated, then return to the 
Mailbox and EDI Address Maintenance page. Continue to step 7.

7 Click Trading Community. 
The EDI Address list page opens.

8 Terminate the partnership(s).
9 Continue to “Add or Delete Mailbox Addresses” on page 276.

Define the Customer’s Service Contacts
Service Contacts is a centralized area where you define who is to:

■ Receive specific email notifications at the company level.

■ Be the default contact for service messages and outages.

■ Be notified as a result of the rules and alerts you later define for the mailbox(es).

Important: For TGMS customers: All contacts to be notified as a result of rules 
and alerts defined in Event Management must be set up using Service Contacts.

Topics include:

■ “Define Service Contacts” on page 279

■ “Re-Assign a Default Contact” on page 280

■ “Remove a Default Contact” on page 280

■ “View, Change, or Delete a Contact” on page 281
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Define Service Contacts

To define service contacts
1 Click the Community Manager tab, and click a Customer Company Name.

The Company Profile page opens.

2 Click Service Configuration.
The Service Configuration page opens.

3 Click Service Contacts.
The Service Contacts page opens. It lists any contacts that have been defined. 
For each contact, the listing shows:

■ First and last name.

■ A list of alerts the person is contacted about (Contact Type column).

■ If the person is a Default contact. Trading Grid automatically designates 
the Technical Contact entered in the Company Profile as the default 
contact. You can change the default contact (see “Re-Assign a Default 
Contact” on page 280).

■ If the person is currently active (In-Use column).

4 Click Actions, and click Add New Contact.  
The Create New Contact Service page opens.

5 Enter the required information.
6 Optionally select the Contact Type(s), or which contacts should receive 

notification(s) for in addition to service messages and outages. 
Note: Based on the service subscription, you might not see all the options 
listed. If in doubt, check with your OpenText sales representative.

■ For IWF Users:

Invitation Contact receives subsequent invitations, such as invites 
for the company to connect to an additional IWF hub 
sponsoring new forms.

Incoming Document Alert ”Whenever a new document arrives in your Document 
Inbox” rule.

Incoming File Alert ”Whenever a new file arrives in your File Inbox” rule. 
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■ For TGMS Users:

Note: When you select an option for a customer contact, Trading Grid 
automatically adds the contact to the notification list for alerts you create later. 
For example, if you subscribe to and select Arrival Alert for this contact, and 
define a rule to generate an alert when a partner has one or more documents 
that need acknowledgment, Trading Grid automatically notifies this contact. If 
you later delete the contact, Trading Grid automatically deletes the contact 
from the Arrival notification list. 

7 Enter the Email Address for the contact. If the address is for a pager, select 
This is a Pager address.

8 Click Submit. 
The Service Contact Request Complete page opens.

9 Click the Return to Service Contacts List link. 
The new contact displays in the list on the Service Contact page.

Re-Assign a Default Contact
Important: You must designate one default contact who receives notifications for 
service messages and outages. Initially, Trading Grid assigns the Technical Contact 
from your Company Profile as the default contact. 

To re-assign the default contact
1 Click the Community Manager tab, and click a Customer Company Name.

The Company Profile page opens.

2 Click Service Configuration.
The Service Configuration page opens.

3 Click Service Contacts.
The Service Contacts page opens.

4 Select the contact you want to make the default contact, click Actions, and 
click Set as Default Contact.
Trading Grid reassigns the “default contact” from the previous person to the 
one you specified. 

Remove a Default Contact
Important: Only one contact can be the default contact.

Arrival Alerts ”Whenever a document interchange 
arrives in your mailbox” rule. 

FA Delinquency ”Whenever a trading partner has a 
delinquent FA” rule. 

Inactivity Alert ”Whenever a mailbox is inactive” 
rule. 

Mailbox Error Alert ”Whenever a mailbox processing 
error occurs on an outbound 
interchange” rule. 
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To remove a default contact
■ To delete a contact that has the default role, first assign a new default contact, 

and delete the previous default contact. 

View, Change, or Delete a Contact

To view, change, or modify a contact
1 Click the Community Manager tab, and click a Customer Company Name.

The Company Profile page opens.

2 Click Service Configuration.
The Service Configuration page opens.

3 Click Service Contacts.
The Service Contacts page opens. 

4 Select the contact you want to view, modify, or delete. 
Important: To delete a default contact, you must first assign a new default 
contact; see “To re-assign the default contact.”
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5 Perform the appropriate action:

Define Customer Alerts and Options
This section describes the Event Management function and provides instructions 
for setting up customer alerts and business calendar options.

Topics include:

■ “Alerts and Options Overview” on page 283

■ “Define the Alerts” on page 283

■ “Mail Slots” on page 288

■ “Password Policy” on page 289

To . . . Do this

Delete the contact ■ Click Actions, and click Delete.

View or modify the 
contact

1 Click Actions, and click View/Modify.
The Modify New Service Contact page opens.

2 Change the contact’s information.
3 (Optional) Change the Contact Type(s), or which contacts 

should receive notification(s) in addition to service messages 
and outages. 

4 Based on your service subscription, you might or might not 
see all the following options:
■ Arrival — ”Whenever a document interchange arrives in 

your mailbox” rule. 
■ FA Delinquency — ”Whenever a Trading Partner has a 

delinquent FA” rule. 
■ Incoming Document — ”Whenever a new document 

arrives in your Document Inbox” rule. 
■ Incoming File — ”Whenever a new file arrives in your 

File Inbox” rule.
■ Mailbox Inactivity — ”Whenever a mailbox is inactive” 

rule. 
■ Mailbox Outbound Error — ”Whenever a mailbox 

processing error occurs on an outbound interchange” 
rule. 

Note: When you select an option for the contact, Trading Grid 
automatically adds the contact to the notification list for that 
alert in Event Management. 
For example, if you previously subscribed to and select the FA 
Delinquency for this contact, and in Event Management you 
define a rule to generate an alert when a partner has one or 
more documents that need acknowledgment, Trading Grid 
automatically notifies this contact. If you later delete the contact, 
Trading Grid automatically deletes the contact from the FA 
Delinquency notification list. 
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Alerts and Options Overview
Use the Trading Grid Event Management feature to define the rules and policies 
to determine when trading partners are compliant or non-compliant, based on 
these rules and policies. The compliancy or non-compliancy of trading partners is 
reported in the Reports component under Functional Acknowledgement 
Management and Transaction Alerts. 

Note: The functions described in this chapter apply only when customers have 
the optional alert services. These services might require an additional fee. Contact 
your OpenText sales representative to verify which trading partners have these 
services.

Set up each customer mailbox with one or more of the following services:

■ Business Calendar option — The days the customer wants the service to 
consider as working or business days for each of your EDI mailboxes.

■ Arrival Alert — When a document is placed in the mailbox, the Trading Grid 
sends the customer a message. An alert is requested for specific document 
types, specific trading partners, or both. In addition, the alert is routed to 
different individuals within the customer company based on document type, 
trading partner, or both. This is particularly useful for a user that checks their 
mailbox infrequently but wants to respond to orders from key clients as soon as 
possible.

■ Mailbox Outbound Error Alert — If the customer sends a document to the 
Trading Grid Messaging Service and it fails processing, the Trading Grid alerts the 
customer. Therefore they are notified of the problem immediately.

■ Mailbox Inactivity Alert — If the customer does not receive documents in 
their mailbox according to the schedule defined, Trading Grid alerts the 
customer, allowing them to check and determine whether or not a problem 
exists.

■ Mail Slots option — Mail slots separate documents received according to 
business process needs.

■ Password Policy — you can impose a more restrictive password policy than 
what the customer has defined.

Important: In order for the these alerts to function properly, all alerts the 
customer subscribed to must be configured. 

Define the Alerts
Important: For the alerts to function properly, you must configure all the alerts 
to which your customer subscribes.

To define customer alerts
1 Click the Community Manager tab, then click the applicable Customer 

Company Name.
The Company Profile page opens.

2 Click Service Configuration > Event Management.
The Transaction Event and Rules and Alerts page opens.

Topics include:
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■ “Business Calendar”

■ “Inactivity Alert” on page 284

■ “Arrival Alert” on page 285

■ “Mailbox Error Alert” on page 287

Business Calendar
Note: The Business Calendar applies only to the Inactivity Alert.

To define the Business Calendar
1 Access the Transaction Event and Rules and Alerts page. See “Alerts and 

Options Overview” on page 283.
The Transaction Event and Rules and Alerts page.

2 In the Mailbox Specific Alerts section, from the Rule type drop-down list, 
select Business Calendar.

3 From the Mailbox drop-down list, select the mailbox to which the calendar 
should apply, then click Configure. 
The Business Calendar page opens.

4 In the Working Days and Time Zone section, enter the following.
■ Working Days — Select the days the service should consider as working 

or business days. Inactivity alerts process Working Days only. 

■ Time Zone — Select the applicable time zone for your community.

■ Daylight saving time observed — Select this option if your community 
observes daylight-savings time.

5 In the Holidays (Optional) section, enter the following:
■ Holidays — Select the days the Trading Grid should ignore. These days do 

not have to be standard holidays; you can specify any day. The Holidays 
you specify are considered Non-Working Days. Click the calendar icon to 
select each holiday date.

6 Click Save. 
7 Repeat these steps for each of your mailboxes.

Inactivity Alert

To create an inactivity alert
1 Access the Transaction Event and Rules and Alerts page. See “Define the 

Alerts” on page 283.
The Transaction Event and Rules and Alerts page opens.

2 In the Mailbox Specific Alerts section, enter the following information.
a From the Rule type drop-down list, select Inactivity Alert.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
The Mailbox Inactivity Alert page opens. 
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3 Enter the following information that applies.

4 Click Save.
5 Repeat these steps for each of your mailboxes.

Arrival Alert
Use this procedure to create an arrival alert.

To create an arrival alert
1 Locate the Transaction Event and Rules and Alerts page. see “Define the Alerts” 

on page 283.
The Transaction Event and Rules and Alerts page opens. 

Field Description

Enable the Event 
Rule

Select this check box to turn on the rule.

Apply the Business 
Calendar

Select this check box to have mailbox inactivity measured only 
during working hours on working day, excluding holidays, as 
defined in the “Business Calendar” on page 284.
Otherwise, mailbox inactivity is measured 7 days a week.

The Range for Receiving Alerts

Start Time Enter the start time for receiving alerts.

Stop Time Enter the stop time for receiving alerts.

Time Zone Displays the time zone previously defined.

Mailbox Inactivity Alert Details

Inactivity Length Enter the number of hours the mailbox is inactive before Trading 
Grid generates a notification.

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define the Customer’s Service 
Contacts” on page 278. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Mailbox Inactivity 
Contact(s) check box. To display the contact information, 
click the Mailbox Inactivity Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

■ If a contact does not display in the list, you must define that 
contact. See “Define the Customer’s Service Contacts” on 
page 278. 

To remove a contact from the Other Contacts list:
1 Click the Other Contacts check box > Modify List.

The list of service contacts displays.
2 Deselect the contact from the list, and then click Submit.
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2 In the Mailbox Specific Alerts section, enter the following information.
a From the Rule type drop-down list, select Arrival Alerts.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
3 On the page that opens, do one of the following:

■ Click Add Arrival Alert

■ Click Actions > Add Rule.

The Add Arrival Alert page opens.

4 Enter the following information.

Field Describe

Document Type Select a Document Type for the rule. 
1 Click Browse. 
2 Find the document type, then click the Select check box.

The selected value displays in Document Type field.

Partner EDI 
Address

Enter the partner’s EDI address.
1 Click Search by Company.
2 Do one of the following:

■ Type a partial or complete name in the pop-up then click 
Search.

■ Leave the field blank then click Search to view a listing 
of all companies.

3 Click Select.
4 Select the company name and an address.

The selected value displays in Partner EDI Address field.
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5 Click Submit.
6 Repeat these steps for each of your mailboxes.

Mailbox Error Alert

To create a mailbox error alert
1 Locate the Transaction Event and Rules and Alerts page. see “Define the Alerts” 

on page 283.
The Transaction Event and Rules and Alerts page opens.

2 In the Mailbox Specific Alerts section, enter the following information.
a From the Rule type drop-down list, select Error Alert.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
The Mailbox Outbound Error Alert page opens.

3 Select the Enable this Event Rule option if it is not already selected.

Your EDI Address Enter your EDI address.
1 Click Browse. 
2 Find the address this rule to, then click the Select check 

box.
3 Click Select.

The selected value displays in Your EDI Address field.

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define the Customer’s Service 
Contacts” on page 278. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Arrival Alerts 
Contact(s) check box. To display the contact information, 
click the Arrival Alerts Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

■ If a contact does not display in the list, you must define that 
contact. See “Define the Customer’s Service Contacts” on 
page 278. 

To remove a contact from the Other Contacts list:
1 Click the Other Contacts check box > Modify List.

The list of service contacts displays.
2 Deselect the contact from the list, and then click Submit.

Field Describe
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4 In the Mailbox Outbound Error Alert Details section, enter the following.

5 Click Submit.
6 Repeat these steps for each of your mailboxes.

Mail Slots
Mail slots separate documents you receive according to business process needs. 
You can set up slots to receive documents in categories; for example, by trading 
partner, document type, etc. 

■ Mail Slot 1 is for Invoices from all standard Suppliers, because these invoices get 
standard handling.

■ Mail Slot 2 is for Invoices from DSD Suppliers, because these invoices get priority 
handling.

■ Mail Slot 3 is for Invoices from Suppliers A and B, because these invoices are 
paid via EFT.

To set up the mail slots for your company
1 On the Trading Grid page, click the Account Manager tab > Service 

Configuration > Mailslots > Create Mailslot.
The Create Mailslot page opens.

Field Description

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define the Customer’s Service 
Contacts” on page 278. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Mailbox Outbound 
Error Contact(s) check box. To display the contact 
information, click the Mailbox Outbound Error 
Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

■ If a contact does not display in the list, you must define that 
contact. See “Define the Customer’s Service Contacts” on 
page 278. 

To remove a contact from the Other Contacts list:
1 Click the Other Contacts check box > Modify List.

The list of service contacts displays.
2 Deselect the contact from the list, and then click Submit.
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2 Enter the following information.

3 Click Submit.

Password Policy
The Password Policy page displays the current policy for this company, regarding 
user passwords. You can define a more restrictive password policy. 

Note: When you change the password policy, your changes override only the 
fields where your policy is more restrictive than what the customer specified. Any 
change in password policy forces all users at this company to change their 
password at their next login attempt.

To change the password policy
1 On the Community Manager page, click Company Management > Policy. 

The Password Policy page opens.

2 Modify the value(s) in any of the fields. 
3 Click Save.

Enhanced Rules
The Trading Grid Event Management feature is where rules and policies are 
defined to determine when trading partners are compliant or non-compliant. 
Compliancy or non-compliancy is reported in the Reports component under 
Functional Acknowledgement Management and Transaction Alerts. 

These steps apply only with these optional alert services (extra fee might apply). 
Contact a OpenText sales representative for more information.

Field Description

Mailslot Name Enter a descriptive name for the mailslot.

Description Enter a description for the mailslot.

Mailbox Use the drop-down list to select a mailbox number.

Rule Definition

My EDI Address Click  Search icon to find and select the applicable value.

Document Type 1 Click  Search icon to find and select the applicable value. 
2 Click Submit. 

Partner EDI 
Address(es), 

1 Enter the address for the first trading partner, then click 
Add.
The address displays. 

2 Repeat this step for each applicable trading partner.

Associate Users
Use this section to select Company employees that handle the documents in this mailslot.

User 1 Use the drop-down list to select the first user, then click 
Add.
The employee’s name displays.

2 Repeat this step for each applicable employee.
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Topics include:

■ “Rules and Alerts Descriptions” on page 290

■ “Define the Alerts” on page 283

Rules and Alerts Descriptions
For each customer mailbox, one or more of the following rules or alerts are used: 

■ Enhanced Calendar Rule — Alerts configured to be sent on the days when the 
service is considered “working” or “business” days for each EDI mailbox.

■ Enhanced Arrival Alert — Alerts customers as soon as a document are placed 
in the mailbox. Alerts configured: 

■ For specific document types or specific trading partners or both.

■ To route the alert to different individuals within the customer company 
based on document type or trading partner or both. 

Note: Alerts like this assists the user to respond to orders from key clients as 
soon as possible.

■ Enhanced Error Alert — Alerts customers when a document fails to be 
processed. 

Note: Alerts like this assists the user to respond to errors immediately. 

■ Enhanced FA Alert — Alerts customer when acknowledgements are not 
received for documents sent according to a defined schedule. 

Note: Alerts like this assists the user to verify receipt of documents sent and 
to circumvent problems with their orders as soon as possible.

Important: For these alerts to function properly, all subscribed alerts must be 
configured. 

Define the Enhanced Rules
Important: In order for the rules to function properly, configure all subscribed 
rules. Based upon the subscription, configure all or some of these alerts.

Topics include:

■ “Accessing Transaction Event Rules and Alerts” on page 290

■ “Business Calendar” on page 284

■ “Inactivity Alert” on page 284

■ “Arrival Alert” on page 293

■ “Error Alert” on page 294

■ “Functional Acknowledgment (FA) Alert Rule” on page 295

Accessing Transaction Event Rules and Alerts 

To define customer rules
1 In Community Manager, select the applicable Customer Company Name and 

click Service Configuration > Event Management.
The Transaction Event Rules and Alerts page opens. 
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2 Continue with any of the following:
■ “Business Calendar” on page 284

■ “Inactivity Alert” on page 284

■ “Arrival Alert” on page 293

■ “Error Alert” on page 294

■ “Functional Acknowledgment (FA) Alert Rule” on page 295

Business Calendar

To define the Business Calendar
1 From the Transaction Event and Rules and Alerts page (see “Define the Alerts”), 

under Enhanced Alerts, click Select Rule Type. 
2 Click Calendar Rule > Configure.
3 Select the Mailbox and click Configure > Create. 

The Enhanced Calendar Rule page opens.

4 Enter the data.

5 Click Save. 
6 Repeat these steps for each of the mailboxes.

Section or Field Description

Rule Name Enter a descriptive name for this rule.

Enable Rule Check this box to use this rule immediately.

My Details If all company mailboxes and address apply to this rule, do 
nothing, else: 

■ From the Mailbox dropdown, select the company mailbox 
for this rule. 

■ From the My Address dropdown, select the address that 
for this rule. If all addresses apply, do not select anything.

Partner Details If all Trading Partners apply, do nothing, else:
■ For the My Partner mailbox, click Search and search for 

the applicable Trading Partner company. Click Select.
■ From the Partner Address dropdown, select the address 

for this rule. If all addresses apply, do not select anything.

Working Days and 
Timezone

For:
■ Working Days. Select the days to consider the service as 

“working” or “business” days. 
■ Time Zone. Select the applicable time zone for the 

community.
■ Daylight saving time observed. Select this option if the 

community observes daylight-savings time.

Holidays Enter the dates the system should ignore. 
These are considered non-Working Days and do not have to be 
standard holidays. 
Click the adjacent Calendar icon to select the date of each 
non-working day.
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Inactivity Alert

To create an enhanced inactivity alert
1 From the Transaction Event and Rules and Alerts page (see “Define the Alerts”), 

under Enhanced Alerts, click Select Rule Type.
2 Click Inactivity Rule > Configure.
3 Select the appropriate Mailbox and click Configure. 

The Inactivity Alert Rule page opens. 

4 On the Inactivity Alert Rule page, provide the following information: 

5 Click Submit.

Field Description

Rule Name Enter a descriptive name for the new rule.

Enable Rule Select this option to use this rule immediately.

File/Document Select the applicable option.

My Details

Mailbox If all company mailboxes and address apply to this rule, do 
nothing.
Otherwise, from the Mailbox dropdown, select the company 
mailbox for this rule. 

Address Select the address that for this rule. If all addresses apply, do not 
select anything.

Partner Details

My Partner If all Trading Partners apply, do nothing. 
Otherwise, click the Search icon and select the applicable Trading 
Partner company. Then, click Select.

Partner Address Select the address for this rule. If all addresses apply, do not select 
anything.

Rule Details

APRF/Document 
Type

If all documents apply for this rule, do nothing.
Otherwise, click Browse and locate the document type and click 
its Select box. Then, click Select.

Direction Select the direction(s) of the file(s) or document(s). The default is 
Inbound.

Apply Business 
Calendar

select this option to measure mailbox inactivity only during working 
hours on working days, and not on holidays, as defined in the 
“Business Calendar”. Otherwise, inactivity is measured 24 hours, 7 
days a week.

Start Time Enter the Start Time for receiving alerts.

Stop Time Enter the Stop Time for receiving alerts.

Time Zone Supplied by system.

Event 
Occurrence

For the length of inactivity, enter the number of days and/or hours 
the mailbox should be inactive before generating a notification; 
that is, if a trading partner's mailbox is inactive for more than the 
number of hours specified, Trading Grid generates a notification.

Notification 
Options

These are the contacts previously defined in the Service Contacts 
list. Select the applicable contacts.
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Arrival Alert

To create an enhanced arrival alert
1 From the Transaction Event and Rules and Alerts page (see “Define the Alerts”), 

under Enhanced Alerts, click Select Rule Type.
2 Select Arrival Rule and click Configure.

The Enhanced Arrival Alert Rule page opens.
 

3 Provide the following information:

Field Description

Rule Name Enter a descriptive name for the new rule.

Enable Rule Use this option to enable this rule immediately.

File/Document Select the applicable option.

My Details

Mailbox If all company mailboxes and address apply to this rule, do 
nothing.
Otherwise, from the Mailbox dropdown, select the company 
mailbox for this rule. 

Address Select the address for this rule. If all addresses apply, do not select 
anything.

Partner Details

My Partner If all Trading Partners apply, do nothing. 
Otherwise, click the Search icon and select the applicable Trading 
Partner company. Click Select.
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4 Click Submit. 

Error Alert

To create an enhanced error alert
1 From the Transaction Event and Rules and Alerts page (see “Define the Alerts”), 

under Enhanced Alerts, click Select Rule Type.
2 Select Error Rule and click Configure. 

The Enhanced Error Alert Rule page opens. 

3 Do the following: 

Partner Address Select the address for this rule. If all addresses apply, do not select 
anything.

Rule Details

APRF/Document 
Type

If all documents apply for this rule, do nothing.
Otherwise, click Browse, find the document type and click its 
Select box. Click Select.

Direction Select the direction(s) of the file(s) or document(s). The default is 
Inbound.

Start Time Enter the Start Time for receiving alerts.

Stop Time Enter the Stop Time for receiving alerts.

Time Zone Supplied by system.

Event 
Occurrence

Select the applicable option.

Notification 
Options

These are the contacts previously defined in the Service Contacts 
list. Select the applicable contacts.

Field Description

Rule Name Enter a descriptive name for the new rule.

Enable Rule Check this option to enable this rule immediately.

My Details

Mailbox If all company mailboxes and address apply to this rule, do 
nothing.
Otherwise, from the Mailbox dropdown, select the company 
mailbox for this rule. 

Address Select the address for this rule. If all addresses apply, do not select 
anything.

Partner Details

My Partner If all Trading Partners apply, do nothing. 
Otherwise, click the Search icon. In the page that appears, find 
and select the applicable Trading Partner company. Click Select.

Partner Address Select the address for this rule. If all addresses apply, do not select 
anything.

Rule Details

Field Description



295 Trading Grid Online

C O M M U N I T Y  M A N A G E R

Enhanced Rules

4 Click Submit. 

Functional Acknowledgment (FA) Alert Rule

To create an enhanced functional acknowledgment alert rule
1 From the Transaction Event and Rules and Alerts page (see “Define the Alerts”), 

under Enhanced Alerts, click Select Rule Type.
2 Select FA Rule and click Configure.

The Enhanced FA Alert Rule page opens.
 

APRF/Document 
Type

If all documents apply for this rule, do nothing.
Otherwise, click Browse and find the document type and click its 
Select box. Click Select

Direction Select the direction(s) of the file(s) or document(s). The default is 
Inbound.

Error Severity Enter the Start Time for receiving alerts.

Change Error 
Status

Enter the Stop Time for receiving alerts.

Notification 
Options

These are the contacts previously defined in the Service Contacts 
list. Select the applicable contacts.

Field Description



C O M M U N I T Y  M A N A G E R
Enhanced Rules

Trading Grid Online  296

1 0

3 Do the following:

4 Click Save.

Field Description

Rule Name Enter a descriptive name for the new rule.

Enable Rule Check this option to enable this rule immediately.

Rule Details

Mailbox If all company mailboxes and address apply to this rule, do 
nothing.
Otherwise, from the Mailbox dropdown, select the company 
mailbox for this rule. 

Address Select the address for this rule. If all addresses apply, do not 
select anything.

My Partner If all Trading Partners apply, do nothing. 
Otherwise, click the Search icon and select the applicable 
Trading Partner company. Click Select.

Partner Address Select the address for this rule. If all addresses apply, do not 
select anything.

Partner FG Address Enter the address of the selected trading partner’s applicable 
Functional Group. If all addresses apply, do not select anything.

My FG Address Enter the address of the applicable Functional Group. If all 
addresses apply, do not select anything.

Function Group Click the adjacent Search icon to select the applicable 
document type. If all types apply, do not select anything.

Apply Business 
Calendar

Select this option to measure mailbox inactivity only during 
working hours on working days, and not on holidays, as 
defined in the “Business Calendar”. Otherwise, inactivity is 
measured 24 hours, 7 days a week.

Do Not Track Select this option to NOT track the Trading Partner(s) and 
Functional Group(s) for the options selected below. 

Resolved 
Acknowledgment 
Codes

Select how to track documents.

Cycle 1

Time to Delinquency Enter the expected amount of time for a response after the 
document or file was received.

Notification Options These are the contacts previously defined in the Service 
Contacts list. Select the applicable contacts.

Cycle 2

Time Since Cycle 1 Enter the expected amount of time for a response after the first 
alert was received.

Notification Options These are the contacts previously defined in the Service 
Contacts list. Select the applicable contacts.

Cycle 3

Time Since Cycle 2 Enter the expected amount of time for a response after the 
second alert was received.

Notification Options These are the contacts previously defined in the Service 
Contacts list. Select the applicable contacts.
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Resolve Customer Issues
When signed on as a customer user, you see exactly what the user sees in Trading 
Grid. This is useful when helping customers solve problems or determining what is 
causing an error.

Topics include 

■ “Log in as a Customer” and then send a test file and examine the customer 
reports for errors or problems.

■ “Upload and Send a File” on page 22 as a test.

■ Examine the “TGMS Reports” for errors or problems.

Log in as a Customer
Use this procedure to login as a customer user.

To log in as a customer 
1 In Community Manager, click Company Management and locate the 

applicable company. 
2 Click the company name to expand the available options and select User 

Management. 
The User Management page opens. 

3 Click Actions > Sign in as this User. 
The Trading Grid system for that user displays. 

From this page you can

■ Navigate and browse to find the information.

■ Return to your own Trading Grid system. Click End Act on Behalf. 

Next steps
■ Send a test file using Transaction Manager — see “Upload and Send a File” on 

page 22.

■ Go to the Reports component and examine the Trading Grid Messaging Service 
(TGMS) customer reports for errors or problems — see “TGMS Reports.”

Invitation Tool
Use the Invitation Tool to create and send reusable invitations that invite a 
customer company or customer user to register for Trading Grid. 

Important: If you do not set up the user in Trading Grid, you must send them an 
invitation to register on Trading Grid. 

On the Invitation Tool page, the 
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■ Company Invitations list shows the invitations created on behalf of an IWF-
subscribed company (the “hub”) to the customers receiving their forms (the 
“spokes”). 

■ User Invitations list shows the invitations created for users at customer 
companies. 

For each invitation, the listings show 

■ Invitation Name — Name given to that invitation when it was created. 

■ Invitation Type 

■ Generic — A generic invitation is a reusable invitation for sending to one 
or more recipients. Each recipient has the same Invitation Code. 

■ Unique — A unique invitation is a one-time invitation that you send to one 
or more recipients. Each recipient has a unique Invitation Code, enabling 
easy tracking of each recipient's response. 

■ Status of the invitation. Statuses are 

■ Saved — The invitation has not yet been sent. 

■ Active — Invitees can now register using this Invitation Code. 

■ Expired — The Invitation Code within the invitation has expired. 

■ Terminated — The invitation is inactive. That is, nobody can register with 
this Invitation Code. 

■ Expiration Date — Date that the Invitation Code in the invitation expires. 

■ Creator — Name of the person who created the invitation. 

Topics include

■ “Create a Company Invitation” on page 298

■ “Copy a Company Invitation” on page 300

■ “Create a User Invitation” on page 301

■ “Modify a Company or User Invitation Details” on page 302

Create a Company Invitation
Create and send reusable invitations to the “spoke” companies associated with a 
“hub” company that was previously set up. 

There are various ways to connect companies to Trading Grid. 

■ For “parent/child” companies, set up both a “parent” company and its “child” 
company(ies) via the “Create company accounts” on page 261 procedure. 

■ For “hub/spoke” companies, i.e., an IWF-subscribed company (the “hub”) 
providing forms to their user companies (the “spokes”): 

■ Set up the “hub” company via the “Create company accounts.” procedure. 

■ Invite the “spoke” companies via this “Create a Company Invitation” 
procedure. Then, when the “spoke” company registers, it specifies the 
association to the “hub” company, thus establishing the “hub/spoke” link. 
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Create a company invitation
1 In Community Manager page, click Invitation Tool.

The Invitation tool page opens.

2 Above the Company Invitations list, do any of the following: 
■ For Resellers: click Actions > Invite Reseller's Customer. 

■ For first invitations to a company: click Invite Reseller's Customer. 

■ Click the applicable action. 

3 On the Step 1: Invitation Details page, enter all the information.  

4 Click Next Step. 

Field Description

Inviting Company From the Reseller's or the Community Administrator’s Customer 
list, select the IWF-subscribed company (the “hub”) that this 
company is associated with. 

Invitation Name Enter a unique, descriptive name for the invitation.

Invitation Type Select either 
■ Unique if this is an invitation that you are sending one time. 

A unique Invitation Code is assigned to each recipient 
company. 

■ Generic if this is an invitation that you send to different 
companies. The Invitation Code is the same for all recipient 
companies. 

Approval Type After an invitee (prospective company who receives the 
invitation) receives this invitation and registers on the Trading 
Grid, the invitee must be approved before the user can access 
the Trading Grid. Select either 

■ Manual if you want the Approver to individually approve or 
reject each invitee that registers. We strongly recommend 
this option for all Generic invitations because the invitation 
code in a generic invitation is not specific to any one 
recipient, and could be distributed to unintended registrants. 

■ Automatic if you want Trading Grid to automatically 
approve each invitee for you. GXS recommends that you 
select this option for any invitation sent to a single company, 
because the recipient company can begin using the service 
as soon as they respond to the invitation.

Registration Status 
Notification 

Enter the email address(es) of the people who want or need to 
be kept up-to-date of the company's registration status, e.g., if it 
registered, if the registration was approved. 

Expiration Date  The final date that the Trading Grid accepts the company's 
registration; this is the date that the Invitation Code supplied 
in this invitation expires.

Notes  Enter up to 4,000 characters of explanatory information that is 
for your use only — the invitee does not see this information. 
The Trading Grid truncates anything over 4,000 characters; click 
the Count Characters box below this field to ensure you stay 
within the 4,000 limit. 
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5 On the Step 2: Services page, select the service(s) and the options. For 
example: privileges for each package that you want the company to have. 
Note: By default, all options are selected for any service. 

6 Click Next Step. 
7 On the Step 3: Recipient Details page, 

■ Enter Email Address(es) — Address(es) of the company(ies). Separate 
multiple addresses by a semi-colon (;), comma (,), or a blank space. 

■ Optionally upload an image (for example: a company logo) to appear in the 
invitation. 

■ Enter the Email Language — Select the language of the invitation text. 

■ Enter the Email Content — Invitation text. 

Click Edit from Template and change the text (in the new page) if necessary. 
Then click Submit.

Note: Note that you can enter the recipient details now, or you can continue 
and save the invitation and enter these details later. You cannot send the 
invitation without the recipient details.

8 Click Next Step. 
9 On the Step 4: Review page. 

Review the information, especially the Service Selection packages and 
privileges. To make changes, click Previous Step to go back to the applicable 
step and make changes. Then, click Next Step to return to this page. 

10 Do one of the following. 
■ To save the invitation information without sending it, click Finish. 

The invitation displays in your Company Invitations list with a Saved 
status. You can send the invitation at a later time. 

■ To both send and save the invitation, click Send Now. 

Do this only if you completed the Recipient Details in Step 7 above. The 
invitation displays in your Company Invitations list with an Active 
status. 

Copy a Company Invitation

To copy an existing company invitation
1 In Community Manager, click Invitation Tool.

The Company Invitation List page opens. 

2 Find and select the applicable invitation to copy, then click Actions > Copy 
Invitation. 
The Copy Invitation page opens. 

3 Enter a new Invitation Name, enter the recipients, and make any other 
changes, as applicable. 

4 Click Save.
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The invitation displays in the Company Invitations list with a Saved status. 

Note: You can send the invitation at a later time. 

5 To send this invitation, go back to the Invitation List and open this invitation. 
Click Actions > Send Now.

Create a User Invitation

To create and send reusable invitations 
1 In Community Manager, click Invitation Tool.

The User Invitations list displays. 

2 Click Actions > Create Invitation. 
The Step 1: Invitation Details page opens.

3 Enter all the information.  

Field Description

Inviting Company Click Invite on Behalf of Another Company to select the 
company of the user you are sending this invitation to. 

Invitation Name Enter a unique, descriptive name for the invitation.

Invitation Type Select either 
■ Unique if this is an invitation that you are sending one time 

to a specific recipient or group of recipients. A unique 
Invitation Code is assigned to each recipient. 

■ Generic if this is an invitation that is sent multiple times to 
different recipients. The Invitation Code is the same for all 
recipients.

Approval Type After an invitee (prospective user who receives the invitation) 
receives this invitation and registers on the Trading Grid, the 
invitee must be approved before the user can access the Trading 
Grid. Select either 

■ Manual if you want the Approver to individually approve or 
reject each invitee that registers. We strongly recommend 
this option for all Generic invitations because the invitation 
code in a generic invitation is not specific to any one 
recipient, and could be distributed to unintended registrants. 

■ Automatic if you want Trading Grid to automatically 
approve each invitee for you. GXS recommends that you 
select this option for any invitation sent to a single 
individual, because the recipient can begin using the service 
as soon as they respond to the invitation.

Registration Status 
Notification

Enter the email address(es) of the people who want or need to 
be kept up-to-date of the invitee's registration status,. For 
example, if they registered, if the registration was approved. 
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4 Click Next Step. 
The Step 2: Services page opens.

5 Select the Service Instances and the options/ For example. privileges, for 
each package that you want the user to have. 
Note: By default, all options are selected for any Service Instance. 

6 Click Next Step. 
On the Step 3: Recipient Details page opens. 

7 Do the following: 

8 Click Next Step. 
The Step 4: Review page opens. 

9 Review the information, especially the Service Selection packages and 
privileges. 
To make changes, click Previous Step to go back to the applicable step and 
make your changes. Then, click Next Step to return to this page. 

10 Do one of the following. 
■ To save the invitation information without sending it, click Finish. The 

invitation displays in the User Invitations list with a Saved status. 

Note: You can send the invitation at a later time. 

■ To both send and save the invitation, click Send. The invitation displays in 
the User Invitations list with an Active status. 

Modify a Company or User Invitation Details
You can modify invitations according to the following rules. 

Expiration Date The final date that the Trading Grid accepts the invitee's 
registration; this is the date that the Invitation Code supplied 
in this invitation expires.

Notes Enter up to 4,000 characters of explanatory information that is 
for your use only — the invitee cannot see this information. The 
Trading Grid truncates anything over 4,000 characters; look at 
the Count Characters box below this field to ensure you stay 
within the 4,000 limit.

Email Address(es) Enter the Email Address(es) — Address(es) of the 
recipient(s). Separate multiple addresses by a semi-colon (;), 
comma (,), or a blank space. 

Image Optionally upload an image, e.g., a company logo, to appear in 
the invitation. 

Email Language Enter the Email Language — Select the language of the 
invitation text. 

Email Content Click the Edit from Template link, change the text (in the new 
page) as desired. 
Click Submit to use the text for the invitation.

Field Description
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Rules
■ The invitation Status must be Active or Saved. 

■ If the Invitation Type is Generic, you can modify the Recipient Details 
fields only. For example, you might want to send this specific invitation to 
another group of invitees. 

■ If the Invitation Type is Unique, you can modify the Email Content field 
only. For example, you might want to send a follow-up reminder to the 
invitee(s). 

To modify an invitation 
1 In Community Manager, click Invitation Tool. 
2 Find the applicable invitation in the lists. 

Important: You can only modify an invitation with an Active or Saved 
status. 

3 Click the name of the invitation. 
■ For a Generic invitation, you can only modify the Recipient Details 

fields. 

■ For a Unique invitation, you can only modify the Email Content field.

4 Do one of the following. 
■ To save the invitation information without sending it, click Save. The 

invitation displays in the applicable Invitation List with a Saved status. 

Note: You can send the invitation at a later time. 

■ To both send and save the invitation, click Send Now, or Resend if the 
invitation is Unique. The invitation displays in the applicable Invitation 
List with an Active status.

On-Boarding and Self-Registration
GXS Support creates the “hub” or “parent” company for you.  This enables you, as 
the “hub” or “parent” company, to invite (via an invitation) your user community 
companies, also known as “spoke” or “child” companies, to register with the GXS 
Trading Grid for the purpose of exchanging data and documents.

Create Invitation for “Spoke” or “Child” Companies
Invitations are sent out by the “hub” or “parent” company to “spoke” or “child” 
companies in the community.

To create an invitation
1 Log into TGO, and on the left side of the page, click Invitation Tool > 

Actions > Invite GXS Customer.
The Invitation List page appears.

2 Click Actions > Invite GXS Customer.
 The Step 1: Invitation Details page displays.
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3 Enter the invitation details. For field help, click the Help link and search for the 
field or page name. When finished, click Next Step.
The Step 2: Service(s) page displays.

4 For the Service Type select Active Invoice Delivery.
The page redisplays.

5  For the Service Type select the applicable service bundle.  Then, select the 
Active Invoices Compliance option (i.e., the “Do you want to . . .” option).
The page redisplays.

6 For the Legal Profile Name, 
a Click Submit. Then, click Search Legal Profile. 
b In the Legal Profile popup that displays, enter the name of your company’s 

legal profile.
c Click Search.
d Select the applicable sender‘s Legal Profile name.

7 For Process Type, select the applicable value from the drop down list.
8 For Delivery Mode, select Secure Email Delivery. 
9 Click Next Step.

The Step 3: Recipient Details page displays.

10 Enter the recipient details. For field help, click the Help link and search for the 
field or page name. When finished, click Next Step.
The Review page displays.

11 Review your invitation data. Use the Previous Step and Next Step buttons to 
make any changes. When finished, click Send Now to send and save the 
invitation.
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Self-Registration Steps for Suppliers
You should have received an email similar to the following that invites your company to 
trade within the community.  

1 Follow the instructions in your email by clicking the first link in your email.  
Or: 

a Click the Access the Trading Grid directly by clicking the second link in your 
email. 

b When prompted, enter the invitation code supplied in the email.
c Click Submit.

The Identify Your Company page appears.

2 Enter the information and click Submit.
The Overview page appears.

3 Carefully read the information and click Next Step to begin the registration.
The Agreement page displays.

4 To accept the Service Agreement, the Accept option.  Then click Next Step.
The My Profile page displays.

5 Enter all of your company data. For field help, click the Help link and search for 
the field or page name. When finished, click Next Step.
The Legal Profile for Receiver page displays.

6 Enter all of your company data. For field help, click the Help link and search for 
the field or page name. When finished, click Next Step.
The Review page displays.
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7 Review your registration data. Use the Previous Step and Next Step buttons 
to make any changes. When finished, click Submit.
Assuming you made no mistakes, the Registration Complete page appears.  
From here you can log into Trading Grid and download your invoices.

Self-Registration Steps for Buyers
You should have received an email similar to the following that invites your 
company to trade within the community.   

1 Follow the instructions in your email by clicking the first link in your email. 
Or:

a Click the Access the Trading Grid directly by clicking the second link in your 
email. 

b When prompted, enter the invitation code supplied in the email.
c Click Submit.

The Identify Your Company page appears.

2 Enter the information and click Submit.
The Overview page appears.

3 Carefully read the information and click Next Step to begin the registration.
The Service Subscription page displays.

4 Do the following. 
a Select the service and click the Subscribe to Selected Service option.
b On the next page, select your pricing option and any Optional Features 

you want.
c Click Accept Pricing.

The Agreement page displays.

5 To accept the Service Agreement, click the Accept option. Then, click Next 
Step.
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The My Profile page displays.

6 Enter your data and login information.  Then click Next Step.
The Company Profile page displays.

7 Enter all of your company data. For field help, click the Help link and search for 
the field or page name. When finished, click Next Step.
The Legal Profile for Sender page displays.

8 Create the legal profile. For field help, click the Help link and search for the 
field or page name. When finished, click Next Step.
The Partnership page displays.

9 Enter your EDI Address information, or select the option for the system to 
create it.  Then click Next Step.
The Review page displays.

10 Review your registration data. Use the Previous Step and Next Step buttons 
to make any changes. When finished, click Submit.
Assuming you made no mistakes, the Registration Complete page appears.  
From here you can log into Trading Grid to send and receive documents.
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Pending Registrations
After an invitee receives an invitation from the company, the company receiving 
forms from an IWF-subscribed company or the individual user must register before 
the Invitee appears on the Invited Companies or Invited Users list. After the 
Invitees are on this list, you must approve them as users of the Trading Grid, 
before they can access the service. 

To approve or reject registrants
1 In Community Manager, click Pending Registrations.

Note: The default Approval Status for each company or user is Pending. 

2 For the applicable company or user, change the Approval Status to Approve 
or Reject. 

3 Click Actions > Submit. 
A confirmation page opens showing your selections. 

4 For any Invitee Rejected, type explanatory text into the Reasons for 
Rejection box. 

5 After reviewing the confirmation page, click Actions > Confirm.
Trading Grid generates and sends an email to each invitee notifying them of 
your approval or rejection. 

Important 
■ After you reject or approve a company or user, Trading Grid removes that person 

from the Invited list. 

■ After approving a company, the company is listed in the Company List in the 
Company Management section. 

■ After approving a company user, that person is listed under in its Users list in 
the User Management section. 

■ If you mistakenly approved a company user, delete the user from Trading Grid in 
the User Management section.

■ If you mistakenly rejected a user, resend the invitation or create and send a new 
invitation. The user must re-register. 
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Account Manager 11
This chapter describes the role of company System Administrators for Trading Grid 
Online and explains how to use the Account Manager Tab to set up and manage 
user accounts.

Topics include:

■ “Overview” on page 310

■ “Company Profile Information” on page 311

■ “Manage User Accounts” on page 313

■ “Trading Relationships” on page 323

■ “Company Subscription” on page 339

■ “Mailboxes and EDI Addresses” on page 339

■ “Service Contacts” on page 345

■ “Messaging Service Alerts and Options” on page 349

■ “Active Document Status Alerts” on page 360

■ “Active Document Data Policies” on page 362

■ “Active Invoice Legal Profiles” on page 364

■ “Machine Users” on page 377

■ “Mailboxes and Mailslots” on page 378

■ “Cross-Reference Tables” on page 380

■ “Billing” on page 383

■ “Policy” on page 385

Important: All components and links discussed in this chapter might not display, 
depending on your Company's subscription agreement and your permissions 
assigned by your Company Administrator. 

Overview
From the Account Manager, you perform most of the administrative tasks 
associated with your mailbox and manage trading partnerships. These partnerships 
are important to your Trading Grid Messaging Service (TGMS) mailbox because you 
cannot exchange documents with a Trading Partner unless a trading partnership 
first is created and approved by both parties.

Trading Grid Online users can log on, and work with TGMS mailboxes. Creating a 
new user bypasses the invitation process and allows users in your company direct 
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access to Trading Grid Online. When you when create a new user account, you also 
set the user’s their role and access rights. 

Note: Each mailbox must have at least one associated EDI address. A mailbox 
may also have optional mailslots.

Navigation Panel
The Navigation Panel displays the functions you can perform in the Account 
Manager.

Link Description

Company Profile View or update your Company information.

User Management Create, activate, remove, update, etc., invitations and Trading Grid 
users at your Company.

Trading Community View, update, or remove the companies with which you have trading 
partner relationships
View, update, or remove the companies which have trading partner 
relationships with you.

Subscription View or change your Subscription Options.

Service Configuration Set or change your document or file notification options.

Billing Print or view your invoiced bills.

Policy Set or change password defaults or restrictions that apply to all users 
at your Company; review and modify other business policies.

 

Company Profile Information
The Company Profile page is the Account Manager home page. If a company’s 
profile information changes, update the profile accordingly.

The Company Profile page consists of these sections:

Section Description

Profile Status System generated data.

Organization Hierarchy If your company has child companies, select the Allow to create 
child company(s) option.

Company Information, 
Business Contact, Technical 
Contact

Company and company contact information.
One person might be multiple contacts. Contacts receive user 
invitations after the company subscribes to Trading Grid.

To change the company profile
1 Review the the Company Profile information and update it with new information 

if it has changed since the company was registered.
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2 To save the changes, do one of the following.
■ Click Actions > Save. 

■ Click Save. 
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Manage User Accounts
Trading Grid Online User Management service allows you to:

■ Create and manage accounts for users in your company.

■ Create, send, and resend invitations to users and Trading Partners.

Topics include: 

■ “Create Company User Accounts” on page 313

■ “Invite Company Users” on page 318

■ “User Action History” on page 322

Create Company User Accounts
Creating a user through the User Management service registers the user 
immediately and bypasses the invitation process. After you create the user account 
following these steps, that person is ready to access and work within Trading Grid 
Online. 

User List
On the left side of the page, when you click the Users link, the Users list page 
opens. This area lists all of your Company users, and for each user displays the 

■ User Name of the user — Click the name to see more information about the 
user. 

■ User ID — Generally, this is the user's email address. 

■ Status — Whether the user is currently 

■ Active — The user registered and was approved to participate in Trading 
Grid Online. 

■ Inactive — The user registered, but is not currently participating in 
Trading Grid Online. 

■ Incomplete — The user registered, but has not yet been approved to 
participate in Trading Grid Online - see the “Approve Invited Users” topic. 

Add New Users

To add a new user
1 Click User Management. 
2 The Account Manager: User Management page displays the User’s tab and User 

List by default.



A C C O U N T  M A N A G E R
Manage User Accounts

Trading Grid Online  314

1 1

3 Click Actions > Create New User. 
The Step 1: User Information page opens.

4 Provide the applicable user information.
. 

5 Click Next Step.
The Step 2: Service Privileges page opens. 
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. 

6 Under Service Instance(s), select the subscription package(s) and options 
(privileges) for each service instance you want the user to have. 

7 Under Roles, select the role of the new user. All roles have access to the user 
functions (Service Instances) that are subscribed to by the Company. 

Role Access to Administrative Functions

Company 
Administrator

All of the administrative functions of Trading Grid Online, 
subscribed to by all Companies in his/her community. These 
functions are in both the Community Manager and Account 
Manager components.
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8 Click Next Step.
9 On the Step 3: Review page, carefully review the information, especially the 

Service Selection instances and options. 
10 Do the following:

a To make any changes, scroll down and click Previous Step.
b Return to the applicable step and make your changes.
c Click Next Step to return to this page.

11 Click Submit to enter the person into Trading Grid Online. 
Note: If you do not enter data for all required fields, Submit is de-activated. 
If you do not yet want this person activated in Trading Grid Online, click Save 
to save the data you entered. The user appears in the Users list with an 
Incomplete status. You can activate the user later.

Trading 
Community Admin

The Trading Community functions in Account Manager that are 
subscribed to by the company. These can include

■ Requesting and approving trading partnerships.
■ Defining and maintaining the AutoForwarding of messages.
■ Setting up and maintaining the AutoCopy distribution lists.

Account User None. This user does not have access to any of the 
administrative functions in Account Manager.

Account 
Administrator

All of the administrative functions in Account Manager that are 
subscribed to by his/her Company. These include:

■ Maintenance of the Company Profile.
■ Inviting or setting up, and maintenance of, Company users 

(User Management).
■ Administration of the Trading Community and its 

distribution list.
■ Subscription modification.
■ Service Configuration, which can include:

■ Setting up and maintaining mailbox information 
■ Defining and setting company or mailbox rules and 

alerts
■ Mailslotting

■ Monitor Billing invoices. 
■ Define or update the company Password Policy.

Service 
Configuration 
Admin

The Service Configuration functions in Account Manager that 
are subscribed to by his/her Company. 

Trading 
Partnership 
Approver

Only the Trading Community function of approving trading 
partner relationships (EDI to EDI).

AutoForward 
Administrator

Only the Trading Community function of setting up and 
maintaining AutoForward partnerships. 

AutoCopy 
Distribution List 
Administrator

Only the Trading Community function of defining and 
maintaining AutoCopy distribution lists. 

Role Access to Administrative Functions
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12 Click User Management. 
The user created displays in the User List. . 

13 Repeat these steps for each user you need to create.
See also 

■ “To modify user data”

■ “To activate, deactivate, or delete a user”

Modify User Data

To modify user data
1 Click User Management.
2 In the section that expands, click Uses.
3 Find and select the applicable user from the list.

Important: You can only select a user with an Active or Inactive status.

4 Do one of the following:
■ Click Actions > Update. 

■ Click the applicable User Name.

The User Information page opens.

5 Change the applicable information. 
6 Click Service Privileges tab to change the users package(s) or roles. 

See User Role definitions in “Create Company User Accounts” on page 313.

7 Click Update to enter save and activate the changes.
Note: Update is inactive if you did not enter data into all required fields. To 
permanently remove the user and all their data from Trading Grid Online, click 
Delete.

Activate, Deactivate, or Delete a User
You can activate, deactivate, or delete users one at a time or in groups. When you 
select multiple users, you can only perform one of the three actions. For example, 
five users are selected for activation only.
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To activate, deactivate, or delete a user
1 Select the user(s). 
2 From the Actions drop-down list, select:

■ Activate to authorize the user to access Trading Grid Online.

■ Deactivate to temporarily prevent the user from using Trading Grid 
Online.

■ Delete to permanently remove the user and all their data from Trading 
Grid Online.

3 Click Yes.

Invite Company Users
You can easily create and send reusable invitations that invite the user to register. 

Important: If you do not “Create Company User Accounts” on page 313 in 
Trading Grid Online, you must send them an invitation to register on Trading Grid 
Online. 

Topics include:

■ “Invitation List” on page 318

■ “Create an invitation” on page 319

■ “Modify Invitation Details” on page 320

■ “Send or Resend Invitation” on page 321

■ “Approve Invited Users” on page 321

Invitation List
When you click the Invitation List link, the Invitation List page opens. This area 
lists all the invitations that you created, and for each invitation, displays the 

Field Description

Invitation Name

Invitation Type

Status 

Expiration Date

Creator

■ Name given to that invitation when it was created. 

■ Generic — A generic invitation is a reusable invitation for 
sending to one or more recipients. Each recipient has the same 
Invitation Code.

■ Unique — A unique invitation is a one-time invitation that you 
send to one or more recipients. Each recipient has a unique 
Invitation Code, enabling you to easily track each recipient's 
response. 

■ Saved — The invitation has not yet been sent. 
■ Active — Invitees can now register using this Invitation Code.
■ Expired — The Invitation Code within the invitation has 

expired.
■ Terminated — The invitation is inactive. That is, nobody can 

register with this Invitation Code. 

■ Date that the Invitation Code in the invitation expires. 

■ Name of the person who created the invitation. 
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Create an invitation

To create an invitation
1 Click User Management. 
2 In the section that expands, click Invitation List.
3 Above the Invitation List, click Actions > Create Invitation.

The On the Step 1: Invitation Details page opens.

4 Enter the following information.

5 Click Next Step.
On the Step 2: Service Privileges page opens.

Field Description

Invitation Name Enter a unique, descriptive name for the invitation.

Invitation Type Select either
■ Unique if this is an invitation that you are sending 

one time to a specific recipient or group of recipients. 
A unique Invitation Code is assigned to each 
recipient. 

■ Generic if this is an invitation that you send multiple 
times to different recipients. The Invitation Code is 
the same for all recipients. 

Registration Status 
Notification

Enter the email address(es) of the people who want or 
need to be kept up-to-date of the invitee's registration 
status, e.g., if they registered, if the registration was 
approved.

Approval Type After an invitee (prospective user who receives the 
invitation) receives this invitation and registers on Trading 
Grid Online, the invitee must be approved before the user 
can access Trading Grid Online. Select either 

■ Manual if you want the Approver to individually 
approve or reject each invitee that registers. We 
strongly recommend this option for all Generic 
invitations because the invitation code in a generic 
invitation is not specific to any one recipient, and 
could be distributed to unintended registrants. 

■ Automatic if you want Trading Grid Online to 
automatically approve each invitee for you. We 
recommend that you select this option for any 
invitation sent to a single recipient, because then the 
recipient can begin using the service as soon as they 
respond to the invitation. 

Expiration Date The final date Trading Grid Online accepts the invitee's 
registration; this is the date the Invitation Code supplied 
in this invitation expires.

Notes Enter up to 4,000 characters of explanatory information 
that is for your use only — the invitee does not see this 
information. Trading Grid Online truncates anything over 
4,000 characters; check the Count Characters box that 
displays to ensure you stay within the 4,000 limit.
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6 Select the subscription package(s) and the options (privileges) for each 
package you want the user to have. 
By default, all options are selected for any Subscription Package that you select. 

7 Click Next Step.
The Step 3: Recipient Details page opens.

8 Do any of the following:
■ Enter the recipient details now.

■ Save the invitation and enter the details later. 

Note: You cannot send the invitation without the recipient details. 
Enter the

9 Click Next Step.
10 On the Step 4: Review page, do the following:

a Carefully review the information, especially Service Selection packages and 
privileges. 

b To make changes, click Previous Step and return to the applicable step 
and make your changes. 

c Click Next Step to return to this page.
11 Do one of the following. 

■ To save the invitation information without sending it, click Finish. 

The invitation appears in your “Invitation List” on page 318 with a Saved 
status. You can send the invitation later. 

■ When you complete Step , click Send Now to send and save the invitation. 

The invitation appears in your “Invitation List” on page 318 with an Active 
status. 

Modify Invitation Details
You can modify invitations according to the following rules: 

The invitation Status must be Active or Saved. 

■ If the Invitation Type is Generic, you can modify the Recipient Details fields only. 
For example, you might want to send this specific invitation to another group of 
invitees. 

■ If the Invitation Type is Unique, you can modify the Email Content field only. For 
example, you might want to send a follow-up reminder to the invitee(s). 

Field Description

Email Address(es) Type the recipient(s) address(es). 
Separate multiple addresses by a semi-colon (;), comma (,), or a 
blank space. 

Email Language Select the language of the invitation text. 

Email Content Invitation text. Do the following:
1 Click the Edit from Template link.
2 Change the text (in the new page).
3 Click Submit to use that text for the invitation. 
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To modify an invitation
1 Click User Management. 
2 In the section that expands, click Invitation List.
3 Find the applicable invitation in the list. 

Note: You can only modify an invitation with an Active or Saved status.

4 Click the name of the invitation.
5 Modify the invitation. Note the following:

■ For a Generic invitation, you can only modify the Recipient Details 
fields.

■ For a Unique invitation, you can only modify the Email Content field.

6 Do one of the following. 
■ To save the invitation information without sending it, click Finish. 

The invitation appears in your “Invitation List” on page 318 with a Saved 
status. You can send the invitation later. 

■ To save and send the invitation, click Send Now. 

The invitation appears in your “Invitation List” on page 318 with an Active 
status. 

Send or Resend Invitation
You can send any invitation with a Saved status; you can resend any invitation 
with a Unique invitation type and an Active status. 

To send or resend invitations
1 Click User Management.
2 In the section that expands, click Invitation List.
3 Find and select the applicable invitation(s) in the list. 
4 Above the User Invitations list, click Actions > Send/Resend.

Approve Invited Users
After the Invitee receives the invitation he or she must register before the Invitee 
appears on the Invited Users list. After the Invitees are on this list, someone must 
approve them as users of Trading Grid Online, before they can access the service. 

When you click the Invited Users link, the Invited Users list page opens. This 
area lists the people that responded to your invitations and have registered. These 
people are waiting for someone to approve them as users of Trading Grid Online. 
For each person, the list displays:

Field Description

Approval Status Everyone in this list has a Pending status. After you approve or reject 
a user, that user is eliminated from this list.

User Name Click the name to see more information about the user. 

Request Type What the invitation is for; for example, User Registration. 

Role The user's role as defined by your community; for example, 
Administrator. 

Invitation Name Name of the invitation sent to this person. Click the name to see the 
invitation contents. 
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To approve or reject an invitation
1 Click User Management.
2 In the section that expands, click Invited Users.
3 Find the applicable user(s) in the list.

The default Approval Status for each user is Pending. 

4 For applicable user(s), change the Approval Status to Approve or Reject.
5 Above the Users listing, click Actions > Submit.

A confirmation page opens showing your selections.

Note: For any Invitee you Reject, you must enter an explanation in the 
Reasons for Rejection box.

6 Carefully review the confirmation page, click Actions > Confirm. 
Trading Grid Online immediately generates and sends an email to each invitee, 
notifying them of your approval or rejection. 

Important: 

■ After you reject or approve a user, Trading Grid Online removes that person 
from the Invited Users List. 

■ If you approved the invitee, that person now appears in your “User List” on 
page 313. 

■ If you mistakenly approved a user, you can delete the user from Trading 
Grid Online. 

■ If you mistakenly rejected a user, you must either resend the invitation or 
create and send a new invitation, and the user must re-register.

User Action History
This is an audit log that provides a history and accounting log of activities 
performed by each company user. Querying capabilities let you find activities based 
on various search parameters and view detailed information on their history. 

You can search for activities by: 

Field Description

User Select from the drop-down list showing all users in your Company. 

Date/Time Range Select either a specified range or a “last number of days” option. 

Action Code Select from a comprehensive drop-down list. 

Details Enter text into the box; for example, an ILOG number. 

Service Enter the complete internal ID number of the session. 

Inviting Company Name of the company that sent the invitation.

Tracking ID ID the user was assigned upon registration completion. This ID 
might be used to track the status of a registration; for example, if it 
is still pending approved. 

Date Registered Date the person submitted their registration data. 

Field Description
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You can filter your search results by 

Field Description

User Name Enter the complete name of the user. 
Note: There is one additional entry for OpenText Client Services, 
which filters to all act-on-behalf-of entries. 

Session ID This filter is for a OpenText Client Services help desk associate to 
help you with any problems. A session ID number is assigned to you 
when you log in and determines which actions were performed 
within the user session. 

Action Code Enter the applicable Action Code. 

Service Enter the complete internal ID number of the session. 

Impersonated User This filter is for a OpenText Client Services help desk associate to 
help you with any problems. 

To access user action history
1 On the Account Manager tab, click User Management.
2 The page expands.
3 Click User Action History.

The User Action History page opens.

Trading Relationships
Important: Trading Relationships are handled differently. 

This section describes the company’s Trading Partner Relationships. A Trading 
Partner Relationship defines the unique relationship between your company and a 
business trading partner for each type of document you send or receive 
electronically. This means that you could define several different Trading Partner 
Relationships for each business partner. A trading partner relationship identifies 
who and where they send documents to and receive documents from within the 
Trading Community. 

There are several types of trading partner relationships you can set up.

Topics include:

■ “For Intelligent Web Forms (IWF) Users only”

■ “For IWF Users only”

■ “About your Trading Community”

■ “Current Trading Partner List”

■ “Standard Trading Partnership” on page 326

■ “Open Trade Partnership” on page 330

■ “AutoForward Partnership” on page 333

■ “AutoCopy Partnership” on page 336
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For Intelligent Web Forms (IWF) Users only

For IWF Users only
Your Trading Partnerships were defined when you registered or by your Community 
Manager. Use the Trading Community page to search for, view, modify, or remove 
Trading Partner Relationships. 

Search for Trading Partners 

To search for a specific Trading Partner
See the “Search for Trading Partners” on page 324.

View Trading Partner Data

To view trading partner data
1 On the Account Manager tab, click Trading Community. 
2 Click Company Name.

Details for the Trading Partner display.

Remove a Trading Partner Relationship

To remove a trading partner relationship
1 On the Account Manager tab, click Trading Community. 
2 Scroll through the list of companies or search for the applicable trading partner 

company. 
3 Click Select next to the applicable company.
4 Click Actions > Delete Partnership.

Important: After you delete a partnership, Trading Grid Online:

■ Removes all associated forms, maps, templates for the trading partner. 

■ Retains all the received and sent documents or files until they expire. 

Create a New Trading Partner Relationship

To create a new trading partner relationship
1 You must contact Technical Support. 
2 Click  (Contact) icon to contact technical support by email, telephone, or online 

chat.

About your Trading Community
Trading Grid Online allows you to create and manage trading partnerships by 
providing three types of partnerships. 

■ A Standard Trading Partnership is where you send (and receive) transactions 
with that Trading Partner only. After you set this up, you can then:

■ Automatically forward documents you receive from this partner to other 
users using a distribution list. 
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■ Automatically send a copy of documents you send to this partner to other 
users via a distribution list. 

■ An Open Trade is where you can send (and receive) transactions with any 
Trading Partner within Trading Grid Online. This is the simplest and most 
convenient trading type in that you can trade with other “open” traders without 
having to set up any trading partnerships. An Open Trade 

■ Allows you to exchange documents with any Trading Partner that requests 
to trade with you at that EDI address. 

■ Enforces a 50-50 split billing process. This means your company pays for 
all the transactions that you send and the receiver's company pays for the 
transactions that you receive and for the storage of that mailbox. 

■ A Group Trade is a partnership set up between you and a group EDI addresses 
and then send a copy of documents that you send to this Group to other 
partners using a distribution list. If you set up an Open Trade, the EDI address 
that you specify can send (and receive) interchanges to any trading partner 
within Trading Grid Online. 

Current Trading Partner List

To see a listing of the your current trading partners
1 Click the Account Manager tab in Trading Grid Online. 

The Company Profile page opens.

2 Click Trading Community.
The Trading Community page opens.
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This page displays two listings. The Trading Partners list displays the current 
partnerships and the following information for each Trading Partnership.

Column Description

Mailbox Number The mailbox number(s) associated with this role and partnership.

Trading Partner Identification of the Trading Partner. 

Partner VAN The network used in this partnership.

Partner EDI 
Address
Your EDI Address

The EDI addresses of both your company and the Trading Partner. 
Click the Trading Partner EDI Address to see information about the 
partnership.

Your Role Whether you are a Sender of interchanges or a Receiver of 
interchanges. If you Send and Receive documents with this trading 
partner, two partnerships display for this Mailbox number and trading 
partner.

Partnership Type Type of partnership, where 

Status Current partnership status, where 

The second listing, the Open Tradings list, displays the EDI addresses that have 
open trading. 

Standard Trading Partnership
A standard trading partnership is set up so you can send (and receive) transactions 
with one specific trading partner. This partnership can then be further defined to: 

■ Automatically forwards documents they receive from this partner to other users 
using a distribution list.

■ Automatically sends a copy of documents sent to one partner to other users 
using a distribution list.

To request a standard trading partnership.
1 On the Account Manager tab, click Trading Community.

■ AutoCopy means that Trading Grid Online automatically sends 
one interchange to multiple receivers. 

■ AutoForward means that Trading Grid Online automatically 
forwards interchanges that the you receive to another Trading 
Partner EDI Address(es). 

■ Normal refers to any standard Trading Partnership setup. 

■ Approved means that the trading partnership is currently 
active. 

■ Pending Partner Approval means that the Trading Partner 
has not yet responded to the trading partnership request. 
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The Trading Community Company List page opens. 

2 Do any of the following that apply:
■ If your company has multiple mailboxes, select the applicable mailbox for 

the new partnership from the Mailbox Number list, or select All. 

■ If this is your first partnership, click Request New Partnership.

■ If this is not your first partnership, click Actions > Request New 
Partnership.

The Step 1: Trading Partner Details page opens.
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3 In the Partnership Information section, enter the following information: 

4 In the Billing Information section, select the billing option established by you 
and the trading partner.

5 Click Next Step.
6 Do one of the following:

■ If you entered an Interconnect EDI Partner Address in Step 3 which 
does not currently exist in Trading Grid Online, a message displays.To add 
the EDI partner address, continue with the following three steps. 

1 Click the Add Partner Address link.

Field Description

Partner EDI 
Address

Do the following:
If necessary, click Trade with Specific Partner.
In Partner VAN, do one of the following:

■ Select GXS if trading partner is on the Trading Grid Online 
network.

■ Select Interconnect if trading partner is on another VAN 
service.

In Partner Address, enter the trading partner’s EDI address.

Your EDI Address Do one of the following:
■ Click Single. Type your EDI address or click Browse and 

select the address. 
■ Click Multiple. Click Browse and select the address.

Your Role Click Sender and/or Receiver check boxes based on your 
role(s) in the trading partner relationship.
If you select both Sender and Receiver, Trading Grid Online 
creates two partnerships for this Mailbox number and trading 
partner.

Your Alias Type a name that represents you to the trading partner.
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The Add Interconnect Partner EDI Address page opens. 

2 Enter the following information.

3 Click Submit.
Note: The Step 2: Review page opens.

7 Do any of the following that apply:
■ Review the information.

■ To make any changes, click Previous Step to return to Step 1 page.

■ Make the changes, click Next Step to return to this page.

8 Click Submit.
The Trading Partnership Request Complete page opens.

9 Click Return to Trading Partnership List.
The Trading Partnerships list page opens. The new partnership displays in the list 
with a type of Normal and a status of Pending Partner Approval.

Field Description

Partner EDI 
Address

Type trading partner’s EDI address.

Interconnect Name ?
Use Select drop-down list to select the Interconnect Name.

Company Name Type trading partner’s company name.

Contact First Name Type trading partner’s contact information.

Contact Last Name Type trading partner’s contact information.

Contact Phone 
Number

Type trading partner’s contact phone number.
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To approve or reject, view, modify, or terminate a Standard 
Partnership
You can only modify the billing information. To modify other partnership details, 
you must first delete the current partnership and then create a new partnership 
with the correct details.

1 On the Account Manager tab, click Trading Community.
2 In the Trading Partnerships listing, select the partnership to approve, reject, 

view, change, or terminate. 
3 Do any of the following that apply.

4 Click Save.

Open Trade Partnership
An open trade partnership allows you to send (and receive) transactions with any 
trading partner within Trading Grid Online. Trading documents and/or files with 
other “open” traders does not require a formal partnership setup. An Open Trade 
Partnership:

■ Allows you to exchange documents with any trading partner that requests to 
trade with you at that EDI address. 

■ Enforces a 50-50 split billing process, which means your company pays for all the 
transactions that it sends, and the receiver's company pays for the transactions 
that you receive and for the storage of that mailbox. 

To request an open trade partnership
1 On the Account Manager tab, click Trading Community.

The Trading Community Company List page opens.

To . . . Do this . . .

Approve partnership Click Actions > Approve Partnership.
The partnership status changes to Approved.
Note: Only a partnership with Pending Your Approval can be 
approved.

Reject partnership Click Actions > Reject Partnership.
The partnership status changes to Rejected.
Note: Only a partnership with Pending Your Approval can be 
rejected.

Terminate partnership Click Actions > Delete Partnership.
The partnership is immediately removed from the listing.

View or modify 
partnership

Click Actions > View/Modify Partnership.
The Trading Partnership Details page opens.
Note: You can only modify the billing information. To modify 
other partnership details:
Delete the partnership.
Create a new partnership with the correct details.

Change partnership 
type

To change Partnership to AutoForward, see “AutoForward 
Partnership” on page 333.
To change Partnership to AutoCopy, see “AutoCopy Partnership” 
on page 336.
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2 In the Open Tradings section, do any of the following that apply:
■ If your company has multiple mailboxes, select the applicable mailbox for 

the new partnership from the Mailbox Number list, or select All. 

■ If this is your first partnership, click Request New Partnership.

■ If this is not your first partnership, click Actions > Request New 
Partnership.

The Step 1: Open Trading Details page opens.  

3 In the Partnership Information section, enter:
■ Your EDI Address — Type your EDI address or click Browse and select 

it.

■ Your Role — If you expect to send and receive interchanges, click 
Receiver check box.

4 Click Next Step.
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The Step 2: Review page opens. 

5 Do the following:
■ Review the information.

■ To make any changes, click Previous Step to return to Step 1 page.

■ Make the changes, click Next Step to return to this page.

6 Click Submit.
The Open Trading Request Complete page opens. 

7 Click Return to Trading Partnership List.
The Trading Partnerships page opens displaying the new partnership in the Open 
Tradings listing. 

For each open Trading, the listing displays:

■ Your EDI Address — Click the EDI Address to see information about the 
partnership.

■ Your Role — Displays your role in the partnership; Sender of 
interchanges or Sender and Receiver of interchanges.
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To view, modify, or delete an open trade partnership
1 On the Account Manager tab, click Trading Community. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community.
4 In the Open Tradings listing, select the partnership to view, change, or 

terminate. 
5 Do any of the following that apply:

6 Click Save.

AutoForward Partnership
A group trade partnership allows you to set up a partnership between the yourself 
and a group EDI address. Trading Grid Online then sends a copy of each document 
that you send to this Group to the other partners in the Group via a distribution list. 

The AutoForward partnership feature automatically forwards interchanges that you 
receive to another EDI Address. For example, a large department store sends 
Purchase Orders to you. Your Sales organization requires a copy of the POs, but 
the department store does not sent the POs to them. The AutoForward feature 
automatically forwards the Purchase Orders to the Sales organization on your 
behalf. 

With AutoForwarding, the data flows as follows between trading partners. PartnerA 
sends to PartnerB. OpenText then AutoForwards the data from PartnerB to 
PartnerC. In this scenario, before an AutoForward partnership is set up, there must 
be active trading partnerships between:

■ PartnerA and PartnerB

■ PartnerB and PartnerC

Use the AutoCopy feature to send one interchange to multiple receivers. First, 
create a Distribution List which has its own valid EDI address. Then send an 
interchange to the receiver EDI address, which is the Distribution List. Trading Grid 
Online sends a copy of the interchange to each member in the Distribution List.

Before setting up an AutoCopy Distribution List, active trading partnerships 
between the sender's EDI address and each of the EDI addresses defined in the 
Distribution List must be set up. A partnership between the sender's address and 
the Distribution List EDI address is not required. 

Important: See “AutoForward Implications” on page 334.

Action Do this

Delete Open 
Trading 
(partnership)

Select the partnership, click Actions > Delete Open Trading.
The partnership is removed from the listing.

View/Modify Open 
Trading

1 Select the partnership, click Actions > View/Modify 
Open Trading.

2 View the partnership information.
Note: Only the billing information can be modified. To 
modify other partnership details, the partnership must be 
deleted then recreated with the correct details. 

3 Make changes to the billing information.
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AutoForward Implications
With AutoForwarding, the data flows as follows between trading partners. PartnerA 
sends to PartnerB. OpenText then AutoForwards the data from PartnerB to 
PartnerC. In this scenario, before an AutoForward partnership is set up, there must 
be active trading partnerships between

■ PartnerA and PartnerB

■ PartnerB and PartnerC

Based on this scenario described:

■ When data is AutoForwarded from PartnerB to PartnerC, PartnerC sees the data 
coming from PartnerB, not PartnerA. 

■ When PartnerA sends an interchange to PartnerB, PartnerA's address is in 
the sender's position of the interchange header, and PartnerB's address is 
in the receiver's position. 

■ When OpenText AutoForwards the data, PartnerB's address is placed in the 
sender position of the interchange header and PartnerC's address is placed 
in the receiver position. This is because Partner A did not send to PartnerC; 
PartnerB did. Therefore, the data received by PartnerC must show that 
PartnerB sent it.

■ OpenText sends a copy of the interchange from Partner B to PartnerC. Most 
likely PartnerC creates a Functional Acknowledgment (or control message) 
and sends it back to PartnerB. Unfortunately, since PartnerB's EDI 
Translator software did not send the original document to PartnerC, it does 
not know how to reconcile the FA. 

■ It is OpenText policy that after data is put on the network it becomes the 
property of the receiver. Therefore, only the original receiver (PartnerB) can 
request an AutoForward partnership.

Both senders and receivers can set up AutoForwarding partnerships. 

Note: For an AutoForwarding partnership established by the sender on the 
sender's account, Trading Grid Online does not inform the receiver about the 
partnership, and vice versa.

Set up an AutoForward Partnership
Important: Before setting up an AutoForward partnership, Trading Partnerships 
must exist and be approved between: 

■ The address that sends the interchanges and the address that receives the 
interchanges. 

■ The address that receives the interchanges and the address to which you want 
to forward the interchanges. 

To set up AutoForwarding
1 On the Account Manager tab, click Trading Community. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community > AutoForward 

Partnership.
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4 Click Actions > Create AutoForward Partnership. 
Note: If no listing displays, click Create AutoForward Partnership again.

The Create AutoForward Partnership page opens.

5 In the AutoForward EDI Address section, enter the following:
■ Sender EDI Address — Address from where the interchanges are sent. 

■ Your EDI Address — EDI address that receives the interchanges that you 
forward. 

■ AutoForward EDI Address — EDI address to which the interchanges 
(that are sent from the Sender EDI Address to Your EDI Address) 
should be autoforwarded. 

Note: Use Search to search and select specific addresses. Click Search by 
Company to display a pop-up to enter a partial or complete name, then click 
Search. To view a listing of all companies, click Search without entering any 
search criteria. Then click the company name, and if applicable, select an 
address. 

6 To forward only specific document types, in the Document Type section, 
select the appropriate Envelope Type.
The page refreshes displaying all associated document types in the Available 
Document Types area. 

7 Do one of the following: 
■ To select one document type, select the type then click Add. 

■ To select multiple document types:

1 Press Ctrl and select the types. 
2 Release Ctrl, and click Add. 

■ To select all document types, click Add All. 

The selection displays in Selected Document Type area.

8 To remove document types:
■ Select the type(s) and click Remove.

■ To remove all types, click Remove All.

9 Click Actions > Submit. 
A confirmation message displays. The AutoForward Partnership is created.

10 Use the AutoForward Partnerships page to view this new partnership. 

To view, modify, or terminate an AutoForward Partnership
1 On the Account Manager tab, click Trading Community.
2 Find the applicable company, and click the name. 
3 In the section that expands, click Trading Community > AutoForward 

Partnership.
The AutoForward Partnership listing opens. 
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4 Do any of the following that apply:

5 Click Actions > Submit. 

AutoCopy Partnership
The AutoCopy Partnership is a group trade partnership that you set up between 
yourself and a group EDI address. Trading Grid Online then sends a copy of each 
document you send to this Group to other partners using a distribution list. This 
partnership is similar to the AutoForward Partnership. See “AutoForward 
Partnership” on page 333.

The AutoCopy feature allows you to send one interchange to multiple receivers. 
This is done by creating a distribution list that has its own valid EDI address. So 
when you send an interchange to the receiver EDI address (the distribution list), 
Trading Grid Online sends a copy of the interchange to each of the members in 
that distribution list.

Before an AutoCopy Distribution List is set up, there must be active trading 
partnerships between the sender's EDI address and each of the EDI addresses in 

Action Do this

Delete Partnership 1 Select the partnership, click Actions > Delete.
The confirmation message displays.

2 Click Yes. 
The partnership is immediately removed from the listing. 

View/Modify 
Partnership

Only Document Types are modified. To modify an EDI address, 
you must delete the current partnership, then create a new 
partnership with the correct EDI address.

To add a document type to be forwarded:
1 Select partnership, click Actions > View/Modify.
2 Locate Available Document Type area and do one of the 

following:
■ Select one document type then click Add.
■ Select multiple document types by clicking Ctrl and 

selecting document types. Release Ctrl and click Add.
■ Select all document types by clicking Add All. 
Your selection displays in the Selected Document Type 
area.

To stop a document type from being forwarded:
1 Select partnership, click Actions > View/Modify.
2 Locate the Selected Document Type area and do one of 

the following:
■ Select one document type then click Remove.
■ Select multiple document types by clicking Ctrl and 

selecting document types. Release Ctrl and click 
Remove.

■ Select all document types by clicking Remove All. 
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the Distribution List EDI address. A partnership between the sender's address and 
the Distribution List EDI address is not required. 

Important: See “AutoCopy Implications” on page 337.

AutoCopy Implications 
When sending EDI data, the Distribution List is the receiver EDI Address for your 
data. When Trading Grid Online processes the interchange, the Distribution List 
address is removed from the data and is replaced by an EDI Address from the 
distribution list. This process is repeated for each address in the list. 

The sender might not be able to reconcile Functional Acknowledgements. The 
sender's software typically expects FAs back from the address used in the 
outbound data (the distribution list), but the FAs do not come back to the sender 
from the distribution list address. They come from the trading partner addresses. 
Either the original receivers must prevent FAs being sent back to the sender, or the 
sender has to turn off FA reconciliation.

Use AutoCopy with AutoForward
This feature can also be used in conjunction with an AutoForward partnership. 
When used with AutoForwarding, the data flows as follows between trading 
partners. PartnerA sends to PartnerB. OpenText then AutoForwards the data from 
Partner B to PartnerC. Extending this scenario, you can use a distribution list that 
you create as the PartnerC address in the AutoForward setup. This enables you to 
AutoForward documents from PartnerA to multiple PartnerCs, where each PartnerC 
is defined within the distribution list. 

An AutoCopy Distribution List

To create an AutoCopy distribution list 
1 On the Account Manager tab, click Trading Community. 
2 Find the applicable company and click the name. 
3 In the section that expands, click Trading Community > AutoCopy 

Distribution List.
4 Click Actions > Create Distribution List.

Note: If no listing is displayed, click Create Distribution List. 

The Create Distribution List page opens.

5 Enter the following information. 

Field Description

Mailbox Number Type the number of the Mailbox that receives the interchanges. 

Distribution List 
Address

Type the EDI address that receives the interchanges Trading Grid 
Online copies and sends. 

Member EDI 
Addresses

Type the EDI addresses to which Trading Grid Online should send 
the copied interchanges. 
To add more than 10 addresses, scroll to the bottom of the page, 
then click Add. 

Primary Billing 
Address

Select Primary Billing Address if this EDI address is the 
primary billing address. 
Otherwise, leave this item un-selected.
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6 Click Actions > Submit. 
A confirmation message displays. The AutoCopy Distribution List is created.

7 Use the AutoCopy Distribution List page to view this new partnership. 

To view, modify, or delete an AutoCopy Distribution List
1 On the Account Manager tab, click Trading Community. 
2 Find the applicable company, click the name. 
3 In the section that expands, click Trading Community > AutoCopy 

Distribution List. 
The Autocopy Distribution List page opens displaying all the listing information 
including: 

■ Mailbox Number — Mailbox that receives the interchanges. 

■ Distribution List Address — EDI address that receives the interchanges 
Trading Grid Online copies and sends. 

4 Do any of the following that apply:

5 Click Save.
The Subscription page displays your current subscription details. From this page 
you can view or change your GXS subscriptions (see “To view or update your 
subscription” on page 339). 

Important: Because of the many new and existing Trading Grid Online functions, 
GXS recommends you work with your GXS Representative to modify your 
company’s subscription package.

Action Do this

Delete 1 Select the distribution list, click Actions > Delete.
2 Confirm the deletion.

The distribution list is removed from the listing.

View/Modify 1 Select the distribution list, click Actions > View/Modify.
2 View the distribution list information.

Note: Only the Member EDI Address information can be 
modified. To modify other distribution list information, the 
distribution list must be deleted then recreated with the 
correct details. 

3 Make the changes to the list.
■ To modify a Member EDI Address, delete it, and then 

add the correct one. 
■ To delete a Member EDI Address, select it, then click 

Actions > Delete. 
The address is removed from the list.

■ To add a new Member EDI Address, type the address 
in Add Member EDI Address, then click Add. 

■ To specify whether an address is the primary billing 
address, select or deselect the Primary Billing Address 
option.
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Company Subscription
To view or update your subscription
1 Click the Account Manager tab > Subscription > Current Subscription.
2 If necessary, select the applicable mailbox.
3 Click Actions > View Subscription or Change Subscription Options, 

whichever is applicable.

Mailboxes and EDI Addresses
This section describes how to configure an EDI mailbox. The procedures describe 
how to: 

■ Update the EDI mailbox information.

■ Add other EDI addresses to mailboxes.

■ Specify data retention.

■ Select reports to receive.

Topics include:

■ “Configure EDI Mailboxes” on page 339

■ “Add or Delete Mailbox Addresses” on page 341

Configure EDI Mailboxes

To configure an EDI mailbox
1 On the Account Manager tab, click Service Configuration > Mailbox and 

EDI Address.
The Mailbox and EDI Address Maintenance page opens displaying a listing of the 
EDI Mailboxes are associated with this account.  

2 To configure the mailbox options, select the applicable mailbox. 
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3 Click Actions > Update Mailbox.  

The Mailbox Information page for the selected mailbox opens.  

4 Specify the following information.

Field Description

Mailbox Number Displays the number for the mailbox. This value cannot be 
changed.

Mailbox Alias Do one of the following:
■ To add an alias for the mailbox, type the value.
■ To change the value displayed, delete the existing value and 

enter another value.

Current Mailbox 
Password

Do one of the following:
■ To add a password for the mailbox, type the value.
■ To change the value displayed, delete the existing value and 

enter another value.
Enter the current password for the mailbox.

New Mailbox 
Password

To define a new password for the mailbox, type the password.

Confirm New 
Password

To confirm the password, type the password again.
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5 Click Save.
6 Repeat steps 2-5 for each mailbox associated with the customer account.

Add or Delete Mailbox Addresses
You can only add or delete EDI addresses. To modify an EDI address, you must 
delete the incorrect address and then re-add the correct address, as specified 
below. 

Important: You cannot delete an EDI address if there are trading partnerships 
currently associated with the address. You must check for and terminate any 
associated Partnerships before deleting the EDI address. See “Terminate 
Associated Partnerships” on page 343.

To add addresses in a mailbox
1 On the Account Manager tab, click Service Configuration > Mailbox and 

EDI Address.
The Mailbox and EDI Address page opens listing the EDI Mailboxes that are 
associated to this account.  

2 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.

Trading Partner 
Transaction Report

This report summarizes the transactions and interchanges sent 
and received between you and your trading partners during the 
previous month. The report lists each transaction, a description, 
and the number of KCs for each trading partner.
Click Yes to subscribe to this report. 

Send Meta Data 
Retention Period

Specify the number of days to retain meta information on data 
sent from your mailbox/EDI address.

Transaction 
Retention Period

Specify the number of days each transaction interchange should 
remain in your mailbox, up to a maximum of 45 days. 
Note: This option might have billing implications. GXS 
recommends you contract your OpenText sales representative 
before selecting this option. 

Field Description
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The EDI Address List page opens.  

3 Scroll down to the Add New EDI Address area and enter the information.
4 Click Add.

A confirmation message displays.

5 Click Return to EDI address list link.
6 Repeat Steps 2-4 to add additional addresses to the mailbox.

This completes the adding EDI addresses to a mailbox procedure.

To delete an EDI address from a mailbox
1 On the Account Manager tab, click Service Configuration > Mailbox and 

EDI Address.
The Mailbox and EDI Address page opens displaying a listing of the EDI Mailboxes 
associated with this account.  

2 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.
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The EDI Address List page opens. 

Important: You cannot delete an EDI address if there are trading 
partnerships currently associated with the address. You must check for and 
terminate any associated Partnerships before deleting the EDI address. See 
“Terminate Associated Partnerships” on page 343.

3 Locate applicable EDI address.
4 In Associated Partnerships? column, click the applicable view partnership 

link. 
5 Select the address to delete.
6 Click Actions > Delete EDI Address.

A confirmation message displays.

7 Click OK.

Terminate Associated Partnerships
Before deleting an EDI address, you must first verify whether any associated 
partnerships exist that reference the EDI address. If partnerships do reference the 
address, then the partnerships must be terminated so the EDI address can be 
deleted.

To verify and terminate associated partnerships
1 On the Account Manager tab, click Service Configuration > Mailbox and 

EDI Address.
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The Mailbox and EDI Address Maintenance page opens.  

2 In the Number of EDI Addresses column, click the number for the applicable 
mailbox.
The EDI Address List page opens displaying the EDI addresses and associated 
partnerships for the selected Mailbox number.  

3 Locate the EDI address that needs to be deleted.
4 Do one of the following:

■ No link displays in the Associated Partnerships? column, close the page 
and continue to “Add or Delete Mailbox Addresses” on page 341.

■ The View partnership link displays in Associated Partnerships? 
column, click the link.

Identify the partnership(s) that need to be terminated then return to the 
Mailbox and EDI Address Maintenance page. Continue to step 5.

5 Click Trading Community. 
The EDI Address list page opens.

6 Terminate the partnership(s).
7 Continue to “Add or Delete Mailbox Addresses” on page 341.
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Service Contacts
Service Contacts is a centralized area where you define who is to:

■ Receive specific email notifications at the company level

■ Be the default contact for service messages and outages

■ Be notified as a result of the rules and alerts you later define for your 
mailbox(es)

Important: All contacts to be notified as a result of rules and alerts defined in 
Event Management must be set up using Service Contacts. 

Topics include:

■ “Define Service Contacts” on page 345

■ “Re-Assign a Default Contact” on page 347

■ “Remove a Default Contact” on page 347

■ “View, Change, or Delete a Contact” on page 348

Define Service Contacts

To define service contacts
1 Click the Account Manager tab > Service Configuration > Service 

Contacts.
The Service Contacts page opens. It lists any contacts that have been defined. For 
each contact, the listing shows:

■ First and last name.

■ A list of alerts the person is contacted about (Contact Type column).

■ If the person is a Default contact. Trading Grid Online automatically 
designates the Technical Contact entered in the Company Profile as the 
default contact. You can change the default contact (see “Re-Assign a 
Default Contact” on page 347).

■ If the person is currently active (In-Use column).

2 Click Actions, and click Add New Contact.  

The Create New Contact Service page opens.
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3 Enter the required information.  

4 Optionally, select the Contact Type(s), or which contacts should receive 
notification(s) in addition to service messages and outages. 
Note: Based on the company’s service subscription, you might not see all the 
options listed. If in doubt, check with your OpenText sales representative.

■ For Intelligent Web Forms (IWF) Users:

■ Invitation — Contact receives subsequent invitations, such as invites 
for the company to connect to an additional IWF hub sponsoring new 
forms. IWFS customer only.

■ Incoming Document Alert — ”Whenever a new document arrives in 
your Document Inbox” rule. 

■ Incoming File Alert — ”Whenever a new file arrives in your File 
Inbox” rule.

■ For Trading Grid Online Messaging Service Users:

■ Arrival Alerts — ”Whenever a document interchange arrives in your 
mailbox” rule. 

■ FA Delinquency — ”Whenever a trading partner has a delinquent FA” 
rule. 

■ Inactivity Alert — ”Whenever a mailbox is inactive” rule. 

■ Mailbox Error Alert — ”Whenever a mailbox processing error occurs 
on an outbound interchange” rule. 

Note: When you select an option for a customer contact, Trading Grid Online 
automatically adds the contact to the notification list for alerts you create later. 
For example, if you subscribe to and select Arrival Alert for this contact, and 
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define a rule to generate an alert when a partner has one or more documents 
that need acknowledgment, Trading Grid Online automatically notifies this 
contact. If you later delete the contact, Trading Grid Online automatically 
deletes the contact from the Arrival notification list. 

5 Enter the Email Address for the contact. If the address is for a pager, select 
This is a Pager address.

6 Click Submit. 
The Service Contact Request Complete page opens.

7 Click the Return to Service Contacts List link. 
The new contact displays in the list on the Service Contact page.  

Re-Assign a Default Contact
Important: You must designate one default contact who receives notifications for 
service messages and outages. Initially, Trading Grid Online assigns the Technical 
Contact from your Company Profile as the default contact. 

To re-assign the default contact
1 On the Account Manager tab, click Service Configuration > Service 

Contacts.
2 Select the contact you want to make the default contact, and click Actions > 

Set as Default Contact.
Trading Grid Online reassigns the default contact from the previous person to the 
one specified. 

Remove a Default Contact
Important: Only one contact is the default contact.

To remove a default contact
To delete a contact that has the default role, first assign a new default contact, 
and delete the previous default contact.
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View, Change, or Delete a Contact

To view, change, or modify a contact
1 On the Account Manager tab, click Service Configuration > Service 

Contacts.
2 Select the contact you want to view, modify, or delete. 

Important: To delete a default contact, you must first assign a new default 
contact; see “To re-assign the default contact” on page 347.

3 Perform the appropriate action:

4 Click Submit. 

To . . . Do this

Delete the contact Click Actions, and click Delete.

View or modify the 
contact

1 Click Actions, and click View/Modify.
The Modify New Service Contact page opens.

2 Change the contact’s information.
3 (Optional) Change the Contact Type(s), or which contacts 

should receive notification(s) in addition to service messages 
and outages. 

4 Based on your service subscription, you might not see all the 
following options:
■ Arrival — ”Whenever a document interchange arrives in 

your mailbox” rule. 
■ FA Delinquency — ”Whenever a Trading Partner has a 

delinquent FA” rule. 
■ Incoming Document — ”Whenever a new document 

arrives in your Document Inbox” rule. 
■ Incoming File — ”Whenever a new file arrives in your 

File Inbox” rule.
■ Mailbox Inactivity — ”Whenever a mailbox is inactive” 

rule. 
■ Mailbox Outbound Error — ”Whenever a mailbox 

processing error occurs on an outbound interchange” 
rule. 

Note: When you select an option for the contact, Trading Grid 
Online automatically adds the contact to the notification list for 
that alert in Event Management. 
For example, if you previously subscribed to and select the FA 
Delinquency for this contact, and in Event Management you 
define a rule to generate an alert when a partner has one or 
more documents that need acknowledgment, Trading Grid Online 
automatically notifies this contact. If you later delete the contact, 
Trading Grid Online automatically deletes the contact from the FA 
Delinquency notification list. 
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Messaging Service Alerts and Options
Trading Grid Online lets you define the rules and policies to determine when 
trading partners are compliant or non-compliant based on these rules and policies. 
Compliancy or non-compliancy is reported in the Reports component under 
Functional Acknowledgement Management and Transaction Alerts. 

Important: Whether or not you see these alerts or options depends on if your 
company has subscribed to the optional alert services (extra fee might apply). If in 
doubt, check with your OpenText sales representative.

For each customer mailbox, you can set up one or more of the following: 

■ Business Calendar option — The days the customer considers “working” or 
“business” days for each of your EDI mailboxes.

■ Arrival Alert — When a document is placed in the mailbox, Trading Grid Online 
sends the customer a message. You can request the alert for specific document 
types, specific trading partners, or both. You can also route the alert to different 
individuals within the customer company based on document type or trading 
partner or both. This is useful for a user that checks his/her mailbox infrequently 
but wants to respond to orders from key clients as soon as possible.

■ Mailbox Outbound Error Alert — If the customer sends a document to 
Trading Grid Online Messaging Service and it fails to process, Trading Grid Online 
alerts the customer. This enables the customer to correct the problem 
immediately. 

■ Mailbox Inactivity Alert — If the customer does not receive documents in the 
mailbox according to a schedule that you define, Trading Grid Online alerts the 
customer, allowing him to determine if a problem exists.

■ Mail Slots option — Mail slots separate documents you receive according to 
business process needs.

■ Password Policy — You can impose a more restrictive password policy than 
what the customer has defined. 

Important: In order for the alerts to function properly, you must configure all 
alerts the customer subscribes to. 

Topics include:

■ “Define the Alerts” on page 349

■ “FAM Alerts and Report Options” on page 358

Define the Alerts
Important: For alerts to function properly, you must configure all alerts you 
subscribed the customer to. Based on your subscription, you might need to 
configure all or some of alerts.

To define customer alerts
1 On the Account Manager tab, click the applicable Customer Company Name.
2 On the Company Profile page, click Service Configuration.
3 On the left side of the Service Configuration page, click Event Management.
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The Transaction Event and Rules and Alerts page opens.   

From here you can define: 

■ “Business Calendar” on page 350

■ “Inactivity Alert” on page 352

■ “Arrival Alert” on page 354

■ “Mailbox Error Alert” on page 356

Business Calendar
Note: Business Calendar applies only to Inactivity Alerts. If you are not defining 
an Inactivity Alert, go to “Arrival Alert” on page 354 or “Mailbox Error Alert” on 
page 356.

To define the Business Calendar
1 Open the Transaction Event and Rules and Alerts page. See “Define the Alerts” 

on page 349.
2 In the Mailbox Specific Alerts section, for Rule type select Business 

Calendar. 
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3 Select the Mailbox to apply the calendar to, then click Configure. 

4 On the Business Calendar page enter the following.
■ Working Days — Days to consider as “working” or “business” days. 

Inactivity alerts process Working Days only. 

■ Time Zone — Select the time zone for your community.

■ Daylight saving time observed — Select this if your community 
observes Daylight Savings Time.
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■ Holidays — Days Trading Grid Online should ignore as non-Working Days. 
Use any days, not only holidays. Click the calendar icon to select each 
holiday date.   

5 Click Save. 
Repeat these steps for each mailbox.

Inactivity Alert

To create an inactivity alert
1 Open the Transaction Event and Rules and Alerts page. See “Define the Alerts” 

on page 349.
2 In the Mailbox Specific Alerts section, enter the following information.

a From the Rule type drop-down list, select Inactivity Alert.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
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The Mailbox Inactivity Alert page opens. 

3 Make sure the Enable Event Rule option is selected.
4 Enter the following information.  

Field Description

Apply the Business 
Calendar

Select this check box to have mailbox inactivity measured only 
during working hours on working day, excluding holidays, as 
defined in the “Business Calendar” on page 350.
Otherwise, mailbox inactivity is measured 7 days a week.

The Range for Receiving Alerts

Start Time Enter the start time for receiving alerts.

Stop Time Enter the stop time for receiving alerts.

Time Zone Displays the time zone previously defined.

Mailbox Inactivity Alert Details
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5 Click Save.
6 Repeat these steps for each mailbox.

Arrival Alert
Use this procedure to create an arrival alert.

To create an arrival alert
1 Open the Transaction Event and Rules and Alerts page. See “Define the Alerts” 

on page 349.
2 In the Mailbox Specific Alerts section, enter the following information.

a From the Rule type drop-down list, select Arrival Alerts.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
3 Do one of the following:

■ Click Add Arrival Alert

■ Click Actions > Add Rule.

Inactivity Length Enter the number of hours the mailbox is inactive before Trading 
Grid Online generates a notification.

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define Service Contacts” on page 345. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Mailbox Inactivity 
Contact(s) check box. To display the contact information, 
click the Mailbox Inactivity Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

If a contact does not display in the list, you must define that 
contact. See “Define Service Contacts” on page 345. 
To remove a contact from the Other Contacts list:

1 Click the Other Contacts check box > Modify List.
The list of service contacts displays.

2 Deselect the contact from the list, and then click Submit.

Field Description
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The Add Arrival Alert page opens. 

4 Make sure the Enable Event Rule option is selected.
5 Enter the following information.

Field Describe

Document Type Select a Document Type for the rule. 
1 Click Browse. 
2 Find the document type, then click the Select check box.

The selected value displays in Document Type field.

Partner EDI 
Address

Enter the partner’s EDI address.
1 Click Search by Company.
2 Do one of the following:

■ Type a partial or complete name in the pop-up then click 
Search.

■ Leave the field blank then click Search to view a listing 
of all companies.

3 Click Select.
4 Select the company name and an address.

The selected value displays in Partner EDI Address field.
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6 Click Submit.
7 Repeat these steps for each mailbox.

Mailbox Error Alert

To create a mailbox error alert
1 Open the Transaction Event and Rules and Alerts page. See “Define the Alerts” 

on page 349.
2 In the Mailbox Specific Alerts section, enter the following information.

a From the Rule type drop-down list, select Error Alert.
b From the Mailbox drop-down list, select the mailbox to which this rule 

should apply, then click Configure.
The Mailbox Outbound Error Alert page opens. 

Your EDI Address Enter your EDI address.
1 Click Browse. 
2 Find the address this rule to, then click the Select check 

box.
3 Click Select.

The selected value displays in Your EDI Address field.

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define Service Contacts” on page 345. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Arrival Alerts 
Contact(s) check box. To display the contact information, 
click the Arrival Alerts Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

■ If a contact does not display in the list, you must define that 
contact. See “Define Service Contacts” on page 345. 

To remove a contact from the Other Contacts list:
1 Click the Other Contacts check box > Modify List.

The list of service contacts displays.
2 Deselect the contact from the list, and then click Submit.

Field Describe
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3 On the Mailbox Outbound Error Alert page, check the Enable this Event Rule 
checkbox.  

4 Enter the following.

5 Click Submit.
6 Repeat these steps for each mailbox.

Field Description

Notify Contact These are the customer’s contacts previously defined in the 
Service Contacts list. See “Define Service Contacts” on page 345. 
Do any of the following:

■ To have the default contact receive the alert, click the 
Default Contact check box. To display the contact 
information, click the Default Contact link.

■ To have the contacts, previously designated as contact for 
this alert, receive the alert, click the Mailbox Outbound 
Error Contact(s) check box. To display the contact 
information, click the Mailbox Outbound Error 
Contact(s) link.

■ To have someone else receive the alert, click the Other 
Contacts check box then click Modify List.
A list of all your service contacts displays.
Select a contact from the list, then click Submit.

■ If a contact does not display in the list, you must define that 
contact. See “Define Service Contacts” on page 345. 

To remove a contact from the Other Contacts list:
1 Click the Other Contacts check box > Modify List.

The list of service contacts displays.
2 Deselect the contact from the list, and then click Submit.
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FAM Alerts and Report Options
The Functional Acknowledgement Management (FAM) service provides you with a 
series of reports and generates notifications for delinquent FAs. 

Important: For each mailbox, you must define the conditions under Trading Grid 
Online should generate an email notification and report data. 

Topics include: 

■ “Define or Modify a Rule” on page 358

■ “Enable a Specific Rule” on page 359

■ “Disable (but Do Not Delete) a Specific Rule” on page 359

■ “Enable/Disable All Rules” on page 360

■ “Delete a Rule” on page 360

Define or Modify a Rule

To define or change a rule 
1 Click Service Configuration.
2 In the section that expands, click Event Management.
3 On the Transaction Events Rules and Alerts page, in the Rule Type dropdown, 

select FA Delinquency, and in the Mailbox dropdown, select your first 
mailbox.

4 Click the Configure link. 
5 On the Functional Acknowledgement Rules page, do one of the following:

■ To add a new rule, click Add Rule. 

■ To modify a rule, select the rule, click Actions > Modify. 

Important: Make sure the Enable this Event Rule option is selected. If it is 
not, you cannot add or modify rule data.

6 In the Tracking Type section, select either 
■ Included for Tracking — Default. Usually select this option. It includes 

all transactions that meet the rule conditions. 

■ Excluded for Tracking — Select this to exclude from notifications and 
reports the transactions that meet the conditions in this rule. With this 
option, you cannot enter any Tracking Policy conditions because they do 
not apply. 

7 (Optional) Enter data in the Rule Conditions section. To select a specific 
Document Type for the rule, click Browse, find the type, and double-click it. 
You can search and select EDI addresses. If you select a Partner EDI 
Address, Trading Grid Online automatically populates the Trading Partner 
field.

8 In the Tracking Policy section, you can select these options:
■ Apply the Business Calendar — Select this option to apply the rule on 

"working days" as defined in your Business Calendar.

■ Functional Acknowledgement address must match original 
transaction address — Select this option to exactly match addresses 
between the FA and original transaction.
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9 Define the Delinquency Policy for this rule as follows: 
■ Time to Delinquency — Number of hours after receipt that the Trading 

Partner must acknowledge all documents or document groups. 

■ Notify Contact — Specify who to notify. 

Note: These are contacts in your Service Contacts list. 

■ For the Default Contact to receive the alert, click the check box. Click 
the Default Contact link to see contact information. 

■ For the designated Alert Contact(s) to receive the alert, click the check 
box. Click the Alert Contacts link to see contact information. 

■ For someone else to receive the alert, select the Other check box, then 
click Modify List. A list of all your service contacts displays. Select a 
contact, then click Submit. 

■ To remove a contact from this list, click Modify List. Deselect the 
contact, then click Submit. 

■ If you do not see the contact you want, define that contact using the 
“Service Contacts” procedures. 

10 Notify Trading Partner Contact — Select this option for Trading Grid Online 
to send a notification to the Trading Partner. 

11 Define the Escalation 1 policy, that is, the action to take when the Time to 
Delinquency expires. Time for Delinquency is the number of hours the 
Trading Partner has to acknowledge the document(s) before Trading Grid 
Online again escalates it. 

12 Specify the contacts to notify for this escalation.
13 Define the Escalation 2 policy, that is, the action to take when the Escalation 

1 Time from Delinquency expires. This Time for Delinquency is the 
number of hours the Trading Partner has to acknowledge the document(s) 
before Trading Grid Online escalates it for the final time. 

14 Specify the contacts to notify for this final escalation.
15 Click Submit.

Enable a Specific Rule

To enable a rule
1 Click Service Configuration. In the section that expands, click Event 

Management.
2 On the Functional Acknowledgement Rules page, select the rule

Note: Its status must Disabled. 

3 Click Actions > Modify. 
4 Deselect the Enable this Event Rule option. 
5 Click Actions > Save.

Disable (but Do Not Delete) a Specific Rule

To disable a rule
1 Click Service Configuration.
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2 Click Event Management.
3 On the Functional Acknowledgement Rules page, select the rule.

Note: Its status must Enabled. 

4 Click Actions > Modify. 
5 Deselect the Enable this Event Rule option. 
6 Click Actions > Save.

Enable/Disable All Rules

To enable or disable all rules
1 Click Service Configuration > Event Management.
2 On the Functional Acknowledgement Rules page, in the Functional 

Acknowledgement Rules dropdown, select one of the following:
■ Turn on all rules to enable all rules 

■ Turn off all rules to enable all rules

3 Click OK. The page redisplays showing the new status for all rules.

Delete a Rule

To delete a rule
1 Click Service Configuration > Event Management.
2 On the Functional Acknowledgement Rules page, select the rule.
3 Click Actions > Delete.
4 Click OK.

Active Document Status Alerts
For outbound transactions, the company administrator can set up email status 
alerts that indicate key events — such as message receipt, processing, delivery, or 
extraction by a Trading Partner — associated with files and documents moving 
through the GXS environment. 

Topics include: 

■ “Define an alert” on page 360

■ “Active Document Data Policies” on page 362

■ “Customize Key Names/Labels” on page 363

Define an alert

To define an alert
1 Click the Account Manager tab in Trading Grid Online.
2 On the Company Profile page, click Service Configuration.
3 In the Service Configuration page, click Event Management. 

The Status Alert Rules page lists alerts and whether or not they are enabled.
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4 To create a new alert, click Create. 
A new page opens. 

5 Define the rule parameters. 

6 Select the Event Type to send an alert for. Event types are: 

7 Enter occurrence, error, and timing information for the Event Type:

Field Description

Rule Name Enter a descriptive name for the rule. 

Enable Rule Make sure that this box remains checked, or the rule is 
disabled.

Document Type If applicable, enter the EDI document type(s) or the 
APRF for non-EDI or binary files. Optionally, click the 
adjacent icon to select a document type. Standards 
currently supported are ANSI X12, EDIFACT, and 
Tradacoms.

Partner Address
My Address

Enter the applicable EDI addresses.

Direction Specify the transaction direction relative to the address 
in My Address. Select the type of direction for this 
rule:

■ Sent from this address — Default. Applies to 
outbound transactions. 

■ Received for this address — Applies to inbound 
transactions.

Do not track Event 
types/Notifications

Select this option to exclude the Trading Partner from 
all Status Alert Rules.

Order Notifications
[Delivery status file via 
Global Platform]

Select this option to generate alerts in the order that 
Event Types are presented in the next step. Alerts are 
delivered as a file. 
If you do not select this option, alerts are generated as 
the events are received, which might or might not be 
in the order that events are processed.

Event Type Description

Accepted by GXS The file/document has been received by GXS from the 
Trading Partner's system.

Mailboxed by GXS The Global Platform mailboxed the translation output 
file for delivery to the Trading Partner.

Processed by GXS The Global Platform successfully processed the 
customer application file with a custom script.

Translated by GXS GXS completed the translation process on the file or 
document. 

Extracted by my Partner The Trading Partner has extracted the document from 
the mailbox or the interconnect. This event is available 
only for transactions that travel through TGMS.

Received by my Partner The file/document has been delivered to the Trading 
Partner's destination.
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■ Notify when this occurs — Select to generate an alert when the event is 
received. 

■ Notify me if there is an error or if this has not occurred . . . — Select 
to notify if one of the following occurs. 

■ An error. 

■ The event has not occurred within a time period after a specific, 
previous event completed. This is referred as a negative status. Specify 
the number of minutes, hours, or days, then select the event type that 
the time period refers to. 

8 Enter delivery information for the Event Type: 
■ Send to service contacts — Select this to send an email alert to all 

Service Contacts designated to receive alerts. 

■ Delivery status file via Global Platform — Select this to send an alert 
file to the address specified in the Receiver field. Optionally, you can 
select the Include additional details option to include more detailed 
information such as document, functional group, and interchange in the 
alert file. 

9 Repeat these steps for each event to include in the rule.
10 Click Save.

Active Document Data Policies
Active Documents supports policy-based data access restrictions for users. Each 
company can define data filter policies based on sender and receiver addresses, 
document types, and other data elements, and assign users to those policies to 
limit which sets of transaction data they can view and work with in Active 
Documents. 

To define an Active Documents data policy
1 Click Service Configuration > Policy Definition.
2 On the Policy Definition Listing page, click Create.
3 On the Create Policy Definition page, enter the Definition Name and a short 

Description.
4 In the Template Name dropdown, select the applicable template. The page 

adds fields.
5 Enter the applicable values. 

Notes: 

■ You can enter more than one value in each field. 

■ Separate each value with a comma.

■ Do not surround the comma with any leading or following spaces.

6 To assign users to see what this policy generates, click the Assign Users tab.
7 Click Save.
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Customize Key Names/Labels
You can define custom labels for your keys, then use the labels to search those 
keys. Use this procedure to define key names rather than use the predefined 
names. 

Important: Once you define a custom key name, you must define custom key 
names for ALL of your keys, as you will not see any of the system-predefined key 
names.

To define a key name
1 Click Service Configuration > Custom Key Names.
2 Click Add.
3 In the Add New Key page, enter the data.  

■ Level (required) — Select the applicable option:

■ Document — Data is transformed into (or from) EDI format.

■ File — Data is transformed between two custom data formats. 

■ Element Name (required) — From the drop-down menu, select the 
applicable element key name to replace. 

Note: Existing key names are case-sensitive. Select the correct 
version of the key name for your data.

■ Custom Key Name (required) — Enter a unique name to use for this key.

■ Direction (required) — Select the direction(s) when the custom key name 
applies.

The remaining fields are optional. You can limit the use of the new custom key 
name to one of your own addresses, and/or a specific trading partner’s 
address, and/or document type. Click the dropdown to select a value.
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4 Click Save, or to add this key to the list and define a new key, click Save & 
New.

Active Invoice Legal Profiles
If your company subscribes to the Active Invoices with Compliance (AIC) Active 
Invoices with Compliance (AIC) service, you must define and maintain the 
applicable legal profile(s), as nearly every country in the world has legislation to 
regulate electronic invoicing. While these regulations are often similar in purpose, 
specific requirements can vary by country. For example, data archiving 
requirements vary between six and eleven years, depending on which countries 
are involved with the invoice. 

You must define a profile for each of your company's entities — that is, each of 
your divisions, sub-divisions, branches, plants, etc. —  in each country where they 
have a valid Value Added Tax (VAT) or Tax ID number. 

For example, a company that with headquarters in the United States, branch 
offices in Italy, France, and Spain, and manufacturing plants in Brazil and Mexico 
would need to define six profiles — one for each country. 

A legal profile:

■ Identifies the default type of input the buyer receives.

■ Determines the period of time that invoices are available in the Invoice Archive.

■ Provides delivery options, including Secure Email Delivery.

■ Specifies contacts that receive email notifications about invoice processing.

■ Provides options for suppliers to display a logo and define additional content on 
invoice input.

Topics include: 

■ “Define a Legal Profile” on page 364

■ “Maintain Legal Entity Relationships” on page 375

Define a Legal Profile
You can define one or more Legal Entity profiles (sender or receiver) for a Business 
Unit. A Legal Entity is the record of the unique Buyer (receiver) or Supplier 
(sender) party, typically from a tax registration perspective, that exchanges 
compliant invoices through AIC. This is a company or a business unit or division 
within a company. 

To define your legal profile(s)
1 Login into the GXS Trading Grid Online.
2 Click Account Manager tab > Service Configuration. 
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3 Click Legal Profile. The Legal Profile List page opens.  

Note: Depending on if you are a sender or receiver, and who you are creating 
a Profile for, you might not see all of the following options or steps.

4 On the Legal Profile list page, to modify a legal profile, in the Legal Profile 
Name column, click the profile, then go to the next step.
To create a new legal profile, click one of the following, which depends upon 
the subscription chosen by your Business Unit. 

Create Option Subscription Description

Sender 
(Subscriber) Legal 
Profile

AIC Sender Click if your Company is a Supplier Hub, that is, a 
corporate sell-side organization (Hub), which is 
proactively planning to push compliant electronic 
invoices out to its customer community, and your 
Company is focused on the Accounts Receivable 
benefits of electronic invoice compliance.

Receiver 
(Subscriber) Legal 
Profile

AIC Receiver Click if your Company is a Buyer Hub, that is, a 
large corporate buy-side organization (Hub), 
which is proactively mandating electronic invoice 
compliance to its Supplier community, and your 
Company is focused on the Accounts Payable 
benefits of electronic invoice compliance.

Create Receiver 
(Non-Subscriber) 
Legal Profile

Click if your company is a Supplier to a buying 
company that has requested compliant e-invoices, 
but the buying company is not using GXS AIC.

Create Sender 
(Non-Subscriber) 
Legal Profile

Click if
■ Your company is a buying company that has 

requested compliant e-invoices.
■ The Supplier company is not using GXS AIC.
■ You are using the Non-Sign EDI invoice 

process type with this Supplier.

Non-GXS Receiver 
Legal Profile

AIC Sender Click if you have a trading relationship with Buyer 
who is not a GXS customer, but uses the AIC 
service.

Non-GXS Sender 
Legal Profile

AIC Receiver Click if you have a trading relationship with 
Supplier who is not a GXS customer, but uses the 
AIC service.
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The buttons to create legal profile are based on the subscription chosen by the 
respective Business Unit (BU) / company, as follows.

■ Create Sender (Subscriber) Legal Profile and Create Non-GXS 
Receiver Legal Profile apply to an AIC Sender subscription.

■ Create Receiver (Subscriber) Legal Profile and Create Non-GXS 
Sender Legal Profile apply to an AIC Receiver subscription.

■ Create Receiver (Subscriber) Legal Profile, Create Sender 
(Subscriber) Legal Profile, Create Non-GXS Receiver Legal 
Profiles, and Create Non-GXS Sender Legal Profile are seen

For creating legal profile for Receivers, click Create Receiver (Subscriber) Legal 
Profile.

5 On the Legal Profile as . . . page, enter or modify the data to modify or define 
the profile. In the Legal Entity Information section, enter the required 
information about the location of the division, plant, or other entity for the 
profile.
For Legal Entity Unique ID, enter a unique combination of letters and/or 
numbers. A Legal Entity is the record of the unique Buyer or Supplier party, 
typically from a tax registration perspective, that exchanges compliant invoices 
through AIC. This is a company or a business unit or division within a company. 

For example, if Company ABC operates in three European countries and is 
registered as a unique tax entity all three, it would have three legal entities in 
AIC.  

6 Be sure to select the Country. The Country drop-down menu has 2 sections. 
■ First the COMPLIANT countries are listed. These countries have a set of 

standards for doing business, as defined by its legal entity.

■ Then, the NON-COMPLIANT countries are listed. These countries have 
no specific defined standards.

7 In the Contact Information section, enter at least one contact.  
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8 To enter one or more of your previously defined Service Contacts:
a Click Select Existing Service Contacts.
b Select the applicable contact(s), then click Select.

9 To define a new contact:
a Enter the data for the first contact. All fields are required. Locale refers to 

the preferred language of the contact, not a country. 
b Click Add. This is required to save the contact. 

10 Repeat the previous two steps to add additional contacts.
Note: The system assigns a Contact ID to each contact; this is an internal ID 
for system use only. 

Important: If you have only one contact and want to replace it, add the new 
contact, make it the default contact, then remove the old contact. 

11 Click Submit to save changes. Options display.
Important: GXS strongly recommends that you consult with your GXS 
Account Manager before selecting the remaining options.

12 In the Signing Information section, specify the Process Type, that is, the 
output format in which to deliver signed invoices. Based on the Country 
selected, and the type of the Legal Profile, you will not see all of the following 
options. Select an option. 

Process Type Option Description

Active Invoice Archive Archives all signed and non-signed invoice documents 
and related artifacts without any validation checking, 
duplicate invoice number checking, or invoices sent to 
a recipient. 
In the Legal Entity Information section, if you 
selected a NON-COMPLIANT country, you must 
select this option.

Active Invoice Archive Archives all signed and non-signed invoice documents 
and related artifacts without any validation checking, 
duplicate invoice number checking, or invoices sent to 
a recipient.

Active Invoice for Latin 
America with and without 
Duplicate Check

Applies to signed invoices in the countries of Mexico, 
Brazil, and Turkey for invoice processing requiring 
approval from Tax authorities. This process applies 
digital signatures to the invoice documents (PDF or 
any other format). AIC then sends a PDF version of 
the signed invoice. 
This process is available with or without the duplicate 
invoice number check feature for invoice documents; 
select the applicable option.

Active Invoice Non Sign With 
Human Readable Image and 
Signed PDF container

Same as Active Invoice Non-sign with Human 
Readable Image with a PDF “container” created to 
sign the invoices and then to send or archive these 
invoices with their related “artifacts,” or data, via PDF 
file(s).

Active Invoice Non Sign With 
Human Readable Image and 
Unsigned PDF container

 Same as Active Invoice Non-sign with Human 
Readable Image with a PDF “container” created to 
send or archive unsigned invoices with their related 
“artifacts,” or data, via PDF file(s).
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Active Invoice Non-sign with 
Human Readable Image

Same as Active Invoice Non-signed EDI except 
that a PDF document (human readable image) of the 
invoice is generated and sent to the recipient.

Active Invoice Non-sign with 
Human Readable Image 
without Duplicate Check

 Same as Active Invoice Non-sign with Human 
Readable Image except that a duplicate invoice 
number check is not performed on invoice documents.

Active Invoice Non-signed 
EDI

AIC receives only EDI invoice documents that are not 
digitally signed. AIC forwards the EDI documents to 
the recipient after content validation.The duplicate 
invoice number check feature is also performed on the 
invoice documents. Duplicate checking ensures that a 
Sender cannot send multiple invoices with same 
invoice number within the Sender’s fiscal year.
AIC also generates:

■ Summary List — list of all transactions 
performed by the customer in a day

■ Trading Partner List — list of trading partners 
with whom the customer has performed 
transactions.

Note: For non-signed invoices, there is an additional 
requirement to maintain the Trading Partner List and 
Summary List. An active relationship between two 
legal entities (Receiver and Sender) is mandatory for 
them to exchange invoices; otherwise the invoices are 
rejected.

Active Invoice Non-signed 
without Duplicate Check

Same as Active Invoice Non-signed EDI except 
that the invoice number duplicate check is not 
performed on invoice documents.

Active Invoice Sign AIC digitally signs the invoices on behalf of a Sender, 
provided the Sender is also selected this Process 
Type. Digital signatures are applied to the invoice 
(PDF or any other format). AIC then sends a PDF 
version of the signed invoice.

Active Invoice Sign with 
Duplicate Check

Same as Active Invoice Sign with an added 
duplicate invoice number check feature performed on 
the invoice documents. Duplicate checking ensures 
that a Sender cannot send multiple invoices with the 
same invoice number within the Sender’s fiscal year.

Active Invoice Sign with 
Duplicate Check and TP 
Report List

Same as Active Invoice Sign with TP Report List 
with an added duplicate invoice number check feature 
performed on the invoice documents. Duplicate 
checking ensures that a Sender cannot send multiple 
invoices with same invoice number within the Sender’s 
fiscal year.

Active Invoice Sign with 
Signed PDF container

Same as Active Invoice Sign with a PDF “container” 
created to sign the invoices and then to send or 
archive these invoices with their related “artifacts,” or 
data, via PDF file(s).

Active Invoice Sign with TP 
Report List

Same as Active Invoice Sign with an added Legal 
Entity Relationship check that generates a list of 
trading partners associated with the Sender.

Process Type Option Description
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If you selected Active Invoice Sign, the page redisplays.  

a In the Digital Signature Information section, click Select/Update 
Digital Signature Information to enable the Digital Signature 
Information page for selecting the Document Format / Sign Format / 
Job Type for Domestic invoices (sender and receiver are in the same 
country) or Cross Border invoices. 

Note: The Default combination (PDF / PDF / CADEASA) is marked 
with a check mark, but it must be selected to populate the Legal Profile.  

Scroll down to the next section to select the combination for Cross-
Border invoices (sender and receiver are in different countries).

Scroll to the bottom and click Select to add your selections. 

Active Invoice Sign with 
Unsigned PDF container

Same as Active Invoice Sign with a PDF “container” 
created to send or archive unsigned invoices with their 
related “artifacts,” or data, via PDF file(s).

Active Invoice Validate Same as Active Invoice Sign with an added feature 
that received signed invoice documents are validated 
for digital signatures.

Active Invoice Validate with 
Duplicate Check

Same as Active Invoice Validate with an added 
duplicate invoice number check feature performed on 
the invoice documents. Duplicate checking ensures 
that a Sender cannot send multiple invoices with same 
invoice number within the Sender’s fiscal year.

Process Type Option Description
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b In the Signing Information - Exceptions section, specify Suppliers that 
should not receive invoices for a specific Process Type. The Legal Entity 
Unique ID displays the first Supplier that you do not want to receive invoices 
in the selected Process Type.
For example, if a Sender (trading partner) selected the Active Invoice 
Sign process type and the Receiver selected the Active Invoice Non 
Signed process type, the Receiver can create an exception for the Sender by 
specifying the Sender Legal Entity Unique ID (VAT / TAX Id) and then 
selecting the preferred process type.  

In the Process Type Documents Information Archive section, from 
the a list of documents relevant for the selected exceptions Process 
Type), select document types from the list. Press the Ctrl key to make 
multiple selections.  

Click Add. You might need to scroll to the right to see the button.

Repeat for each Supplier to make an exception for. 

Note: The document selections apply to all Suppliers named in the 
Process Type. To select other documents, use a different Process 
Type.

c Use the Process Type Documents Information Delivery section in the 
same way as the previous step. 



371 Trading Grid Online

A C C O U N T  M A N A G E R

Active Invoice Legal Profiles

d The Archive Information section displays the Default Archive Period 
for the country in which this entity is located. . 

To disable invoice reports archiving, select Disable Archiving? 

Important: This option prevents viewing invoices.

If you do not disable archiving, do one of the following. 

■ Select GXS Archive as your archive. The Default Archive Period, is 
based on the country of this profile. You can use the Extend to option 
to extend this period for each invoice by a number of months. 
Enter your Cloud Profile Id, which is your Cloud Archive Service (TG-
CAS) identification.
If you want a URL link to access the archived files, select the Archive 
Link option, and then select a Delivery Mode of Email or GXS 
Supported Communication Methods in Step 14.

■ Select Customer Archive and enter your Cloud Profile Id.

13 In the Notification Type section, select the alerts and documents to deliver to 
the Contacts defined in this profile.  

Select as needed:

■ Invoice Copy to deliver a copy of the unsigned invoice.

■ Success Alerts (Suppliers only) to deliver a "success" email after the 
invoice is successfully sent.

■ Error Alerts (Suppliers only) to deliver an "error" email if an error 
occurred and the system could not deliver the invoice.
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14 In the document Delivery Mode section, for delivery of AIC-generated 
documents (not yet archived) to the service contact (default contact in case of 
a signed/validated document). 
Note: The Delivery Mode is applicable only if your company subscribed to 
the Deliver compliance package.

Select one: 

■ Email to deliver the documents via email attachments. The maximum 
number of document attachments delivered is 10 per email.

■ GXS Supported Communication Methods to use GXS-supported 
communication methods in which the compliant invoice package is 
delivered to the TGMS mailbox from where GXS can forward it to the 
customer using any GXS-supported communication method, e.g., AS2, FTP, 
etc.

■ Secure Email Delivery to deliver the documents via a secure link in an 
email. For more information, see “Secure Email Delivery” on page 373.

■ Web Services to deliver the documents to Spain or to the Italian 
Government. This applies to Non-GXS Receivers only.

For signed invoices, documents delivered are: 

■ Signed/validated PDF documents.

■ Invoice copies, if selected in the Notification Type section (previous 
step).

For Non-signed EDI invoices, the Summary List is delivered.

15 For the document delivery Type, select either:
■ Real Time Delivery to archive and deliver invoice-related documents 

when they are generated.

■ Delayed Delivery to archive and deliver invoice-related documents after all 
artifacts (for example, audit trail, summary, etc.) are generated.

Then, you can select:

■ Suppress invoice data delivery . . .? to suppress delivery of the original 
file (submitted by the Supplier) to the Buyer mailbox.

■ Deliver Compliance Package to deliver all of your documents related to 
an invoice. The default for this option is Delayed Delivery, which submits 
the compliance packages once per day.

■ Submit compliance package as zip to deliver the artifacts as one package in 
zip format.

16 (Suppliers only). In the Human Readable Format section, you can specify 
that a logo or additional information display on invoices sent or received.  

a In the Locale dropdown, select the language of the logo or user-defined 
field.



373 Trading Grid Online

A C C O U N T  M A N A G E R

Active Invoice Legal Profiles

b To specify a logo, enter the name of the logo file or click Browse to find 
and select it. It cannot be larger than 10 megabytes.

c Click Upload. The page redisplays showing the logo. You might need to 
scroll down to see it.

17 (Suppliers only). To specify additional fields to appear on invoices, in the User 
Defined Fields section, 

a Enter the Field Label and Description. Both are required. 
b Click Add to save the information. The page redisplays showing the field 

you entered. You might need to scroll down to see it.
c Repeat to add additional user fields.

18 Click Submit. Your profile displays on the Legal Profile list page.
See also “Maintain Legal Entity Relationships”

Secure Email Delivery
The Secure Email Delivery option delivers the documents by a secure link in an 
email sent to the person designated in the Legal Profile. The recipient downloads 
the documents to the Active Invoice Archive.

Important: Documents received by Secure Email Delivery are retained for 180 
days only.

The process is:

1 The Secure Email Delivery contact receives the secure email.  

2 The email recipient clicks the click here link in the email. If the user is already 
logged into Active Invoices, the Invoice List displays the Secure Delivered 
documents. . 



A C C O U N T  M A N A G E R
Active Invoice Legal Profiles

Trading Grid Online  374

1 1

3 From this page, you can do the following:  

■ Filter the listing.  

■ Open the Invoice Information page for the document. t 
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■ Download the invoice.  

Maintain Legal Entity Relationships 
Important: This applies to Non-Signed EDI Invoice Trading Partners only.

Every Company that sends or receives Non-Signed EDI Invoices must maintain a 
file of Trading Partners with which the invoices are exchanged in order to log and 
track Trading Partner changes. The AIC search function lets you quickly find an 
associated Trading Partner's legal entity profile to: 

■ View — for example, to see if status or address information has changed.

■ Update by entering an end date to terminate the E-Invoicing agreement with 
that Trading Partner. Terminated entity relationships remain accessible for three 
years past the end date.

To find and view or update a Legal Entity Relationship
1 Log into Trading Grid Online.
2 Click the Account Manager tab.
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3 Click Service Configuration > Legal Profile. The Legal Profile page opens.  

4 In the Legal Entity Relationship Search section, for the My Legal Entity 
Name or My Legal Entity ID, select the entity associated with the Trading 
Partner(s) to view or update.
If you are looking for a specific Trading Partner, enter that Trading Partner's 
Legal Entity Name or Legal Entity ID.

5 Click Search. On the Modify Document page your document form displays the 
Legal Entity Relationship Search Results.  

6 To view or update Trading Partner information, in the rightmost column of the 
list, click the partner’s View/Update link.
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7 On the Update Legal Entity Relationship page, view the information or, to 
terminate the e-invoicing the agreement with that partner, enter the End Date. 
Note: The End Date must be at least 1 day prior to the current date.  

Machine Users
Machine user accounts are specialized accounts that allow machine-to-machine 
communications for some GXS connectivity options. Unlike a personal user 
account, a machine user account does not require information such as an email 
address or physical mailing address. Machine user accounts are not required for all 
GXS connectivity options; if no accounts are displayed, then your current 
connection method does not require one. 

Topics include:

■ “Add a Machine User” on page 377

■ “Update or View a Machine User” on page 378

■ “Activate or Deactivate a Machine User” on page 378

Add a Machine User

To add a machine user
1 On the Account Manager tab, click Service Configuration > Machine User.

The Machine User page opens.

2 Click Actions, and click New Machine User.
The Step 1: Machine User Create Information page opens.

3 Enter the required information, and click Next Step.
The Step 2: Service Privileges page opens.

4 Select the Service Instance(s) (subscription package and privileges) for each 
Service Instance you want the user to have. By default, all options are selected. 

5 Select the Role of the new user, and click Next Step.
The Step 3: Review page opens.
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6 Review your information. To make any changes, click Previous Step.
7 Click Submit.

Update or View a Machine User

To update or view data for a specific account
1 On the Account Manager tab, click Service Configuration > Machine User.

The Machine User page opens.

2 Select the account you want to view.
3 Click Actions > Update.

Activate or Deactivate a Machine User

To activate or deactivate a specific account
1 On the Account Manager tab, click Service Configuration > Machine User.

The Machine User page opens.

2 Select the account you want to view.
3 Click Actions; then select Activate or Deactivate.

Mailboxes and Mailslots
A mailbox is an electronic storage place provided by OpenText, which allows you to 
exchange data, email, and reports with Trading Partners. Each user is assigned a 
unique mailbox. You can then add and set up individual mailbox slots to categorize 
the information you receive, for example, by Trading Partner or document type.

Example:

Mail Slot Typical Use Category/Description

Mail Slot 1 Invoices from all standard Suppliers. These invoices get standard 
handling.

Mail Slot 2 Invoices from DSD Suppliers. These invoices get priority handling.

Mail Slot 3 Invoices from Suppliers A and B. These invoices are paid via EFT.

To add and set up mail slots for your company
1 On the Account Manager tab, click Service Configuration > Mailslots. 
2 Click Create Mailslot.

The Create Mailslot page opens.
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3 Enter the Mailslot Name and Description. The text you enter should 
describe the purpose of the mail slot.  

4 In the Rule Definition section:
a For the My EDI Address and Document Type fields, click the adjacent 

(Search) icon to find and select the applicable values, and click 
Submit. 

b For the Partner EDI Address(es), enter the address for the first trading 
partner, and click Add. 
The address displays.

c Repeat this step for each trading partner.
5 In the Associate Users section:

a Select the Company employee(s) that handle the documents in this 
mailslot.

b From the User drop-down list, select the first user, and click Add.
The employee's name displays.

c Repeat this step for each trading partner.
6 Click Submit.
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Cross-Reference Tables
Cross-reference tables are comma-delimited (.csv) files that identify fields with 
specific values in EDI documents. OpenText Professional Services uploads these 
tables to Trading Grid Online to replace and validate document information during 
the transformation process.

You can update values in the tables, add or delete rows, and revert to previous 
versions of a table. To further edit a table, you can download and then open it in a 
another application such as Microsoft Excel.

Topics include:

■ “File Format Guidelines” on page 380

■ “Update values in a cross reference table” on page 2

■ “Add or Delete Rows in Cross-Reference Tables” on page 381

■ “Download Cross Reference Table as .csv Files” on page 382

■ “Upload Cross Reference Tables” on page 382

■ “Revert Cross Reference Table To Previous Versions” on page 383

File Format Guidelines
The information in a .csv file to adhere to the following guidelines:

File Name
The name of the .csv file must be in the following format: 

<table_name>.csv.

Table Cell Structure
The first cell in the table must be the table name in the following format:

<table_name>.csv)

The other cells in the first row must be the header values for the table. The values 
in the first column cannot be changed from Trading Grid Online.

Delimiters
Use the comma (,) character as the column delimiter.

Use the double quote (“) character as the text delimiter.

Important: OpenText recommends that you do not use a comma or double- 
quote characters in the original table cell values, and do not add them in the text 
you modify. If you must include a comma inside a cell, enclose the string with 
double quotes in the input file.

Use a UNIX-style end of row delimiters (LF or Hex 0A).

Characters
Use the UTF-8 character set, which most Web pages support.

Currency characters, such as pound (£), yen (¥), and euro (€) can be included in 
cross reference tables. They are in the UTF-8 character set.

Each cell has a character limit of 4000 characters. If more than 4000 characters are 
used, the system truncates your input.
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Example Format
The example below includes the table name in the first column of the first row. The 
remaining columns in the first row serve as headers in the .csv file and in Trading 
Grid Online:

Supplier Lookup,WholeSeller Name,Mailing Address Street,City,State,Addition Info
AX,BAXTER RAW MATERIAL,123 Central Ave.,Kansas City,Kansas,
CD,"Daltex Contractors, LLC ",225 White's Circle,Prosper,Texas,75078
MD,Southwest Supply,453 New-South Street,West Memphis,Arkansas,75126

Update Cross-Reference Table Values

To update values in a cross-reference table
1 On the Account Manager tab, click Service Configuration > Cross 

Reference Tables. 
2 Click the link for the table you want to update, and find the table cell you want 

to update.
3 Click in the cell. 
4 Type the new value.
5 Click outside the cell.
6 Click Save.

Add or Delete Rows in Cross-Reference Tables

To add or delete rows in a cross-reference table
1 On the Account Manager tab, click Service Configuration > Cross 

Reference Tables. 
2 Click the link for the table you want to update, and find the place in the table 

where you want to add or delete a row.
3 Right-click in a table cell, and select one of the following options: 

■ Add Row Above

■ Add Row Below

■ Delete Row
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4 Perform the appropriate action: 

5 To deploy your updates, click Deploy. 
6 At the confirmation message, click Yes.
7 To verify deployment has finished, click + to open the bottom of the page.
8 Click Refresh, and verify the time of the update. Click Show to view additional 

information about the change. 
9 To get a refreshed view of the tables, press Cross Reference Table 

Summary at the top of the page.

Download Cross Reference Table as .csv Files
To make extensive edits to a table, you can download it and open it in an 
application like Excel. 

To download a cross reference table for editing
1 On the Account Manager tab, click Service Configuration > Cross 

Reference Tables. 
2 Click the link for the table you want to download.
3 Click Download, then Open or Save.

The table opens in Excel.

4 Edit the rows in the table.
5 Click Save.
6 To upload the modified table back to Trading Grid Online, go to “Upload Cross 

Reference Tables” on page 382.
Note: Do not upload the original cross reference table file unless the line 
endings are LF (line feed). The original files are typically uploaded by 
Professional Services.

Upload Cross Reference Tables

To upload an edited cross reference table
1 On the Account Manager tab, click Service Configuration > Cross 

Reference Tables. 
2 Click the link for the table you want to upload.
3 Click Upload.
4 Navigate to the file you want to upload, and click Open. 
5 Click Save.

If you selected... Do this:

Add Row Above
Add Row Below

1 In the new row, add values in each column.
2 Click outside the cell.
3 Click Save.

Delete Row The row is deleted.
■ Click Save.
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Revert Cross Reference Table To Previous Versions
If a previous version of a table is available, you can use the old table instead of one 
you just modified. 

To revert a cross reference table to a previous version
1 On the Account Manager tab, click Service Configuration > Cross 

Reference Tables. 
2 Find the table you want to revert.
3 In the Revert Available column, click Yes.
4 At the confirmation message, click Yes.

The table is automatically reverted to the previous version.

Billing
The Billing service is available to users who have billing permissions. It contains a 
summary of accounts. For each invoiced bill, it lists the following information:

■ Invoice Number — Unique invoice number of your bill. 

■ Invoice Date — Cut-off date of billing in a particular month. 

■ Due Date — Date when the bills should be paid. 

■ Customer User ID — Company name in capital letters. 

■ Account Unit — Currency code that returns a value like USD (US Dollar). 

■ Total Due — Payable amount in a particular month. Total amount due is the ($) 
US Dollar figure. 

Topics include:

■ “Configure Invoiced Bill Columns” on page 383

■ “Find an Invoiced Bill” on page 384

■ “View Invoiced Bill Data” on page 384

■ “Print Invoiced Bills” on page 384

■ “View or Download Invoiced Bills” on page 384

Configure Invoiced Bill Columns
You can configure the Invoiced Bills page to show specific columns. 

To configure columns in an invoiced bill list
1 On the Account Manager tab, click Billing. 

The Invoiced Bills page opens and lists all invoiced bills.

2 Click  Configure and make your changes. 
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Find an Invoiced Bill

To search for an invoiced bill
1 On the Account Manager tab, click Billing. 

The Invoiced Bills page opens and lists all invoiced bills.

2 Click  Search, and enter your criteria.

View Invoiced Bill Data
Important: To view the data, you must have Adobe Reader installed on your 
computer. You can download and install the free Adobe Reader from 
www.adobe.com. 

To view data for an invoiced bill
1 On the Account Manager tab, click Billing. 

The Invoiced Bills page opens and lists all invoiced bills.

2 Click the applicable Invoice Number. 
3 At the prompt, select Open this file from its current location.
4 Click OK. 

The Account Summary page opens and displays the bill in PDF format.

Print Invoiced Bills

To print invoiced bills 
1 On the Account Manager tab, click Billing. 

The Invoiced Bills page opens and lists all invoiced bills.

2 Click  Print. 
A new page displays the list. You can resize the page to view the entire list.

3 Click  Print.
4 Select your printing preference, and click Print.

View or Download Invoiced Bills

To view or download the invoiced bills
1 On the Account Manager tab, click Billing. 

The Invoiced Bills page opens and lists all invoiced bills.

2 Click either XML or CSV, depending on which format you want.
The File Download prompt opens.

3 Select Save this file to disk, and click OK. 
The Save As prompt opens.

4 Locate the directory where you want to save the file, and click Save.

www.adobe.com.
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Policy
The Password Policy page shows the current user password policy for a company. 
You can impose a more restrictive password policy.

Initially, a Community Manager set up the password policy for all companies in the 
community. If you have the Company Administrator or Account Manager role, you 
can impose a more restrictive password policy. 

Important: When you change the password policy, the changes override only the 
fields where your policy is more restrictive than initially specified.

Topics include:

■ “Change Password Policy” on page 385

■ “Terms and Conditions” on page 385

Change Password Policy

To impose a more restrictive password policy
1 Click the Community Manager tab > Company Management > Policy. 

The Password Policy page opens and displays the current user password policy. 

2 Change the value in any field, and click Save. 
Note: Any change in password policy forces all users at the company to 
change.

Terms and Conditions
You can create custom Terms and Conditions (T&C) that display for users to read 
and accept. 

Follow these guidelines:

■ GXS supplies the default Terms and Conditions (T&C). 

■ A custom T&C overrides the GXS Terms and Conditions. 

■ Custom T&C must be approved by the GXS Administrator and GXS Legal team 
before they are displayed to your users. 

■ Only one custom T&C is active and displays to ALL users, regardless of their 
country. That is, you cannot define country-specific Terms and Conditions. You 
can, however, create a T&C with text in different languages. 

■ After GXS approval of a T&C, the previously active T&C is made inactive. 

■ The Terms and Conditions page displays existing T&Cs that you defined. The 
status for a T&C is: 

Status Description

Draft Saved T&C, which can be edited at a later point in time. Can be deleted.

Requested Pending approval by GXS. Cannot be edited, but can be deleted. Only 
one T&C can have this status.

Active Last approved T&C. Cannot be edited or deleted.

Inactive T&C was previously active, but was replaced by another T&C. Cannot be 
edited or deleted.

Rejected GXS did not approve this T&C. Cannot be edited, but can be deleted.
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From this page, you can do the following.

To view T&C details
■ Click the applicable Reference ID number. 

To edit T&C details
■ Click the applicable Reference ID number. Remember, only T&Cs with a status 

of Saved can be edited. 

To delete a T&C
1 Select the T&C.
2 Click Delete T & C. Remember, only T&Cs with a Saved, Requested, or 

Rejected status can be deleted. 

To create a new T&C
1 Click Create Custom T & C. 
2 Select the applicable language.
3 Enter the applicable text, using the format options in the toolbar.
4 When finished, click Save.
5 To then create this T&C in a subsequent language, 

a Select the language.
b The new editor opens. Type the text in the selected language. 
c Click Save. 
d Repeat this step for all other languages you want this T&C to appear in. For 

example, if you enter text in both English and Italian, the English version 
will display to users whose default language is English, and the Italian 
version will display to users whose default language is Italian.

e When finished, click Submit for Approval to request OpenText approval.
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Active Orders Classic A
Important: This section applies to Buyers and Suppliers using the classic version 
of Active Orders. If your company updated to the new version, you are currently 
performing these functions in the Active Orders component.

Topics include:

■ “Active Order Alert Management” on page 388

■ “Define Alerts” on page 389

■ “Define Business Rules” on page 393

■ “Define Display Templates” on page 397

■ “Add Logos to Documents” on page 402

■ “Upload Terms and Instructions” on page 403

■ “Upload Order Closure and Retention Policy” on page 403

■ “Define Inventory Criteria” on page 404

■ “Manage Department Codes” on page 405

■ “Change Invoice Status Names” on page 405

■ “Manage Email Alerts” on page 406

■ “Field Descriptions and Terms” on page 408

Active Order Alert Management
You need to set up email alert rules for your company; that is, define the 
circumstances under which you want Active Orders to generate and send an email. 
For example, if you submitted an order and the supplier has not acknowledged it, 
you might set up an “Overdue Acknowledgment” alert, where:

■ An email is sent every day (Frequency). 

■ Orders must be acknowledged within 2 days (Threshold = 48). 

■ A maximum of 4 emails are sent (Maximum number of alerts = 4). 
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These settings mean if an order has not been acknowledged within 48 hours, 
Active Orders sends the first email alert. Active Orders sends an email alert each 
succeeding day until either:

■ The Supplier enters an acknowledgement.

or 

■ Active Orders sends four emails. 

If your company is a new user, you must select the document types you want to 
display in the Message Center on the Operations Center tab. 

If your company is an existing user, you might want to eliminate some document 
types that currently display in the Message Center.

Define Alerts

To define alerts
1 Click the Account Manager tab > Service Configuration > Buyer Alert 

Management or Supplier Alert Management. 
The Business Process Manager Event Notifications (or Supplier Settings) page 
opens to the Notifications tab.

2 In the top area (optional):

Field Description

Preferred Email 
Language

Select the language in which you prefer to receive emails

“From” email 
address

Change to represent the buying organization. The address that 
displays is the address that you made your Default Contact 
when you added your “Service Contacts.”

Email Addresses Enter the email addresses for the recipients that you defined 
when you added your “Define Service Contacts” who should 
receive all email alerts (that you select) for all suppliers. 
Note: This list should not include your buyer users; they select 
the alerts they want to receive. To do so, select Other 
Contacts, and click Modify List.

Frequency Enter the number of days between alerts when specifying 
multiple alerts. 
For example, if you enter 2, and then select to generate a 
maximum of 3 alerts for Overdue Shipments, Active Orders 
generates Overdue Shipment alerts over 6 days — one alert 
every 2 days for a total of 3 alerts.
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3 In the New Documents section (suppliers), enter or select:

4 In the Invoice section (suppliers), enter or select:

5 In the Shipments section (buyers and suppliers), enter or select:

Field Description

New Order Generate an email whenever the Buyer submits an Order to 
Active Orders.

New Remittance 
Advice

Generate an email whenever the Buyer submits a Remittance 
Advice in Active Orders.

New Order 
Forecasts

Generate an email whenever the Buyer submits a New Order 
Forecast in Active Orders.

Delivery Method Whether to generate an Email or display it in the Message Center 
on the Operations Center page or both. Select for each option.

Field Description

Rejected Invoice Generate an email whenever the Buyer rejects an non-DSD 
Invoice in Active Orders.

Rejected DSD 
Invoice 

Generate an email whenever the Buyer rejects a Direct Store 
Delivery Invoice in Active Orders.

Delivery Method Whether to generate an Email or display it in the Message Center 
on the Operations Center page or both. Select for each option.

Field Description

New Ship Notice 
Arrival

When a supplier submits a Ship Notice in Active Orders.

Overdue Shipment When a supplier does not submitted a Ship Notice by your 
Requested Arrival Date in the order. 

■ In Threshold, enter the number of hours after the 
Requested Arrival Date that you want to generate the first 
alert. 

■ In Maximum number of alerts, enter the total number of 
alerts you want to generate.

Pending Shipment Before a shipment is due. This is a proactive alert, based on 
your Requested Arrival Date in the order, that your buyers 
might want to send to their suppliers as a reminder. 

■ In Threshold, enter the number of hours before the 
Requested Arrival Date that you want to generate the first 
alert.

■ In Maximum number of alerts, enter the total number 
of alerts you want to generate.

Delivery Method Whether to generate an Email or display it in the Message 
Center on the Home page or both. Select for each option.
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6 In the Invoice section (buyers), enter or select:

7 In the Orders section (buyers and suppliers), enter or select:

8 In the Out of Stock section (buyers and suppliers), enter or select:

Field Description

New Invoice When a supplier submits a non-DSD Invoice to Active Orders.

New Direct Store 
Delivery (DSD) 
Invoice Arrival

When a supplier submits a DSD Invoice to Active Orders.

Delivery Method Whether to generate an email or display it in the Message 
Center on the Home page or both. Select for each option.

Field Description

New Order When a supplier acknowledges an order in Active Orders.

New Order 
Acknowledgement

When a supplier acknowledges an order in Active Orders.

Overdue Order 
Acknowledgement

When a supplier has not acknowledged your order within a 
certain amount of time. 

■ In Threshold, enter the number of hours after you 
submit the Order that you want to generate the first 
alert.

■ In Maximum number of alerts, enter the total number 
of alerts you want to generate.

Rejected Order 
Acknowledgements

When a supplier rejects an order in Active Orders.

New Commitments When a supplier generates an “order promise” committing to 
the dates and quantities for the delivery of items that you 
requested.

Overdue 
Commitments

When a supplier has not entered commitment data within a 
certain amount of time. 

■ In Threshold, enter the number of hours after you 
submit the Order that you want to generate the first 
alert,

■ In Maximum number of alerts, enter the total number 
of alerts you want to generate.

Missed Commitments When a supplier did not send the correct item quantity or ship 
the items you requested according to the commitment data 
the supplier sent.

Delivery Method Whether to generate an email or display it in the Message 
Center on the Home page or both. Select for each option 
selected.

Field Description

Out of Stock Enter the total number of alerts you want to receive when a 
product is out of stock. 

Delivery Method Whether to generate an email or display it in the Message 
Center on the Operations Center page or both.
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9 In the UCCEAN Prefix Code section (suppliers), enter your unique prefix 
value required for the generation of UCC/EAN-128 complaint barcodes. 
The UCCEAN code is the standard encoding format for barcodes.

10 In the New Order Forecasts section (buyers), enter or select:

11 In the New Credit section (buyers), enter or select:

12 In the New Debit section (buyers), enter or select:

13 In the Order, Invoice Mismatch Alert section (buyers and suppliers), select 
the Order, Invoice Mismatch Alert to track order and invoice discrepancies, 
and select what you want to base mismatches on:

Field Description

New Order Forecasts Track when a Supplier submits a planned material purchases.

Delivery Method Indicate how to display it in the Message Center on the 
Home page.

Field Description

New Credit Track when a Supplier submits a Credit Note to Active Orders

Delivery Method Indicate how to display it in the Message Center on the 
Home page.

Field Description

New Debit Track when a Supplier submits a Credit Note to Active Orders

Delivery Method Indicate how to display it in the Message Center on the 
Home page.

Field Description

Quantity When the Order line Quantity does not match the Invoiced 
line Quantity.

Unit Price When the Order line Unit Price does not match the Invoiced 
line Unit Price.

Extended Price When the Order line Extended Price does not match the 
Invoiced line Extended Price.

Number of Days Enter the number of days to keep the alert on the Message 
Dashboard.

Delivery Method Whether to generate an email or display it in the Message 
Center on the Home page or both.
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14 In the Order, Ship Notice Mismatch Alert section (buyers and suppliers), 
select the Order, Ship Notice Mismatch Alert to track order and ship notice 
discrepancies, and select what you want to base mismatches on.

15 Click Actions, and click Preview Alert and Notification Changes.
16 Review your settings, click Actions, and click Save to activate your settings.

Define Business Rules
To define business rules
1 Click the Account Manager tab > Service Configuration > Business 

Rules. 
The Business Process Manager Rules page opens.

2 Select the options you want to use:

Field Description

Quantity When the Order line Quantity does not match the Ship 
Quantity.

Unit of Measure When the type of measure for the item stated on the Order 
does not match that of the Ship Notice.

Buyer Item ID When the number or code that you assigned to the line item 
on the Order does not match that of the Ship Notice.

Number of Days Enter the number of days to keep the alert on the Message 
Dashboard.

Delivery Method Whether to generate an email or display it in the Message 
Center on the Home page or both.

Field Description

Default Currency Code Select the currency code that you want your item amounts based on.

Invoice Rules Select one or more of Invoice rules. For complete information, see Invoice rules in ““Field 
Descriptions and Terms” on page 408.

■ Allow non-Order invoice — Select this rule to let Suppliers create Invoices that do 
not have a corresponding Order.

■ Allow negative invoice quantity — Select this rule to let Suppliers create an Invoice 
for a negative quantity, that is, a credit against a line item.

■ Allow Supplier to edit invoice discount terms and conditions — Select this rule 
to let Suppliers change the discount terms and conditions that you specify per your 
Order.

■ Allow zero tax amount for taxable items — Select this rule to let Suppliers enter '0' 
as an entry in the Tax Amount field in an invoice.

■ Update the Invoice status to “Received” upon processing an 
acknowledgement — Select this rule to automatically generate a Received status for 
the invoice after you send back an acknowledgement that the Invoice has been 
received, for example, an ANSI X12 997 functional acknowledgement. Otherwise, the 
status remains Submitted.
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Fixed Price Rules Select one of the Invoice Fixed Price rules. For complete information, see Invoice rules in 
“Field Descriptions and Terms” on page 408.

■ Limit invoice by Order quantity - Tolerance — Ensures Suppliers invoice you only 
for a Shipped Quantity that equals your Requested Quantity plus a specified 
Tolerance (percentage of your Requested Quantity). 

■ Limit invoice by shipped quantity - Tolerance — Ensures Suppliers invoice you 
only for a Shipped Quantity that equals the quantity shipped plus a specified 
Tolerance (percentage of the shipped quantity).

■ Limit invoice by received quantity - Tolerance — Ensures Suppliers invoice you 
only for a Shipped Quantity that equals the quantity you received plus a specified 
Tolerance (percentage of the shipped quantity). If you select this rule, you must also 
select the Limit SN received quantity - Tolerance nn % Ship Notice rule.

■ No rules — Suppliers can invoice you for any quantity.

Invoice Variable Price 
Rules

Select one or both of the Invoice Variable Price rules. For complete information, see 
Invoice rules in “Field Descriptions and Terms” on page 408.

■ Hide Order value details — Select this rule to keep Suppliers from seeing the Order 
Total Amount, Unit Price, Extended Price, and Open Amount to Invoice.

■ Limit invoice by price - Tolerance — Ensures Suppliers invoice you only for an 
amount that equals the Order Total Amount plus a specified Tolerance (percentage 
of the total dollar amount).

Credit Note Rules Select one or more of the Invoice Credit Note rules. For complete information, see Invoice 
rules in “Field Descriptions and Terms” on page 408.

■ Credit Amount can exceed Original Line Item Amount — Select this rule to let 
Suppliers create a Credit Note for an amount greater than the line item amount on the 
corresponding Invoice.

■ Allow Partial Credit — Select this rule to let Suppliers create a Credit Note for an 
amount less than the line item amount on the corresponding Invoice.

■ Create Credit Without Invoice — Select this rule to let Suppliers create a Credit Note 
that does not have a corresponding Invoice.

Field Description
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3 In the Order section, optionally select the Filter user's message center 
dashboard and alerts based on department code rule. If selected, Active 
Orders message center dashboard as well as email alerts are filtered based on 
events that are relevant to their particular department codes.

4 If you are requesting acknowledgements on a line item level, in the Line 
Acknowledgement Attributes section:

■ If you do not allow partial acknowledgements, select the All lines in the 
order must either be accepted or rejected rule.

■ Select the attributes that the Supplier can change when acknowledging a 
line item.

5 To override Order line deletion, in the Override Order Line Delete Action 
section select:

■ Line is shipped — Select this rule to display a line that the Supplier has 
shipped. 

■ Line is received — Select this rule to display a line that you have 
received. 

■ LIne is invoiced — Select this rule to display a line that you have 
invoiced. 

Ship Notice Rules Select one or more Ship Notice rules. See Ship Notice rules in “Field Descriptions and 
Terms” on page 408.

■ A Ship Notice cannot have more than one product ID or part number — 
Ensures Suppliers create a Ship Notice where, for each line item entered, the part 
numbers are the same.

■ A Ship Notice cannot contain line items with different Ship-To addresses — 
Ensures Suppliers create a Ship Notice where all line items are shipped to the same 
address.

■ A Ship Notice cannot contain line items from multiple Orders — Ensures 
Suppliers create a Ship Notice for line items in only one Order.

■ A Ship Notice cannot be created with a date in the past by more than ___ 
hours — Ensures in the Shipping Date field, Suppliers only enter a current date, future 
date, or a date in the past that is within your specified limit.

■ A Ship Notice cannot contain lines previously flagged with “Last Shipment” 
indicator — Ensures Suppliers do not create a Ship Notice for line items where 100% 
of the quantity has been shipped.

Optionally, select one of the following:
■ Limit by Ship Notice scheduled quantity - Tolerance — Ensures Suppliers 

enter a Ship Quantity that equals the Requested Quantity plus a specified 
Tolerance (percentage of requested quantity).

■ Limit by Ship Notice received quantity - Tolerance — Ensures Suppliers enter 
a Ship Quantity that equals the Open Quantity to Ship plus a specified 
Tolerance (percentage of open quantity). Selecting this rule tells Active Orders to 
calculate the Open Quantity to Ship based on the quantity you received, rather 
than the quantity the Supplier shipped.

■ No rules — Suppliers can ship any quantity.

Field Description
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6 To handle missed commitments, in the A Schedule is Miss Committed 
When section, select:

7 Optionally, in the Extract Rules section, select the Include 'transaction 
date' with data extracts rule. The Transaction Date is when the document 
arrives in the Active Orders system, which might be different from the current 
date in the document. If you select this rule, and there are any translation 
maps based on the version of the extract without Transaction Date, the maps 
might need to be updated to include the Transaction Date value.

8 Optionally, in the Remittance Advice section, select the For a Remittance 
Advice, the sum of all amounts paid in the advice rule to display the 
payment amount on the Remittance Search results page and Remittance Advice 
Header page.

9 Click Actions, and click Preview Alert and Notification Changes.
10 Review your settings. Click Actions, and click Save to activate your rules.

Field Description

The shipment is split The shipment is split if the Supplier cannot ship the total ordered 
quantity at once. This means that the total quantity was divided into 
two (2) or more shipments with corresponding shipment dates. The 
schedule is considered as a missed commit if the supplier failed to ship 
the items on the indicated shipment dates. 

The first shipment is ___ days earlier 
than the requested date
OR 
The final shipment is ___ days later than 
the requested date in a split shipment 
scenario

Select this rule to set the number of days between the first shipment 
and the requested date, OR between the final shipment and the 
requested date before the schedule is considered as a missed commit. 

Split Shipments will not result in miss 
commitments

Select this rule if the supplier's split shipments are not considered as 
missed commits. 

Commit date is ___ days earlier or ___ 
later than the requested date

Select this rule to set the number of days wherein the commit date is 
earlier or later from the requested date. 

Commit date is ___ days later than the 
cancel-by date

Select this rule to set the number of days wherein the ordered item is 
considered as a missed commit. The ordered items are considered 
cancelled if the supplier does not commit on or before the indicated 
number of days. 

Commit quantity is over ___% or under 
___% of requested quantity

Select this rule to set the variance of the commit quantity over the 
requested quantity in terms of rate value, which can either be in excess 
or under the requested quantity. 
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Define Display Templates
Topics include:

■ “Order Display Template” on page 397

■ “Ship Notice Display Template” on page 397

■ “Invoice Display Template” on page 399

■ “Remittance Advice Display Template” on page 400

■ “DSD Invoice Display Template” on page 400

■ “Credit Note Display Template” on page 401

■ “Debit Note Display Template” on page 402

Order Display Template
Use this procedure to set up a display template for orders. The template 
determines the information displayed to both you and your suppliers.

To set up a display template for orders
1 Click the Account Manager tab > Service Configuration > Form Edits. If 

necessary, click the Order tab. 
The Form Edits - PO page opens.

2 In Pre-Defined Fields, change the names of the fields.
3 In Header/Summary Fields, specify the fields to display in the Header 

section.
4 In Header Acknowledgment Fields, click the check box next to the section 

title to display the fields. Then, specify the fields to display.
5 In Buying Company Address, Bill To Address, Supplier Company 

Address, Ship To Address, and Mark For Address, click the check box next 
to the section titles to display the fields.

6 In the remaining sections, click the check box next to the section titles to 
display the fields. For each section, specify the fields to display.

7 Click Actions, and click Preview Form Edit Changes.
8 Review your settings. 
9 Click Actions, and click Submit to activate your edits.

Ship Notice Display Template
Your company might require suppliers to provide certain data elements as part of 
the Ship Notice. Use this procedure to create the Ship Notice you want your 
suppliers to send.

To create ship notices
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens. 

2 Click the Ship Notice tab. 
The Form Edits - Ship Notice page opens.
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3 In the Header/Summary Fields section, indicate which fields you want to 
display on the Ship Notice, if they are required, and field lengths. Maximum 
field lengths are:

4 In the Buyer Defined Input Fields - Header Level section:
a Define additional fields you want to see in the Ship Notice header. Each 

field has a maximum of 30 characters. 
b To set a pairing condition, from the Flex Field Pair section, select a 

corresponding flex-field. 
Example: If Header Field 1 is paired with Header Field 2 (which is Flex-
Field 2) and if the supplier enters a value on field 1, then field 2 should also 
have a value. Otherwise, Active Orders generates an error if field 2 has no 
value. If the supplier does not put a value in either field, then no condition 
is affected. 

5 In the Ship From Address, Shipment Equipment, and Line Field sections, 
specify the fields you want to display.

6 In the Buyer Defined Input Fields - Header Level and Buyer Defined 
Input Fields - Line Level sections:

a Define additional fields that you want to see in the line item header area of 
the Ship Notice. Each field has a maximum of 30 characters. 

b To set a pairing condition, from the Flex Field Pair section, select a 
corresponding flex-field. 
Example: If Line Field 1 is paired with Line Field 2 (which is Flex-Field 2) 
and if the supplier enters a value on field 1, then field 2 should also have a 
value. Otherwise, Active Orders generates an error if field 2 has no value. 
If the supplier does not put a value in either field, then no condition is 
affected. 

7 In setting up the Ship Notice display template, customize the drop-down lists 
for Standard Carrier Alpha Codes, Service Contracts, and Buyer Locations. To 
do so:

a Click Actions, and click Code Table Management.
b Select the Code Table Name, enter the information in the fields, and click 

Add. 
Repeat this step for all the codes you want to add.

c Repeat steps a and b.
d Click Actions, and click Save Code List to save your codes.

8 Click Preview Buyer Setting Changes.

Field Length Field\ Length

Ship Notice Number 30 Notes 80

Carrier Code 17 Name 60

Carrier Name 35 Address 55

Carrier Tracking Number 30 City/Town 30

Transport Number 10 State/Province 2

Packing List Number 30 Postal Code 15

Amount of Packaging 7 Weight 10
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9 Review the Ship Notice, and click Submit to save the settings.

Invoice Display Template
Your company might require suppliers to provide certain data elements as part of 
an Invoice. Use this procedure to create the Invoice form you want your suppliers 
to send you. 

To create an invoice form for suppliers
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens.

2 Click the Invoice tab.
The Form Edits - Invoice page opens.

3 In the first two sections, indicate which fields you want to display on the 
Invoice., if they are required, and specify field lengths.

4 In the Buying Company Address, Bill To Address, and Supplier 
Company Address sections:

a Click the box next to the section titles if you want those fields to display. 
b In each section, indicate the fields you want to display on the Invoice, if 

they are required, and specify field lengths.
5 In the SAC Header (Service Allowance or Charge) section, select the check 

box next to the section title if you want the fields to display. Specify the 
Number of SAC lines and fields you want to display.

6 In the Buyer Defined Input Fields - Header Level section:
a Define the fields you want to display on the Invoice, if they are required, 

and specify field lengths.
b To set a pairing condition, from the Flex Field Pair section, select a 

corresponding flex-field. 
Example: Header Field 1 is paired with Header Field 2 (which is Flex-Field 
2). If the supplier enters a value on field 1, then field 2 should also have 
value. Otherwise, Active Orders generates an error if field 2 has no value. 
If the supplier does not put any value on both fields, then no condition is 
affected.

7 In the SAC Header (Service Allowance or Charge) and SAC Line sections, 
click the check box next to the section title if you want the fields to display. 
Specify the number of lines and the fields to display.

8 In the Buyer Defined Input Fields - Line Level section:
a Define the fields to display on the Invoice, if they are required, and specify 

field lengths.
b To set a pairing condition, from the Flex Field Pair section, select a 

corresponding flex-field. 
Example: Line Field 1 is paired with Line Field 2 (which is Flex-Field 2). If 
the supplier enters a value on field 1, then field 2 should also have value. 
Otherwise, Active Orders generates an error if field 2 has no value. If the 
supplier does not put any value on both fields, then no condition is 
affected.
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9 In setting up the Invoices display template, you can customize the drop-down 
lists for Special Charge and Allowance Codes, Line Tax Code, Line Tax Country 
Code, and Unit of Measure. To do so:

a Click Code Table Management, and select a Code Table Name. 
b Add codes or select existing codes, and Edit or Delete them.
c Click Save Code List to save your changes.

10 Click Actions and click Preview Form Edit Changes.
11 Review your settings, and click Actions and then click Submit to save the 

settings.

Remittance Advice Display Template
Specify the names of fields on a Remittance Advice.

To specify field names on a remittance advice
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens.

2 Click the Remittance Advice tab. 
The Form Edits - RA page opens.

3 In the Pre-Defined Fields section, change the names of the fields.
4 In the Header/Summary Fields section, specify the fields you want to 

display in the Header section.
5 In the Supplier Company Contact Details and Buyer Company Contact 

Details sections, click the check box next to the section titles if you want any 
of the fields to display. Then, for each section that you selected, specify the 
fields that you want to display.

6 In the Line Item Fields section, specify the fields that you want to display.
7 Click Actions and click Preview Form Edit Changes.
8 Review your settings, click Actions, and click Submit to activate your edits.

DSD Invoice Display Template
Your company might require suppliers to provide certain data elements as part of a 
DSD Invoice. Use this procedure to create the Invoice form you want your 
suppliers to send you.

To create a DSF invoice form for suppliers
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens.

2 Click the DSD Invoice tab.
3 In the first section, indicate the fields you want to display on the Invoice, if they 

are required, and specify field lengths. For one field, select the name.
4 In the Line Fields section, click the check box next to the section title if you 

want those fields to display. Indicate which fields you want to display on the 
Invoice, if they are required and, for three fields, select the name.

5 In the Buying Company Address, Bill To Address, and Supplier 
Company Address sections, click the check box next to the section titles if 
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you want those fields to display. In each section, indicate which fields you want 
to display on the Invoice, if they are required, and specify field lengths.

6 In the SAC Header (Service Allowance or Charge) and SAC Line sections, 
click the check box next to the section titles if you want the fields to display. 
Specify the number of lines and the fields that you want to display.

7 In the Buyer Defined Input Fields - Header Level and Buyer Defined 
Input Fields - Line Level sections:

a Define the fields you want to display on the Invoice, if they are required, 
and specify field lengths.

b To set a pairing condition, from the Flex Field Pair section, select a 
corresponding flex-field. 
Example: Header/Line Field 1 is paired with Header/Line Field 2 (which is 
Flex-Field 2). If the supplier enters a value on field 1, then field 2 should 
also have value. Otherwise, Active Orders generates an error if field 2 has 
no value. If the supplier does not put any value on both fields, then no 
condition is affected.

8 Click Actions and click Preview Form Edit Changes.
9 Review your settings., click Actions, and click Submit to save the settings.

Credit Note Display Template
Your company might require suppliers to provide certain data elements as part of a 
Credit Note. Use this procedure to create the form you want your suppliers to send 
you.

To create a credit note form for suppliers
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens.

2 Click the Credit Note tab.
3 In the first two sections, indicate which fields you want to display on the Credit 

Note, if they are required. For some fields, you can specify field lengths.
4 In the Buying Company Address, Bill To Address, and Supplier 

Company Address sections, click the check box next to the section titles if 
you want those fields to display. In each section, indicate which fields you want 
to display on the Invoice, if they are required, and specify field lengths.

5 In the SAC Header (Service Allowance or Charge) and SAC Line sections, 
click the check box next to the section titles if you want the fields to display. 
Specify the Number of SAC Lines and the fields that you want to display.

6 In the Buyer Defined Input Fields - Header Level and Buyer Defined 
Input Fields - Line Level sections:

a Define the fields you want to display on the Credit Note, if they are 
required, and specify field lengths.

b To set a pairing condition, from the Flex Field Pair section, select a 
corresponding flex-field. 
Example: If Header/Line Field 1 is paired with Header/Line Field 2 (which 
is Flex-Field 2) and if the Supplier enters a value on field 1, then field 2 
should also have value. Otherwise, Active Orders generates an error if field 
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2 has no value. If the Supplier does not enter a value in either field, then 
no condition is affected.

7 Click Actions and click Preview Form Edit Changes.
8 Review your settings, click Actions, and click Submit to save the settings.

Debit Note Display Template
Your company might require Suppliers to provide certain data elements as part of a 
Debit Note. Use this procedure to create the form that you want your suppliers to 
send you.

To create a debit note form for suppliers
1 Click the Account Manager tab > Service Configuration > Form Edits.

The Form Edits - PO page opens.

2 Click the Debit Note tab.
3 In the first two sections, indicate which fields you want to display on the Debit 

Note and if they are required.
4 In the Buying Company Address, Bill To Address, and Supplier 

Company Address sections, click the check box next to the section titles if 
you want those fields to display. In each section, indicate which fields to display 
on the Invoice, if they are required, and specify field lengths.

5 In the SAC Header (Service Allowance or Charge) and SAC Line sections, 
click the check box next to the section titles if you want the fields to display. 
Specify the fields to display.

6 In the Buyer Defined Input Fields - Header Level and Buyer Defined 
Input Fields - Line Level sections, define the fields to appear on the Debit 
Note, if they are required, and specify field lengths.

7 Click Actions and click Preview Form Edit Changes.
8 Review your settings, click Actions, and click Submit to save the settings.

Add Logos to Documents
Use this procedure to upload your corporate logo so it appears on all documents. 

Note: 

■ Logo files must be *.gif or *.jpg.

■ Maximum size is 5000 bytes.

■ Maximum width 160 pixels.

■ Maximum height is 64 pixels.

To upload a corporate logo
1 Click the Account Manager tab > Service Configuration > Branding.

The Upload Organization Logo(s) page opens.

2 Select the language of the logo(s) you want to upload.
3 Click Browse to locate the logo file. 
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4 Click Upload to add the file to the list.
5 Repeat steps 3 and 4 for all logo files that you want to upload.
6 From the list of uploaded files, select a logo file, and click Preview.
7 For the logo to appear on your documents, click Publish.

Important: 

■ If you do not perform steps 6 through 7, the logo does not display on 
documents.

■ If you previously published a logo, re-publishing a new logo overrides the 
previous logo. 

Upload Terms and Instructions
Use this procedure to upload a Terms and Instructions document(s) in .DOC, .PDF, 
.HTML, etc., formats. The document is common to all orders; each order header 
contains a link to the document(s), which prompts the Supplier to read it. If your 
company subscribes to the Active Orders Inventory function, you can upload terms 
and instructions for that function.

To upload terms and instructions
1 Click the Account Manager tab > Service Configuration > Branding.

The Upload Standard Terms and Instruction File(s) page opens.

2 Select the function to which you want to upload Terms And Instructions.
3 Click Browse to locate your file, and click Attach to add it to the list. 

Note: The file size cannot exceed 2000 KB.

4 Repeat these steps for all files you want to upload. 

Upload Order Closure and Retention Policy
To upload terms and instructions
1 Click the Account Manager tab > Service Configuration > PO Closure & 

Archival Policy. 
The PO Closure Status page opens.

2 Select the condition(s) under which you want Active Orders to close all orders.
3 For the retention period, enter the 

■ Closed PO Retention Period — Number of days Active Orders should 
hold a closed order in the system, after which the order is deleted, along 
with its related documents. 

■ Maximum Retention Period — Number of days Active Orders should 
hold any inactive document. 

4 Click Actions and click Preview PO Closure & Archival Policy.
5 Review your settings, click Actions, and click Save to activate this policy.
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Define Inventory Criteria
Use these topics to define the parameters you want for the Inventory function.

Topics include:

■ “Time Period” on page 404

■ “Location Hierarchy” on page 404

Time Period
Use this procedure to define the time period in which you want to see shipment 
activity, that is, the amount of stock shipped.

To enter a time period for inventory criteria
1 Click the Account Manager tab > Service Configuration > Time Period.

The Time Period Configuration page opens.

2 Select the Current Frequency for which you want to see a shipped stock 
total; for example, weekly, monthly, etc.

3 Select the day of the week \ you want the week to begin on for data reporting 
purposes. The selected day is referred to in WTD report columns.

4 Click Save to save your settings.

Location Hierarchy
Use this procedure to set up a hierarchy of your inventory locations so you and 
your suppliers can find inventory data and search for out-of-stock conditions. 

For example, you might want to set up the following hierarchy: 
Eastern region

Northeast

■ Philadelphia

■ Trenton

Southeast

■ Atlanta

■ Savannah

■ Raleigh

Western region

To define an inventory hierarchy
1 Click the Account Manager tab > Service Configuration > Location 

Hierarchy.
The Location Administration page opens.

2 To add a sub-location, click ***All Locations*** and select Add sub-
location.

3 For the new sub-location, enter an ID number, name, and location, and click 
Save to save the new sub-location.
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4 Repeat steps 2 through 3, as needed to add sub-locations.
Note: 

■ You can add sub-locations to sub-locations by clicking the sub-location and 
selecting Add sub-location.

■ To change sub-location information, click that sub-location and select Edit.

■ To remove a sub-location, click that sub-location and select Delete.

5 Click Save to save your hierarchy.

Manage Department Codes
Use this procedure to set up the Department Codes you want displayed on the 
message center dashboard and in email alerts.

To set up department codes
1 Click the Account Manager tab > Service Configuration > Manage Dept 

Codes. 
The Manage Dept Codes page opens.

2 Select a user from the Buyer User drop-down list. 
The department codes for the selected user display.

3 On the Department Codes section, select department code(s). 
Note: To select multiple codes from the list, hold CTRL key from the 
keyboard and left-click the mouse. You can Add, Edit and Delete department 
code(s).

4 Perform the appropriate action: 

5 Click Actions, and click Preview Manage Dept Codes.
6 Review your settings, click Actions, and click Save to activate the Department 

Codes.

Change Invoice Status Names
Use this procedure to change the word for a particular invoice status in Active 
Orders. For example, a buyer or suppliers might want an Invoice that is “In 
Progress” to display a status of “Processing.”

To modify invoice status names
1 Click the Account Manager tab > Service Configuration > Manage 

Invoice Status.

To . . . Do this:

Add your selections on the User 
Department Codes section

■ Click Add to User.

Remove department code(s) ■ Select department code(s) on User Department 
Codes, and click Remove from User.
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The Manage Invoice Status page opens.

2 For an Active Orders status, select the word you want to display.
3 Click Actions, and click Preview Manage Invoice Status.
4 Review your settings, click Actions, and click Save to activate the new 

statuses.

Manage Email Alerts
Your Company Administrator has set up a series of email alerts, which you can 
specify to receive, including the:

■ Type of alert - for example, an overdue shipment 

■ Alert threshold, that is, the number of hours before/after you receive the first 
alert. For example, 24 hours after a shipment is overdue. 

■ Number of alerts per document; for example, 2. 

■ Alert frequency, that is, number of days between alerts. For example, 1 day. 

Use this procedure to determine and set up the alerts that you want to receive. You 
can also specify that suppliers also receive certain alerts. 

Note: You cannot change the type of alert, the alert threshold, the number of 
alerts, or the alert frequency. Contact your Company Administrator if you have any 
issues with the settings. 

See also “Modify Your Email Alert Settings” on page 407.

To set up your personal email alerts for the first time
1 Click the Account Manager tab > Service Configuration > User Alert 

Settings.
The Business Process Manager Event Notifications page opens to the User 
Settings tab.

2 To set up your first Supplier Company:
a Click Actions, and click Add Supplier Company.

The Search pop-up opens.

b Enter the complete or partial Supplier Company name, and click Find.
The search results display.

c Select the Supplier(s), and click Submit.
The Supplier(s) are listed in the Alert Management section, followed by 
the types of alert(s) your Company Administrator has set up for your 
company.

3 Repeat these steps for all supplier companies in which you are interested.
4 Optionally, in the Default Email Distribution section, enter your email 

address to ensure all email alerts for all supplier companies selected in the next 
step are sent to you. You can add additional recipients, but they receive all 
email alerts that you select. You can add recipients for specific alerts in specific 
companies in step 6.

a Click Modify List.
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A list opens.

b Select the recipient you want all alerts that you select to be sent to. If you 
do not find the recipient you need, see the “Define Service Contacts” topic.

c Click Submit.
The recipient(s) display in the Default Email Distribution section.

Note: To remove an address from the distribution list, select it and click 
Delete.

5 In the Alert Management section, select the alert(s) you want to receive for 
each supplier company. For alert definitions, see “Field Descriptions and Terms” 
on page 408.

6 To add additional recipient(s), such as the supplier, to an alert you selected, do 
the following: 

a Click the icon adjacent to the selected alert.
A pop-up opens

b Click Modify List.
c Select the recipients you want this alert to be sent to. If you do not find the 

recipient you need, see the “Define Service Contacts” topic.
d Click Save 

7 Repeat these steps for other alerts you want to add an additional recipient(s) 
to.

8 Click Actions, and click Save Alert Settings.

Modify Your Email Alert Settings
Keep these tips in mind when modifying email alert settings:

■ You cannot change the type of alert, the alert threshold, the number of alerts, or 
the frequency. Contact your Company Administrator if you have any issues with 
these settings. 

■ If your Company Administrator adds a new alert that you want to receive, select 
it and add your address to the alert email list. 

■ In the Default Email Distribution section, adding, deleting, or replacing an 
email address(es) does not effect previously selected alerts. That is, if you add 
a new email address in this section, you must also add that address to any 
previously selected alerts that you want that recipient to receive. 

To modify your email alert settings
1 Click the Account Manager tab > Service Configuration > User Alert 

Settings.
The Business Process Manager Event Notifications page opens to the User 
Settings tab.

2 To add supplier(s):
a Click Actions, and click Add Supplier Company.

The Search pop-up opens.

b Enter the complete or partial Supplier Company name, and click Find.
The results of your search display,
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c Select the applicable supplier(s), and click Submit 
3 To receive emails for a previously unselected alert, select that alert. Click the 

adjacent icon to make sure your email address is on the list. If it is not, add it 
by clicking Modify List and selecting yourself from the page that opens.

4 To stop receiving emails for a specific alert, clear (de-select) the alert.
Note: When you clear an alert, all recipients no longer receive emails. 

5 To remove yourself as a recipient, or another recipient:
a Make sure the alert is still selected.
b Click the icon adjacent to the selected alert.
c Select the recipient, and click Delete 
d Click Save.

6 Click the Save action.

Field Descriptions and Terms

Icon Description

Indicates no comments or remarks were made.

Comments exist for this field. Click the icon to read the text.

status Supplier acknowledged and accepted the Order. 

status Supplier acknowledged the Order, but neither accepted nor rejected it.

status Order does not require an acknowledgment.

status Supplier acknowledged, but rejected, the Order.

status Supplier acknowledged part of the Order, but not the entire Order.

status Fully committed status. Supplier agreed to both the date and quantity 
requested for all schedules in the Order.

status Partially committed status. Supplier has not entered commitment data for all 
schedules in the Order, but, for the ones entered, has agreed to both date 
and quantity requested.

status Fully missed status. Supplier committed to all schedules in the Order, but the 
date or quantity committed to were not as requested in at least one 
schedule.

status Partially missed status. Supplier did not commit to all schedules in the Order, 
and, for one or more of the committed schedules, the committed date or 
quantity was different from the requested date or quantity.

status Partial credit status. Partial credit against the associated Invoice.

status Full credit status. Complete credit against the associated Invoice.
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Acknowledged Status
The Supplier acknowledged the Order by accepting or rejecting it, or the system 
received an EDI Order Acknowledgement. Icons include:

 Acknowledged and accepted.

 Acknowledged but rejected.

 Acknowledgment not required.

 Acknowledged, but neither accepted nor rejected.

 Acknowledged part of the Order, but not the entire Order.

additional data
Additional data fields you or the Supplier entered for the document.

adjusted amount
On a Remittance Advice, your approved amount. This amount is subtracted from 
the Invoice Amount, resulting in the Net Amount Paid to the Supplier.

Allowances/Charges
An allowance is an additional amount that you allow the Supplier to add to the 
Invoice (for example, an allowance for freight charges).

A charge is an amount that you are requesting the Supplier to subtract from the 
Invoice (for example, promotional discount).

A  next to the amount indicates you made comments about this charge. Click the 
 to read the comments.

Amount
■ On the Invoice Search Result page, the total Invoice amount.

status Deleted status. Status occurs when, because of a change or a delivery, the 
Requested Quantity for a part schedule or Order line item becomes zero.

status Supplier invoiced all line items in the Order.

status Supplier invoiced some of the line items in the Order.

status A previous Invoice(s) exists against this Order.

status You or your Hub paid the entire Invoice.

status You or your Hub made partial payment(s) against the Invoice.

status Supplier shipped all line items in the Order.

status Supplier shipped some of the line items in the Order.

status Supplier opened the Order.

Icon Description
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■ On the Remittance Advice Search and Search Result pages, the Invoice amount 
that was paid. 

Note: On the Search page, enter the Invoice amount paid to access the 
Remittance Advice for that Invoice. To do so, enter the exact amount, or your 
search results will not be valid.

■ On the Order Search Results page, the total amount of the Order.

Amount of Packaging
Number of Packaging Type units being shipped.

Bill to Address
Address where the Invoice should be sent for payment.

blanket Order
Your long-term commitment to the supplier for a part against which short-term 
releases are generated to satisfy requirements. Often, blanket Orders cover only 
one part with pre-determined delivery dates. A blanket Order is synonymous to a 
standing Order.

buyer
The customer, or the entity that issues Orders to Suppliers/Vendors.

Buyer
Buying Company
Refers to your company name and contact information.

Buyer Item ID
Buyer Part #
Buyer Part Number
Number or code you assigned to the line item, which is the part number associated 
with the part schedule or the Order line item.

Carrier
Carrier Name
Name of the shipping vendor or the routing method used by the shipping vendor.

Carrier Code
The standard carrier alpha code (SCAC).

Carrier Tracking Number
The number assigned by the shipping vendor to track this shipment.

charges and allowances
An allowance is an additional amount that you allow the Supplier to add to the 
Invoice (for example, an allowance for freight charges)

A charge is an amount that you request the Supplier subtract from the Invoice (for 
example, promotional discount).

A  next to the amount indicates that you made comments about this charge. 
Click the  to read the comments.

Column to Sort by
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On any of the Search pages, specify how you want your search results sorted. By 
default, results are sorted in ascending or descending order based on the data in 
the column you select. 

To change the order, select a sort option beneath the field.

commit
For an Order that is a Stock Transfer Order (STO), the Supplier must commit to the 
dates and quantities for the delivery of items that you requested. This process 
generates a “Promise,” which you can review and use to evaluate the Supplier's 
performance about whether the Supplier meets your commitments. You decide if 
the Supplier must commit to an Order.

Commit Date
Date when you receive the shipment. This date cannot be before your Requested 
Date.

Commit Quantity
The number of the ordered parts that arrive at your specified location on the 
Commit Date.

commitment statuses
 Fully committed. The Supplier agreed to both the date and quantity 

requested for all schedules in the Order.

 Partially committed. The Supplier has not entered commitment data for all 
schedules in the Order but, for the ones entered, has agreed to both date and 
quantity requested.

 Fully missed. The Supplier committed to all schedules in the Order, but the 
date or quantity committed to were not as requested in at least one schedule.

 - Partially missed. The Supplier did not commit to all schedules in the Order 
and, for one or more of the committed schedules, the committed date or quantity 
was different from the requested date or quantity.

Comments
Optional text that provides information about the document. A  in this field 
indicates you made comments. Click the  to read the comments.

Credit Note statuses
 Partial credit. The Supplier entered a partial credit against the associated 

Invoice.

 Full credit. The Supplier entered a complete credit against the associated 
Invoice.

Currency
Code indicating the type of money, for example, USD for the United States dollar 
or JPY for the Japanese yen, that the item amount is based on. Currency for an 
Invoice is the same as its corresponding Order. If there was no associated Order, 
the currency is usually that of the Supplier's country.

For Remittance Advices:

■ On the Search page, you can specify the type of currency for which you want to 
see payment advices.
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■ On the Search Results or Details page, lists the type of currency in which 
payment was made for that advice.

Date
On the Search Result pages, the date that the document was created.

Date Prepared
Creation date of the Remittance Advice.

Date Range
The starting (From) and ending date (To) between which you want to see 
Invoices, Orders, Shipping Notices, or Remittance Advices. Click the calendar icon 
to select the dates. Or, enter the dates in the specified format (mm/dd/yyyy or 
dd-mm-yyyy, or yyyy-mm-dd. Then, select the type of date you are looking for, 
either:

■ Document — Date the user entered in the document itself.

■ Transaction — Date when the document arrives in the OLV system.

For Shipping Notices or Order schedules, the system finds those with a Requested 
Arrival Date within the Date Range you specify. 

For Invoices or Remittance Advices, the system finds those with a creation date 
within the Date Range you specify.

Debit Amount
■ On the Debit Note Search Result page, the total Debit Note amount. 

■ On the Remittance Advice Search and Search Result pages, the Invoice amount 
that was paid. 

Note: On the Search page, enter the Invoice amount paid to access the 
Remittance Advice for that Invoice. To do so, enter the exact amount, or your 
search results will not be valid.

■ On the Order Search Results page, the total amount of the Order. 

Debit Note Number
Unique identifier for the Debit Note the Buyer assigns when creating the Debit 
Note. 

Debit Note statuses
 Partial debit. The Buyer entered a partial debit against the associated 

Invoice.

 Full debit. The Buyer entered a complete debit against the associated Invoice.

Default currency code
Select the code indicating the type of money you want your item amounts based 
on.

Deleted or  status
This status occurs when you delete either the Order or the Requested Quantity for 
a part schedule or Order line item.

Department Code



413 Trading Grid Online User Guide

A C T I V E  O R D E R S  C L A S S I C

Field Descriptions and Terms

A buyer-assigned code identifying the internal department carrying this product. 

Note: Usually used in a retail context.

Description
Short description of the line item.

Discount/Adj Amount
On a Remittance Advice, the amount by which you adjusted the Supplier's Invoice 
amount. It could be the amount specified by the Buyer Approver during the 
adjudication process. This amount is subtracted from the Invoice Amount, resulting 
in the Net Amount Paid to the Supplier.

Discount (percent)
Percent of the discount for the Invoice if you pay it within the number of allowed 
Discount Days.
Discount Days
The number of days that you have to pay the Invoice and still be eligible for the 
discount.

Download
Download Summary
Click this action to download all pages of your search results into a Microsoft Excel 
spreadsheet (.xls).

End Date
Expiration date of a blanket Order.

Equipment for transport
How the items are being shipped, for example, Trailer. Mutually Defined 
indicates you and the Supplier discussed this and agreed on the shipment transport 
equipment.

Exit
Click this link to exit Order Lifecycle Visibility and close your browser.

Extended Price
The unit price of the line item multiplied by the quantity that was invoiced.

The extended price is affected by products that are sold in unit multiples. If the 
you specified that the product is sold in multiples, the Multiple Quantity field 
identifies how many of this item represent a unit. To determine the extended price, 
the system divides the quantity ordered by the quantity of the multiple, and then 
multiplies by the unit price.

Firm status
You generate this status. 

Note: This is a “true” order that you are requesting the Supplier to fill. That is, 
you are committing to purchase.

■ This Order line item order is for a stipulated period of time.

■ You cannot change the Order line item order details during the stipulated time 
period. 

■ The Supplier has not yet committed to the Order line item order.



A C T I V E  O RD E R S  C L A S S I C

Field Descriptions and Terms

Trading Grid Online User Guide  414

■ The Order line item has an assigned Order number.

FOB Description
FOB Terms
Specifies FOB (Free-on-Board) Destination (DE) or Origin (OR).

■ FOB Destination indicates that the Supplier own the goods while in transit and 
is responsible for any loss or damage up to the time of delivery.

■ FOB Origin indicates that you are responsible for any loss or damage of the 
goods while in transit.

Forecast
A schedule with planned status.

GTIN
Global Trade Identification Number. Number or code you assigned to the line item. 
The part number associated with the part schedule or the Order line item.

Hub
Refers to your company name and contact information.

Invoice
Bill prepared by the Supplier of goods or services, and then submitted to you for 
payment. An Invoice lists all items or services bought, together with amounts.

Invoice Amount
Inv. Amount
■ When creating an Invoice, the total Invoice amount that the Supplier is billing 

you. This amount is for the items ordered or services that you received.

■ On the Invoice Search Results page, the total Invoice amount that the Supplier 
billed.

■ For a Remittance Advice, the amount that you specified during the adjudication 
process. This amount, minus the Discount/Adj Amount, results in the Net 
Amount Paid you paid.

Inv. Date
Invoice Date
Date the Invoice was created or entered into the system.

Invoice Gross Amount
Sum of the Invoice line item amounts (including Allowances and Charges) plus 
any freight or tax charges.

Invoice Line No
The line number of the line item in the Invoice.

Invoice No.
Invoice Number
Invoice Number to use
Unique identifier for the Invoice that the Supplier assigns when creating the 
Invoice.



415 Trading Grid Online User Guide

A C T I V E  O R D E R S  C L A S S I C

Field Descriptions and Terms

On the Search for Invoice and Search for Remittance Advice pages, you can specify 
the Invoice for which you want to see information. Or, you can enter a partial 
Invoice Number followed by an asterisk (*).

On any Search Results page, click the number to see Invoice information.

Invoice rules
These rules are set by the Company Administrator. 

Rule Select rule to . . . 

Allow negative invoice quantity Let Suppliers create an Invoice for a negative quantity, that is, the Supplier can create 
a credit against a line item.
For example, if the Unit Price is $100 and the Qty Available to Invoice is 40 and 
the Supplier enters a Ship Quantity of -20, the line item extended value would be 
$-2000 and the Qty Available to Invoice would be adjusted to 60.

Allow non-Order Invoice Let Suppliers create Invoices that do not have a corresponding Order.

Allow Supplier to edit invoice 
discount terms and conditions

Let Suppliers change the discount terms and conditions that you specify per your 
Order.

Limit invoice by Order quantity - 
Tolerance nn %

Ensure Suppliers invoice you only for a Shipped Quantity that equals your 
Requested Quantity plus a specified Tolerance (percentage of your Requested 
Quantity). Otherwise, the Supplier can invoice you for any Shipped Quantity, even 
one that exceeds your Requested Quantity.
For example, if the Requested Quantity = 100 and Tolerance = 10%, and the 
Supplier creates an Invoice for a Shipped Quantity of 111,

■ If this rule is “on” (selected), OLV gives the Supplier an error message stating 
“Customer will not allow invoicing greater than X% over the Order Qty,” and the 
Invoice is not submitted to you.

■ If this rule is “off” (not selected), OLV submits the Invoice to you.

Limit invoice by shipped quantity - 
Tolerance nn %

Ensure Suppliers invoice you only for a Shipped Quantity that equals the quantity 
shipped plus a specified Tolerance (percentage of the shipped quantity). Otherwise, 
the Supplier can invoice you for any Shipped Quantity, even one that exceeds the 
quantity shipped.
For example, if the Shipped Quantity is 100 and Tolerance is 5%, and the 
Supplier creates an Invoice for a Shipped Quantity of 110,

■ If this rule is “on” (selected), OLV gives the Supplier an error message stating 
“Customer will not allow invoicing greater than X% over the Shipped Qty,” and 
the Invoice is not submitted to you. 

■ If this rule is “off” (not selected), OLV submits the Invoice to you.

Limit invoice by receipt quantity - 
Tolerance nn %

Ensure Suppliers invoice you only for a Shipped Quantity that equals the quantity 
received plus a specified Tolerance (percentage of the shipped quantity). Otherwise, 
Suppliers can invoice you for a Shipped Quantity that exceeds the what you 
received. 
Important If you select this rule, you must also select the Limit SN received 
quantity - Tolerance nn % Ship Notice rule. 

No rules Enforce no quantity restrictions on a Supplier Invoice.

Hide Order value details Prevent Suppliers from seeing the Order Total Amount, Unit Price, Extended 
Price, or the Open Amount to Invoice (maximum amount the Supplier can 
invoice).

Limit invoice by price - Tolerance 
nn %

Ensure Suppliers invoice you only for an amount that equals the Order Total Amount 
plus a specified Tolerance (percentage of the total dollar amount). Otherwise, the 
Supplier can create an Invoice that exceeds the Order Total Amount.

Credit Amount can exceed 
Original Line Item Amount

Let Suppliers create a Credit Note for an amount greater than the line item amount on 
the corresponding Invoice.
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Invoice Status
Invoice status includes:

■ Paid — You submitted Remittance Advice document against the Supplier's 
invoice.

■ Approved — You read the Invoice and approved it for payment.

■ Rejected — You read the Invoice and will not approve it. You should enter 
explanatory comments for the Supplier.

Invoice Ticket Number
Field used for DSD Invoices. Number of the delivery ticket. There might be multiple 
delivery ticket fields.

Invoice Total
The total invoice amount, which is:

the extended line item price, which is the unit price of the line item 
multiplied by the quantity invoiced

      plus

any Allowances

      minus

any Charges

      plus

any Freight amount

      plus

any Tax amount

For a Remittance Advice, the invoice total is the amount specified during the 
adjudication process. This amount, minus the Discount/Adjusted Amount, results 
in the Net Amount Paid by you.

Invoice types
Common Invoice types are:

■ Service-Related — Invoice where the line items specify a quantity and a price, 
but the quantity times price typically cannot exceed a specific amount. 
Additionally, the Supplier can enter detail lines that must not exceed the total for 
the line for the line item.

■ Fixed-Price — Invoice where the price is fixed and the Supplier enters only a 
quantity to Invoice. The goods are received via a business standard receiving 
processes at a receiving dock. Also known as Direct Material Invoice.

■ Variable-Pricing — Invoice where line items have a quantity and an initial 
price, but the price can vary with each shipment; for example, oil, grain, steel. 
The Supplier enters the price and quantity. Also known as Commodity Invoice.

Allow Partial Credit Let Suppliers create a Credit Note for an amount less than the line item amount on 
the corresponding Invoice.

Create Credit Without Invoice Let Suppliers create a Credit Note that does not have a corresponding Invoice.

Rule Select rule to . . . 
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■ Non-receivable — Invoice where the line item has a fixed price and a specified 
quantity, but the goods are not received via standard processes. This invoice 
type can require a requestor acknowledge receipt prior to payment. Also known 
as Drop Ship Invoice.

■ Mixed — All other Invoices.

Invoiced (full) or  status
The Supplier submitted an Invoice(s) for all quantities against all Order line items, 
or the system received an EDI Invoice indicating this.

Invoiced (partial) or  status
The Supplier submitted an Invoice(s) for some of the quantities or some of the 
Order line items, or the system received an EDI Invoice indicating this.

Invoiced Qty
Invoiced Quantity
Number of line item units that the Supplier is invoicing you for. This number cannot 
be greater than the Open Qty to Invoice.

Item Total
Sum of the extended line item amounts on the Invoice. The extended line item 
amount is the unit price of the line item multiplied by the quantity invoiced.

Kitting Details
Displays in the Order Details area of the Order. It indicates the Order item 
contains sub-items. The information that displays is based on what you selected in 
the Child Line Item Fields area in the Form Edits section of Buyer Settings.

Last Shipment
Indicates if this shipment represents the last items shipped against the Order.

line item
One item on an Order, regardless of quantity. An Order can contain multiple line 
items. Each line item is independent the other line items. A line item can contain 
one or more order schedules.

Location
Names of places where products are stored.

Method of Payment
How you are paying the Invoice; for example, Check, Electronic, etc.

missed commit
A missed commit occurs when a Supplier commits a given part schedule, but the 
date is not the date you requested for 100% of the net quantity. All split commits 
are considered to be missed commits. Also, a part schedule is a missed commit if 
you change the date or quantity for a previously committed schedule.

Missed Commits
OLV looks for the part schedules in current Orders (acknowledged or not) where 
the corresponding Order line item does not match the total quantity or arrival date 
requested. Missed commits include only committed Order line items that contain 
commit information, and that you did not receive.



A C T I V E  O RD E R S  C L A S S I C

Field Descriptions and Terms

Trading Grid Online User Guide  418

Multiple Qty
Multiple Quantity
For products that are sold in unit multiples. If you indicate the product is sold in 
multiples, the Multiple Quantity field identifies how many of this item represent 
a unit. To determine the extended price, the system divides the quantity ordered 
by the quantity of the multiple, and then multiplies by the unit price.

Net Days
The number of days you have to pay the Invoice. Invoices that are paid past the 
indicated Net Days are considered late. If you pay within the Discount Days, 
you are eligible for the discount percentage.

Net Amount Paid
On a Remittance Advice, the difference between the approved Invoice Amount and 
the Discount/Adj Amount.
New Invoice Alert
Select to generate an email when that Supplier submits an Invoice to OLV. The 
email is sent to all recipients you specify on the User Alerts page.

New Ship Notice Alert
Select to generate an email when that Supplier submits a Ship Notice in OLV. The 
email is sent to all recipients that you specify on the User Alerts page.

New Overdue Shipment Alert
Select to be notified, by email, when that Supplier has not submitted a Ship Notice 
by your Requested Arrival Date. The email is sent to all recipients that you specify 
on the User Alerts page.

New SN Alert
Select to generate an email when that Supplier submits a Ship Notice in OLV. The 
email is sent to all recipients that you specify on the User Alerts page.

New status
Recently web-created Invoice that has not yet been sent to you.

Notes
Enter any additional business information about the order.

Number of Units
Number of Packaging Units.

Number Shown per Page
On any of the Search pages, specify the number of documents to display on each 
Search Results page.

Open Qty to Invoice
Number of line item units yet to be shipped and invoiced.

Open Qty to Ship
Number of line item units yet to be shipped - Order Qty - Received Qty = Open 
Qty to Ship.

Order
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Purchase Order, or your authorization to formalize a purchase transaction with the 
Supplier. An Order should state:

■ The name, part number, quantity, description, and price of the goods or services 
ordered

■ Agreed-to terms as payment, discounts, date of performance, and transportation

■ Any other agreements pertinent to the purchase and its execution by the 
Supplier

Order Acknowledgment
Accept indicates the Supplier has acknowledged (reviewed) the Order and has 
agreed to its contents.

Order Acknowledgement Alert
Select to generate an email each time that Supplier has not acknowledged one of 
your Orders within a certain amount of time. The email is sent to all recipients that 
you specify on the User Alerts page.

Order Line Number
The identifier of a line item on an Order. Click the number to see line item details. 

For a line item in the Invoice, the Order Line No. specifies its corresponding line 
number in the Order.

Order No.
Order Number
Unique identifier for the Order:

■ On the Order Search page, you can specify the Order for which you want to see 
information. You can enter a:

■ Complete Order Number

■ Partial number (one or more characters) followed by an asterisk (*)

■ On the Invoice Search Results and Invoice Header tab pages, the Order from 
which the Invoice was created.

■ On any Search Results page, click the number to see Order information.

Order Qty
Total required quantity for the line item, as specified in the Order.

Order Release No.
An optional field used by some companies to identify an order within a blanket 
Order.

A blanket Order is your long-term commitment to a Supplier for an item against 
which short-term releases are generated to satisfy requirements. Often, blanket 
Orders cover only one item with predetermined delivery dates. A blanket Order is 
synonymous to a standing Order.

order schedule
Each order schedule has a given quantity for a specific date that belongs to the line 
item that belongs to an Order.
Order Status
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On the Order Search page, search for Orders based on their status. For status 
explanations, see “Status.”

Orders to Acknowledge
Order line items that the Supplier has not yet acknowledged, or that need to be 
“re-acknowledged” per your request.

Order Total

Total monetary amount you have authorized for all Order line items.

Organization
On the Search page, click the drop-down list to see a list of subdivisions. The 
corporate-level is at the top on this list. Use this list to see Orders for all divisions, 
or for a single division.

Out of Stock
On the Inventory Activity page, these fields indicate the number of items that are 
out-of-stock for that specific time period.

Overdue Commit Alert
Select to be notified by email when that Supplier has failed to enter commitment 
data within a certain amount of time. The email is sent to all recipients you specify 
on the User Alerts page.

Overdue Shipment Alert
Select to be notified by email when that Supplier has not submitted a Ship Notice 
by your Requested Arrival Date. The email is sent to all recipients you specify on 
the User Alerts page.

Overdue status
This status applies to a firm order that is past due. This status occurs when your 
Requested Arrival Date is past the current date, which is based on your standard 
time, and you have not received a Shipping Notice.

Packaging Type
Packaging Units
How the items are packaged for shipment; for example, carton, pallet, etc.

Paid (full) or  status
The Hub has paid all Invoices related to the Order, or the system received an RA or 
EDI 820 stating this.

Paid (partial) or  status
The Hub has made some payments related to the Order, or the system received an 
RA or EDI 820 stating this fact.

Payment No.
Payment Number
Unique identifier for a Remittance Advice. On the Search for Remittance Advice 
page, you can specify this number to access only that Remittance Advice. Or, you 
can enter a partial number followed by an asterisk (*).

On any Search Results page, click the number to see Remittance Advice 
information.

Payment Method
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How you are paying the Invoice amount, for example, Credit Card.

Pending Shipment Alert
Select to generate an email before a shipment from that Supplier is due. The email 
is sent to all recipients you specify on the User Alerts page. This is a proactive alert 
that you might want to send to the Supplier as a reminder.

PO
Purchase Order. This document is your authorization to formalize a purchase 
transaction with the Supplier. An Order should state:

■ The name, part number, quantity, description, and price of the goods or services 
ordered

■ Agreed-to terms as payment, discounts, date of performance, and transportation 

■ Any other agreements pertinent to the purchase and its execution by the 
Supplier

Purchase Order
Your authorization to formalize a purchase transaction with the Supplier. An Order 
should state:

■ The name, part number, quantity, description, and price of the goods or services 
ordered

■ Agreed-to terms as payment, discounts, date of performance, and transportation

■ Any other agreements pertinent to the purchase and its execution by the 
Supplier

Reason Code*
For a Remittance Advice, the reason for the Discount/Adjusted Amount. To see an 
explanation for the Reason Code, click the code. The system lists the common EDI 
ANSI reason codes with a short description.

Received Quantity
The quantity of the part schedule or Order line item that you already received.

release
The authorization to produce or ship parts that you ordered.

Release No.
Release Number

An optional field used by some companies to identify an order within a blanket 
Order.

A blanket Order is your long-term commitment to a Supplier for an item against 
which short-term releases are generated to satisfy requirements. Often, blanket 
Orders cover only one item with predetermined delivery dates. A blanket Order is 
synonymous to a standing Order.

Remit to
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Address where the Invoice confirmation or payment is sent. This address could be 
a combination of physical/street addresses, bank account/routing information (for 
electronic funds transfer), or lot box related information.

Important: Your organization is responsible for providing and maintaining a list 
of accurate and approved remit-to addresses for each Supplier so your company's 
back end/ERP systems accepts the Invoices.

Remarks
Explanatory information and details about the line item. A  next to the amount 
indicates comments. Click the  to read the text.

remittance advice
Some supply chain trading partners transmit invoice remittance information to their 
Suppliers. 

A remittance advice is a document that identifies the invoice settlement date and 
payment amount and contains information on a payment, such as the receiving 
bank account and the Invoices that were paid. It shows the details of a Buyer 
Company payment, which could be for multiple Invoices. Accounts Payable usually 
generates Remittance Advices for EFT (electronic funds transfer) payments. For a 
payment by check, the Remittance Advice is the check stub.

Requested Date
Requested Arrival Date
Requested Delivery Date
Requested Ship date
Date you asked to receive the ordered parts from the Supplier.

Requested Quantity
The quantity of the line item you requested in the Order schedule or Order line 
item.

Retailer
Refers to your Company name and contact information.

Retailer SKU
Number or code you assigned to the line item, or the part number associated with 
the part schedule or the Order line item.

Revision
The revision level of the part, which indicates the number of changes to the part. 
The Order might or might not have releases against it.
rules
See “Invoice rules” and “Ship Notice rules.”

Saved Queries
When doing a search on inventory activity, on your Inventory Activity Search 
Results page, you can specify to name and save the search criteria you entered. 
Then, on the Search Inventory Activity page, you can select the query from this list 
to do the same search.

Schedule Date Range
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The starting (From) and ending date (To) between which you want to see Order 
Schedules or Ship Notices based on the Requested Arrival Date. Enter the dates 
in the specified format. Or, click the calendar icon to select the dates.

For Shipping Notices or Order line numbers, the system finds those with a 
Requested Date within the Date Range you specify. For Invoices or Remittance 
Advices, the system finds those with a creation date within the Date Range you 
specify.

Schedule No.
Unique identifier for the Order schedule.

Schedule Type
There are various types of Orders. The status of the Order line item indicates the 
type of Order:

■ Planned status — You generate this status. Planned Order line items are 
for Supplier planning purposes; they contain forecasted future 
requirements. For a planned Order line item:

■ An Order number has not been assigned to the line item.

■ You have not committed to the line item order.

■ You can change the Order line item order details at any time.

■ You can delete the Order line item order at any time.

■ Firm — The Buyer generates this status. Note that:

■ This is a “true” order that you are requesting that the Supplier is to fill. 
That is, you are committing to purchase.

■ This Order line item order is for a stipulated period of time.

■ You cannot change the Order line item order details during the 
stipulated time period.

■ The Supplier has not yet committed to the Order line item order. 

■ The Order line item has an assigned Order number.

■ Overdue — Applies to Firm orders that are past due. This status occurs 
when your Requested Arrival Date is past the current date, which is based 
on your standard time, and you have not received a Shipping Notice.

Settlement Date
Date on the Remittance Advice that specifies when you made the payments 
included in the advice.

Ship from Address
Location of the items being shipped.

Ship Notice Number
Shipping Notice Number
The Supplier's Invoice number or other unique identifier for the shipment.

Ship Notice rules
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Ship Notice rules are set by the Company Administrator.

Rule Select rule to . . . 

A Ship Notice cannot have more than 
one Product ID or part number

Ensure Suppliers create a Ship Notice where, for each line item entered, the 
product IDs or part numbers are the same. Otherwise, the Ship Notice line items 
can contain different product IDs or part numbers.
Example: The Supplier enters a shipment quantity for two different Order 
schedules, one where the Part Number is 123, the other where the Part 
Number is 456. If this rule is:

■ On (selected), OLV gives the Supplier an error message stating “All part 
numbers must match on this ASN,” and the Notice is not submitted to you.

■ Off (not selected), OLV submits the Ship Notice to you.

A Ship Notice cannot contain line items 
with different Ship-To addresses

Ensure Suppliers create a Ship Notice where all line items are shipped to the 
same address. Otherwise, the Supplier can ship different line items to different 
addresses. OLV does not check the addresses, but you are asked to select a 
single address for OLV to map for the Ship Notice/ The single address that you 
select is the only address viewable in the EDI translation.
Example: The Supplier, enters a shipment quantity for two different Order 
schedules, one with an address of 100 Edison Park Drive, the other with an 
address of 1600 Pennsylvania Avenue. If this rule is:

■ On (selected), OLV gives the Supplier an error message stating “All ship-to 
address must match on this ASN,” and the Notice is not submitted to you.

■ Off (not selected), OLV submits the Ship Notice to you.

A Ship Notice cannot contain line items 
from multiple Orders

Ensure Suppliers create a Ship Notice for line items in only one Order. 
Otherwise, the Supplier can enter line items from multiple Orders in the Ship 
Notice.
Example: The Supplier searches the database for all Orders that need to be 
shipped and enters Ship Notice information. If this rule is:

■ On (selected), OLV gives the Supplier an error message stating “Your Ship 
Notice cannot include quantities against multiple Orders,” and the Notice is 
not submitted to you.

■ Off not selected), OLV submits the Ship Notice to you.

A Ship Notice cannot be created with a 
date in the past

Ensure Suppliers enter a current or future date into the Shipping Date field. 
Otherwise, the Supplier can enter any past, current, or future date in the 
Shipping Date field.
Example: The current date is June 15 and the Supplier creates a Ship Notice 
with a Shipping Date of June 10. If this rule is:

■ On (selected), OLV gives the Supplier an error message stating “Ship Notice 
Date” cannot be in the past, and the Notice is not submitted to you.

■ Off (not selected), OLV submits the Ship Notice to you.

A Ship Notice cannot contain lines 
previously flagged with “Last 
Shipment” indicator

Ensure Suppliers do not create a Ship Notice for line items where 100% of the 
quantity has been shipped.
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Ship Quantity
The number of parts in this shipment. The number should not exceed your 
requested quantity minus the Total Shipped Quantity.

Ship to Address
Location to which the items are being shipped.

Ship-to-Location ID
A Buyer-assigned code identifying one of their shipping destinations; for example a 
distribution center or store.

Shipped
Shipped (WTD)
Shipped (num Weeks ago)

Number of items that were shipped. 

Shipment Date
The date the order is to ship.

Shipment Time
The time of day the order is to ship.

Shipped (full) or  status

Limit by SN scheduled quantity - 
Tolerance nn %

Ensure Suppliers enter a Ship Quantity that equals the Requested Quantity 
plus a specified Tolerance (percentage of requested quantity). Otherwise, the 
Supplier can enter any Ship Quantity, even one that exceeds your Requested 
Quantity.
Example: The Requested Quantity is 100 and the Tolerance is 10%. The 
Supplier creates a Ship Notice with a Ship Quantity of 111. If this rule is:

■ On (selected), OLV gives the Supplier an error message stating “Shipment 
Quantity cannot exceed Requested Quantity,” and the Notice is not 
submitted to you. 

■ Off (not selected), OLV submits the Ship Notice to you.

Limit by SN received quantity - 
Tolerance nn %

Ensure Suppliers enter a Ship Quantity that equals the Open Quantity to 
Ship plus a specified Tolerance (percentage of open quantity). Otherwise, the 
Supplier can enter any Ship Quantity, even one that exceeds or is less than the 
Open Quantity to Ship. Selecting this rule tells OLV to calculate the Open 
Quantity to Ship based on the quantity received, rather than the quantity the 
Supplier shipped. These quantities can differ due to loss-in-transit, damage, 
shrinkage etc.
Example: The Requested Quantity is 100, Open Quantity to Ship is 100 
and the Tolerance is 10%. The Supplier enters SN#1 with a Ship Quantity 
of 80, and Buyer sends in a receipt quantity of 75. Then, in SN#2, the Supplier 
enters a final Ship Quantity of 20. If this rule is:

■ On (selected), OLV calculates the Open Quantity to Ship to be 25 and 
rejects the Ship Notice. 

■ Off (not selected), OLV calculates the Open Quantity to Ship to be 20 
and accepts the final Ship Notice. 

Important If you select this rule, you should also select the Limit invoice by 
receipt quantity - Tolerance nn % Invoice rule.

No rules Select this option to place no ship quantity restrictions on the Supplier.

Rule Select rule to . . . 
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All of the quantities for all Order schedules were shipped, or the system received 
an EDI Shipping Notice document stating complete shipment.

Shipped (partial) or  status
Some quantities or some Order schedules have been shipped, or the system 
received an EDI Shipping Notice document stating this.

SKU Number
The Buyer-assigned Stock Keeping Unit identification number used in inventory 
management.

SN Alert
Select to generate an email when that Supplier submits a Ship Notice in OLV. The 
email is sent to all recipients that you specify on the User Alerts page.

Special Charges
An optional or additional charge the Supplier is charging for a specific line item 
within an Invoice. A  next to the amount indicates that the Supplier made 
comments specifically about this charge. Click the  to read the text.

A Special Charge is added to the Invoice line item total.

split commit
A split commit is when the Supplier cannot guarantee the entire quantity on a 
given date, but is tied to a single part schedule. All split commits are considered to 
be missed commits.
standing Order
See “blanket Order.”

Status

Status Icons and explanation

Acknowledged Supplier acknowledged the Order by accepting or rejecting it, or 
the system received an EDI Order Acknowledgement.

■  Acknowledged and accepted.
■  Acknowledged but rejected.
■ Acknowledgment not required.
■ Acknowledged, but neither accepted nor rejected.

Committed ■ Fully committed. Supplier entered all the required 
commitment data for the Order.

■ Partially committed. Supplier entered some, but not all of, the 
required commitment data for the Order.

■ Fully missed. Supplier did not fulfill any of the commitment 
promise.

■ Partially missed. Supplier did not fulfill all of the commitment 
promise.

Credit ■ Partial credit. Supplier entered a partial credit against the 
associated Invoice.

■ Full credit. Supplier entered a complete credit against the 
associated Invoice.

Deleted ■ Status occurs when you delete either the Order or the 
Requested Quantity for a part schedule or Order line item. 
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Stock Condition
On the Search Inventory Activity page, search for a product that is based on its 
stock status.

Sub Contractor

Firm You generate this status:
■ This is a “true” order that you are requesting the Supplier to 

fill. That is, you are committing to purchase.
■ This Order line item order is for a stipulated period of time.
■ You cannot change the Order line item order details during 

the stipulated time period.
■ The Supplier has not yet committed to the Order line item 

order.
■ The Order line item has an assigned Order number.

Invoiced ■ Fully invoiced. Supplier submitted an Invoice(s) for all 
quantities against all Order line items, or the system received 
an EDI Invoice indicating this.

■ Partially invoiced. Supplier submitted an Invoice(s) for some 
of the quantities or some of the Order line items, or the 
system received an EDI Invoice indicating this.

■ Previously invoiced. There is a previous Invoice(s) against this 
Order.

New Recently web-created Invoices that have not yet been sent to you.

Overdue Applies to Firm orders that are past due. This status occurs when 
your Requested Arrival Date is past the current date, which is 
based your standard time, and you have not received a Shipping 
Notice.

Paid (full) ■ Fully paid. You or your Hub has paid all Invoices related to the 
Order, or the system received an RA or EDI 820 stating this.

■ Partially paid. You or your Hub has made some payments 
related to the Order, or the system received an RA or EDI 820 
stating this.

Planned You generate this status. Planned Order line items are for Supplier 
planning purposes; they contain forecasted future requirements.
For a planned Order line item:

■ An Order number has not been assigned to the line item.
■ You have not committed to the line item order.
■ You can change the Order line item order details at any time.
■ You can delete the Order line item order at any time.

Shipped (full) ■ Fully shipped. All quantities for all Order schedules were 
shipped, or the system received an EDI Shipping Notice 
document stating complete shipment.

■ Partially shipped. Some quantities or some Order schedules 
have been shipped, or the system received an EDI Shipping 
Notice document stating this.

Submitted Invoices that were sent.

Viewed  Supplier opened the Order on the web, or the system received an 
EDI functional acknowledgement.

Status Icons and explanation
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On the Order, the name of the Supplier's company.

In a Remittance Advice, the Supplier's contact information.

Submitted status
The Invoice was sent to you or your Hub.

Supplier
On the Order, the name of the Supplier's company.

In a Remittance Advice, the Supplier's contact information.

Supplier Catalog Number
Supplier Part Number
Supplier's catalog number for the Order line item or the part schedule.

Supplier Item ID
The alphanumeric value the Supplier uses to identify a particular product.

Supplier Code
The specific business partner relationship code that you assigned the Supplier. 
Each Supplier has a unique company code within your company system. 

Note: If the Supplier company has different branch locations, you might have 
assigned multiple Codes, with each Code representing a different branch location.

Supplier Number
The Vendor Number you assigned when you approved the Supplier as a Trading 
Partner.

Supplier SKU
The Supplier-assigned Stock Keeping Unit identification number used in inventory 
management.

Supplying Company
On the Order, he name of the Supplier's company.

In a Remittance Advice, the Supplier's contact information.

Tax Amount
Total tax amount for the goods being invoiced.

Taxable
Whether or not the line item is a taxable product.

Terms Description
Short description of the sale terms, for example, Net 30.

Terms Start from
Code identifying the date when the terms of sale begin.

■ 1 - Ship date

■ 2 - Delivery date

■ 3 - Invoice date

Time Zone
For a Shipping Notice, the time zone that applies to the Shipment Time.

Total Amount
For a Remittance Advice, the sum of all amounts paid in the advice.
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Total Shipped Qty
The total quantity the Supplier shipped for the specific parts schedule or Order line 
item. This number is:

■ Never less than your Requested Quantity, because the system assumes the 
Supplier shipped the Received Quantity.

■ Equal to the Received Quantity plus any quantity in transit; that is, any 
quantity that the Supplier has shipped but you have not yet received.

TransOrder Number
The voyage, trailer, or flight number.

TransOrder Method
How the items are being shipped; for example, Rail, Air, etc. Mutually Defined 
indicates you and the Supplier discussed this and agreed on the shipment method.

Unit Price
The price of the line item, per unit. The unit is specified in the UOM field, and the 
dollar type is specified in the Currency field.

UOM
Unit of Measure, which is the type of measure for the item; for example, EA for 
each, DZ for dozen. Ordering and shipping are based on this type of unit.

UPC
Number or code you assigned to the line item. The part number associated with 
the part schedule or the Order line item.

Vendor
On the Order, the name of the Supplier's company.

In a Remittance Advice, the Supplier's contact information.

Vendor Code
Vendor ID
The specific business partner relationship code you assigned the Supplier. Each 
Supplier has a unique company code within your company system. 

Note: If the Supplier company has different branch locations, you might have 
assigned multiple Codes, with each Code representing a different branch location.

Vendor Item ID
Supplier's catalog number for the Order line item or the part schedule.

Viewed or  status
Supplier opened the Order on the web, or the system received an EDI functional 
acknowledgement.

Weight
Weight of the total shipment. When creating a Shipping Notice, remember to select 
the Unit of Measure and Weight Type.

Weight Type
Type of shipment weight, for example, gross or net. Mutually Defined indicates 
you and the Supplier discussed this and agreed on the weight type.
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Active Documents Classic B
Active Documents classic is the previous version of Active Documents. This is the 
version you will use if you do not have access to the Active Documents tab in 
Trading Grid Online. 

Topics include:

■ “Enable the Active Documents Dashboard”

■ “Search for Transactions”

■ “Search Results”

■ “Transaction Process Lifecycle — Classic”

■ “Transaction Process Lifecycle — New”

■ “Scheduled Reports”

■ “Delivered Reports”

■ “Glossary”

Enable the Active Documents Dashboard
When you first use Active Documents Classic, the Active Documents Dashboard on 
your Operations Center page might be minimized. Display it the way you would 
display any minimized page. 

However, if the Active Documents Dashboard is not minimized or displayed, you 
must perform the steps in this topic.

Otherwise, go ahead and “Use the Active Documents Dashboard.”

Or, to work directly with your documents, click the Reports tab.

To enable the dashboard, do the following.

1 On the Operations Center page, click the Configure icon. 
The Configure This Page area opens.
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2 Click the Page Components title bar to open that area. 

In the Copy to Operations Center column, click the Active Documents 
Dashboard check box > Set Components. 
The Active Documents Dashboard is added to the Configure This Page 

area.  

3 (Optional) In the Active Documents Dashboard row, remove the check in 
the Minimize column check box to deselect the Minimize option, unless you 
want the Dashboard to display in a minimized state. (You can maximize the 
Dashboard manually.) 

4 (Optional) If you want the Active Documents Dashboard to display above 
the Message Center on the Operations Center page, in the Order column, 
change the values to 1 for the Active Documents Dashboard and 2 for the 
Message Center. 

5 Click Apply. 
6 Trading Grid re-configures the Operations Center page and displays the Active 

Documents Dashboard.  

Use the Active Documents Dashboard 
An Active Documents Dashboard provides links to quickly view activity in a number 
of categories, such as communication errors, and drill down for more information 
in a category of errors or processing. 

To view your Active Documents Dashboard, click the Operations Center tab. 

The contents of the Dashboard display in part based on the GXS services that you 
subscribe to (for example, extended event information) and your Trading Grid 
implementation. 

Depending on your role and subscription options, your Trading Grid service 
includes one of two Dashboard types. 
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Most Managed Services customers will see this type:

And, most Trading Grid Messaging Services customers will see this type:

The Inbound and Outbound columns organize the information by transmission 
direction. Each column lists types of information, such Communication Errors 
and Not Acknowledged, and the number of current records for each type of 
information (for example, the number of communication errors). Other categories 
are:

Category Description

Negative status alerts If set up by an administrator.

Extended errors  These are errors related to extended events, which your 
company can publish to GXS from your back end system. For 
example, your system might detect that a file failed to 
reconcile and report that to GXS. This type of information 
displays in Active Documents if you subscribe to the 
Extended Event service. 
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A number greater than 0 indicates a live text link that you can click to view more 
information. It is the quantity of errors of that type (for example, Communication 
Errors) for the company during the selected time period. 

Click a text link to begin drilling down into data. Sections below provide more 
details about drilling down and using the Select Date selector. 

To update the counts on the Dashboard at any time, click Refresh. 

See the following for more information:

■ “Change the Reporting Time Period”

■ “Select a Mailbox” on page 434

■ “View Dashboard Information” on page 434

■ “Save a PDF of the Dashboard” on page 435

■ “Print the Active Documents Dashboard” on page 435

Change the Reporting Time Period
By default, the Active Documents Dashboard displays exceptions and activity for 
the past three days or 24 hours, depending on your Trading Grid service. 

To change the time period
1 Do one of the following:

■ At the top of the Dashboard, if the Select Date drop-down list displays, 
select a different three-day time range to report.

■ At the top of the Dashboard, if the Time Frame drop-down list displays, 
select an option from the list — the last 24 or 48 hours, or a three-day time 
range before that.

The Dashboard values are updated via data from the selected time range.

Unreconciled Extended 
Events

During transaction processing, Trading Grid did not receive 
all events from a business unit that subscribes to the 
Extended Event service.

Unreconciled GXS Events During transaction processing, Trading Grid did not receive 
all events that occur on the GXS side of processing.

Unextracted Transactions Files not picked up by trading partners.

Extracted Transactions Files picked up by trading partners.

Acknowledgements Files that trading partners have not acknowledged or for 
which acknowledgments are late.

Recent Transactions Total of Extracted, Unextracted, and Rejected Transactions in 
the selected Time Frame.

Rejected Transactions Outbound files rejected by trading partner, or inbound files 
rejected by customer.

Interconnect Rejects Inbound only; files from a third-party VAN, for example, that 
are rejected at GXS. This service will be available in a coming 
release. 

Category Description
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Select a Mailbox
Your Trading Grid service might let you select a specific GXS mailbox on the Active 
Documents Dashboard. The Dashboard then displays counts for transactions 
associated only with the selected mailbox. 

To select a different mailbox to apply to the Dashboard
At the top of the Dashboard, in the Mailbox # drop-down list, click a mailbox 
identifier. 

View Dashboard Information
The information displayed by the Dashboard depends on your Trading Grid service.

To view dashboard information
1 Click the Operations Center tab. 
2 On the Active Documents Dashboard, do one of the following: 

3 Click a dashboard link to open the Reports tab and view the list of Partners and 
associated addresses that meet the dashboard criteria. 
The Error Count or Count column shows the number of files of the selected 
category and direction for each partner in the list. 

4 In the Partner Name column, click the link for the partner transactions you 
want to review. 

To view Do this Comments

Error information In the Inbound or Outbound column, do one of 
the following: 

■ Click the Communication Errors, 
Processing Errors, or Extended Errors 
text link, for example. 

■ Click the number link for the error type and 
transmission direction that you want to view. 
The number represents the number of errors 
of that type and direction for the selected 
mailbox. 

Negative Status 
Alerts

 in the Inbound or Outbound column, click the 
Negative Status Alerts link.

Your Trading Grid service might support 
negative status alerts of errors or events that 
fail to occur during transaction processing

Un-reconciled 
Event information

in the Inbound or Outbound column, click the 
Un-reconciled Extended Events or Un-
reconciled GXS Events text link.

Un-reconciled events indicate that Trading Grid 
did not receive all events during transaction 
processing. Events might occur on the GXS or 
customer (“extended”) side of processing.

Acknowledgment 
information

Do one of the following, depending on which is 
available: 

■ In the Acknowledgments column, click 
either:
■ Not acknowledged to see all 

transactions not yet acknowledged. 
■ Late acknowledgments to see only 

unacknowledged transactions that are late.
■ In the Outbound column, click the number 

link for the two acknowledgment categories. 

Accounts that send EDI data might track 
whether or not acknowledgments confirming 
receipt of the data are received. To do so, they 
subscribe to the Active Documents - FA 
Management service that displays the number 
of unacknowledged files and overdue 
acknowledgments.
In most cases acknowledgments are considered 
late when they are not returned within 24 
hours. However, you might have a different late 
acknowledgment period. 
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A new page lists the file(s) for that partner. The list includes file information, 
such as sender and receiver identifiers, APRF (document type), and creation 
date and time. 

5 In the GXS Ref. No. column, click an identifier link to drill down into that file. 
The Processing Lifecycle page opens. You can:

■ In the Error Status section, click the View List link.

The Specific Errors List popup displays error information.

■ Scroll to the Status Alerts section to view information. 

■ Examine event or acknowledgement information in the lifecycle. For 
lifecycle information, see the “FA Information.” section.

Save a PDF of the Dashboard 
To save a PDF of basic information in all categories on the Active Documents 
Dashboard, click the Adobe PDF icon above the Dashboard. Rollover text varies by 
implementation: 

■ MS Dashboard PDF Download 

■ Active Documents Dashboard 

When the File Download dialog opens, click Open or Save to open or save the 
file.

Print the Active Documents Dashboard 
This functionality is not available in all implementations. 

To print the Dashboard, click the Print icon. 

If a Print icon is not available, click the MS Dashboard PDF Download icon, 
then in the dialog box, click Open. When the file opens, print it. 

Search for Transactions
All data formats — for example, EDI, XML, and user-defined formats — are initially 
processed as files. You can refine search criteria in different ways, depending on if 
you search tracking data at the file, interchange, or document level. 

There are three areas on any Search page. 

■ Filter area — Filter the search based on an address, transmission direction, or 
other criterion, or apply a saved search that contains filter and other settings. 

■ Tracking data area — Specify tracking data at the file, interchange, or document 
level. 

■ Actions area — Click Search and Clear to perform the search or clear the 
search fields. 

When using Search, to view a field description: 

■ Look up the field in the “Glossary” on page 464. 

■ Click the blue information icon to the right of the field, if present. 



A C T I V E  D O C U M E N T S  C L A S S I C

Search for Transactions

Trading Grid Online User Guide  436

B  

Click Reports tab > Search to search for documents. You can search for tracking 
data in Active Documents for 90 days after the document processes. The physical 
files are archived. Contact GXS to request copies of data over 90 days old. 

Note: Based on your subscription permissions, you might see some or all of these 
functions. Search options include: 

■ “Configure the Search Page” on page 436

■ “Begin Searching” on page 436

■ “Search on Keys” on page 438

■ “Search for Related Documents” on page 439

■ “Group Search Results” on page 439

Configure the Search Page

To configure the Search page
1 Click the Reports tab. 
2 On the Active Documents Search page, at top right click the Configure icon. 

The Configure Search Page panel displays. 
3 In the Used Search Criteria section, deselect check boxes for search levels 

you do not use. Those levels no longer display on the Search page. 
Important: This is not recommended if you exchange EDI data. 

4 In the Default Search Criteria section, select a default search level that 
automatically displays when displaying Search. For example, if you select 
Document, the Search page displays the Document search criteria by default. 

5 To search on primary and secondary keys in a File search, select the Use 
primary and secondary key for file search option. (This is available by 
default in Document searches.)

6 Click Apply. Trading Grid re-configures the Search page.

Begin Searching

Define a New Search

To begin a new search
1 To define a new search, first set up your filter parameters. Filter parameters 

are: 

Parameter Description

GXS Ref No  Unique number created at GXS to track documents. 

Your EDI address and/or 
one or more Partner 
Address(es)

Separate multiple addresses with a comma. 

Specific partner name(s) Separate multiple names with a comma)

Mailbox Specific GXS mailbox, or leave All selected. (TGxx, GXS 
only). 

Direction  Only files that you sent, or you received, or both.
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a Enter any parameter criteria.
b To return files for a specific time period, in the Time Frame drop-down list 

select one of the following options: 

2 Select a Tracking Data Level. Tracking data consists of information at the file 
(system default), interchange, or document level. 

Select one:  

Search options vary by tracking data level. For example, at the document level, 
you might search for a Document Type. 

3 Based on your selection in the previous step, the page redisplays with the 
applicable fields. Enter data in these fields as needed. 

Option Description

Specific No. of Days In the Last X No. of Days From and To fields type the 
most recent number of days to search and the start and 
end times for those days. For example, search from 5 
days ago to 3 days ago, beginning at 00:00:00 the first 
day and ending at 11:59:59 on the ending day.

Specific Date Range  In the From and To fields enter a start date and time and 
an end date and time. Click the calendar icon to open a 
dialog where you can select a date. 

Relative Time 
Range

In the From drop-down list, select the beginning of the 
time period, such as Monday of Last Week or First of 
this Month, and in the next drop-down list select a time 
of that day. In the To drop-down list, select Today or 
Yesterday and select a time on that day for the end of 
time period. 

None Do not use a Time Frame to restrict the search. 
If you select None, Active Documents searches the past 
90 days of tracking data. This might delay results. 
Results might exceed the maximum number of records 
that the system displays.

Tracking 
Data Level Description (can vary by GXS implementation)

File Data translated to or from one non-EDI data format to another non-
EDI data format, or data processed as a pass-through (without 
translation). 
Options might include searching for files with or without errors, 
negative alerts, or other events. 

Interchange EDI-formatted data reporting activity at the interchange level.

Document EDI-formatted data reporting activity at the document level, or XML-
formatted data processed with XML document identification.
Options include viewing related documents (for example, Invoices 
related to Purchase Orders searched for). 
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For field information, see the“Glossary” on page 464. 

4 (Optional) If your Trading Grid service lets you
■ Search for documents that are related to the documents returned by the 

original search. See “Search for Related Documents” on page 439.

■ Configure the Search page to search for files as well as documents by 
Primary Key and Secondary Key. See “Search on Keys” on page 438.

■ Group file search results. See “Group Search Results” on page 439. 

5 Click Search. 
6 Go to “Search Results” on page 440.

Note: After viewing your search results, you can “Save all Search Criteria” on 
page 442 for future use.

Use a Saved Search
You can use a search that you or someone else has saved.

1 Click the Reports tab. 
2 If that tab is already selected but the Search page is not displayed, on the left 

side of the page, click Search. 
The Active Documents Search page opens. Search options vary among GXS 
services subscribed to. 

3 Click Select Saved Searches drop-down > name of the saved search > OK. 
The page refreshes to display the search parameters.
Note: You might see searches saved by other members of your organization. 
They are organized by user, beginning with you. 

4 Change the parameters for this search, if needed. Click Clear to clear all search 
fields.

5 To delete a saved search, click Delete.
The saved search disappears from the drop-down list.

6 Click Search.
7 Go to “Search Results” on page 440.

Search on Keys 
Your Trading Grid service might enable you to target a document search by using 
primary and secondary keys, or only by primary keys. These are data keys such as 
PO Number and SAP IDOC Number or Type. 

You might also be able to modify the Search page to allow key searches at the file 
tracking level. See “Configure the Search Page” on page 436. 

To search on keys
1 In the Primary Key and/or Secondary Key fields type the first character(s) 

of the key type. For example, for Purchase Order Number you could type P. 
TGMS users — always type D or doc for document. This applies to any type of 
document identification number (Purchase Order Number, Invoice Number, Ship 
Notice Number, etc.) that you will enter in the next step.

2 When Active Documents displays available options (PO Number, Product ID, 
etc., click one to insert it in the field. 
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TGMS users — select DOCUMENT ID for any type of document identification 
number (Purchase Order Number, Invoice Number, Ship Notice Number, etc.) 
that you are entering in the next step.

3 In the Primary Key Value and/or Secondary Key Value fields, type the 
specific value to search for the selected key. For example, type the actual PO 
Number or Product ID to use in the search. 
In the Value field, if you type a partial key value followed by an asterisk (*), 
the system searches for any files or documents with the selected key value that 
begins with that sequence of characters. 

Search for Related Documents
Your Trading Grid service might allow you to search for documents that are related 
to the documents returned by the original search. For example, you can search for 
810s related to the 850s returned by the search. 

To search for related documents
1 In the Document Type field, type the document type(s) on which to base the 

related documents search. Separate multiple document types by commas. For 
example, type 850 to search for documents related to one or more 850s. 

2 (Optional) To further define the source document, for example, search for 
documents related to a specific 850, use the Primary Key and Secondary 
Key fields to target that 850. See “Search on Keys” on page 438.

3 Select the Related Documents check box. The Related Document Type 
field displays. 

4 Do one of the following: 
■ To display only specific type(s) of related documents (for example, 810s), 

type that ID in the Related Document Type field. You can enter multiple 
types separated by a comma. 

■ To return related documents of all types, leave the field blank.

Group Search Results
Your Trading Grid service might allow you to group search results by address 
(Sender or Receiver ID), time interval, and other criteria. This can make it easier to 
analyze search results that include many records. 

You can define the order in which to apply criteria to the search results. For 
example, Active Documents could sort search results first by partner name, then 
within each partner group by document type, then within each partner group and 
document type by time interval, etc.

The Group Result By option is available at all levels of Search. 

To group search results 
1 In the File, Interchange, or Document tracking data area of the Search page, 

select the Group Result By check box. 
New fields display below the check box.  

2 Use the drop-down lists to specify the order in which to apply criteria to sorting 
the list, and to omit criteria from sorting. 
For any field you want the sort to ignore, select Consolidate for that field.



A C T I V E  D O C U M E N T S  C L A S S I C

Search Results

Trading Grid Online User Guide  440

B  

For example, sort 1st by My Address, 2nd by Partner Name, and select 
Consolidate for the Time Interval. Your results will be sorted by Partner 
Name within My Address.

Search Results
The Search Results page displays the applicable files, documents, or interchanges 
based on your search criteria. 

Note: Some columns display only in a downloaded file, not in the user interface. 

Configure the Search Results Page
You can configure the search results page for each transaction level (file, 
interchange, and document). This enables you to display additional data as 
columns on a page or in an output file. 

To configure the Search Results page
1 On the Search Results page, in the Reports bar, click Configure.

A panel displays the options for the Search Results page. 

2 Do the following: 

3 Click Submit (for a new search) or Update Saved Search (for a saved 
search). Trading Grid refreshes the page. 
For a saved search, Active Documents uses the new display settings in future 
searches.

To close the panel without submitting or updating, click the X at top right. 

To . . . Do this . . .

Add a column Click Add Column > select the column > OK. The 
column name is added to the list. For example, add a 
column for Functional Group Sender and/or Receiver 
for document-level searches. 
An asterisk (*) after a column name in the Add 
Column drop-down indicates that the column displays 
only in scheduled reports, not on the search results 
page.
A plus symbol (+) after a column name indicates that 
the column displays only for search results with a 
Status of Incomplete or With Errors. 

Remove a column Click the X next to the column name. (The white X 
turns red when your mouse pointer touches it.) The 
column name disappears from the list.

Move a column Click the column name and drag it to a different place 
in the list.

Change the default sorting 
method

In the Sort By drop-down list, select a different 
column to use for sorting.

Change the number of 
results that display on a page

In the Lot Size drop-down, select a different number. 
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View the Results
From the Search Results page, you can also view

■ “Results with More than 1000 Records” on page 441

■ “Grouped Results” on page 441

■ “View Related Documents” on page 441

■ “Drill Down into Data” on page 442

■ “Print and Save Results” on page 442

■ “Save all Search Criteria” on page 442

Results with More than 1000 Records
For searches that return more than 1,000 results, the system displays the first 
1,000 found. 

To view the remaining results
1 Click Generate Report above the table. A dialog opens. 
2 In the dialog create a scheduled report as described in “Save/Schedule/Send 

Reports” on page 460.
Note: 

■ To view the search criteria without returning to the Search page, click the 
View search criteria link at upper right. 

■ If you use a Specific Date Range in the Time Frame option, you must 
select Now in the dialog and generate a one-time report, not a scheduled 
report. 

Grouped Results
When you use groups to organize large search results, the Search Results page 
displays a Count column that lists the numbers of documents found for each 
group in the search results. 

Click a number link in the Count column to view details for the group of search 
returns in that row of the Search Results table. 

View Related Documents 
If your Trading Grid service supports viewing documents related to the documents 
found in a search, use this procedure to view the related documents. 

To view related business documents 
1 On the Search Results page, click the View Related Business Documents 

icon.
The Related Business Documents page opens.

2 To view related documents in a specific document type, click the number link 
under the icon for that document type. 
For each applicable document type, a table displays basic details for related 
documents of that type. 

3 To view the process lifecycle or related documents for a document on the page, 
use the icons as described in “Drill Down into Data” on page 442.
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Drill Down into Data
To access specific data, in the GXS Ref No. column of the Search Results table: 

■ For file searches, click a file link to see its processing history and file contents. 

■ For interchange searches, click the interchange link to view. 

■ For document searches:

■ Click the View Process Lifecycle icon to view document processing 
information. See “Transaction Process Lifecycle — Classic” on page 443.

■ Click the View Related Business Documents icon to view basic 
information about documents related to the document in the Search 
Results. See “View Related Documents” on page 441.

Print and Save Results
On the Search Results page:

■ To print the results, click Print, then in the dialog that opens click the icon again. 

■ To save or view the results as a PDF file, click PDF and follow the prompts. 

■ To save or view the results in an Excel spreadsheet, click CSV and follow the 
prompts. 

■ To view the search criteria that created the results, click the View Search 
Criteria link.

Save all Search Criteria
You can save search criteria (also called report query) to use again later so you do 
not have to recreate the search. 

A saved search and any scheduled report run from that search uses the column 
and column ordering preferences in the Configuration (also called Personalization) 
panel when you save the search. To set display preferences for a search, see 
“Configure the Search Results Page” on page 440. 

To save search criteria 
1 To save your search criteria for a future search, on the bottom right of the 

Search Results page, click Save/Schedule Report. 
2 In the dialog that opens, in the Name field type a unique name for the search, 

for example, “ABC Inc., 810.”
Note: 

■ To prevent report duplication, if the search criteria includes a Specific 
Date Range, you must select the Now option. This generates an 
immediate, one-time report, not a regular scheduled report. See also 
“Save/Schedule/Send Reports” on page 460.

■ To schedule a regular report based on this search, see “View Scheduled 
Reports.”

3 Click Save. 
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Transaction Process Lifecycle — Classic
Important: There are two lifecycle displays — “classic” and “new.” The 
“classic” is the established Active Documents lifecycle. The other is not a “new” 
lifecycle per se, it simply displays the same data in a new, easier-to-navigate 
format. You can easily display either lifecycle — see “Enable the “Classic 
Lifecycle” Option” on page 443 or “Enable the “New Lifecycle” Option” on 
page 452.

Active Documents captures the processing history of files, EDI interchanges, EDI 
documents, and XML documents as they pass through various tracking points. 

Processing lifecycle details provide information about a specific transaction at key 
processing points in each environment. The points that display in the lifecycle 
history depend on the path the transaction follows during its lifecycle. 

Note: The Transaction Processing Lifecycle can provide visibility into both internal 
and Managed Services processes in one view. You may have the option to publish 
edge events to Active Documents . Edge events are transactions from a customer’s 
internal system, such as SAP (an ERP system).

Enable the “Classic Lifecycle” Option
You can easily toggle between the Classic Lifecycle and the New Lifecycle.

1 Find the transaction to examine. See “Search for Transactions” on page 435. 
2 On the Search Results page, in the upper right corner of the listing, click the 

 (Configure icon).
3 For the Show New Lifecycle View option, select No.  

4 Click Submit.
Use this procedure to toggle between the “new” and “classic” lifecycle.

View a Process Lifecycle

To view a process lifecycle
1 Find the transaction to examine. See “Search for Transactions” on page 435. 
2 If necessary, “Enable the “Classic Lifecycle” Option” on page 443.
3 On the Search Results page, click the View Process Lifecycle icon. 

The Processing Lifecycle page displays the processing history of the file, 
interchange, or document. 

Icons represent a processing stages that is detailed in a box lower on the page. 
The icon displays in the title bar of the processing stage, which is a platform, 
translator, application, or other service used to process the transaction. 

Hover your cursor over a processing stage icon to display a description of that 
processing stage. 



A C T I V E  D O C U M E N T S  C L A S S I C

Transaction Process Lifecycle — Classic

Trading Grid Online User Guide  444

B  

For example, these icons 

represent Managed Service Platform > Translation Service > 
Managed Service Platform, respectively.

If an icon includes a red box containing an X, that processing stage failed. 

To jump to a processing stage, click that icon. 

The Processing Lifecycle page includes several sections, depending on the 
number of processing stages. Some sections enable you to drill down into the 
data. See the links under “Transaction Process Lifecycle — Classic” on 
page 443. 

Error Information
If the processing lifecycle contains error information for the lifecycle process or a 
file, a View List link displays in Error Status section near the top of the page. This 
enables you to drill down into information about errors in processing, which could 
be an invalid address, decryption error, or others. 

The Error Status section might display an Update Status link. To use this 
feature, see “Update Error and Event Statuses” on page 444. 

To view errors in a lifecycle or file
1 Scroll to the Error Status section. If errors exist, the numbers next to 

Lifecycle and New indicate the quantities of error of that type.  

2 To view error information, click View List.
The Specific Errors List popup displays error information for the lifecycle or file. 

3 After viewing information, click the X at top right to close the popup. 

Update Error and Event Statuses
The Error Status section near the top of the Processing Lifecycle might display 
status information about errors and events for the transaction. After correcting an 
issue, you can update the status. 

Extended events are processing events that occur on the customer side of 
processing outside of GXS and that the customer company publishes to GXS. Active 
Documents displays the information, such as status, in the Processing Lifecycle, if 
you subscribe to the Extended Event service. 

GXS events are processing events that occur at GXS.
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Trading Grid reconciles one type of event against the other to ensure that 
processing is fully audited and to report issues. Trading Grid might determine that 
an unreconciled transaction between GXS and a customer cannot recover without 
action. When this occurs, Active Documents displays status information and status 
update options on the Processing Lifecycle page for the transaction. Statuses are:

Status Description

Unresolved Errors occurred in processing the transaction on the customer side.

Unreconciled Trading Grid did not receive all events for processing the transaction.

Resolved Errors on the customer side or an unreconciled event status on the 
customer or GXS side have been corrected, and the status updated. 

Reconciled Trading Grid received all events for the file transfer. 

To view and update an error or event status
1 Scroll to the Error Status section. For example:  

2 View the information and edit a status as needed. Statuses and actions are: 

After clicking the link, a popup asks if you want to change the status. 

3 To change the status as described in the popup, click OK. 
4 The status description updates — for example, Unresolved Extended Errors 

changes to Resolved Extended Errors. The Update Status link remains, in 
case you want to change the status back. 

Status Action

Unresolved 
Extended Errors

After correcting errors on the customer side of processing, to 
update the status to Resolved, click Update Status. This 
clears this condition from the Active Documents Dashboard. 

Resolved Extended 
Errors

If errors remain on the customer side of processing, to 
update the status to change it back to Unresolved, click 
Update Status. 

Unreconciled 
Extended Event

Trading Grid received extended events from the customer 
but not GXS events for the transaction. After correcting the 
issue, to update the status to Resolved (not to Reconciled), 
click Update Status. This clears the condition from the 
Active Documents Dashboard. 

Unreconciled GXS 
Event

Trading Grid received GXS events but not extended events 
from the customer for the transaction. After correcting the 
issue, to update the status to Resolved (not to Reconciled), 
click Update Status. This clears the condition from the 
Active Documents Dashboard. 

Resolved Extended 
Event

If extended events remain unreconciled with GXS events, to 
change the status to Unreconciled, click Update Status. 

Resolved GXS Event If GXS events remain unreconciled with extended events, to 
change the status back to Unreconciled, click Update 
Status.
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Status Alerts
If your company subscribes to the Status Alert Service, the Processing Lifecycle 
provides a Status Alerts summary below the top section of the page. Status Alerts 
allow customers to optionally receive status alerts for their inbound and outbound 
transactions at different points, as the transactions are processed on the Active 
Documents platform and delivered to their trading partners. 

Status alerts

■ Provide status information about transaction processing, which includes 
information about processing events that might require action.

■ Communicate transaction events to your backend system and send emails for 
events that may require immediate attention or action. 

■ Are defined by the Community Administrator.  If your company does not 
subscribe to this service but would like to, see your Community Administrator or 
GXS Representative.

Like the Error Status summary described in “Error Information” on page 444, the 
Status Alerts summary links to details about the status alerts through your Active 
Documents Dashboard.  

The lifecycle displays only the most recent report for a status type.  

The Status Alerts section of the Processing Lifecycle displays:

■ Statuses of key events in transaction processing.

■ Green icons for positive event statuses (events that occurred within the 
configured time period).
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■ Red icons for negative event statuses where either (error occurred event has not 
occurred within configured time period) .

■ An error event occurred. 

■ A specific event has not occurred within configured time period. 

For example, a red icon for a mailboxed event might mean that the event was 
rejected or that the event wasn’t received before a specific period of time 
expired. 

■ Time of event status.

■ Link to view details of the status alert. 

To view information about a status alert, click its link in the Status File column.

Possible Event Types, depending on your implementation, can include:

Status Description

accepted The file was received by Active Documents from the 
trading partner's system. This is the starting point 
for all flows.

mailboxed Active Documents mailboxed the translation output file for 
delivery to the trading partner. Not used if the Translated 
status is in the same lifecycle.

tgmsmailboxed The file was sent to the Trading Partner via Trading Grid 
Message Services (TGMS).

extracted Trading partner extracted the file from the mailbox or 
interconnect. 

tgmsextracted The file was received by the Trading Partner via Trading 
Grid Message Services (TGMS).

receivedbp Received by my Partner. The file/document was delivered 
to the trading partner's destination.

receivedfp Received from my Partner. The file/document was 
delivered to my destination.

FA Information
The Processing Lifecycle page might display Functional Acknowledgement 
information.

Acknowledgment Codes are as follows: 

Managed Service Platform Data
Multiple Managed Service Platform entries might exist because transactions can 
pass through the Managed Service Platform at different stages of processing.

For example, in a transaction with no errors:

■ A — Accepted ■ R — Rejected

■ E — Accepted with errors ■ W — Rejected; assurance failed validity tests

■ M — Rejected; message 
authentication code failed

■ X — Rejected; content after decryption count 
not be analyzed

■ P — Partially Accepted; at least 
one transaction set rejected
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■ Managed Service Platform routed file to a translator. (See also “Translation 
Information” on page 448) 

■ Translated output entered another Managed Service routing cycle for 
transmission to the recipient. 

TGMS Data
Trading Grid Messaging Service (TGMS) enables data exchange with your partners. 
It manages your inbound and outbound transactions. 

As with Managed Services, multiple Trading Grid Messaging Service sections might 
exist because transactions can pass through the TGMS as well as Managed 
Services at different stages of processing. 

This section displays when the transaction was received and mailboxed, for 
example. 

Other processing stages might also display, such as a Trading Grid Message Service 
Mailbag section, when a collection of files are going to a Trading Partner via a third 
party.

Communication Sections
A processing lifecycle can display different types of communication information.

Depending on your communication setup, the Processing Lifecycle page might 
include sections that display data exchange information. They might include any of 
the following protocols or standards, depending on your Trading Grid service. 

AS2 FTP/SFTP SAP ALE

AS3 X.400 OFTP

IFTP SMG HTTPS

POP3 SMTP

As with Managed Service Platform and Trading Grid Messaging Service, the 
lifecycle might include multiple communication sections, depending on the 
processing that occurs. 

If a Trading Grid Communication section displays, it is likely because your service 
processes files through the BizManager communication application at GXS. This is 
indicated by text in the title, for example, Trading Grid Communication 
(BizClientSendsFile).

Extended Event Data
Extended events are processing events that occur outside of GXS and that your 
company publishes to GXS. If you subscribe to the Extended Event service, the 
Processing Lifecycle page displays extended event data. 

Event data can include, for example, an IDOC number, status information, and SAP 
Client identifier.

Translation Information
The Translation section might include a link to the TGTS application, where you can 
drill down into the translation issue. 
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The Trading Grid Translation section of a Processing Lifecycle describes the 
translation input and output and includes original and formatted input and output 
files, when available. 

To view translation data and files
1 Next to the Session # at the top, click the Data and Models link to open a 

popup. .
The Translation Session information appears.  

It displays: 

■ Translation Session Number

■ Translation Instance, which might identify a group of files passed to the 
translator

■ Links to view Original and Formatted input and output files from 
translation.

■ Links to view a business view spreadsheet of output files.

■ Names of translation models and attachments, if any, in the translation 
session

■ Option to reprocess files

■ Option to download XIF files

2 To view or save an original or formatted input or output file from translation, 
click the appropriate link, then in the dialog click Open or Save. 

3 To view a business view spreadsheet of output files, in the Output Files 
section, click the CSV link.

4 (GXS only) To reprocess the file through the translator again, in the Reprocess 
section, click Reprocess, or to reprocess and generate a trace file, click 
Reprocess with Trace on. The trace log file displays in the Translation 
section.

5 (GXS only) To view an XIF file (XIF_<Translation Session Number>), in the XIF 
Files section, click Download, then open or save the XML file in the usual 
manner. 

To view details for translator inputs or outputs
1 In the Translation section, next to Translation Input or Translation 

Results, click a link to view files, interchanges, or documents. 
2 View the information. 
3 Do any of the following.

■ On a List Files page, to drill into the processing lifecycle for each linked file, 
click the file link. You can download the file, if available.
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■ On a List Unlinked Files page, click the download link to open the 
Unlinked Files Download dialog, then click the Download link for Original 
File or Formatted File. 

Note: For a raw text file, use Original File. For a text file with line 
breaks where delimiters exist, use Formatted File. (Availability 
depends on original document.) 

Note: You cannot drill down into life cycle detail for unlinked files 
because metadata is not available.

■ On a List Interchanges page, click a link under GXS Ref No to return to 
the Process Lifecycle page.

■ On a List Documents page, in the GXS Ref No column, click one icon to 
return to the Process Lifecycle page, or click the other icon to view related 
documents for the document in that row. An icon key displays on the page.

■ To view or download the list as a PDF or CSV file, click that link at top right. 

■ To print the list, click the Print icon at top right. 

4 If the Translation Results section includes a Bypass Files row, you can click 
the Download link in that row to view and download bypassed files for the 
translation.

Applicable Related Documents
To view documents related to the process lifecycle, click the View Related 
Business Document(s) link above the processing stages icons. 

To view related business documents 
1 On the Processing Lifecycle page, click the View Related Business 

Document(s) link above the navigation icons. 
A new page opens.

2 To view related documents in a specific document type, click the number link 
under the icon for that document type. 
For each applicable document type, a table displays basic details for related 
documents of that type. 

3 To view the process lifecycle or related documents for a document on the page, 
use the icons as described in “Drill Down into Data” on page 442.

Audits and Notes
Use this procedure view audit information, such as a record of email notifications, 
status updates, and other activity for the processing lifecycle. 

In a future release, status updates will include statuses updated in OM. 

To view audits and notes for a lifecycle
1 To view audits and notes for a lifecycle, at the top of the Processing Lifecycle 

page, click the View Audits & Notes link. Or, scroll down to the Audit 
Messages & Notes section.
The Audit Messages & Notes title bar displays.
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2 Under the Audit Messages & Notes title bar, click View Audits & Notes. (If 
no button displays, click the Audit Messages & Notes title bar to display the 
button.) 
A table displays any current audit messages or notes. 

Information includes from left: 

■ Type of entry (for example, Audit of an email notification, or Note 
generated by the system or a GXS technician)

■ Author of the entry

■ Date the entry was created 

■ Details of entry (for example, email notification sent, or a status change in 
the lifecycle)

3 To view an email notification — for example, confirmation that a file was sent — 
click its Show Email link. Author is Notification Email. 
A copy of the email displays in a box. Click Close to close it. 

4 To view other pages in a long list, or to change the number of rows that display 
on a page, use the controls below to list. 

5 To exit Audit Messages & Notes, click the Processing Lifecycle title bar. That 
section displays. 

Print a Processing Lifecycle Page
To print a lifecycle page, click the Lifecycle PDF Download icon at top right.

Transaction Process Lifecycle — New
Important: There are two lifecycle displays — “classic” and “new.” The “classic” 
is the established Active Documents lifecycle. The other is not a “new” lifecycle per 
se, it simply displays the same data in a new, easier-to-navigate format. You can 
easily display either lifecycle — see “Enable the “New Lifecycle” Option” on 
page 452 or “Enable the “Classic Lifecycle” Option” on page 443.

Active Documents captures the processing history of files, EDI interchanges, EDI 
documents, and XML documents as they pass through various tracking points. 

Processing lifecycle details provide information about a specific transaction at key 
processing points in each environment. The points that display in the lifecycle 
history depend on the path the transaction follows during its lifecycle. 

Note: The Transaction Processing Lifecycle can provide visibility into both internal 
and Managed Services processes in one view. You may have the option to publish 
edge events to Active Documents . Edge events are transactions from a customer’s 
internal system, such as SAP (an ERP system).
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Enable the “New Lifecycle” Option
You can easily toggle between the Classic Lifecycle and the New Lifelcycle.

1 Find the transaction to examine. See “Search for Transactions” on page 435. 
2 On the Search Results page, in the upper right corner of the listing, click the 

 (Configure icon).
3 For the Show New Lifecycle View option, select Yes.  

4 Click Submit.
Use this procedure to toggle between the “new” and “classic” lifecycle.

View a Process Lifecycle

To view a process lifecycle
1 Find the record to examine. See “Search for Transactions” on page 435. 
2 “Enable the “New Lifecycle” Option” on page 452.
3 On the Search Results page, click the View Process Lifecycle icon. 

By default, the Item Details section of the Processing Lifecycle displays. The 
Summary Information section of the page shows the processing history of 
the file, interchange, or document. 
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When you scroll down on the page, the next section is the Lifecycle Details 
that lists all of the processing steps for the transaction, translator, application, 
or other service used to process the transaction. 

To see what occurred during a processing stage, click the icon preceding the 
Step name. For example, 

Note that you download files in different formats. Select

■ Original File to download the file without any formatting.

■ Formatted File to download the file with line breaks inserted.

■ PDF File to download the file in PDF format.
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■ CSV File to download the file in a spreadsheet format. 

Click the Lifecycle Content tab to see a hierarchy of all the files and 
documents involved in this one lifecycle.  

In this example, you can “drill down” by clicking on a file name. This file has 
one interchange.

And then, drill down further by clicking on the Interchange. This interchange 
has one document.  

You can personalize this page, or the various sections of the page, by selecting 
or rearranging columns. Click Column Settings and make your selections.

Error Information
If the processing lifecycle contains error information for the lifecycle process for a 
file. This enables you to drill down into information about errors in processing, 
which could be an invalid address, decryption error, or others. 

The error section might display an Update Status link. To use this feature, see 
“Update Error and Event Statuses” on page 444. 

To view errors in a lifecycle or file
1 On the Processing Lifecycle page, click the Item Details tab.

The total number of errors appear in the Lifecycle Details section.  
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2 To view error information, click the Errors link.
The applicable error information displays. 

Status Alerts
If your company subscribes to the Status Alert Service, the Processing Lifecycle 
provides a Status Alerts summary. Status Alerts allow customers to optionally 
receive status alerts for their inbound and outbound transactions at different 
points, as the transactions are processed on the Active Documents platform and 
delivered to their trading partners. 

Status alerts

■ Provide status information about transaction processing, which includes 
information about processing events that might require action.

■ Communicate transaction events to your backend system and send emails for 
events that may require immediate attention or action. 

■ Are defined by the Community Administrator.  If your company does not 
subscribe to this service but would like to, see your Community Administrator or 
GXS Representative.

Like the Error Status summary described in “Error Information” on page 444, the 
Status Alerts summary links to details about the status alerts through your Active 
Documents Dashboard. The lifecycle displays only the most recent report for a 
status type. 

The Status Alerts section of the Processing Lifecycle displays:

■ Statuses of key events in transaction processing.

■ Green icons for positive event statuses (events that occurred within the 
configured time period).

■ Red icons for negative event statuses where either (error occurred event has not 
occurred within configured time period) .

■ An error event occurred. 

■ A specific event has not occurred within configured time period. 

For example, a red icon for a mailboxed event might mean that the event was 
rejected or that the event wasn’t received before a specific period of time 
expired. 

■ Time of event status.

■ Link to view details of the status alert. 

To view information about a status alert, click its link in the Status File column.

Possible Event Types, depending on your implementation, can include:

Status Description

accepted The file was received by Active Documents from the 
trading partner's system. This is the starting point 
for all flows.

mailboxed Active Documents mailboxed the translation output file for 
delivery to the trading partner. Not used if the Translated 
status is in the same lifecycle.
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FA Information
The Processing Lifecycle page might display Functional Acknowledgement 
information. 

Acknowledgment Codes are: 

Managed Service Platform Data
Multiple Managed Service Platform entries might exist because transactions can 
pass through the Managed Service Platform at different stages of processing.

For example, the translated output entered another Managed Service routing cycle 
for transmission to the recipient. 

TGMS Data
Trading Grid Messaging Service (TGMS) enables data exchange with your partners. 
It manages your inbound and outbound transactions. 

As with Managed Services, multiple Trading Grid Messaging Service sections might 
exist because transactions can pass through the TGMS as well as Managed 
Services at different stages of processing. 

tgmsmailboxed The file was sent to the Trading Partner via Trading Grid 
Message Services (TGMS).

extracted Trading partner extracted the file from the mailbox or 
interconnect. 

tgmsextracted The file was received by the Trading Partner via Trading 
Grid Message Services (TGMS).

receivedbp Received by my Partner. The file/document was delivered 
to the trading partner's destination.

receivedfp Received from my Partner. The file/document was 
delivered to my destination.

■ A — Accepted ■ R — Rejected

■ E — Accepted with errors ■ W — Rejected; assurance failed validity tests

■ M — Rejected; message 
authentication code failed

■ X — Rejected; content after decryption count 
not be analyzed

■ P — Partially Accepted; at least 
one transaction set rejected

Status Description
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Other processing stages might also display, such as a Trading Grid Message Service 
Mailbag step, when a collection of files are going to a Trading Partner via a third 
party.

Communication Sections
A processing lifecycle can display different types of communication information.

Depending on your communication setup, the Processing Lifecycle page might 
include sections that display data exchange information. They might include any of 
the following protocols or standards, depending on your Trading Grid service. 

AS2 FTP/SFTP SAP ALE

AS3 X.400 OFTP

IFTP SMG HTTPS

POP3 SMTP

As with the Managed Service Platform and Trading Grid Messaging Service, the 
lifecycle might include multiple communication sections, depending on the 
processing that occurs.

Extended Event Data
Extended events are processing events that occur outside of GXS and that your 
company publishes to GXS. If you subscribe to the Extended Event service, the 
Processing Lifecycle page displays extended event data. 

Event data can include, for example, an IDOC number, status information, and SAP 
Client identifier.

Translation Information
The Trading Grid Translation section of a Processing Lifecycle describes the 
translation input and output and includes original and formatted input and output 
files, when available.

Applicable Related Documents

To view business documents related to the process lifecycle
1 On the Processing Lifecycle page, click the Related Business Document(s) 

tab. 
A list of related documents display.
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2 To see, for example, related documents in a specific document type, at the top 
of the list underneath the Document Type heading, enter the document type 
such as 850. 
You can filter the list by typing values in the boxes underneath some of the 
column headings.

Audits and Notes
View audit information, such as a record of email notifications, status updates, and 
other activity for the processing lifecycle. 

To view audits and notes for a lifecycle
1 Scroll down to the Audit and Notes section, and if necessary, expand the 

section.
A list of Audit messages and notes displays, showing the

■ Type of entry (for example, Audit of an email notification, or Note 
generated by the system or a GXS technician)

■ Author of the entry

■ Date the entry was created

■ Details of the entry

■ Whether or not a notification was sent

2 To view an email notification — for example, confirmation that a file was sent — 
click its View link.
A copy of the email displays. Click Close to close it. 

Scheduled Reports

Standard Reports
Active Documents provides several traditional document tracking reports. 

■ Map Usage Report — Retrieve a summary of activity related to a specific 
translation map or all maps. Includes the numbers of started, completed, and 
failed sessions. 

■ Outstanding Issues Report — List of unacknowledged documents with an 
issue assigned to them. GXS Global Support Services (GSS) assigns an 
outstanding issue to an outbound transaction when the trading partner fails to 
acknowledge the transaction. GXS notifies the client via the ISSUES log, and FA 
tracking for that document for that trading partner ends. 

■ Do Not Track Report — List of trading partners that have a Do Not Track rule 
for FA tracking. If some trading partners do not have the capacity (or 
continuously fail) to send FAs, they can be put on DO NOT TRACK status so that 
Active Documents does not provide FA tracking services for those trading 
partners. 
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■ Outbound (and Inbound) Reconciliation Reports — Reconciliation reports 
enable you and GXS Support to audit inbound and outbound transactions and 
identify transactions not fully processed on the GXS service.

You can generate these reports on demand or schedule them. 

Create a Standard Report

To create a Standard Report
1 Click the Reports tab. 
2 On the left side of the page, click Standard Reports. 
3 In the list that opens, select a report type. (Map Usage Report is selected by 

default.) 
4 On the Search page, define the content of the search and report.

Or, use a previously saved search.

a In the Select Saved Searches list, select a search name and click OK. 
The system displays the stored criteria. 

b Make any needed changes. 
c Click Search. The search results display. 

Note: For Outbound and Inbound Reconciliation Reports: 

5 Click Schedule. A dialog opens.
6 Enter the data as described in “Save/Schedule/Send Reports” on page 460.
7 Click Save.

The system adds the schedule to the Scheduled Reports list. If you selected 
Now in the dialog, the system generates this as a one-time report.

Create a TGMS Report or 1-Time only Report
1 Click the Reports tab. 
2 If the Search page is not displayed, on the left side of the page, click Search. 
3 On the Search page, define the content of the search and subsequent report.

Or, use a previously saved search for the report.

a In the Select Saved Searches list, select a search name and click OK. 
The system displays the stored criteria. 

b Make any needed changes. 
c Click Search. The search results display. 

4 Click Save/Schedule Report. A dialog opens.
5 Use the dialog as described in “Save/Schedule/Send Reports” on page 460.

■ For the List All/Exceptions option, select All to report all input/output 
files, or Exception to report only those with errors.

■ Be sure to select the File or Document radio button. It determines 
your options in the bottom section of the dialog.

■ In the bottom section, deselect any Exception conditions that are not 
applicable or that you do not want in the report.
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After completing and saving the dialog, the system adds the schedule to the 
Scheduled Reports list. 

Note: If you selected Now in the dialog, the system generates this as a one-time 
only report. To see it, go to the Delivered Reports page. It does not display on the 
Scheduled Reports page. 

6 To view a list of reports or a specific report, see:
■ “Transaction Process Lifecycle — New” on page 451

■ “Delivered Reports” on page 462

■ “To download reports” on page 463

Save/Schedule/Send Reports
Use this procedure to save and schedule a report and optionally email it to 
contacts. 

Note: To generate a one-time report, you must create a schedule for the report.

1 If you clicked Save/Schedule or Schedule after creating a report, a dialog 
opens. 

2 Do one of the following: 
■ To overwrite a saved search (report) with the new search, select the 

Overwrite the saved search name option. 

■ To save the search as a new search, select the Save as a new search 
option, and in the Name field type a unique, meaningful name for the new 
search. If you used an existing search to create the new search, the 
existing search stays in the system. 

Note: In either case, the name you enter becomes the Report Name in the 
Scheduled Reports and Delivered Reports lists. 

3 To save any of the above changes to an existing report, but not change the 
schedule, click Save. Otherwise, continue. 

4 To schedule the report, select the I want to schedule this report check box. 
Important: Do this even for one-time reports.

The dialog displays controls for scheduling and Report Format. 

5 Do one of the following: 
■ For a regularly scheduled report, select the option Daily, Weekly, or 

Monthly, then enter the day or date and time for the report schedule. 

■ For an immediate, one-time report, select the Now option. (If the search 
uses a Specific Date Range, only Now is available.)

Note: You can also generate a regularly scheduled report 
immediately. See “To immediately generate a scheduled report” on 
page 462.

6 Select the Report Format. 
7 To send the report to another person as an email attachment,

a Select the Send this report as an email attachment option. Fields for 
email recipients display: 

■ Available Contacts in Trading Grid.
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■ Available Users in your organization.

b Hover your cursor over an email address for information about the contact 
or user.
In the lists: 

■ Select the applicable person (for multiple persons, hold down the Ctrl 
key and select persons), then click Add. The addresses display at right. 

■ To select all in a list, click Add All. 

■ To remove entries from a list, select them as above and click Remove, 
or click Remove All. 

Note: If you do not see the contact that you want, have your 
Company Administrator add that person as a Trading Grid Online user or 
Trading Grid Online service contact via the Trading Grid Online Account 
Manager. 

c Some users may see an Additional Recipients field. If so, you can 
specify email addresses not in either list. Separate addresses with a 
comma. 

8 For Managed Services (MS) users, if you don’t distribute the report by email, 
and your company is configured in Managed Services, select the Send this 
report via the Managed Services Platform option.  

Active Documents sends the report to a mailbox on a Managed Services Platform 
enterprise machine. Either of the following are possible: 

■ Users with access can access the machine by FTP and download the 
report. 

■ The mailbox can forward the report to another machine or service that 
makes it available to users. 

9 For TGMS users, if you don’t distribute the report by email, and your 
company is configured in Trading Grid Message Services, select the Send this 
report via TGMS  option.  

10 New fields display to route the report file. Enter data into these fields; they are 
required. For field information, see the “Glossary” on page 464.
Note: All three values must be valid identifiers configured in Managed 
Services or Trading Grid Messaging Services. For help, contact your system 
administrator.

11 Click Save and close the dialog. 
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View Scheduled Reports

To view the Scheduled Reports list
■ On the left side of the page, click Scheduled Reports. 

The Scheduled Reports page opens.

To see the current schedule for a report, in the Report Name column, click the 
applicable report name. 

Note: If the Report Name is not a hyperlink, the report is a one-time report 
previously executed. 

Change/Generate/Delete a Report Schedule

To change a report schedule
1 On the left side of the page, click Scheduled Reports.
2 In the Report Name column, click the applicable report name. 
3 In the Save or Schedule dialog that opens, view or change information. 
4 Click Save.

To immediately generate a scheduled report 
1 On the left side of the page, click Scheduled Reports. 
2 Find the applicable report in the list. 
3 In the Execute Once column, click Execute for the report. 

The system adds a one-time report to the Scheduled Reports list with the same 
name, along with ONCE and the current date and time.

Note: Many users delete one-time reports. Select the report check box, then 
click Delete. 

4 Click Delivered Reports to view the report. 

To delete scheduled reports
1 On the left side of the page, click Scheduled Reports. 
2 In the View drop-down list at top, click Only my reports. The list refreshes.
3 Click the check box(es) in the row of the scheduled report(s) to delete. 
4 Click Delete.

Delivered Reports
Delivered Reports are Scheduled Reports, including one-time reports, generated by 
the system. 

To view a list of delivered reports
■ On the left side of any Active Documents page, click Delivered Reports. 

The Delivered Reports page opens. 

On the Delivered Reports page, 

The list shows the following for each generated report. 
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■ Name of the report (click the name link to open the report) 

■ Report format (for example, PDF)

■ Date and time the report was generated 

■ Name of user who created/scheduled the report 

■ Report status, such as New, Read, Processing, or Failed

■ Report ID (click link to view audit log for the report)

Download Reports

To download reports
1 In the Delivered Reports list, find the row containing the latest version of this 

report.
2 In the Report Name column, click the name of the report. (Status cannot be 

Processing.)
3 Follow the prompts to open (or save) the report. 

View Audit Logs

To view the Audit Logs 
An audit log for a delivered report includes information such as who received the 
report and when. A log is available only if Active Documents emails the report to 
recipients. 

1 In the Delivered Reports list, find the row containing the latest version of this 
report.

2 In the Report ID column, click the link for the report. A dialog displays audit 
information, such as who received the report. 

Retention Period
Active Documents deletes delivered reports after 45 days. 

Delete Delivered Reports

To delete a delivered report
Delete it from the Scheduled Reports list — see “To delete scheduled reports” on 
page 462.

Many users delete one-time reports.



A C T I V E  D O C U M E N T S  C L A S S I C

Glossary

Trading Grid Online User Guide  464

B  

Glossary

AI See Translation.

AI Bridge See Translation Instance 

AI Session Number See Translation Session Number.

Application Reference An application identifier used in file or message routing, assigned by GXS during 
the implementation process. Application Reference IDs might identify a particular 
system, process, recipient, or data type. The value might also be blank, such as 
for inbound data moving from the GXS network into the first Managed Services 
routing cycle. This identifier is usually unique to a specific process, data type, or 
trading partner. 

AS2 A data transport protocol designed to provide secure and reliable file transfer 
over the Internet. AS2 communication activity is reported on the Managed 
Services Dashboard. 

CFTP Bridge Connect-Out FTP Bridge. A Managed Services connection point that can use 
standard FTP connections to pass data to (or pull data from) a remote host. 

Client Address See Partner Address.

Communication Type The communications protocol, standard, or interface used to submit the 
transaction to the Trading Grid. 

Control Number Interchange Control Number of the data coming in or going out. It is a number 
assigned by EDI systems to various structural levels of an EDI file for the purpose 
of verifying data integrity. 

COS Bridge Connect-Out Service Bridge. A Managed Services connection point that can pass 
task parameters to a user's program, UNIX shell script task, or NT command file. 

Created Date and Time Date and time that the transaction was created. 

Delinquent Acknowledgment See Late Acknowledgment.

Delivered Report A scheduled report extract or a standard Managed Services report generated on 
a scheduled basis. 

Direction Direction (inbound or outbound) of data movement from the perspective of the 
GXS customer (associated with the My Address field), not the customer’s 
partner (associated with Partner Address). 

Document An electronic business document, typically in EDI format. 

Document Type A code in EDI that identifies a specific type of EDI document, for example, 810 or 
INVOIC. In this field in Search, enter the identifier of a document type to return 
only documents of that type. To search for documents of multiple types, separate 
the types with commas. 

EDI Electronic Data Interchange. A standardized data structure for exchanging 
business documents electronically. 

Enterprise See Managed Services platform. 

Extended events Events that occur outside of GXS which the customer publishes to GXS. For 
example, your backend system might detect that a file failed to reconcile and 
reports that information to GXS. 

Extracted Status or event type in some implementations. Indicates that the trading partner 
extracted the document from the mailbox or interconnect.

File A data file moving through the Managed Services environment. 
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Functional Group Refers to a structural level of an ANSI X12 EDI-formatted file that contains a 
document (or documents) of a particular document type. GXS Ref Num - a 
unique number created by the Managed Services platform to track EDI 
interchanges, EDI documents, and files.

Functional Group Control Number A number assigned by EDI systems to the functional group header and trailer 
segments of an EDI file for the purpose of verifying data integrity. Typically 
applies only to ANSI X12 formatted data. 

Functional Group Type A two-digit code found in the group header segment of an ANSI X12 EDI-
formatted file that identifies the type of business document it contains. 

Group See Functional Group 

GXS Ref No. A unique number created by the Managed Services platform to track:
■ Transmission files — preceded by F- 
■ EDI interchanges — preceded by I- 
■ EDI groups 
■ EDI documents — preceded by D- 
■ XML documents — preceded by U- 
■ Trading Grid Messaging Service transactions 

On the Search page, the GXS Ref Num is a quick way to access lifecycle 
processing information. 

ICS (Interchange Services) Former name of a GXS value-added network service that manages the electronic 
exchange of business documents between trading partners. ICS might appear in 
an error message. 

IFTP A file transfer protocol with enhanced scripting used to create automated, robust 
and reliable File Transfer Protocol operations.  IFTP communication activity is 
reported on the Managed Services Dashboard. 

ILOG Number Input Log Number, assigned by the Trading Grid for tracking purposes and 
uniquely identifies a file transmitted by the Sender. An ILOG is an 11-digit 
number, based on the combination of the month, day, Greenwich Mean Time, 
and the decimal fraction of the hour. 

Inbound data Data being received by your company. 

Input File(s) The file(s) that are used as the source data during a translation session. 

Interchange Refers to an EDI-formatted file. 

Interchange Control Number A number assigned by EDI systems to the interchange header and trailer 
segments of an EDI file for the purpose of verifying data integrity. 

Interconnect Name The name of a third-party VAN, for example, between your company and GXS in 
the file routing process. 

Late Acknowledgment An EDI acknowledgment which has not been returned in the period of time 
designated in the acknowledgment tracking rule, usually 24 hours. 

Lifecycle A sequential history of data activity at various processing points on the Managed 
Services platform. 

Mailbag ID References an interconnect service (for example, a third-party VAN). Value must 
be numeric. 

Mailbox GXS mailbox identifier. 

Managed Services Dashboard High level view of communication and data tracking, enabling management by 
exception. 

Managed Services Platform The routing application used to manage the flow of data between managed 
Services clients, their trading partners, and various processing points in between. 
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Model A file used during translation that defines the structure of a file and mapping 
rules for its data content. 

My Address Your EDI or GXS routing address. 

My Functional Group Address Your EDI functional group address; applies only to the ANSI X12 standard. 

Organization Report See Delivered Report 

Outbound data Data sent by your company to a Trading Partner. 

Output File(s) The file(s) that are created as a result of a translation session. 

Partner Address The EDI or GXS routing addresses of your Trading Partner. 

Partner Name The company name of your business partner, as it is defined in Active 
Documents. On the Search page, you can enter a partial name and the system 
displays a drop-down selection list that matches the value you entered. 

Primary Key (and Value) The type and value of a document identifier assigned by the sender to identify a 
particular documentsuch as Purchase Order Number. 
On the Search page, if you enter a partial key, the system displays a list of key 
types beginning with the same character(s). Click one to select it. Then, in the 
Value field, enter the identifier value to use for the selected key. In the Value 
field, you can type a partial value ending in an asterisk (*) for the system to 
return any documents with the selected key value that begins with those 
characters. 
Some Managed Services clients might have keys defined at the file level.

Production/Test Flag This is a field/flag in the EDI interchange header for ANSI X12.  This field 
indicates if a transaction is test or production.  Users can send test transactions 
on the production system to Trading Partners, and this flag distinguishes which 
transactions are test and which are production.  You should work with your 
Trading Partner in deciding how to use this flag. 

Receiver The recipient ID in a Managed Services routing cycle. For data processed as EDI, 
the recipient ID is typically an EDI address. For non-EDI file types, the recipient 
ID represents a routing ID. 

Reference # See GXS Ref No. 

Scheduled Report A set of search parameters set up to extract Managed Services data on a daily, 
weekly, or monthly basis. The term also applies to Standard Managed Services 
reports that are scheduled. 

Secondary Key (and Value) The type and value of a secondary document identifier assigned by the sender to 
identify a particular document such as Trading Partner. 
On the Search page, if you enter a partial key, the system displays a list of key 
types beginning with the same character(s). Click one to select it. Then, in the 
Value field, enter the identifier value to use for the selected key. In the Value 
field, you can type a partial value ending in an asterisk (*) for the system to 
return any documents with the selected key value that begins with those 
characters. 
Some Managed Services clients might have keys defined at the file level.

Sender The originator ID in a Managed Services routing cycle. For data processed as 
EDI, the originator ID is typically an EDI address. For non-EDI file types, the 
originator ID represents a routing ID. 

Sender Reference A number or alphanumeric value referencing the file in the routing process. The 
value is assigned by a process in the routing cycle. 

Session # The number assigned to uniquely identify a specific translation instance. 

Standard The format and version number for the type EDI data contained in the data file, 
for example, ANSI (5020), EDIFACT (00.A) or Tradacoms. 
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Standard Reports A set of pre-defined reports available through the Managed Services reporting 
tool. 

Status In Search, a drop-down list of possible statuses to search, based on the platform, 
level of tracking, and configuration. Status searches can apply to inbound and 
outbound transactions. 
In Managed Services, at the file level you can search the following statuses:

■ With Errors 
■ Without Errors 
■ With Negative Alerts (last status alert was for an error or an event that 

did not occur within a specified time period for the event type)
■ Without Negative Alerts (last status alert for file was for an event that 

occurred within the specified time period for the event type)
In Managed Services, at the document level, you can search the following 
statuses, depending on your service subscription: 

■ Acknowledged 
■ Not Acknowledged 

In other implementations, you might also be able to search for files with the 
following Status: 

■ Extracted (picked up by trading partner)
■ Unextracted (not picked up by trading partner)
■ Rejected (by GXS)
■ Rejected from Interconnect
■ Incomplete (incomplete itineraries, which are GXS instructions for 

processing a document)
In any implementation, leave All selected to not search based on a specific 
status.

Time Frame Date criteria based on when GXS processed the document, whereas Invoice Date 
Range is based on the content of the actual invoice document. From the 
selection list, select the type of date search: 

■ Specific Date Range — Use calendar icons to select From and To dates. 
Enter the time using a 24-hour clock, i.e., enter values from 00:00 to 23:59. 

■ Last No. of days — Enter the desired number of days back from the 
current date, e.g., 10, 15, etc.

■ Relative Time Range — Select the days and times in the From and To 
fields. 

■ None — Search all available records.

Translation The GXS data transformation process used in translating data between data 
formats. Data is translated from any format to another format. Many Managed 
Services customers use the system to translate between their in-house data 
formats and standard EDI (Electronic Data Interchange) formats. 

Translation Instance Identifies which Application Integrator translation instance processed the 
transaction.  There is one or more than one translation instance, depending on 
the implementation.

Translation Session Number A number assigned to each translation process. 

UDF User-defined file format. 

Unextracted Status or event type in some implementations. Indicates that the trading partner 
has not extracted the document from the mailbox or interconnect.

User ID The email address that you use to log in to Trading Grid Online. 
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User Report See Delivered Report 

XML/UDF Refers to document-level processing for data in either XML structure or a user-
defined format to enhance search. The XML structure might follow a defined 
standard, such as RosettaNet, or an in-house data format. 
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Active Documents 
Translation Errors C

Use these Active Documents translator error messages for reference. For users 
subscribing to the Cloud Based Translations service, use these messages and their 
solutions for initial troubleshooting.

Error Numbers -1 and -2

-1 EOF
Some errors are generated to control the natural processing flow of the translator 
and these soft errors sometimes do not require any resolution. These errors are 
written in the trace log to show the process flow, but they are not user-retrievable. 

Cause Resolution

End of file encountered. No resolution required.

Sockets connection closed. One of the sockets programs 
(client or server) exited, thereby closing the connection.

Verify that both programs are 
running.

Sockets connection closed. Connection between the 
client and server was broken due to network problems.

Contact your network or system 
administrator.

-2 Character Set read_set Error
Some errors are generated to control the natural processing flow of the translator 
and these soft errors sometimes do not require any resolution. These errors get 
written in the trace log to show the process flow, but they are not user-retrievable .

Cause Resolution

Input file has data not in the list of valid characters defined by 
#CHARSET. This is an internal error while parsing the input 
document using the access model. Error -2 is not accessible in 
the data model.
This error could be converted to return an error #0 if the 
minimum number of characters are parsed. If the minimum 
size is not met, the data model returns an error #138.

Modify the data model 
(data model item minimum 
size), access model, or 
input file.
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Error Numbers 128 – 193

128 Code Space Exceeded
Cause Resolution

The code generated from the rules requires 
more than the allocated code generation 
space.

Reduce the number of actions per condition 
by inserting null conditions.

129 Stack Exceeded
Cause Resolution

An error has occurred in the rules processing, 
possibly caused by an improper function 
argument count.

Check functions for proper argument type 
and count.

130 Stack Underflow
Cause Resolution

An error has occurred in the rules processing, 
possibly caused by an improper function 
argument count.

Check functions for proper argument type 
and count.

131 Illegal Instruction
Cause Resolution

An error has occurred in the rules processing, 
possibly caused by an improper function 
argument count.

Check functions for proper argument type 
and count.

132 Message Queue Illegal I
Cause Resolution

Fatal internal error. Call Customer Support for assistance.

133 Source Access Syntax Error
Cause Resolution

Error in parsing the source access 
model.

Make sure that the correct access model name is 
being referenced in the map component file.

Make sure that the correct access 
model name is being referenced in the 
map component file.

Edit the access model to fix the improper syntax.
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134 Source Model Syntax Error
Cause Resolution

Syntax error within the 
source data model. Error 
may be in the line above or 
below the line number 
reported.

Edit the data model for any of the following common syntax 
errors:

 

135 Target Access Syntax Error 
Cause Resolution

Error in parsing the target access 
model.

Ensure the correct access model name is being 
referenced in the map component file.

Missing parenthesis or bracket or 
syntax error at line X.

Edit the access model to fix the improper syntax.

 

136 Target Model Syntax Error 
Cause Resolution

Syntax error within the target data 
model. Error may be in the line 
above or below the line number 
reported

Edit the data model for any of the following common 
syntax errors:

The target data model specified in 
the map component file cannot be 
found.

Check the name of the target data model in the map 
component file. Enter a valid target data model in the 
map component file. Check that the target data model 
exists.

The access model associated with 
the given target data model is 
wrong (Access Obj “Segment for 
dm not found”). 

Assign the data model item with the proper item type. 
Assign a different access model to the map component 
file.

The target data model base 
filename has not been entered at 
all or specified correctly. This issue 
arises when running generic 
models and the Process Tracking 
report returns an error of “Bypass 
with error 136".

Check the target data model base filename at the 
Trading Partner lowest level-outbound values. Ensure 
that the target data model exists on the system.

■ Check for missing brackets and characters, such as, 
(,{,},).

■ Check for upper-/lowercase spelling. Make sure the 
variable labels are spelled correctly.

■ Check for arrow pointers (->) when referencing an 
Array or Variable.

■ Check for missing brackets and characters, such 
as, (,{,},).

■ Check for upper-/lowercase spelling. Make sure 
the variable labels are spelled correctly.

■ Check for arrow pointers (->) when referencing a 
MetaLink, Array, or Variable.
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137 ATTACH Error 
Cause Resolution

When running the ATTACH function and the 
map component file does not exist.

Edit the model to call the correct map 
component file.

When running an inbound standard 
translation and you get the error “Message 
processing, Error 137,” then the trading 
partner is not defined properly.

Verify the inbound map component file is 
defined properly at the Trading Partner 
lowest level-inbound values.

138 Data Model Item Not Found
Cause Resolution

Invalid date, numeric format, or not found in 
character set.

Check the data for valid date or numeric 
values.

Maximum data model item size has been 
exceeded.

Increase the size of the data model item.

139 Data Model Item – No Value Found
Some errors are generated to control the natural processing flow of the translator 
and these soft errors sometimes do not require any resolution. These errors get 
written in the trace log to show the process flow, but they do not stop the process.

Error code 144 is returned in cases where the data model item has a value 
assigned to it before the function is executed. If there is no value assigned to the 
variable at runtime and the ampersand is missing, the translator tries to evaluate 
the variable. If the translator cannot evaluate the variable, it returns error code 
139.

Cause Resolution

A result of the NOT_NULL( ) 
function; depends on whether the 
element is mandatory or optional.

If the element is optional (may not have a value) 
then use the NOT_NULL() function. This function 
will write out the element only if the variable 
references a value.

No values on the Array or MetaLink. Ensure there is a value on the Array or MetaLink.

Referencing a source data model item 
that has not yet been parsed.

Ensure that the data model item referenced was 
already parsed.

140 No Instance
Some errors are generated to control the natural processing flow of the translator 
and these soft errors sometimes do not require any resolution. These errors get 
written in the trace log to show the process flow, but they do not stop the process.

Cause Resolution

When an item is not initialized, 
no reference can be made to 
that item.

The item needs to be initialized at the beginning of the 
model.

If this step is missing, then when the variable is referenced 
in the next statement, error 140 will be generated.

VAR->Count = 0

VAR->Count = VAR->Count + 1
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141 Mandatory Segment/Record Missing
Some errors are generated to control the natural processing flow of the translator 
and these soft errors sometimes do not require any resolution. These errors get 
written in the trace log to show the process flow, but they do not stop the process.

Cause Resolution

Input data does not match the tag value. 
This error could happen on a single or 
multiple occurrence of the tag item.

If the tag segment is optional, then it is a soft 
error and no resolution is required. If the tag 
segment is mandatory, then check the data 
records, it is possible that data records are out 
of sequence.

142 Try Next Error
Cause Resolution

Fatal internal error. Call Customer Support for assistance.

143 Sort on Non-sort Item
Cause Resolution

Fatal internal error. Call Customer Support for assistance.

144 Wrong Argument Type
Error code 144 is returned in cases where the data model item has a value 
assigned to it before the function is executed. If there is no value assigned to the 
variable at runtime and the ampersand is missing, the translator tries to evaluate 
the variable. If the translator cannot evaluate the variable, it returns error code 
139.

Cause Resolution

Improper function argument type; for 
example, numeric passed to a function 
expecting a string. 

Check functions for proper argument type 
and count.

145 Parse Environment Error
Cause Resolution

Cannot parse the .env file. Check the names of the environment (.env) file in the 
directory and the data model when it is called to be loaded.

146 Invalid Date, Time, or Numeric String
Cause Resolution

Source data model only. Data does not 
match the specified field format, for 
example, alpha characters in a numeric 
field.

Modify the data model or input file. A second log 
file specifies the field in error and the value 
received (e.g., 01.e000971.log). If no error code is 
put on the element, it returns to the tag.
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146 Invalid Date, Time, or Numeric String
Cause Resolution

Source data model only. Data does not 
match the specified field format, for 
example, alpha characters in a numeric 
field.

Modify the data model or input file. A second log 
file will be produced that tells exactly what field 
is in error and the value received (example: 
01.e000971.log). If no error code is put on the 
element, it returns to the tag.

147 RETURN Executed
Cause Resolution

Whenever the keyword RETURN is executed. Soft error; no resolution required.

148 RELEASE Executed
Cause Resolution

Whenever the keyword RELEASE is executed. Soft error; no resolution required.

149 REJECT Executed
Cause Resolution

Whenever the keyword REJECT is executed. Soft error; no resolution required.

150 CONTINUE Executed
Cause Resolution

Whenever the keyword CONTINUE is 
executed.

Soft error; no resolution required.

151 BREAK Executed
Cause Resolution

Whenever the keyword BREAK is executed. Soft error; no resolution required.

152 Lookup Error
Cause Resolution

Failed to look up an ID with the function, 
#LOOKUP.

Verify that the code being checked exists in 
the database.

153 Memory Allocation Error
Cause Resolution

A memory allocation could not be made due 
to an out-of-memory condition or a corrupted 
memory manager.

Check memory allocated to program. Exit 
other programs, if possible.
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154 Virtual Memory Allocation Error
Cause Resolution

A memory allocation could not be made due 
to an out-of-memory condition or a corrupted 
memory manager.

More document data has been parsed than 
the translator can store. Reduce data parsed 
in one map component file by breaking into 
separate map component files. Check for 
data model function syntax errors, that is, for 
the wrong number of arguments.

155 Virtual Memory Allocation Size Error
Cause Resolution

An attempt was made to allocate more than 
4092 bytes of memory for a data model item.

Check the data model for improper size 
specification.

156 Fatal Virtual Memory Error
Cause Resolution

A reference to an unallocated memory page 
has occurred.

Check for data model errors, such as 
improper number of arguments to functions.

More than the allowable data has been 
parsed.

Reduce the amount of data parsed by: 

157 Access Memory Allocation Error
Cause Resolution

A memory allocation could not be made due 
to an out-of-memory condition or a corrupted 
memory manager.

Check the memory allocated to the program. 
Exit other unneeded programs.

158 Data Tree Memory Allocation Error
Cause Resolution

An allocation of a data tree structure could not be 
made due to an out-of-memory condition or a 
corrupted memory manager. This may happen 
when the document loop is set to a high or infinite 
number of occurrences.

Set the data model to read one 
document at a time.

159 Number of Allowable Translations Exceeded
Cause Resolution

Attempted to invoke more than the allowed 
number of concurrent translators.

Wait until other translation sessions have 
ended before executing another session.

■ Breaking the data model into two or 
more individual models.

■ Using CLEAR_VAL( ) to remove 
unneeded values stored on Arrays 
and/or MetaLinks.
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160 Error Opening Infile
Cause Resolution

Cannot find specified input file. Cannot find specified input file.

File permissions are incorrect. Try chown or chgrp to change the ownership 
or the group to which the file belongs.

File attributes are incorrect 
(read/write/execute).

Try chmod to change the file mode access 
permissions.

Sockets input error. The server that creates 
the input socket was not running when the 
client tried to connect to it.

Run the server program.

The input socket could not be created by the 
client because it could not connect to the 
server.

Verify that the server is running. Also, check 
whether another client is connected to the 
server. If necessary, contact your network or 
system administrator.

Sockets input error. The input socket could 
not be created by the server due to a lack of 
system resources.

Contact your network or system 
administrator.

161 Error Opening Outfile
Cause Resolution

The translator cannot find or read in the 
output file specified.

Check to see if the file exists and is spelled 
correctly. Also check the permissions of the 
file.

The server that creates the output socket 
was not running when the client tried to 
connect to it.

Run the server program.

The output socket could not be created by 
the client because it could not connect to the 
server.

Verify that the server is running. Also, check 
whether another client is connected to the 
server. If necessary, contact your network or 
system administrator.

The output socket could not be created by 
the server due to a lack of system resources.

Contact your network or system 
administrator.

162 Error Opening Swapfile
Cause Resolution

An error has occurred in attempting to open 
the virtual memory swap file.

Check permissions on the directory in which 
the swap file is going to be placed. Refer to 
the Control Server Installation Guide for 
details on the environment variables SWPDIR 
and TMPDIR.
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163 EXEC Error
Cause Resolution

When the EXEC command is executed within 
the data model, it returns either 0 or 163. 
Return code 0 means that the command was 
executed successfully. Return code 163 
means that an error has occurred during the 
execution of the command.

The resolution depends on the command 
being executed. Examples include:

164 sort_STK malloc Error
Cause Resolution

An error has occurred in the allocation of the 
sort stack.

Check memory allocated to program. End 
other unneeded programs.

165 Message System Call Error
Cause Resolution

An internal error has occurred in the 
message system processing.

Call Customer Support for assistance.

166 Error Log Open Error
Cause Resolution

An error has occurred in attempting to open 
the error log file.

Check permissions on the directory into 
which the error log is to be placed.

167 Function Not Found
Cause Resolution

Unknown function found upon execution. 
The function may have passed the parsing 
check.

Check your data model and make sure to use 
a function supported by your current version 
of software. Check the spelling of the 
function name.

168 Data Model Memory Allocation Error
Cause Resolution

An error has occurred in the memory 
allocation of the data model item.

Check memory allocated to program. End 
other unneeded programs.

169 Invalid Function Used in Target Access Model
This error code occurs when access functions (FIRST_DELIM, SECOND_DELIM, etc.) 
are used in a target mode access model. These access functions should be used for 

■ A file that is copied, renamed, or 
removed does not exist.

■ The Directory into which the file is to be 
copied does not exist.
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source only.

Cause Resolution

An error has occurred in the output stage of 
processing.

Remove the invalid function from the access 
model or use a different access model.

170 Command Line (-at) ATTACH Error
Cause Resolution

Missing the map component file (.att). Verify that the file exists and is spelled 
correctly.

Syntax error in the parsing of the map 
component file.

Look in the map component file and verify 
that no syntax errors exist.

Missing source and target data models. Check the map component file; a source or 
target data model and access model 
definition must be present.

171 No Children Found
Some errors are generated to control the natural processing flow of the translator. 
They are soft errors and sometimes do not require any resolution. These errors get 
written in the trace log to show the process flow, but they do not stop the process. 
This error occurs on the tag or container where all children are optional.

Cause Resolution

Missing delimiters in a variable length record 
type.

Define the element separator within the 
model. For example:
SET_SECOND_DELIM(“*”)

Missing the record's tag match value in a 
variable length record type.

Modify the model or input file.

Required labeled item not found. Check the order of the required segments in 
the model.

172 Access Item is a Null Pointer
Cause Resolution

This is an internal fatal error. Call Customer Support for assistance.

173 Improper Access Model Item Definition
This error occurs when an access object defined in a data model is not found.

Cause Resolution

An error has occurred in the output phase of 
processing, caused by an improper access 
item (item type) definition.

Check the access model for proper definitions 
of access items (item types). Check the data 
model for the proper assignment of item 
types.



A C T I V E  D O C U M E N T S  T RA NS L A T I O N ER R O RS

Error Numbers 128 – 193

Trading Grid Online User Guide  480

C  

174 Virtual Memory Free List Error
Cause Resolution

An internal error has occurred in the virtual 
memory free list processing.

Call Customer Support for assistance.

175 Virtual Memory Out of Space Error
Cause Resolution

A reference to virtual memory beyond the 
addressable range has occurred. 

Call Customer Support for assistance.

176 Data Field/Element Too Short
Cause Resolution

A data model item's minimum size has not 
been met.

Check data model item's definition and input 
stream data.

177 Data Field/Element Too Long
Cause Resolution

A data model item's maximum size has been 
exceeded.

Check data model item's definition and input 
stream data.

178 Error in Administration Database Open
Cause Resolution

An error has occurred in the opening of an 
Administration Database.

Check for proper Administration Database 
name specifications and access privileges.

179 Unable to Get Lock
Cause Resolution

An error has occurred in obtaining a lock on 
an Administration Database record.

Check the number of Administration 
Databases open system wide.

180 Unable to Unlock
Cause Resolution

An error has occurred in releasing a lock on a 
Administration Database or Profile Database 
record.

Another user is accessing the same record. 
Ask the other user to exit from the database 
and then retry. If necessary, call Customer 
Support for assistance.

181 Read Error in Administration Database
Cause Resolution

An Administration Database record key was 
not found.

Check for proper key specification.
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182 Write Error in Administration Database
Cause Resolution

An Administration Database record was not 
able to be written.

Check for the proper key specification.

183 I/O Error in Administration Database Access
Cause Resolution

An internal error has occurred in 
Administration Database processing.

Call Customer Support for assistance.

184 Wrong Permissions or Invalid Output Character
Cause Resolution

Input data field contains the element or sub-
element separators in the data stream.

Modify the model by changing the delimiters 
set or input file to eliminate use of the 
delimiter character.

In the map component file, the output 
filename is missing or is misspelled.

Check the map component file and modify it 
accordingly.

185 Truncation Error – Data Model Object
Cause Resolution

Data length is greater than the 
maximum size of the output/target 
field.

Turn truncation off by using the TRUNCATION_FLG 
keyword environment variable or modify the model or 
input file. Refer to the Appendix in the Workbench 
User's Guide for an explanation of the NUMTRIM( ) 
function for numeric truncation, and an explanation of 
the #CHARSET access model function for automatic 
truncation of spaces.

186 Invalid Argument Value
Cause Resolution

This error is produced when you pass invalid 
values to a given function. For example, 
when a function requires a number and an 
alphabetic character is passed.

Verify with the Workbench documentation for 
correct syntax and value of the function.

187 Exceeded Maximum Data Models
Cause Resolution

More than 50 different data models were 
used during a single translation session.

Review all ATTACH statements in the data models. 
Open fewer data models by restructuring the 
process flow or model content.
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188 Exceeded Maximum Access Models
Cause Resolution

More than 50 different access models 
were used during a single translation 
session.

Review all ATTACH statements in the data models. 
Open fewer access models by restructuring the 
process flow or model content.

189 STOP Executed
Cause Resolution

This error message is encountered when the 
STOP keyword is executed within an Include 
statement or Declaration.

Soft error; no resolution required.

190 Mandatory Data Field – Element Missing
Cause Resolution

A mandatory element missing 
in the segment.

Use the following resolutions:

191 Invalid Character in the Data Field/Element
Cause Resolution

An invalid character was found in the data 
element, such as an invalid data type or a 
character not in the character set.

Use the following resolutions:

192 Missing Post Delimiter
Cause Resolution

The post condition is missing in the data 
parsed.

Edit the data and add the missing delimiter.

193 Access Model Pre-Condition Not Met
Some errors are generated to control the natural processing flow of the translator. 
They are soft errors and sometimes do not require any resolution. These errors get 

■ Edit the data and add the missing element.
■ Modify the data model and remove it if the wrong 

mandatory segment was defined.

■ Edit the data and correct the missing 
element.

■ Modify the data model and verify that 
the data type is defined properly for that 
element.
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written in the trace log to show the process flow, but they do not stop the process. 

Cause Resolution

A delimiter precondition that is defined in the 
access model is not found in the input 
stream.

Use the following resolutions:

Error Numbers 200 – 255

200 Unable to Recover
Cause Resolution

More than one error has occurred in the 
element or segment and the translator is 
unable to recover.

Edit the data and correct the error in the 
segment.

201 Recovery on Minimum
Refer to “176 Data Field/Element Too Short” on page 480 with RECOVERY mode 
set.

202 Recovery on Maximum
Refer to “177 Data Field/Element Too Long” on page 480 with RECOVERY mode 
set.

203 No Value Available for Item
Refer to “190 Mandatory Data Field – Element Missing” on page 482 with 
RECOVERY mode set.

205 Recovery on CHARSET
Refer to “191 Invalid Character in the Data Field/Element” on page 482 with 
RECOVERY mode set.

206 Recovery on POST_COND
Refer to “192 Missing Post Delimiter” on page 482 with RECOVERY mode set.

208 Recovery on LKUP
Refer to “152 Lookup Error” on page 475 with RECOVERY mode set.

■ Edit the data and add the missing 
delimiter.

■ Change the access model item 
referenced by the data model item to 
one that does not have a precondition 
defined.

■ Change the access item definition of the 
precondition to optional.
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211 Invalid Structure
Cause Resolution

An invalid structure exists either in the 
xml document or schema or .dtd.

Correct the error in the xml document or schema or 
.dtd. Ensure that the structure is valid.

212 XSL Missing Schema
Cause Resolution

Unable to locate these files 
within the OT_XSDPATH 
environment variable.

Do one of the following:

213 XML Referring Invalid DTD/Schema
Cause Resolution

XML validation error as the referenced 
DTD/XSD is incorrect in syntax.

Ensure that the reference DTD/Schema is 
valid and follows correct syntax.

214 XML Invalid Against Schema
Cause Resolution

Occurs when the XML document is not 
according to the specified .dtd or schema, if 
a reference to the .dtd or schema exists.

Ensure that errors such as required fields are 
missing, structure not matching schema, and 
other schema field validations are corrected.

215 XML Stylesheet Error
Cause Resolution

Occurs when the XML document has a 
stylesheet error, and is unable to parse.

Correct the stylesheet error.

216 XML Stylesheet Error
Cause Resolution

Occurs when the XML document has a 
stylesheet error while executing AI extended 
function.

Correct the stylesheet error.

217 XML Proxy Server Error
Cause Resolution

Occurs when the XML document has a proxy 
server error and is unable to locate the proxy 
server.

Locate the proxy server error.

■ If the name of the .dtd or schema starts with “http:” 
then the proxy server is used to locate the file.

■ If the name of the .dtd or schema does not start with 
“http:” then ensure that the files are located within the 
OT_XSDPATH environment variable.
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218 Source Constraint Stylesheet Parse Error
Cause Resolution

Occurs when the XML document has a source 
constraint stylesheet error and is unable to 
parse.

Correct the stylesheet error.

219 Target Constraint Stylesheet Parse Error
Cause Resolution

Occurs when the XML document has a target 
constraint stylesheet error and is unable to 
parse.

Correct the stylesheet error.

220 Source Constraint Stylesheet Validation Error
Cause Resolution

Occurs when the XML document has a source 
constraint stylesheet error and is unable to 
validate.

Correct the stylesheet error.

221 Target Constraint Stylesheet Validation Error
Cause Resolution

Occurs when the XML document has a target 
constraint stylesheet error and is unable to 
validate.

Correct the stylesheet error.

222 Output XML Validation Error
Cause Resolution

Occurs when the XML document that is 
output has a validation error if a reference to 
the .dtd or schema exists.

Correct the validation error.

237 Internal c-tree Error
Cause Resolution

Out of disk space when performing 
a rebuild.

Free up additional space. The rebuild requires 12 times 
the space of the file to be rebuilt. By default, the 
working directory is used for temporary files during the 
rebuild. Another directory can be specified for use by 
using the environment variable TMPDIR. Refer to the 
Control Server Installation Guide for additional 
information about the TMPDIR environment variable.

Database has become corrupted. 
Possible causes of corruption 
include performing a kill -9 on the 
Control Server, a corrupt file 
system, internal system problems, 
or similar issues.

Delete the corrupted file. For example, delete the DM_ 
file causing the problem so a new one can be created.
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238 Maximum CPU Time Exceeded
Cause Resolution

CPU maximum time has been 
reached. This could be from a 
spinning translation.

Correct the translation that is causing the spinning. If 
the translation is running correctly and taking time to 
process due to the size of the input file, increase the 
MaximumCPUTimeAllowed value under Standards - 
Global - SystemResourceConfiguration within 
Tradeguide.

239 Maximum Output File Size Exceeded
Cause Resolution

Output files created by the 
translation have reached the 
maximum size.

Correct the maps that are causing the output files to be 
so large, possibly due to spinning on one record or field.
If the output file needs to be large, increase the 
MaximumOutputFileSizeAllowed value under Standard - 
Global - SystemResourceConfiguration within 
Tradeguide.

 

248 Value Stack Memory Error
Cause Resolution

Translator runs out of memory 
when adding to the value 
stack.

You can resolve this error message in one of three ways:

249 Error in idcopy In Access Parser
Cause Resolution

Fatal internal error. Call Customer Support for assistance.

250 Translation Memory Error
Cause Resolution

Ran out of memory during 
translation. Could be caught 
in an infinite loop.

Correct the data model and, for UNIX users, consider setting 
the system ulimit for additional protection. It is 
recommended that when using the asterisk (*) to set a 
variable maximum occurrence, check the rule logic or the 
nature of the data model to ensure the loop exists 
appropriately.

■ Add more system memory.
■ Perform a modeling change that attaches to the target x 

number of line items, then clear the arrays upon 
returning to the source data model. Repeat until all line 
items are parsed.

■ On UNIX, increment the maximum data size.



487 Trading Grid Online User Guide

A C T I V E  D O C U M E N T S  T R A N S L A T I O N  E R R O R S

Error Numbers 200 – 255

251 Error Allocating vstack 
Cause Resolution

Out of memory or corrupted memory 
manager.

Check memory allocated to program. Exit 
other programs, if possible.

 

252 Unable to Open Archive File (in ARCHIVE_REC())
Cause Resolution

Cannot write to archive file. Check file permissions in directory.

 

254 Error Allocating Buffer Space for Device
Cause Resolution

Out of memory or corrupted memory 
manager.

Check memory allocations. Refer to memory 
usage documentation.

 

255 Error Parsing Command Line Map Component File
Cause Resolution

Syntax error in the parsing of 
the map component file from 
the command line.

Use the following resolutions:

 

■ Look at the command line entry, and verify that no 
syntax errors exist. If errors exist, make the necessary 
corrections.

■ Look in the map component file, and verify that no 
syntax errors exist. If errors exist, make the necessary 
corrections.
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